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PART 1: ON1 PHOTO RAW 2023 OVERVIEW

ON1 Photo RAW 2023 is a complete photo editing solution, built around a full-featured photo organizer, a 
sophisticated raw processing engine, and modern image enlargement technology. It is infused throughout 
with modern AI-based, machine learning technology, all designed to make your photo editing and 
organization efficient and worry-free.

With Photo RAW, you can apply quick edits and stylized effects to your photos, remove noise easily with 
the amazing NoNoise AI, sharpen out-of-focus details with TackSharp AI, and perform expert portrait 
retouching with Portrait AI. Nearly all of your edits can be made globally or locally to specific regions of a 
photo, and with the new Super Select AI tool, you can point to an area of a photo — sky, people, foreground 
or background, or other objects — and automatically apply effects, sky replacements or other adjustments 
to those specific areas. You can even create presets that will only be applied to specific regions of any 
photo, without having manually to create complicated masks or layers.  

For more complex projects, Photo RAW includes advanced masking tools that let you create and refine 
complex selections with a few clicks, as well as layering functionality for compositing and blending images 
quickly and easily. You can also combine a series of photos into beautiful panoramas, stunning HDR images, 
and perfectly focus-stacked photos with the click of a button, or use the time-lapse feature to create 
flicker-free movies from hundreds of still images. You can even use many of the image-processing plugins 
created for Adobe Photoshop in your ON1 Photo RAW 2023 workflow.

With all of this, Photo RAW lets you work in a fully non-destructive workflow: you can import, sort and 
view raw photos in Browse, and finish them in the Edit module without having to worry about saving your 
edits. The next time you open your photo, all of your settings will be remembered, and you can easily 
change settings, add new ones, or start over from scratch, all without having to save additional versions of 
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your photo. Photo RAW 2023 is even non-destructive when working with such non-raw formats as JPEG, 
Photoshop (PSD), PNG and TIFF.

When you’re done editing, you can use Photo RAW’s Resize AI technology to perform industry-standard 
image enlargement on your photos—with full printing capabilities. Resize AI uses AI neural networks to 
create the highest-quality photo enlargements of any resizing tool on the market. Its super-resolution 
technology enlarges photos while maintaining and recovering detail and sharpness.

And, when Photo RAW 2023 is used in conjunction with the optional ON1 Cloud Sync service, you can 
capture, view and edit your photos across multiple computers and mobile devices without having to worry 
about their location. You can even share presets, and extras like backgrounds and textures, between two 
computers.

Getting Help
You can find an extensive collection of 
video tutorials and help documents in 
the Help section of the ON1 website 
(on1help.zendesk.com). This is the 
best and quickest way to dig into the 
entire ON1 workflow and discover new 
techniques that will help you with your 
photo editing and organizing. There, 
you can search our Knowledge Base for 
frequently asked questions, common 
issues and more. 

Inside ON1 Photo RAW 2023, you 
can use the Learning Hub to directly 
display videos for getting started with 
the app, search the ON1 online help 
system—including with and online chat 
assistant—and the ON1 Shop, where 
you can purchase add-ons and courses 
for Photo RAW. If you’re a member of 
the ON1 Plus community, you’ll also 
find access to Plus content and loyalty 
reward downloads.

The Learning Hub is accessible via the 
Help menu or from the Help icon at the 
bottom of the left bumper panel.  

The Learning Hub is available directly from within ON1 Photo RAW 2023, and includes links 
to videos (which can be played directly in the Hub window), ON1’s online help system, and 
the ON1 store.

https://on1help.zendesk.com/hc/en-us


ON1 Photo RAW 2023 User Guide	 Part 1: Overview	 3

System Requirements

MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.15.6, 11 or 12
Windows 10 or 11 
current maintenance releases, 64 bit only

macOS 12 and above
Windows 11 
current maintenance releases, 64 bit only

PROCESSOR Intel or AMD processor, 2GHz or faster, or Apple Silicon processor

RAM 8 GB 16 GB or more

HARD DRIVE 3 GB for installation 3 GB for installation and SSD drive

DISPLAY Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 2GB VRAM, 1920x1080 
resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 2GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 8GB VRAM, 1920x1080 
resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 8GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

MOBILE APP Apple iPhone or iPad with iOS 14 or 
higher; Android phone or tablet with 
Android 10 or higher.

current maintenance releases, 64 bit only

Apple iPhone/iPad with iOS 15 or higher; 
Android phone or tablet with 64-bit 
Android 11 or higher.

current maintenance releases, 64 bit only

INTERNET A high-speed internet connection and active account for ON1 Cloud Sync, activation, 
auto-update checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports pressure-sensitive tablets for controlling brush size and/or opacity, and 
external control devices (such as those from LoupeDeck and El Gato). Supports ICC/
ICM profiles for camera input, display, soft-proofing, and printing. Hardware display 
calibration tool is recommended.

Photo RAW 2023 also supports many plugins designed for use with Adobe 
Photoshop.

LANGUAGES 
SUPPORTED

English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, 
Portuguese, Italian, Dutch
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Installation
To install ON1 Photo RAW 2023, you must 
first download and install the ON1 Application 
Manager, which manages your ON1 applications 
and free trials. Once you’ve installed the 
Application Manager, double-click on the app 
icon. You will first be prompted to sign in to your 
ON1 account. The Application Manager will then 
communicate with the ON1 servers, and display 
any apps you already have installed, as well 
as any newer apps that are available for your 
account.

Your license lets you install Photo RAW on two 
computers. When you enter your ON1 account 
info, Photo RAW communicates with the ON1 
activation server and registers your software for 
that computer.

If you wish to move your copy of Photo RAW 
from one registered computer to a new one, and 
you are not going to be using the older machine, 
it is best to sign out of the old computer first. 
Open Photo RAW and select Sign Out from the 
Help menu. This will deactivate Photo RAW 
2023 on the current machine, and you can 
install and sign in on another machine from the 
Application Manager.

FREE TRIAL VERSION

ON1 Photo RAW 2023 can also operate as a 
fully featured trial version for 15 days from 
when you first launch it. This gives you time 
to evaluate the product and see if it fits your 
needs. To install Photo RAW as a trial, click on 
the Free Trials label in the Application Manager, 
and click on the Install button. The Application 
Manager will display the number for days left in 
your trial; to purchase Photo RAW, click on the 
Buy button in the Free Trials section.

MAC INSTALLATION LOCATION
On a Mac, the application is installed in the ON1 
Photo RAW 2023 folder in the Applications 
folder. 

The ON1 Application Manager, showing the login screen, the available apps for 
your account, and the currently installed apps.
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If a previous version of ON1’s Photo RAW, Perfect Photo 10 or Perfect Photo Suite is found, it will be 
maintained or replaced based on your preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS INSTALLATION LOCATION
The application is installed in the ON1 Photo RAW 2023 folder in the \Program Files\ON1\ directory. 
If a previous version of ON1’s Photo RAW, Perfect Photo 10 or Perfect Photo Suite is found, it will be 
maintained or replaced based on your preference during installation.

Support files are installed into \ProgramData\ON1\.

UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of ON1 Photo RAW on your computer, the installation process will move over 
any cataloged folders, albums, and metadata presets. 

BACKING UP YOUR PHOTO RAW CONFIGURATION

ON1 Photo RAW 2023 includes a back-up and restore function for most of the app’s settings, presets, 
extras, all edits, made to any image and much more (your photos are not backed up, however). To learn 
more about this feature, see “Backing up Your Work in Photo RAW” on page 276. 

NOTE: If you have Adobe Lightroom Classic CC installed on your Windows 
or Mac system, the Installer will add a Lightroom plugin for migrating your 
Lightroom catalog to Photo RAW. See “Moving Your Lightroom Catalog to 
Photo RAW” on page 272 for information on this process.

Launching ON1 Photo RAW 2023
To launch Photo RAW 2023, with access to all modules, follow these steps:

MAC

1.	 Open your Finder.

2.	 Navigate to the Applications folder.

3.	 Navigate to the ON1 Photo RAW 2023 folder.

4.	 Double-click on the ON1 Photo RAW 2023 application icon.

You can add ON1 Photo RAW 2023 to your dock for easy access by clicking and holding the icon in the 
dock and selecting the Keep In Dock option. If you use Launchpad it can be found there as well.
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WINDOWS 10

1.	 Open the Start screen by pressing the Window key.

2.	 Select ON1 Photo RAW 2023.

If you selected the “Add Icon to Desktop” option during installation you can also access ON1 Photo RAW 
2023 from there.

You can log into your ON1 user account area (https://www.on1.com/login/) at any time to download the 
software, see the number of computers you have registered, and make basic changes to your account 
information, including your email address, password, and notifications.

If you have issues related to installing or activating Photo RAW, please contact ON1 customer support, 
which can be reached by clicking on the ON1 website’s Support tab (https://on1help.zendesk.com).

Uninstalling ON1 Photo RAW 2023
To uninstall ON1 Photo RAW 2023, first deactivate your product: open ON1 Photo RAW 2023 and select 
Sign Out… from the Help menu. (This will allow you to transfer your license to another computer.)

On a Mac, go to the Applications/ON1 Photo RAW 2023/Documentation folder, and double-click on the 
Remove ON1 Photo RAW 2023 application.

On a Windows computer, go to Control Panels, and under Programs select Uninstall a program. In the list 
that comes up select ON1 Photo RAW 2023 and then click on the Uninstall button.

Working with Files
ON1 Photo RAW 2023 can view and open the following file types, in RGB color mode, at either 8 or 16 bits 
per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

• High Efficiency Image Format (HEIC)

•	 ON1 Photo format (ONPHOTO) 

Photo RAW can export files in PSD, PSB, TIFF, JPEG, DNG and PNG format.

ON1 Photo RAW 2023 uses your camera manufacturer’s raw format as the default format when editing 
your photos. Photo RAW’s non-destructive editing capabilities let you view your raw files—or any other 
supported file type from the list above—in Browse, and work on them in the Edit module without having to 

https://on1.com/login/
https://on1help.zendesk.com
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create any intermediary files. There are no multiple versions of images cluttering up your directory; Photo 
RAW remembers the edits you’ve made to your photos and applies them non-destructively to your original.

This means is that there is no need to “open” the files to edit them; you just work with them as desired, 
and ON1 Photo RAW 2023 will remember your edits as you travel across the modules, even when you are 
working with a layered photo. You’ll only need to save them in a different form when you wish to export or 
share them in non-raw formats, or when you wish to work with the Resize module.

NOTE: ON1 Photo RAW 2023 can also view and catalog most standard video 
formats inside the Browse module. While you cannot play or edit video from 
within Photo RAW, you can perform file management tasks and edit metadata. 
Double-clicking on a video file in Photo RAW will launch the default video 
player for your computer.

ON1 Photo RAW 2023 Modules
ON1 Photo RAW 2023 has three modules: Browse, Edit, and Resize. Each module focuses on 
one task, giving you access to just what you need to get that task done. Browse handles file-
management operations, Edit performs non-destructive pixel editing—in a layered workflow, if 
you choose—and Resize is used to enlarge images, primarily for printing to large-format printers.

Browse is the default module. It is used to navigate through your drives and cloud services to find 
images, as well as to import photos and perform specialized image-combination tasks: assembling 
panoramas, creating high-dynamic range (HDR) images, creating focus-stacked images, and 
building time-lapse movies from a sequence of photos. 

When you take an image from Browse to the Edit module, Photo RAW 2023 works in a non-
destructive manner, preserving your edits as you work. When you return to Browse, you’ll see 
your edits applied in all of the various viewing modes. (Thumbnail, Detail, Filmstrip, Compare and 
Map.

Within the Edit module are five tabs, Develop, Effects, Sky Swap AI, Portrait AI and Local 
Adjustments. Each tab has a specific area of functionality: Develop for basic editing, Effects for 
stylization, Sky Swap for replacing skies in an image, Portrait for retouching portraits, and Local 
Adjustments for targeted editing of specific areas in your images.

Opening an image in Resize is destructive. Because the end result is a new, scaled file, usually 
intended for printing, Resize creates a copy of the image (generally saved in the .PSD format) and 
saves that to the same directory as your original image.

THE MODULE SELECTOR

The Module Selector is on the right side of the screen, visible at all times. At the top of the 
selector are icons for Browse and Edit. Clicking on one of those icons will take you to that 
module.
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When you are working in Browse, the selector will have five icons in the center that are intended for use 
when combining photos: Layers (which takes you into the Edit module), Pano, HDR, Focus and Time, for 
time-lapse. (For more on these functions, see “Combining Photos with Photo RAW” on page 189.)

At the bottom of the selector is the Resize icon, and icons for printing, sharing or exporting an image or 
group. (see “Output and Sharing” on page 208)

Using Photoshop Plugins with Photo RAW
ON1 Photo RAW 2023 has the capability to run many plugins created for use with Adobe Photoshop, even 
if you don’t have Photoshop installed on your system. When you process an image in the Edit module, and 
want to run it through a plugin, you are creating a new layer in your image document.

To set up Photo RAW to use Photoshop plugins, you open Photo RAW’s Preferences and click on the Plug-
ins tab. There, you can open Photo RAW’s default folder for Photoshop plugins and copy the plugins to 
that location, or you can select a secondary folder that contains plugin files, by clicking the Choose button. 
You’ll have to restart Photo RAW for the plugins to become available; once active, you can open a photo in 
the plugin by choosing Filters from the Layers menu in the Edit module. Photo RAW will launch the plugin; 
once you’re done, and the plugin returns the edited photo to Photo RAW, it will appear as a new layer, 
where you can apply any of the Edit module’s functions.

To learn about working with the Layers feature in Photo RAW, see page 190.

WHICH PHOTOSHOP PLUGINS WORK WITH PHOTO RAW?

When checking to see if a Photoshop plugin is suitable for use in Photo RAW, note the following 
exceptions: 

• Photo RAW does not support Photoshop automation plugins. That includes plugins that 
create layers or change the canvas size such as interpolation applications.

• It also does not support Photoshop panels.

Even without those exceptions, we cannot guarantee that all Photoshop plugins will work properly with 
ON1 Photo RAW. You should test each added plugin to make sure that it functions as intended. A current 
list of supported plugins can be found in the Help section of the ON1 website (https://on1help.zendesk.
com).

https://on1help.zendesk.com
https://on1help.zendesk.com
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Extras
ON1 Photo RAW 2023 supports a number of additional file types that can be used in various modules. 
These files are called Extras, and the file types include:

• Presets for use within the Edit module.

• Paper presets (type and size) for use within Resize.

• Backgrounds that can be imported and used with Photo RAW’s Layers feature.

• Borders than can be imported and used in Layers and Effects.

• Textures that can be imported and used in Layers and Effects.

• Look-up tables (LUTs) for use with Effects’ LUTs filter.

• Custom brush shapes, which are generally saved as black-and-white TIF files. Photo RAW can 
also import brush shapes saved in the Adobe Brush Preset format (.abr).

• Sun flares, which can be imported and used with Effects’ Sun Flare filter.

• Watermarks, image files (transparent PNGs) that can be used with Export and Print.

• Skies, replacement skies for use with Photo RAW’s Sky Swap AI feature in the Edit module.

ON1 includes a number of extras in the product when you install Photo RAW, and you can create your own, 
or add extras downloaded from the ON1 website. You can use the Extras Manager to import and manage 
your own extras, creating categories for each type, and deleting extras that you no longer want.

HOW TO IMPORT EXTRAS

To import extras, choose Manage Extras from the File menu in Browse and Edit, then follow these steps:

1.	 Select the type of extras you wish to import from the list of tabs at the top. You can only 
import extras of one type at a time.

The Extras Manager is used to import (and remove) everything from presets to replacement skies, watermark files and 
more.
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2.	 Click on the Import button in the footer of the left column. A dialog box will open; select the 
files to import. If you want to import an entire folder, open the folder, select the first file, 
then shift-click on the last file. Click Import when your selection is complete.

3.	 Select a category for your extras to live in. This is where you will be able to find it inside 
ON1 Photo RAW 2023. When importing presets, you can select from a preexisting category 
or create a new one (which will show up in the Presets list). For other extra types, the first 
time you import, you’ll need to create a new category; after that, any time you import that 
type, you can choose that original category, or you can create another one. 

When your extras have been imported, they will be displayed in the a appropriate Extras Manager category.

NOTE: Most extra types mentioned here will have a corresponding Import 
button in their respective panes or windows. (For example, watermarks in the 
Export panel, or skies in the Sky Swap AI pane, and so on.) Clicking the Import 
button in these instances will open the Extras Manager. To import backgrounds 
and custom brushes, choose Manage Extras from the File menu.

Organizing presets

The Presets tab of the Extras Manager gives you additional options for working with large groups of 
presets inside Develop and Effects. When you are using the Presets tab, you’ll see ‘+’ and ‘-’ buttons, which 
let you add or delete categories to the list of your presets. 

You can also add subfolders to any of the Presets categories, which can help organize and manage large 
collections of presets. You can use drag-and-drop to move existing categories into another, or you can add 
a category subfolder to an existing category by clicking on the category and then clicking on the ‘+’ button 
in the Extras Manager window. (When you are importing presets, Photo RAW gives you the opportunity to 
add presets to any category folder or subfolder.)

The Presets section of the Extras Manager will also let you export presets, for sharing with other users, or 
to save seldom used presets for archiving purposes. To export a complete category, click on the category in 
the list on the left side of the window and click on the Export button. This will export a folder that contains 
a single .ONpreset file, which includes all of the presets from that category. If you would like to export a 
single preset, click on the preset from the list on the right side of the window and click Export.

What type of images can I import as Extras?

Here is a breakdown of the different file types that can be used with the various extras categories:

• Backgrounds and textures may be JPEG, TIFF, or Photoshop files.

• Border files must have a large central area that is transparent, so only files that support 
transparency, such as PNG, can be imported as borders.

• LUTs can be in either .3DL or .CUBE format.

• For custom brushes, Photo RAW can import Photoshop-compatible brushes saved as black-
and-white TIF files, or files saved in Photoshop’s .abr file format.

• Sun flare files are usually JPEG files with a black background.
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• Since most watermarks are overlays on top of an image, those files are usually PNGs with 
areas of transparency, although JPGs can also be used.

• Sky-replacement images may be any image file that Photo RAW can open, including JPEG, 
TIFF, or Photoshop files, although the most common types are JPG or TIFF. (See “Replacing 
Skies with Sky Swap AI” on page 170.)

NOTE: If you download an .ONPreset or .ONP file (for use with Develop or 
Effects), you can simply double-click on it to install it. For more information, see 
the Presets section of this guide, starting on page 117.

USING EXTRAS WITH LAYERS IN THE EDIT MODULE

You can view and add extras to any open document in the Edit module by adding a new layer. Just click 
Layer > Add Layer from the File menu to open up a file browser window on-screen, where you can choose 
installed extras or any file from your computer. For more on this, see “Working with Layers” on page 190. 

USING EXTRAS IN EFFECTS

You can access your imported borders, textures, LUTs and sun flares in Effects, as you would any of the 
default extras installed with Photo RAW. To use them follow these steps:

1.	 Open an image in Effects.

2.	 In the Filter Options pane, add the filter type you wish to work with from the Add Filter 
button (Borders, Textures, LUTs, or Sun Flare).

3.	 From the Category pop-up, select a category you have imported. User-added extras 
categories will appear at the bottom of the category list.

4.	 Choose an extra from the imported category.

NOTE: Each filter will have a different method for choosing its extras. Specific 
information on the different filters can be found in the Effects section of this 
guide: page 154 (Borders), page 162 (LUTs), page 166 (Textures), and page 
165 (Sun Flare). For information on working with custom brush shapes, see 
“Using Custom Brushes to Add Overlays To Photos” on page 187.

USING OTHER EXTRAS: WATERMARKS AND SKIES

Imported watermark files will be displayed in three locations: in the Logo section of the Watermark panes 
in Photo RAW’s Export (see page 229) and Print (see page 243) functions, as well as in the My Extras tab 
when you add a new layer to a document in the Edit module (see page 190).

When you add replacement skies to the Extras Manager, each category that you added will be added to 
the Sky category list at the top of the Sky Swap AI pane. All skies in that category will be listed in the Skies 
pop-up menu under the Sky category menu. 
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HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1.	 Open the Extras Manager in any module (File > Manage Extras).

2.	 Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.

3.	 To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4.	 To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.

NOTE: If you are using Photo RAW as a subscription, the Cloud Sync option will 
sync all of your imported extras between your licensed computers. See “Using 
ON1 Cloud Sync with Photo RAW” on page 65 for more about this service.  

Customizing Photo RAW’s Keyboard Shortcuts
You can customize ON1 Photo RAW 2023’s 
hotkeys via the Keyboard Shortcuts window. 
This window lets you view and change the 
shortcuts for any tool, tool option, module, or 
menu item inside Photo RAW. You can assign 
shortcuts to menu items that don’t yet have 
a shortcut, build multiple sets of shortcuts 
as preset styles, and create a summary of 
your shortcuts that can be viewed in any web 
browser.

To view or change Photo RAW’s hotkeys, choose 
Keyboard Shortcuts from the Edit menu in any 
module. By default, Photo RAW’s shortcuts will 
be displayed, organized hierarchically by the 
following groups: 

• Modules, commands for switching 
between Photo RAW’s different 
modules.

• Develop, for applying tone and 
color adjustments directly from the 
keyboard while you are working in the Edit module. (See “Adjusting Tone & Color settings via 
hotkeys” on page 73 for details on working with this feature.) 

The Keyboard Shortcuts window displays a list of modifiable commands and 
operations in five distinct groups.
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• Tools, for the 18 tools available in the 
Edit module.  

• Tool Options, for the brush and 
mask viewing options available in any 
masking tool’s Options Bar.

• Menu, which includes all of Photo 
RAW’s menu items in each module. 

You open each group by clicking on the triangle 
to the left of the group name, or you can use 
the search field at the top of the Keyboard 
Shortcuts window to search for a command in 
any of the groups (right). 

Each command that has an assigned key will 
display that key in the Shortcut column. The 
Shortcut field will be empty for any command 
that doesn’t have an assigned key, and any field 
with a grayed-out shortcut means that you 
cannot modify that command’s keys.

NOTE: Some keyboard shortcuts cannot be changed. These include menu 
commands used by the operating system (Cut, Copy, Paste), and the Browse 
module shortcut (G). Also, you can’t use the Escape, Return/Enter, or Delete 
keys as a shortcut.

MODIFYING HOTKEYS

The Default preset style’s hotkeys cannot be 
modified, but you can create your own set of 
shortcuts by double-clicking on any command 
you wish to add or change. You’ll be asked if you 
want to create a new preset. Clicking Yes will let 
you name the new preset style, and Photo RAW  
will make a duplicate of the Default set.

At this point, you can change any existing 
hotkeys, or add your own to commands that 
don’t have them, by double-clicking in the 
Shortcut field for that command. The field will 
be highlighted, and you can press the key or key 
combination you wish to use. If that key is used 
by another command, a dialog will inform you of 
that, and giving you the option of either keeping 
the existing hotkey/command combination, or 
changing it to the new command.

When you add or change a hotkey the first time, Photo RAW will prompt you to 
create a new preset style, which makes a duplicate of the Default preset. You 
can switch between preset styles—including back to Photo RAW’s Default 
set—by using the pop-up menu at the top of the Keyboard Shortcuts window.

If you try to add a shortcut key combination that is already in use, Photo RAW 
will let you know, and give you the option of keeping (Cancel) or removing (OK) 
the other command/shortcut.

The search field at the top of the window lets you quickly find commands 
based on keywords.
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When you change a default shortcut to a new key combination—even for commands and options that didn’t 
initially have a shortcut—a Reset arrow will appear to the right of the Shortcut field. Clicking the icon will 
reset the command to its original state, from the Default preset style.

To delete a shortcut, double-click in the Shortcut field and press the Delete key. 

The Summarize button at the top of the Keyboard Shortcuts window will create an HTML table of the 
current set of hotkeys. You’ll be asked where to save the file, and double-clicking on it will open that table 
in your default web browser, where you can view or print the list. 

You can return to the original Photo RAW shortcuts by clicking on the pop-up menu at the top of the 
Keyboard Shortcuts window, and choosing Default from the list of preset styles. That menu can also be 
used to create a new preset or to delete an existing one that you created. The Default preset cannot be 
removed, however.

Using Photo RAW with a Scroll Wheel
When you are using ON1 Photo RAW 2023 with a mouse that has a scroll wheel, there are number of 
different options available throughout the app, on both Mac and Windows.

Throughout the app, the scroll wheel has the following general options:

• Using the scroll wheel will pan up and down in the current window. In Browse’s Thumbnail 
view, it will scroll the window. In most other views, using the scroll wheel with the cursor 
over the preview area will pan the image on screen up and down. Holding the Shift key down 
and scrolling will pan left or right.

• Hold Option (Mac) or Control (Windows) with the scroll wheel to zoom in or out of an image.

In the Edit module, when working with any tool that has a brush size and feather option, press Command-
Option (Mac) or Control-Alt (Windows) and scroll to change the brush size. To change the feather, press 
Option-Shift (Mac) or Alt-Shift (Windows).

The General Preferences option for setting the scroll wheel, from earlier versions of Photo RAW, has been 
removed.

Changing Photo RAW’s font size
By default, Photo RAW prioritizes the main workspace to focus on photos, using a small font size to display 
panel names, labels, file names any other basic text. You can adjust the default font size to one of three 
settings, Small, Medium or Large, by choosing the General tab of Photo RAW’s Preferences window. Select 
the option from the Font Size pop-up, and restart Photo RAW to have the effect take place.

Photo RAW has three options for displaying type in the main workspace, Small (left), Medium (middle), and Large (right). To change the size, go to 
the General tab of the Preferences window, and pick the new option from the Font Size window. The change will take effect the next time you 
launch the app.
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PART 2: ORGANIZING WITH BROWSE
ON1 Photo RAW 2023’s Browse module is a powerful and incredibly fast photo browser and manager. It 
gives you one place to find, view and manage your images, no matter where they are located.

Browse is an ideal environment for performing quick sorts and edits after a shoot: You can import, then 
view, your photos immediately without having to wait for a long cataloging or preview-creation process. 
You can rate, add keywords and flags, create albums, and even remove photos, all from within Browse. And, 
with the new Keyword AI feature, Photo RAW will automatically analyze your photos in the background, 
suggesting new keywords on the fly, letting you search your photo library in entirely new ways.

Browse also has a sophisticated indexing system, designed to let you get access to your favorite folders of 
images quickly; just add a folder to the My Catalogs pane, and it will index your photos in the background, 
giving you increased search capabilities and even faster access to your most important photos. 

When using the ON1 Cloud Sync service (see page 65 for more), you can easily share a cataloged folder 
or album with other computers of yours (a laptop, for example) and any of your mobile devices. 

Browse also lets you apply any editing presets from the Edit module directly to an image or group of 
images. You can copy edits made on one photo and paste them onto another, or even a group of photos. 
Some of Browse’s key features:

• Find your photos fast, wherever they are: local or network drives and cloud-based services.

• Manage duplicates or similar photos (and more) quickly with the Smart Organize feature.

• Import your photos from your camera, memory card or other device.

• Add any metadata—from creator to keywords and GPS—quickly to a group of photos, and use 
metadata templates to apply often-used metadata information during the import process.

• Catalog important folders of photos, to get the fastest access to your most important photos 
across multiple sources, while still preserving your folder hierarchies and locations.

• View and cull photos from a shoot in four different views: Grid, Filmstrip, Detail and Compare 
views. Use the Map view to see where you shot your photos, or to add location information.

• Dual-display capability that lets you work more efficiently. See Grid view on one display, and 
Detail view on another, or use this mode to present photos on a TV or projector.

• Apply Edit module presets to a single image or group, or sync edits across a group.

• Build panoramas and high dynamic range (HDR) images directly from within Browse, and 
blend multiple photos at different focus distances to increase depth-of-field.

• Create flicker-free time-lapse videos from sequences of raw images.

• Connect your Nikon or Canon camera and capture photos directly, with full manual camera 
support, using tethered-shooting mode.

• Quickly find photos based on their creation date, or any combination of metadata 
information, including time of day, camera/lens type, file type and more.  

• Create albums from a selection of photos, or use advanced searching methods to create 
“smart” albums that dynamically update based on metadata.

• Copy, move, delete and rename files.

• Sort, flag, rate or color code your images.
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ON1 Browse Main Screen Overview

The Browse module has three main sections: the Catalogs/Browse/Presets panel on the left side of the 
screen, the Preview window in the center, and the Photo Info panel on the right side.

The main components of Browse module include:

A.	Shortcuts: This palette contains shortcuts to the Getting Started, Smart Organize and 
Advanced Search windows, as well as to your most common photo storage locations. (See 
“Using Shortcuts” on page 32.)

B.	 ON1 Cloud Sync/Preferences/Help/Panel icons: Accesses the ON1 Cloud Sync status 
window (when available), the ON1 Learning Hub or Photo RAW’s Preferences window. The 
icon at the bottom opens and closes the left panel. (See “Using ON1 Cloud Sync with Photo 
RAW” on page 65 for more on the syncing service.)

C.	 My Catalogs/Browse/Presets Panels: Switch between the cataloged folders panel, local 
drives and cloud sources, and Edit module presets by clicking on the tabs.

D.	Cataloged Folders: Displays your cataloged folders (shown) or local disks, favorite folders and 
cloud sources, depending upon which tab has been selected.

E.	 Cloud Sync: Shows all ON1 Cloud Sync devices.

F.	 Albums Pane: This pane is for creating albums, also known as collections of images. Albums 
can be grouped into subfolders for easy organization.
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G.	Smart Albums Pane: This pane includes collections of dynamically built albums based on 
criteria set in the Advanced Search window.

H.	Dates Pane: Search for photos based on the capture date. 

I.	 Recent Pane: This keeps track of recently opened files and folders.

J.	 Tethered Shooting Pane: This lets you connect your Nikon or Canon camera to your 
computer; you can capture images directly from the camera to ON1 Photo RAW.

K.	 View Selector: (Icons from left) Open/close the Browse/Presets panel; toggle Dual Display 
Mode on and off; switch between Grid, Detail, Filmstrip, Compare and Map views.

L.	 Preview: The window where you can view your images in thumbnail or detail view. Above the 
area, you can also find the breadcrumbs bar, which shows the path of the selected image or 
folder in the Preview area.

M.	Thumbnail Size/Sort Options: The slider adjusts the thumbnail size, while the Sort By pop-up 
adjusts sort order based on standard selection criteria, such as file name, date captured and 
more. (You can also create your own custom sort order.)

N.	Filter Panel: Lets you filter the current Browse view based on likes, star ratings, color labels 
or any text associated with the images.

O.	Selection Information: Lists the number of selected images out of the total number in the 
current view.

P.	 Copy to My Catalogs: Clicking this button lets you add the currently selected photos to any 
of your existing cataloged folders.

Q.	Info Pane: This section will give you detailed metadata about your image when available. 
(Also displays Navigator and Histogram panes when in Filmstrip, Detail and Compare modes.)

R.	 Metadata Pane: This pane will show your metadata for the selected image.

S.	 Album Info/AI Keywords List: Displays the names of any albums in which the currently 
selected photo resides, and a list of suggested AI-generated keywords for the photo.

T.	 EXIF/IPTC/Location Info: Displays additional detailed information about the selected file.

U.	Keyword List: All keywords found in your image catalog.

V.	 Reset All/Previous/Sync: These buttons let you synchronize the edit settings of one image 
on another (or group). Reset All removes all edit adjustments made in Edit from the selected 
image or group of images. Previous will past the Edit module settings from the last edited 
photo onto the currently selected photo. When you have multiple photos selected, the Sync 
button will be visible; clicking this will synchronize the edits from the photo selected first, 
and onto the other photos in the selection. 

W.	Module Selector: Use this to switch to other modules inside ON1 Photo RAW 2023.

X.	 Layers/Panorama/HDR/Focus/Time: When multiple images are selected in Browse, 
use these buttons to open the images as separate layers in the Edit module, or to create 
panoramas, high dynamic range (HDR) or focus-stacked images. The Time button will build 
a time-lapse video from the selected images. (See “Combining Photos with Photo RAW” on 
page 189 for information on using these features.)

Y.	 Export/Print/Share: Shortcuts for exporting (Resize), printing and sharing selected photos. 
The bottom icon will open and close the Info pane.
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WORKFLOW BASICS IN BROWSE

ON1 Photo RAW 2023 provides a great deal of flexibility in how you wish to work with your photos. You 
can browse for existing photos in folders that are connected to your computer (including cloud services like 
Dropbox, Google Drive and Microsoft OneDrive). You can also import photos directly from your camera or 
other device. And, once you’ve found a photo (or photos) you wish to work on, moving to the Edit module is 
a single click away. 

If you store your photo library in a specific location on an internal or external hard drive (or multiple drives), 
you can have Photo RAW index those folders. This process ‘catalogs’ the photos, reading their metadata 
and building previews, letting you navigate and access your photo library much more quickly than if you 
were to simply look at a random folder of images. Cataloging a folder doesn’t move or change your photos; 
it just makes it easier for you to find and work with them inside Photo RAW.

Getting Started window

The first time you launch Photo RAW, Browse displays a Getting Started window, designed to help you get 
working quickly. This window has three options:

• Edit a Single Photo: clicking this button will give you the MacOS or Windows file-selection 
dialog, where you can navigate to a specific photo. Once you’ve chosen an image, Photo RAW 
will open that photo directly within the Edit module (starting with the Develop tab). You have 
access to all the editing tools, and when you’re done editing, you’ll be asked to save a copy 
of the edited version of your photo. (See “Working in the Edit Module” on page 72 for 
information on editing photos.)

• Browse a Folder: this button will open the file-selection dialog for your computer. There, you 
can navigate to a specific folder of photos. Clicking the Open button in that dialog will display 
that folder’s photos in the Browse Preview area.

• Catalog Your Photos: clicking this button will let you choose a folder to be cataloged by 
Photo RAW. This folder (and any subfolders of photos within it) will be added to the My 
Catalogs pane. (See “Cataloged Folders” on page 30 for info on creating cataloged folders.)

The Getting Started window is designed to help you get working quickly with ON1 Photo RAW 2023.
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The Getting Started window can be accessed at any time by clicking the ‘+’ button in the Shortcuts section 
on the left side of the Browse window (see “Using Shortcuts” on page 32), or via the Help menu. 

NOTE: If you wish to use the full non-destructive editing capabilities of Photo 
RAW when working on your photos, do not use the Edit a Single Photo option. 
Instead, inside Browse, find the photo you wish to edit, select it, and click on 
the Edit module selector on the right side of the main window. (See “Using 
Photo RAW as a Raw Editor” on page 74 for more about non-destructive 
editing and why it might be important to your workflow.)

Working in the Preview Area
The Preview window is the largest part of the Browse workspace. Here, you can view folders of images 
(including all images synced via ON1 Cloud Sync) in either thumbnail or detail view, based on the folders, 
albums or filters you have chosen via the Browse panel. There are five main views in the Preview window:

• Grid, which displays a grid of thumbnails of your images. This view also displays folders, 
letting you go up and down a folder hierarchy quickly. You can also change the information 
displayed in each cell in the grid. Shortcut key: G

• Photo (also known as Detail), which you get by double-clicking on a thumbnail. You can view 
this image in either ‘fit to window’ view, or can zoom in to see more detail. Shortcut key: E

• Filmstrip, which displays a strip of images from a folder or album at the bottom of the screen. 
The currently selected image displays in the preview area above the strip; use the arrow keys 
to move through the folder, or click on an image in the filmstrip to view it in the preview area. 
Similar to Detail view, the Filmstrip mode lets you view the current image in ‘fit to window’ 
and zoom views. Shortcut key: F

• Compare, which lets you view a group of photos in separate panes inside the preview area. 
You can zoom in on one or all of the selection, and lock the panning so that, as you move 
around one photo, the others move with it. Using Compare, you can quickly find the best 
images in a sequence, whether it be for composition, sharpness, facial expressions or more. 
Shortcut key: C

• Map, which can be used to display locations for photos that have GPS-based location data, or 
to search for locations that can then be applied to a photo or group of photos. Shortcut key: M

You can change the viewing mode between the different views by clicking on the view selector at the 
bottom of the window, or by using the shortcut keys listed above. 

NOTE: You can use your mouse’s scroll wheel in most of Browse’s view modes 
to help navigate and to zoom in and out when looking at photos. See “Using 
Photo RAW with a Scroll Wheel” on page 14 for more information.
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ALTERNATIVE VIEW MODES

In all of Browse’s preview modes you have three options for viewing the contents of the current window:

• Photo RAW’s default is a resizable, movable window.

• Full Screen Mode, which can be found in the Window menu, will expand the main window 
to fit the contents of the current display. The menu bar is hidden, but it can be viewed by 
moving the mouse cursor to the top of the screen. This mode can be toggled on and off by 
pressing Option-Control-F (Windows) or Command-Control-F (MacOS).

• Full Screen Preview, also found in the Window menu, will display the currently selected 
photo full-screen, without any of the other interface elements. You can use the arrow keys 
on the keyboard to move from photo to photo. This option is helpful when you wish to view 
a selection of photos as large as possible without any distractions. (This mode can also be 
turned on by pressing Shift-F (MacOS only).)

Using Photo RAW to display slideshows

You can create on-the-fly, full-screen slideshows to display groups 
of photos inside Browse. Select a group of photos in the preview 
area, and choose Quick Slideshow from the Window menu. The 
slideshow will loop until you stop, by pressing the Esc key.

The Quick Slideshow submenu has options for the amount of time 
between slides and whether to display a fade transitions between 
slides or have no transition at all. 

FAST PREVIEW MODE

Sometimes, when you get back to your computer after a shoot, you want to be able to go through a large 
number of photos quickly, looking for your best shots. ON1 Photo RAW’s Fast Preview mode lets you do 
just that. Select Fast from the View menu’s Preview Quality option, and you can jump from photo to photo 
quickly with minimal lag between shots.

If you are more concerned about color accuracy than speedy previews, select Accurate from the Preview 
Quality option in the View menu. ON1 Photo RAW will generate a full-resolution preview of your photo, 
using the photo’s embedded color profile. This will take a few seconds, depending upon the size of the raw 
file you’re working with, but you will get a better sense of the actual color in the photo.

Persistent Thumbnail Cache

When you go through a folder of photos, Browse caches thumbnails and preview images as well as 
extracted metadata. This will make it faster the second time you browse a folder. It also stores user-added 
or adjusted metadata such as ratings, labels, keywords, captions, rotation and GPS data, among others. You 
can adjust the size of the cache and the storage location of the cache in the System tab in Photo RAW’s 
Preferences window (see page 269).
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FOCUS AND CLIPPING VIEWS

When you’re viewing photos with an eye toward selecting the best images in a group for editing, you 
generally want to look at issues with both exposure and sharpness. To help you with this, Photo RAW 
offers two viewing aids that are available in both the Browse and Edit modules: Clipping and Focus Mask 
overlays. In the Browse module, you can display these overlays in Detail, Filmstrip and Compare modes; in 
the Edit module, the overlays can be displayed in any of the tabs.

Clipping

Clipping occurs when the shadow and highlight tones in an 
image are suddenly cut off to completely white or black, rather 
than fading smoothly. (Large expanses of white pixels in a photo 
are often referred as ‘blown’ highlights, and can be distracting.) 
One of the benefits of shooting in raw format is that, while 
many photos will have areas of pure white or black when 
originally viewed on-screen, there is still recoverable data in the 
raw image. The Clipping overlay can help determine how big a 
problem you might have with a photo, and how easy (or difficult) 
it will be to fix. 

To display the Clipping overlay temporarily, press the J key; to 
turn it on permanently, choose View > Show Clipping, or press 
Alt (Windows) or Option (Mac) J on your keyboard.

The Clipping view overlay displays areas that have either pure white or pure black in them. Areas with a 
blue overlay indicate pure black pixels, while the areas with a red overlay indicate pure white pixels.

Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a 
lot of photos from a shoot, it can be a bit tedious to check 
focus at that level. Photo RAW’s Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt/Option J. The sharpest areas in your 
image will be represented by a bright green overlay. As you 
move from photo to photo in a folder, you’ll be able to tell 
whether you have an acceptable level of sharpness where 
you need it by the strength of the overlay. The mask will 
continue to be displayed even as you zoom in on a photo.

Clipping view displays pure white pixels with a bright 
red overlay, and pure black pixels with a bright blue 
overlay.

The Focus Mask option displays areas of sharpness with a 
bright green overlay.
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WORKING IN GRID VIEW

Grid view displays thumbnails of folders and images you have selected using the Folder or Albums panes. 
There are many operations you can perform from inside Grid view, including:

• Use the breadcrumbs to navigate (the ‘<’ button goes up one folder).

• Select your image while in Grid view and open the photo in one of the editing tabs.

• Adjust thumbnail size using the on-screen slider or use “-/+” keys on your keyboard.

• Choose Show Subfolder Contents from the View menu when you want to view the contents 
of all subfolders (this only works when you are viewing cataloged folders).

Changing the thumbnail display options

You can change the display characteristics of each 
thumbnail cell in Grid view, via the Thumbnail 
View Options command, which is in Browse’s View 
menu (and available when you right-click on any 
thumbnail in the grid). The Thumbnail View Options 
window has two sections, one for choosing the 
appearance of each thumbnail, the other for the 
information labels associated with each thumbnail.

In the Appearance section, the Size option sets 
the size of the top and bottom label text (Small or 
Large); the Fitting options let you set the image 
thumbnail so that all of the image is displayed 
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(Fit) or that it fills the frame of the thumbnail (Fill); and the Theme option lets you choose a Dark or Light 
appearance.

The Labels section lets you adjust the displayed data for the top (right and left sides) and the bottom 
labels in each thumbnail, and how each label is displayed—all the time, or only when you mouse over the 
thumbnail. You can also choose whether to display the rotation arrows and edit badges (which indicate that 
the image has been edited inside Photo RAW), as well as preview images for folders viewed inside Browse.

By default, the labels are set up to display the ratings and label information on the top left, the favorites 
state (like, empty, reject) on the top right, and the bottom displays the filename. You can however, set any 
of the three label locations to display any of more than 20 pieces of metadata, including filename, camera 
and lens information, exposure and ISO, capture date, ratings, image dimensions, and much more.

NOTE: Most of the data fields that you can display in the Thumbnail View 
Options are visible in the Metadata panel. See “Metadata Pane” on page 39 
for more information.

Sorting photos in Grid view

When working in Grid view, you can sort the thumbnails in a number of different ways by choosing the Sort 
By pop-up at the bottom of the window. The sorting options include: date captured or modified; color label; 
file name, type, or size; and rating. 

You can also create a custom sort order by dragging thumbnails inside the grid window; click and drag the 
thumbnail so that the outline sits between two images. 

Once you change the order of images this way, the 
Sort pop-up will change to Custom, and Photo RAW 
will remember the sort order for that folder until you 
change it. (Custom sorting also works—and the custom 
order remembered—when you’re viewing albums.)

At the bottom of the Sort pop-up are settings for 
sorting the view in ascending or descending order; 
selecting one of the options will rearrange the view 
accordingly. If you have a custom sort order, choosing 
these options will change the view in the opposite 
order.

Metadata viewing in Grid view

When you have the Photo panel open on the right side of the screen in Grid view, Photo RAW will display 
the Info pane at the top, which includes summary information about the selected photo, and the Metadata 
and Keyword panes, which let you view, edit and adjust many of the metadata fields for the current photo. 
When you have multiple items selected, the panes will display the information for the primary item in the 
selection (represented with a heavier outline in the grid); adding keywords or other editable metadata 
(author, location data or descriptions, for example) will apply those items to the entire selection. See page 
37 for more on the Photo panel and its operation.  

To reorder a photo in Grid view, drag it between the two photos 
where you want it to be placed.
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WORKING IN PHOTO (DETAIL) VIEW

In Photo view—also known as Detail view—you get a full-screen version of your photo. When you go to 
this view, your images will be displayed in Fit mode, showing the entire image. You can click on the image 
to zoom in to 100%. This is useful for judging small details and sharpness. Single-clicking on a image that is 
magnified will return back to Fit mode. You can click and drag a magnified image to look around. Your zoom 
mode is maintained as you move from image to image so you can compare the same spot in several frames.

When you view an image in Photo view and have the right-hand Photo panel open (as shown above), the 
Levels, Navigator (Nav) and Info panes will be visible as tabs at the top of the panel on the right. Clicking on 
the label will display that tab’s data. In the Navigator pane you can reposition the preview and change the 
magnification amount. The Levels pane displays a composite histogram of the image being displayed. You 
can also view and adjust the rating and flag labels for the current image, either via the keyboard or via the 
Info pane. (See “The Photo Panel” on page 37 for details on the Nav, Levels and Info panes.)

When working in Photo view, you can move to the next image by using the arrow keys on your keyboard, 
and you can add author, keyword, description and other information via the Metadata and Keyword List 
panes.

In Detail view, you can zoom to 100% to check small details and sharpness in a photo, view its histogram, and even apply a preset, all without having to leave 
Browse.
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WORKING IN FILMSTRIP VIEW

Filmstrip view presents a large version of your current image in the preview area, displaying other photos 
from the current view in a strip of thumbnails at the bottom of the screen. The photos are sorted by the 
current sort order, which can be changed via the Sort pop-up above the strip.

The current image is represented by a blue rectangle in the filmstrip, and you can use the arrow keys to 
move from photo to photo, or you can scroll with your mouse and click on a photo to display it in the 
preview. (You can also rate and flag images inside this view.)

When you view an image in Filmstrip view and have the right-hand Photo panel open (as shown above), the 
Levels, Navigator (Nav) and Info panes will be visible as tabs at the top of the panel on the right. Clicking on 
the label will display that tab’s data. In the Navigator pane you can reposition the preview and change the 
magnification amount. The Levels pane displays a composite histogram of the image being displayed. You 
can also view and adjust the rating and flag labels for the current image, either via the keyboard or via the 
Info pane. (See “The Photo Panel” on page 37 for details on the Nav, Levels and Info panes.)

NOTE: Filmstrip view is also available as a view in Photo RAW’s Edit and 
Resize modules. In Edit, you can rate and flag photos, using the same keyboard 
shortcuts, and move from image to image for editing. In Resize, Filmstrip view 
lets you batch-process multiple images.

Filmstrip view is similar to Detail view, but displays a strip of photos from the current folder (or album). You can easily move to another photo by using the 
right and left arrow keys, or by scrolling and clicking with your mouse.
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WORKING IN COMPARE VIEW

Compare mode is for those times when you shoot a sequence of photos of the same type of scene—a 
portrait session, a wedding, a landscape series, for example—and wish to narrow that group down to 
find your best ones. With Compare, you can select a group of photos, view them side-by-side to check 
composition, zoom in simultaneously to check focus, and rate your favorites and remove the rejects.

To use Compare mode, you can choose one of two methods:

• Select a group of images you wish to compare in either Grid or Filmstrip view. To select a 
group of contiguous photos (ones next to each other in order), simply click on the first one 
you wish to compare, then hold down the Shift key and click on the last photo. If you want to 
add noncontiguous photos, click on the first photo, then use the Command (Mac) or Control 
(Windows) key and click on each subsequent photo you wish to compare. When you have 
your selected photos, press the C key, or click on the Compare icon in the View Selector at 
the bottom left of the Browse window.

• You can also select photos directly in Compare mode: press the C key or click on the 
Compare icon in the View Selector at the bottom left of the Browse window. In the strip at 
the bottom of the window, you can select the photos in the same manner as the first option, 
by clicking on the first photo in a sequence, and Shift-clicking on the last, or by using the 
Command (Mac) or Control (Windows) key to select noncontiguous photos from a group.

When you enter Compare, you will see your selected photos in a grid in the Preview area, fit to show the 
entire photo. The currently selected photo will have a blue box around it, while the other items in the 

Compare mode displays selected photos as panes inside the preview area. The photo highlighted with a blue box is the current selection. Clicking in that pane 
will zoom the photo; if the Lock pan/zoom box is checked (above the filmstrip), then all of the compared photos will zoom with it.



ON1 Photo RAW 2023 User Guide	 Part 2: Organizing with Browse	 27

selection will have a light gray box around them. You can switch the primary selection by using the arrow 
keys on your keyboard, or by clicking inside the pane you wish to make primary. 

If you click once inside the current selection, the photo will zoom in to show greater detail; if you click and 
hold the mouse button down, you can pan across or down your photo, so you can check for things like 
detail, sharpness or facial expressions. (Clicking a second time inside the pane will reduce the photo to fit all 
of it in the pane.) 

To see the detail across the group of selected photos, click on the Lock pan/zoom dot above the filmstrip. 
Now, when you click on an area inside the primary photo, all of the photos will zoom simultaneously to the 
same location of your click. And, if you click and drag inside the primary photo, all of the selected photos 
will pan along with the primary. To pan one photo—which can be useful if the field of view was different 
than the rest—click on that photo to make it the primary selection, then hold down the Shift key and click 
and drag inside that pane. If you do this and wish to get back to the original zoom position, click on the 
Sync button next to the Lock pan/zoom setting, and it will reset the zoom view to the same place in each 
compared photo.

Use the spacebar if at you want to zoom between fit and 100% on the selected photo in the grid. Toggling 
the spacebar between views does not “lock” and will not sync with other photos even if Lock is turned on.

If you wish to remove a 
photo from the group, 
select it (by clicking on it 
or by pressing the left or 
right arrow keys) and press 
the / (slash) key on your 
keyboard. The photo will be 
removed from the Compare 
window, and the remaining 
photos will resize to best fill 
the available space in the 
window. (You can also add 
additional photos to the 
Compare window by using 
the selection techniques 
mentioned above.)

When using Compare, you can rate or flag a photo, apply a preset and add other metadata. These functions 
will only be applied to the primary selected photo (outlined in blue). There are two exceptions:

• Using the Sync settings button on the far right side of the Browse window, underneath the 
Info pane. Clicking on that will sync all of the Edit settings between the primary selection and 
all of the items being compared.

• Using the Create Album or Add to Album commands from the Albums menu: this adds all of 
the currently selected photos to either the new album (when you check the Add Selected 
Items button) or to the chosen album. This feature can be helpful when you have a group of 
images that you would like to keep for a client or to further segment a series.

Zooming into a photo, and panning to the common areas of concern, you can easily determine which photo is 
sharp enough for your needs.
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WORKING IN MAP VIEW

Photo RAW’s Map view provides a simple mechanism to add GPS information to a photo, by searching 
for a place on a web-based map, or to view the location of a photo that already has location information 
embedded in its metadata. An internet connection is required to add or view map data.

The Map display has three controls: the buttons in the upper left corner of the map, to switch between 
Street, Satellite and Outdoors (topographic) views; a search area, which lets you look for a place (cities, 
counties, roads); and the controls on the lower left, which let you zoom in or out of the current map view. 
To move around the current view, click and drag inside the window. The filmstrip displays other photos 
in the current folder. To move between photos you can use the arrow keys, or you can use the mouse to 
select a new photo.

To view the location of any GPS-tagged photo on a map, select the photo and click on the Map view icon at 
the bottom of the main Browse window.

To add GPS data to a photo, select a photo or group of 
photos and click on the Map view icon at the bottom of 
the screen. There you can search for a location via the 
search bar. Once you have the desired area, right-click on 
the map to add a location for the photo (or photos) in that 
spot. If the position is correct, click inside the pop-up box 
to set the pin. 

If you would like to choose a different point instead, right-
click in another location. 

Photo RAW’s Map view can display the coordinates of a selected photo, or let you add GPS coordinates by clicking specific places on a map.

Right-clicking on a spot on the map will generate this pop-up. 
To confirm the location, click in the box; otherwise, you can 
right-click elsewhere to choose a different location.
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Once added, Photo RAW will enter that position in the GPS field of the Metadata panel. 

Photo RAW can also look up standard location information — city, 
state, country — from the GPS coordinates in a photo, and populate 
that information in the Location tab of the Metadata pane (shown 
on the right). To do this, click on the photos you wish to update and 
choose Set Location from GPS Coordinates from the Photo menu. 
(See “Metadata Pane” on page 39 for more information.)

My Catalogs, Browse and Presets Panels
On the left side of the Browse window are three tabs, My Catalogs, Browse and Presets. My Catalogs 
and Browse are designed to let you organize and find your photos quickly and easily, while the Presets 
panel lets you apply Edit module presets to your photos directly in the Browse module. (See “Applying Edit 
Module Presets in Browse” on page 60.) To move between the panels, click on the appropriate tab at the 
top of the panel. You can hide the left panel by clicking on the Show/Hide Panel icons at the bottom left 
and right sides of the panel. (Pressing the Tab key will show and hide both panels simultaneously.)

DIFFERENCES BETWEEN MY CATALOGS AND BROWSE TABS

The top panes in the My Catalogs 
and Browse panels contain 
different views of your folders and 
other sources, most of which are 
designed to help you with file-
related tasks. 

The My Catalogs pane lists all 
of your cataloged folders and 
your registered ON1 Cloud Sync 
devices, as well as the Albums, 
Smart Albums, Dates, Recent, and 
Tethered Shooting panes. 

The Browse panel includes 
a Favorites pane, which lets 
you add and access frequently 
visited folders; it also includes a 
configurable list of cloud storage 
services. The remainder of the panel includes Local Drives, Albums, Recent, and Tethered Shooting panes

NOTE: Earlier versions of ON1 Photo RAW combined the Cataloged 
Folders and Local Drives tabs into a single Browse panel. If you prefer that 
arrangement, check the Legacy Browse tab option in the General Preferences 
screen. (See “General Settings” on page 266.)

The My Catalogs view (above left) displays your cataloged folders and ON1 Cloud Sync devices you 
have registered, while the Browse view (above right) displays folders designated as Favorites (for 
quick access), attached local drives and any cloud storage services you have installed on your 
computer.
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Navigating Sources

To view the contents of any folder in the Cataloged Folders or Local Drives panes, click on the triangle next 
to the folder name. This will display the photos and subfolders within the selected folder inside the Preview 
area. To view the contents of a subfolder, either click on the subfolder inside the Folders pane, or double-
click on it in the Preview area. (You can use the breadcrumbs bar at the top of the Preview area to navigate 
back to the top of your folder system.)

TIP: Any pane in Photo RAW can be collapsed by clicking in the pane’s title bar; 
a Hide/Show link is visible when you move your cursor over the title bar, but 
the entire title bar is clickable. 

CATALOGED FOLDERS

A cataloged folder is a shortcut for your favorite or most-used folders of photos. A folder designated as 
cataloged is cached in the background to improve the speed of loading those folders (and any subfolders) 
and their photos. Cataloged folders are ideal for portfolios, your favorite photos, or for your primary library 
of photos. Cataloged folders are necessary when using the Advanced Search feature to search for photos 
across multiple folders.

You can make any available folder a cataloged folder by clicking on the ‘+’ button at the top of the 
Cataloged Folders pane; by right-clicking on a folder in the Preview area of the Browse panel and choosing 
Make Cataloged Folder from the pop-up menu; or by choosing Add Cataloged Folder from the File menu. 
The cataloging process is designed to work in the background, so it doesn’t affect other work you do in any 
Photo RAW module. (You’ll see a small progress indicator to the right of the folder as this process happens.)  

When you catalog a folder, you will be prompted to choose the size of the previews that are generated 
during the cataloging process, and whether you wish to publish the folder to ON1 Cloud Sync. The three 
thumbnail options are:

• Standard, which extracts the image metadata and EXIF thumbnail and creates a high-quality 
thumbnail and a fit-screen-sized preview.

• Medium, which extracts metadata, EXIF thumbnail and creates a high-quality thumbnail.

• Minimal, which extracts metadata and the EXIF thumbnail only.
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For most purposes, you’ll want to choose the default preview size, Standard. If, however, you are working 
with a system that has disk space restrictions, or have a network connection to your cataloged folder, 
choose either Medium or Minimal. (You can change the preview size later by right-clicking on the folder in 
the My Catalogs list and selecting the Preview Size option.)

If you would like to publish the folder to ON1 Cloud Sync, click the box and choose either Editable Preview 
or Originals from the pop-up menu. The Preview files are editable versions of your original photos, but are 
a fraction of the size. Which option you choose will depend upon your intent, and your ON1 Cloud Sync 
storage availability. See page 65 for more detailed information about the sync service.

A cataloged folder that has been published to ON1 Cloud Sync will display the Cloud Sync icon next to the 
folder name. 

To remove a cataloged folder, right-click on the folder in the pane and choose Remove Cataloged Folder. To 
unpublish it from ON1 Cloud Sync, right-click the folder and choose Unpublish from ON1 Cloud Sync.

Adding photos to existing cataloged folders

You can add photos from any location inside Browse to 
an existing cataloged folder via the Copy to My Catalogs 
option. To use this feature, you must already have at least 
one cataloged folder. Then, when working in Browse, select 
the photo or photos you wish to add, and choose Copy to 
My Catalogs from the File menu, or via the folder icon (with 
a ‘+’ button) to the right of the search bar at the top of the 
Browse window. (You can also right-click on a photo and 
choose Copy to My Catalogs from the pop-up menu.)

Inside the Copy to My Catalogs dialog box, you can choose 
which cataloged folder you wish to copy the photos, can 
add them to a new subfolder, and choose whether to move 
the photos or copy them. If you are copying to a folder that 
has been published with ON1 Cloud Sync, those photos will 
automatically be synced to the cloud.

Moving the files is only available when you are moving the 
photos to a new location on the same drive; otherwise, a 
copy of the file is made in the new location.

FAVORITES

Photo RAW’s cataloged folder feature is useful for 
keeping your primary photo library organized, but there 
might be times when you have a group of folders that 
you frequently access, but that you do not wish to have 
cataloged. (One common instance might be a folder where 
you export temporary images for social media or other 
uses.) In these cases, the Favorite folders option can be 
helpful. Any folder you designate as a favorite will appear 
in this area, along with cloud-based storage services like 
Google Drive, Dropbox and OneDrive.

The Copy to My Catalogs dialog box lets you copy or move 
selected photos into your existing cataloged folders.

The Browse panel’s Favorites pane lets you add frequently 
accessed folders that might be used for temporary or other 
applications.
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To add a folder to the Favorites pane, you can click the ‘+’ button in the Favorites pane. You’ll get 
your system’s file/folder selection window. Navigate to the folder you wish to add, then click Open. 
Alternatively, you can navigate to your chosen folder in Browse and drag the folder onto the ‘+’ icon in the 
pane, or right-click on the folder and choose Add to Favorites from the pop-up menu.

Cloud storage services

Browse supports cloud storage services from Dropbox, Google Drive, and Microsoft OneDrive. These 
services—when installed on your computer and other devices—keep local copies of your images on your 
computer, and Browse can find and monitor these locations automatically. 

During the installation process, ON1 Photo RAW 2023 automatically looks for the default installation 
locations for these services. If you do not have one of these services installed, and wish to remove it, right-
click on the service name in the Favorites pane and choose Remove from Favorites from the pop-up menu. 
If you add one of these services after installing Photo RAW, click the ‘+’ button at the top of the pane, and 
locate the folder via your computer’s file-selection window. 

LOCAL DRIVES

Browse automatically recognizes any disk (volume) inside 
or attached to your computer. This includes internal and 
external hard drives, optical drives, thumb drives, digital 
camera memory cards, digital cameras, any devices that 
support USB Mass Storage, and network-attached services 
(including mapped volumes on Windows).

Disks appear in the Local Drives pane below the Favorites 
section, with a hard drive icon next to them. Keep in mind 
that some disks, like optical drives, are often read-only. 
You will be able to view a copy of a photo, but will be 
prompted to save the image to a new location if you wish 
to edit it.

USING SHORTCUTS

The Shortcuts selector on the left side of the Browse panel is 
a list of icons designed to give you quick access to a number of 
commonly used system destinations or Browse functions. From 
top to bottom, the icons represent the Getting Started window, 
your Desktop, your Pictures folder, cataloged folders, local 
drives, albums, the Smart Organize window, ON1 Cloud Sync 
devices, and the Advanced Search window. Clicking on one of the 
icons will either display the shortcut’s contents in the Preview 
window (Desktop, Pictures, Cataloged Folders, Local Drives, 
Cloud Services, Albums, Cloud Sync), or will open a specific 
function window in Photo RAW (Getting Started, Smart Organize, 
Advanced Search).

By default, the Pictures shortcut uses your My Pictures folder 
(Windows) or Pictures (Mac). You can change the default location 
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in the General section of the Preferences window (see “General Settings” on page 266).

Shortcuts can be useful when you have the right panel hidden to maximize viewing in the Preview window.

ALBUMS PANE

ON1 Photo RAW 2023’s Albums feature lets you organize or keep 
track of photos on a project, event or even a broader category like 
a portfolio. Albums are created by selecting images manually and 
adding them to a new (or existing album) by dragging and dropping 
photos onto the pane. You can nest albums together to help 
manage your collections, and all albums created can be published to 
ON1 Cloud Sync, which are indicated by the Cloud Sync icon to the 
right of the album name. (Any albums created on other ON1 Cloud 
Sync devices will be displayed in the Albums pane on all of your 
connected computers.)

Creating an album

Click the ‘+’ icon in the pane and choose Create 
Album… from the pop-up menu. You can 
also create an album by selecting photos and 
dragging them onto the ‘+’ icon in the Albums 
pane.

The New Album dialog box gives you options for 
adding an album name, and whether you wish 
to add the selected photos to the new album. If 
you would like to publish the album to the ON1 
Cloud, click the box and choose either Editable 
Preview or Originals from the pop-up menu. 
Which option you choose will depend upon your 
intent, and your storage availability. See page 
65 for more detailed information about ON1 
Cloud Sync.

Adding photos to an existing album

There are multiple ways to add photos:

• Dragging and dropping a photo on the album name.

• Selecting a photo or group of photos, right-clicking on the photo and choosing Add to Album 
from the pop-up menu.

• Choosing Album > Add to Album and picking the destination album from the menu.

• You can also copy a photo and paste it into an album: click on a photo, choose Edit > Copy, 
then click on the album in the Albums pane, and choose Edit > Paste.

Removing photos from an album

To remove a photo (or photos) from an album, select them in the album, then choose Remove from Album 
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from the Album menu, or right-click on the photo and choose Remove from Album from the pop-up menu. 
(You can also select a photo and press Shift-Delete.)

Delete an album

To delete an album, right-click on the album name and choose Delete.

Publishing and unpublishing an album from ON1 Cloud Sync

You can publish any existing album to ON1 Cloud Sync by right-clicking on the album name and choosing 
Publish to ON1 Cloud Sync. Right-clicking and choosing Unpublish from ON1 Cloud Sync will remove that 
album from your synced devices, but leave it on the device from which it was originally shared.

NOTE: ON1 Cloud Sync albums can only be unpublished from the device that 
they were created on, but you can delete any published album from any ON1 
Cloud Sync device. Doing this will remove that album from all of your devices. 
See “Using ON1 Cloud Sync with Photo RAW” on page 65 for more detail.

Changing the album thumbnail preview

To change the preview thumbnail of an album, double-click on the album name. Select a photo you would 
like to use for the preview, right-click on it and choose Set Album Preview from the pop-up menu.

Nesting albums

To create a set of nested albums, create a blank album by clicking on the + icon in the Albums pane. You can 
easily add sub-albums to that new master album set by dragging and dropping albums onto the new one in 
the Albums pane. When you click on the master album, Browse will display the albums that are part of that 
collection in a folder-style view. Double-clicking on an album icon will display the contents of that album. 
To view all the images in a nested set, choose Show Subfolder Contents from the View menu.

When you click on a nested album set, Browse displays the sub-albums. Double-clicking on a sub-album will open that album. If you 
wish to view all of the images in a nested album set, click the Show Subfolder Contents button from the View menu.
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To move a sub-album from a master album to the top Albums level, drag and drop it out of the master, or 
right-click on the sub-album name and choose Move to Top.

If you drag an album onto an existing album that already contains images, you will see the top-level album’s 
images at the root level, along with any sub-albums.

SMART ALBUMS

Smart albums are a dynamic album type that created from 
the results of a custom search operation built within the 
Advanced Search window (see “Finding and Filtering Images 
with Advanced Search” on page 49). When you use 
Advanced Search to create a filtered set of photos in your 
collection, such as “all photos that have been rated three 
stars or greater after June 2018,” you can save that search 
as a smart album, and, when you click on the album, Photo RAW will perform that search in real time.

You can edit, rename or delete smart albums by right-clicking on the album name. The Edit option reopens a 
version of the Advanced Search window, letting you change the criteria for that smart album.

NOTE: Nested albums and smart albums cannot be published to Cloud Sync.  

DATES PANE

Photo RAW’s Dates pane offers a quick way to look for 
cataloged images based on when they were taken. Using a 
simple timeline interface, you can drill down into your photo 
library by year, month and day. It makes searching for things 
like birthday and holiday photos a snap.

Opening the Dates pane, you’ll see a list of years, with the 
current year at the top (only years that have photos taken 
during them will be present in the list). Clicking on a year will 
show you all of the photos taken during that year. Clicking 
on the triangle to the left of the year will display a list of 
all the months that have photos in them, and you can keep 
drilling down to the day level. Drilling down to any level 
in the pane—year, month, day—will show all photos taken 
during that period.

The Dates pane works only with cataloged folders.
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TETHERED SHOOTING

The Tethered Shooting pane lets you remotely control many 
Nikon and Canon cameras connected to your computer via 
USB, and capture images from the camera to your computer. 
Tethered shooting is used for shooting and saving images 
in a studio setting, displaying your images immediately 
on your computer’s display. It is an excellent way to make 
adjustments to lighting and composition in the studio.

To get started with tethered shooting, connect your camera 
to your computer with the appropriate USB cable (your 
camera’s manual should have information on the cable required, if the 
camera didn’t come with one). Turn the camera on, then, in the Tethered 
Shooting pane, turn the pane on by clicking the button to the left of the 
pane’s name. 

Photo RAW will search for a connected camera and, if found, it will 
open Photo RAW’s Import window. In the panel on the right side of that 
window, you can choose a number of options for saving your tethered 
shots, including file name and location, metadata, any Develop or Effects 
settings, and time adjustments. (See “Importing Photos into Browse” on 
page 44 for an explanation of panes in the Import window.)

Once you have chosen your tethered import settings, click the Start 
Shooting button at the bottom right of the Import window, which will close 
the window. The Tethered Shooting pane will now have the model of your 
camera selected, with the current shot settings in the table at the bottom 
of the pane. The settings are, from left to right and top to bottom, shutter 
speed, aperture, ISO, camera shooting mode (Manual, Aperture/Shutter 
Priority), exposure compensation, and white balance. Any setting that has a 
drop-down will let you change that setting.

Clicking the Fire button in the pane will take a shot with the current 
camera settings, and will save it to the location you chose in the Import 
Settings window. If you’re in Grid View, the image will appear at the 
beginning of the end of the thumbnail grid, depending upon how your sort 
order is set up. If you’re in Detail or Filmstrip view, the tethered image will 
appear in the Preview area.

When you are finished with a shoot, turn the Tethered Shooting pane off 
by clicking the button next to the pane’s title, turn your camera off, and 
disconnect it from your computer.

NOTE: ON1 Photo RAW 2023’s Tethered Shooting feature currently supports 
most Canon and Nikon digital SLR cameras. Check this page ON1’s support 
website (on1help.zendesk.com) for a list of supported cameras.

Turning Tethered Shooting on will 
present you with a variation of Photo 
RAW’s Import window. In the right 
pane of this window,  you can set the 
file characteristics for tethered shots.

https://on1help.zendesk.com/
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RECENT

The Recent pane keeps track of recently opened files browsed 
folders. Files are listed in order of last opened. You can access your 
most recent files in this pane by clicking on the one you want and it 
will appear in your main preview window. 

You can clear the recent list by pressing the ‘x’ icon in the title bar.

The Photo Panel
The panel on the right side of the screen contains information relative to the currently selected image in 
the Preview area, and includes three sections: Nav, Levels, and Info.

THE NAVIGATOR PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This pane presents a thumbnail view of the current 
image. The white square region marks the image area 
that is visible in the preview pane. You can pan your 
image by clicking and dragging inside the square.

At the bottom of the Navigator pane are several zoom 
buttons representing percentage zoom views (100%, 
50% and 25%). Click on one of the buttons to change 
the view. Fit zooms to fit the current canvas size, while 
100 zooms to 100%, displaying the actual pixels.

THE LEVELS PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This pane gives you a color chart of the shadow, 
midtone and highlight areas based on an image’s RGB 
values (commonly known as a histogram). This is useful 
to show areas within the image that may be clipping. 
Clipping is when your image contains pure blacks or 
white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top 
of each end is a triangle. If the triangle is lit, there is 
clipping on that side of the histogram. If you click on 
the arrows, you will activate the clipping overlay on your image, which displays the areas that are clipped. 
Those areas with a blue overlay are pure black, while the areas with the red overlay are pure white. You can 
turn the clipping view off again by clicking on one of the triangles. You can also temporarily enable clipping 
view by holding down the J key at any time. (Clipping can be turned on or off permanently by pressing Alt 
(Windows) or Option (Mac) and the J key.) The clipping view is useful when you are making adjustments to 
the brightness and contrast of your image.

The Levels pane also displays the RGB values under the cursor at the bottom of the pane.

The Navigator pane

The Levels pane
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INFO PANE (ALL VIEWS)

The Info pane displays common metadata and other information for the currently selected image in a large, 
easy-to-read format. This metadata includes:

• Camera make and model

• Lens focal length

• Capture date and time

• File type

• ISO

• Shutter speed

• Aperture

• Exposure compensation

• Image dimensions

• File size

• Rating, color label and like status

• Any settings applied inside the Edit module

If any of the metadata fields are unavailable they will be left blank.

TIP: You can adjust the star rating, color label and flag for the current photo 
directly from within the Info pane.

Settings Applied

At the bottom of the Info pane is a section that shows all 
of the operations from the Edit module that have been 
applied to the current image. Clicking on the right arrow 
to the left of the label will display a list of every tab in 
the Edit module, as well as primary adjustment options, 
including cropping, retouching and text operations. If an 
image has had any adjustments made to it, that section 
of the Settings Applied area will be represented in white 
type, and you can drill down further into the Develop, 
Effects, Portrait, Sky Swap and Local Adjustment tabs to 
see which adjustments were made to an image. (On an 
image that has had no adjustments, the settings will be 
grayed out.)

Double-clicking on any of the available items inside the Settings Applied area will jump to that setting inside 
the Edit module, where you can adjust it easily.

The Info pane, with the Settings Applied option hidden. 

The Settings Applied section of the Info pane gives you a quick 
window into which adjustments were made to an image in the 
Edit module. Click the right arrow to open the section and view 
the individual edits. Double-click on any item in the list to take 
you to that setting in the Edit module.
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METADATA PANE

The Metadata pane displays all of the available metadata 
information about a photo in one place. Some of this is 
embedded metadata from your camera, while other elements 
can be added manually, or, with the new Keyword AI feature, 
you can have Photo RAW 2023 scan your photos and suggest 
keywords based on their contents, making it easy to find 
photos based on a wide variety of data types.

The Metadata pane consists of the following sections:

A.	Preset: Lets you apply a saved metadata preset (see 
page 41) to your image, which can include any 
changeable metadata found throughout the pane.

B.	 Author and Description: For manually entering 
author information and a description. (The Author 
field is tied to the IPTC Creator field.)

C.	 Keyword section: Add keywords manually and 
modify existing keywords.

D.	AI Keywords: Automatically generated keywords 
based on image data and AI semantics.

E.	 Albums: Lists all albums that the current photo 
resides in.

F.	 Show EXIF/IPTC/Location data: When clicked, 
each tab displays specific information on the current 
photo, much of which can be edited or changed (see 
page 41)

Keyword AI

Photo RAW 2023’s Keyword AI feature is designed to take 
the pain out of manual keywording. By scanning your photos 
automatically and suggesting keywords based on the contents 
of a photo, location information, and much more, you can find 
images quickly, even if you have never entered any keywords 
on your photos. Photo RAW  can ‘see’ hundreds of objects 
and regions, identify locations, find people, and understand 
photographic properties, all of which then become searchable 
terms to help find photos faster.

By default, the photos in all of your all of your cataloged 
folders are scanned by Photo RAW and all AI-generated keywords are displayed in the AI Keywords section 
of the Metadata pane. And, when you use the Advanced Search window to find images based on any text, 
Photo RAW will also check the contents of the AI keywords and display any images meeting the search 
criteria (see “Finding and Filtering Images with Advanced Search” on page 49 for details).

These AI keywords are associated with the photo, but they are not embedded in the photo unless you click 



ON1 Photo RAW 2023 User Guide	 Part 2: Organizing with Browse	 40

on the arrow in the specific keyword in the AI Keywords section. To add all of the suggested keywords to 
the photo’s embedded metadata, click on the Add All button. You can also remove an AI keyword from a 
photo by hovering over the keyword in the section and clicking on the ‘x’ icon on the right side of the label.

While Photo RAW automatically scans all photos in 
your cataloged folders, you can manually generate AI 
keywords on any photo by clicking the Scan button. To 
scan a group of images, select them in Browse’s Grid view 
and then click Scan in the Metadata pane.  

You have a few options for fine-tuning the specifics of 
what Photo RAW searches for when creating AI-
generated keyword; these options can be found in the 
Keyword AI tab of the Preferences window. There, you 
can choose what type of data you want to include when Photo RAW is scanning your cataloged folders. 
These options include location data, photographic properties, histogram properties, face, age and gender 
information, and specific objects and regions. If, for some reason you do not want the Keyword AI feature 
to scan your cataloged folders, you can also turn the feature off from the Preferences window.

NOTE: ON1 Photo RAW 2023 performs nearly all of its Keyword AI scanning 
entirely on your computer. (The exception to this is for reverse lookup of GPS 
coordinates.) At no point are your photos uploaded to the cloud or shared.

You can adjust the Keyword AI scan parameters via Photo RAW’s Preferences window. You can also 
turn the automatic keyword scan off, if you prefer, although you can always manually scan for AI 
keywords from the Metadata pane’s Scan button.

You can add and remove AI-generated keywords from the 
Metadata pane, as well as scan photos (or groups pf photos) that 
do not reside in cataloged folders.
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Other metadata

The bottom of the Metadata pane has three labels/tabs for viewing or adding specific types of information 
to your photos:

• EXIF (Exchangeable Image File Format) displays all of the data embedded by your camera. 
Depending upon the camera, some of all of this information will be displayed, and many of 
the fields are editable. 

• IPTC (International Press Telecommunications Council) is an industry-standard metadata 
format, and offers much more detailed metadata information than EXIF. It historically has 
been used by journalists and stock photographers to catalog and tag photos, as well as add 
copyright information, captions, and other data.

• Location includes GPS information, as well as country, state/province and city information. 
Photo RAW can automatically look up this information for any photo that has GPS 
coordinates, via the Set Location from GPS Coordinates item in the Photo menu.

To go back and forth between the EXIF, IPTC and Location fields in the Metadata pane, click on the label. If 
you don’t wish to view any of the metadata tabs, click the None tab. 

When you enter text into any field in the Metadata pane, Photo RAW will add that information to the 
currently selected image. You can change the metadata in multiple images at the same time by selecting 
them all, then changing any of the fields in the pane.

Metadata templates

With Photo RAW, you can create metadata templates that apply common information to your images, such 
as copyright, author, contact information, your website and more. These preset templates can be applied 
directly in the Metadata pane, as well as via the Import feature (see “Importing Photos into Browse” on 
page 44).

Saving a metadata template is easy: you can either go to an 
image that has the basic metadata items you wish to use, 
or you can select an image without metadata and add your 
common items to the Metadata pane. Once you have the 
metadata set, click on the Preset drop-down menu at the top 
of the pane and choose Save New Preset. The Save Preset 
dialog will appear on-screen, and you can choose which 
metadata fields you wish to save as part of the template. 
For example, while you might wish to save the copyright and 
contact information as part of your preset, you might not 
want to apply keyword, GPS or description data to a group 
of images. 

You can update a metadata template by selecting the preset 
in the pane, then changing the appropriate fields as desired, 
and then choosing Update Preset with Current Settings from 
the Preset drop-down. To delete a metadata preset, first 
choose the preset from the drop-down menu, then choose Delete Preset from the menu. 

The Save Metadata Preset dialog lets you choose which 
metadata fields get saved to a preset from the currently 
selected image.
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Embedding metadata

Metadata you add in Browse is stored in industry-standard XMP sidecar files for raw files. This facilitates 
the transfer of metadata to any application that supports XMP. When you edit an image, create a copy of 
an image for editing or use the ‘Send to’ command, the metadata is embedded into the file automatically 
(with the exception of raw files). You can manually embed your metadata into images using the Embed 
Metadata command from the Photos menu. This will open each image you have selected, update the 
metadata and re-save it. This is supported for TIF, PSD, PSB and JPG files; raw and PNG files do not 
support direct embedding of metadata.

Reading metadata

Sometimes, when you’ve been sharing raw images across machines or with others, the metadata 
information might get ‘lost,’ or is different than your original metadata. In these instances, choose Read 
Metadata from the Photo menu, which will grab the metadata from the file or the XMP file (for raw files).

KEYWORD LIST PANE

As you add cataloged folders or browse through folders 
of non-cataloged photos inside ON1 Photo RAW 2023, 
any keywords you have added—to any photo—are 
stored in an internal database. That list of keywords 
is visible in the Keyword List pane, and from there, 
you can search for established keywords and display 
those photos from your cataloged folders, manage the 
keyword list, and apply keywords to new images. And, 
to help manage your keywords, Photo RAW 2023 will 
also let you create subcategories of keywords (see 
“Using hierarchical keywords with Photo RAW” on page 
43).

If you double-click on a keyword in the list, Photo RAW 
will search your cataloged folders for that keyword, and display the results in the Preview window. In this 
search, Photo RAW is actually performing a search in the Advanced Search pane, so you can refine your 
search there, if you wish to add additional filter criteria. (If you would like to search the current folder only, 
choose the Filter Current Photos option in the Advanced Search pane.)

You can assign keywords to an image in any of Browse’s views. Click on the button to the left of a keyword 
in the Keyword List, and Photo RAW will apply that keyword to the currently selected image or images. 
(You can also enter keywords into the Add Keywords field in the Metadata pane.)

Right-clicking on a keyword gives you a pop-up menu with a list of options you can perform:

• Assign Keyword to Selected Photos: adds that keyword to the current selection.

• Remove Keyword from Selected Photos: removes that keyword from the selection

• Add Keyword: Lets you create a new keyword, with the option to save that keyword as a 
subcategory of the currently selected keyword.

• Edit Keyword: lets you rename the selected keyword, and applies the new keyword to all of 
the cataloged and known photos that used it.

The Keyword List includes any keywords you’ve ever used, but you 
can filter the list by typing into the search field at the top of the 
pane. Double-clicking on an item in the pane will display all of the 
photos that have that keyword.
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• Delete Keyword: Removes that keyword from the cataloged and known photos that use it.

• Find Cataloged Photos with Keyword: Displays (in grid view) all of the photos in your 
cataloged folders that use the selected keyword.

Refining the Keyword List

Because the list of keywords can be extremely long, you can use the pane’s search field to look for 
keywords: as you start to type in the field, Photo RAW will display a list of keywords that contain the 
letters you’ve typed. Once you’ve narrowed your search, you can select a keyword from the list (shown, 
right), and perform any keyword operations detailed in the previous section.

Using hierarchical keywords with Photo RAW

In addition to standard keywords, ON1 Photo RAW 2023 
also supports the creation and use of hierarchical keywords. 
This option lets you “nest” keywords within a top-level 
keyword, which can be helpful to manage and categorize 
keywords. 

For example, you might want to use a master keyword for 
states that you’ve visited—“California,” “Nevada,” “Oregon,” 
etc.—and use sub-keywords for places within the state, like 
“Death Valley,” “Joshua Tree”, “Valley of Fire” and others. 

Hierarchical keywords are displayed in the Keyword pane 
with a small right arrow to the left of the top-level keyword. 
Clicking on the arrow will display the sub-keywords for that 
master, with the number of images with that keyword on the 
right side. As is the case with standard (i.e. non-hierarchical) keywords, you can double-click on any of the 
nested keywords to show all of the photos in your cataloged folders that use that keyword.

To create a keyword hierarchy, first create your master keyword by clicking on the gear icon at the top 
of the Keyword List pane and choosing Add Keyword. Enter the name of the top-level keyword and click 
Apply. (If you have photos selected, and don’t want to add the new keyword to those images, uncheck the 
“Add to Selected” box before clicking Apply.)

To create a new nested keyword, right-click on the master keyword and choose Add Keyword from the 
pop-up. The dialog box should now give you a check box to nest the new keyword inside the top-level 
keyword, as well as to add the new keyword to any selected photos.

If you wish to create new hierarchies from existing keywords, it is best to first create your master keyword, 
and then drag any existing keywords onto that master. 

Hierarchical keywords can help with keyword management, 
and can be extremely useful when you wish to use primary 
and secondary categories for such image categories as 
locations, people, types of shoots, and so on.

To create a hierarchical keyword set, create the top-level keyword by choosing Add Keyword from the Keyword List pop-up. Then, right-click the 
top-level keyword and choose Add Keyword. There, you will have the option to nest the new keyword inside the top-level keyword. 
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Importing Photos into Browse

ON1 Photo RAW’s Import function lets you quickly grab photos directly from your camera, memory card, 
phone, tablet, or other source location (like a portable hard drive loaded with images from the field).

To import photos, connect your camera, card or other device and choose Import from Browse’s File menu. 
The Import window opens, with the following options:

A.	 Import Options Bar: Lets you choose the source (camera, memory card, or other device), if 
Photo RAW should search through subfolders on the source, eject the device after importing, 
and to bypass images that have already been imported. You can also choose options for 
selecting all photos or none of them.

B.	 Preview window: Displays the images to be imported. By default, all photos are included; 
click the check mark in the corner of any image to remove it from the import process.

C.	 Thumbnail size: Adjusts the size of the thumbnails in the preview area. 

D.	Preset selector: Applies an import preset—which can include any of the settings from the 
import panel on the right—to the currently selected images.

E.	 Destination: This pane sets the location of the imported images, as well as a secondary folder 
that you can use to store a copy of your photos saved as a backup to another location. (See 
below for specifics on using this pane.)

F.	 Rename: This pane lets you rename the imported files, with options for custom text, 
serialization, and image metadata. (This pane uses the same token-based renaming function 
and presets found in the Rename Files dialog; see page 47 for more.)
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G.	Add Metadata: Lets you add assorted metadata to the imported images, ranging from 
keywords, copyright information and more. To access the complete IPTC metadata fields, 
click the More drop-down; you can also add GPS coordinates and a description via this  
section of the pane. You can use existing metadata presets (or create your own in this 
window) to apply consistent metadata across multiple imports; simply enter the data you wish 
to include and choose Save New Preset from the Preset menu in the pane. (See “Metadata 
templates” on page 41 for more on metadata presets.)

H.	Photo Settings: This pane lets you apply any Edit module presets to the imported images. 
(These settings are not permanent; you can adjust or reset the adjustments via the Settings 
menu. See “Presets” on page 117 for more.)

I.	 Edit Capture Date: Use this pane when you wish to change the capture date of imported 
images. The Adjust Time Zone setting can be helpful if you forget to change your camera’s 
clock when you travel across multiple time zones.

Once you have adjusted your import settings and 
selected the images for import, click on the Import 
button to perform the operation. While your photos are 
being imported, you’ll see a progress bar displayed in 
the lower right side of the Browse window. If your import location is a cataloged folder, the new images will 
be indexed automatically in the background.

DESTINATION PANE OPTIONS

Destination is the only pane in the Import window that you 
have to set up when importing images. It has a number of 
different options for where you wish to import images:

• Use the Folder pop-up to choose the destination 
for your import. Recently used destinations will be 
in the list, or you can choose a different folder.

• To put your imported images into a new folder—
one that you name—inside the primary import 
location, enter the name of the new subfolder in 
the Put in Subfolder field. Photo RAW will create 
that folder and import the images to that location.

• Turning on the Secondary Folder option will copy 
the imported images to another folder connected to your computer (using the parameters 
in the Put in Subfolder and Generate Subfolders settings, if used). It is intended for people 
who wish to back up their photos onto another drive or location. Use the pop-up menu to 
determine the backup location; any previously used folders will be listed in the menu.

• Use the Generate Subfolders option if you would like to use image metadata or import count 
information to create customized subfolders during import. This option uses the same token-
based function used in the Rename pane; see “Renaming Files and Folders in Browse” on 
page 47 for specifics on using these tokens. For example, you could have imported photos 
automatically organized by two levels of folders, one by year, and inside each year, folders for 
each month. When images are imported, Photo RAW will place each image in the appropriate 
location based on the settings in this field, creating the folder if it doesn’t exist.

While Photo RAW is importing images from a camera or card, you’ll 
see a progress indicator at the bottom of the Browse window.
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Each time you import images, Photo RAW will display your previous settings.

BYPASSING DUPLICATE FILES DURING IMPORT

The Don’t Import Duplicates option is helpful for those times when you re-
use a card in the field, but don’t delete the photos from it.

Each time you use the Import function, Photo RAW keeps a record of every 
imported photo’s filename and capture time. When you add a card to import, 
the app checks its import database, and if it finds a duplicate, it will uncheck 
it in the Import window, and display an “Already Imported” icon to the right 
of the checkbox.  

Photo RAW saves the original filename and time metadata, so the Don’t 
Import Duplicates option works even if you use the Rename option to 
rename the photos on import. And, if for some reason you wish to re-import 
a photo, you can click the selection check mark to re-import it.

SAVING IMPORT SETTINGS AS A PRESET

Photo RAW makes it easy to save often-used import settings as a preset: things like copyright and other 
metadata, file-naming conventions, import locations and more. To save an import preset, adjust the 
information and settings in any of the panes on the right of the Import window, and choose Save New 
Preset from the pop-up. Thereafter, when you choose the preset, it will apply those saved settings to the 
current import job. If you wish to change a setting for an existing preset, select the preset, make your 
changes in the panels and choose Update Existing Preset from the preset selector’s pop-up menu.

Photo RAW remembers the last-used import preset when you choose Import from the File menu.

Managing Files and Folders in Browse

CREATING A NEW FOLDER

You can create a new folder from the right-click contextual menu in the preview area or selecting Add 
Subfolder in the Edit menu. This will create a new folder inside the selected folder; if you have files selected 
in the preview area, you also will get the option to move or copy the selected images into the new folder.

DELETING A FOLDER

To delete a file or folder, click on it and press the Delete key or right-click and select ‘Delete’ from the 
contextual menu. Then, confirm that you wish to move the file to the trash. If you have multiple files and or 
folders selected it will move them all to the trash. If you make a mistake you can use the Undo command, 
although some files, like those on a network volume, are deleted immediately and cannot be undone.

With the Don’t Import Duplicates 
option on, any photo that has already 
been imported will be deselected.
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COPYING AND MOVING FILES AND FOLDERS

You can copy and move files and folders in the ways you are accustomed to on your computer. You can 
select files and folders and use the Edit > Copy command to copy them to the clipboard and then Edit > 
Paste to paste them to new location, inside or outside of Browse. You can use this to copy a file or folder 
from one place to another or to attach an image to an email for example.

You can also use the familiar drag-and-drop functions to copy or move files and folders. Dragging and 
dropping a file or folder will move it if it is on the same drive or copy it to another drive. You can drag and 
drop in and out of Browse module.

NOTE: Due to the non-destructive nature of Photo RAW 2023’s workflow, 
copying a photo and pasting it outside of Photo RAW will paste the original file. 
If you wish to incorporate any Edit module changes, use the Export or Quick 
Export commands to get a version of the photo with your edits.

SHOW IN FINDER/SHOW IN EXPLORER

To view a file or folder in the Finder (MacOS) or Explorer (Windows), right-click on an image or folder in the 
Preview area and choose Show in Finder or Show in Explorer from the pop-up menu.

CHANGING A FOLDER’S THUMBNAIL PREVIEW

By default, Photo RAW chooses an image from a folder to use as the preview thumbnail for that folder. 
To change this, double-click on the folder icon and select a photo you would like to use as the thumbnail. 
Right-click on the photo and choose Set Folder Preview from the pop-up menu. 

RENAMING FILES AND FOLDERS IN BROWSE

Browse offers two methods for renaming files or folders 
inside ON1 Photo RAW 2023: single file and batch. 

To quickly rename a single file or folder, click on it in most 
Browse views and choose Rename File from the Edit menu, 
or right-click on the item and choose Rename File from the 
pop-up menu. This will display a window where you can type 
in a new name for the item. Clicking OK will rename that file 
or folder.

Batch-renaming groups of files or folders

To rename multiple items in Browse as a batch, select them in the current view and choose Rename File 
from the Edit menu or the right-click contextual menu. Photo RAW will display the Rename window, which 
offers an array of options for renaming files based on custom text and image metadata.

Renaming a single file or folder.
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In batch-rename mode, the Rename window has a central text entry field, where you can add any custom 
text you wish all of the renamed files to have. You can also insert a set of tokens (via a pop-up menu) that 
will be added to the renamed files. These tokens are in four main groups:

• Filename, which includes options for 
using the original filename, number 
suffix (taken from the image as 
recorded by the camera) and enclosing 
folder name.

• Date/Time, which includes a list of 
date (year, month, day) and time data 
that can be combined in various ways.

• Sequence, which adds an incremented 
number to each renamed file in the 
batch, as well as the total number of 
files in the batch. Each of these token 
sets include options for leading zeros 
in the resultant filename. 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found on “Export” on page 229, in the Export section of 
this guide.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Photo RAW will rename all of the files.

The Presets pop-up menu at the top of the Rename window includes a set of common batch combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

NOTE: The Rename window remembers the parameters of your last operation, 
which can be helpful for creating presets.

When renaming multiple files or folders, Photo RAW ‘s batch-rename feature 
lets you use complex combinations of custom text and image metadata. You 
have the capability to save your custom rename settings as a preset to reuse at 
other times.
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Finding and Filtering Images with Advanced Search
The Advanced Search window is designed to help you find photos in your photo library based on a 
extensive variety of criteria specific to photos and the metadata embedded in them. You can search based 
on any text associated with a photo; likes, labels and star ratings; dates, including creation and modification 
dates, time of day and seasons; keywords (including AI-generated keywords); and nearly any piece of 
metadata, from camera body and lens information to aperture, ISO settings, and much more. 

Advanced Search options are flexible: they can be applied to the current foldrter view or album, or they can 
search any or all of your cataloged folders. You can also save any search as a preset style, so you can use it 
again in the future, or you can save your search as a Smart Album that is available in the My Catalogs/
Browse panels.

To call up the Advanced Search window, click the magnifying glass icon in the Shortcuts selector on the 
left, choose Advanced Search from the File menu, or press Command-F (MacOS) or Control-F (Windows). 
The search window will displayed over the primary Photo RAW window, and remains open as you search. 

In the Advanced Search window, you apply your own criteria 
and your search locations, or you can choose from a number of 
preset searches. Advanced Search contains three components, 
listed from top to bottom:

• Saved Searches: Photo RAW comes with a set of 
preset saved searches, most of which are simple 
searches with a single set of criteria, such as by rating, 
‘like’ settings, date and more. Choosing an item from 
the pop-up menu will adjust the Source and Search 
Criteria settings and display the results in the preview 

The Advanced Search window is designed to help you search for photos in your library quickly and easily, 
from more than 50 search fields, including date information, ratings, camera and lens metadata and any text 
associated with a photo.

The Saved Searches option lets you choose from 20 
stock simple searches, and you can also save any 
search to this menu.
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area. You can also save your own search criteria via the pop-up: choose Save New Style from 
the bottom section of the menu and give the new saved search a name. Once you have saved 
it, those searches will be displayed at the bottom of the Saved Searches menu.

• Source: This section instructs Photo RAW where to search. 
The Source pop-up menu lets you choose between the 
photos in the current view; cataloged folders (all, or a specific 
folder): all photos that Photo RAW knows about (cataloged, 
favorites, and any images you’ve viewed in Browse); and any 
photos synced with Cloud Sync. When you have Current 
Photos selected as a source, you’ll see a Lock icon on the right side of the Source pane. 
Clicking the lock ‘on’ will keep using the search criteria as you move from folder to folder.

• Search Criteria: The core of the Advanced Search window, this section lets you fine tune your 
search, using multiple criteria and specific matching options. These options are described in 
more detail below.

At the bottom of the Advanced Search window are three items: a link to ON1’s online help for the 
Advanced Search feature, a Reset button, which resets the current search to its default state, and Create 
Smart album, which will save the current search criteria as a Smart Album in that pane in the My Catalogs/
Browse panels (see “Smart Albums” on page 35 for more information).

Photo RAW’s Advanced Search is dynamic: as you adjust the options in the window, the selection of photos 
that meet your criteria and other settings will be displayed in Browse’s main window, in Grid view. If you 
add or remove criteria, change the source folders, the thumbnail grid will update.  

When you close the search window, Photo RAW will return you to the view that you were in when you 
invoked Advanced Search.

NOTE: Advanced Search saves your last search criteria when you close the 
window, and will display that the next time you open it. You can adjust the 
settings as desired, use a saved search, or press the Reset button to start a new 
search.

SETTING THE SEARCH CRITERIA

The Search Criteria section consists of two parts: the matching options, and the criteria the search is 
using to find photos. The Match options set how you wish the search criteria to be filtered, based on three 
options: choosing photos that meet all of the current criteria, those that meet any of the criteria, or those 
that match none of the criteria.

You build the search options by adding criteria from the Add Field pop-up, using as many criteria as you 
wish to achieve your chosen search results. When you add a field, the default is Everything, which searches 
every piece of text-based metadata in your photos. You can change it by choosing another field from the 
pop-up menu. If you wish to remove a criterion you’ve added, click the ‘x’ on the right side of the item.

Source options for Advanced Search
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Search fields 

Advanced Search has 19 categories of search criteria, many of 
which have additional subcategories. The categories, and what 
they search for, are:

• Album — whether a photo is in an album or not 
(Smart Albums are not supported).

• Camera — searches for specific camera and lens 
metadata used to take a photo, including aperture, 
shutter speed, ISO, focal length, camera name, and 
more.

• Cloud Sync — whether or not an item has been 
synced with ON1 Cloud Sync

• Color Label — photos with a specific color label 
(icon and text name); can search for multiple labels 
as well (i.e. Red and Green).

• Date — capture date, edited date or time of day 
(morning, afternoon, evening, night) of a photo.

• Description — searches the contents of the Description field in the Metadata pane

• Edited — searches for photos that have had adjustments applied in the Edit module; includes 
any adjustments in specific modules—Develop, Effects, Local Adjustments, Portrait, Sky 
Swap—as well as Layers, NoNoise, cropping, retouching, Liquefy tool, and text additions.  

• Everything — searches for any text-based data (filename, keywords, metadata information) 
associated with a photo.

• File Type — searches for specific image and video file types. Image formats include RAW, 
TIFF, PNG, JPEG, PSB, PSD, DNG, ONPHOTO, and HEIC. Video formats include M4V, MOV, 
AVI, WMV, MPEG, and MTS.

• Filename — filename or the folder path that the photo resides within.

• IPTC — searches IPTC-specific fields—as shown in the Metadata pane—including Copyright 
Status, Creator/Author, Job Identification, and Title. 

• Keywords — searches for applied keywords, as well as whether there are keywords attached 
to an image or not.

• Likes — photos set with Like (icon with a filled-in heart), Dislike (‘X’ icon) or Not Set (empty 
heart).

• Location — draws from Location information section of the Metadata pane, can also search 
for photos with or without GPS data.

• Object Type — whether a file is a Photo, Version, or Video.

• Rating — photos with a star rating set.

• Season — searches date information for photos shot during Spring, Summer, Winter, or Fall; 
includes Northern and Southern Hemisphere options.

• Shared — searches for photos that have been shared to SmugMug.

There are 19 categories of search criteria in the Advanced 
Search window. When you click the Add Field button, the 
default field is Everything; click on the pop-up menu to 
change it to a different search field.
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• Size — searches for photos based on size information, including file size on disk, height and 
width, long and short edge, number of megapixels, and orientation (landscape, portrait, 
square).

Search field operators

Each search field has an operator option and a subject field. Fields where the subject field is a list of items—
Edited, File Type, Likes, Object Type, and Shared—have a simple, “is/is not” binary set of operators. Search 
fields that have a text- or numeric-based subject field will have additional operators that let you refine the 
search in very specific ways:

• “is/is not” will look for the exact match of the subject in the search field.

• “contains/does not contain” will look for matches that at least include the subject in the 
search field.

• “starts with/ends with” will look for matches where the text of the subject field is at the 
beginning or the end of the target. This is most often used when searching filenames, but it 
also is available in any metadata subject that has a text entry.

• “is empty/is not empty” is used to determine whether the contents of a metadata field 
contain information or not, and can be helpful when finding which photos in your library 
don’t have GPS information, or a color rating. 

• “is greater than/is less than” is used when the subject field being searched for contains 
numeric data. This operator is commonly used when searching ratings, but can be used in 
many other search types, especially with camera-specific metadata. 

The simplest search operator is the “is/is not” operator. Here, we want to search for all RAW files in the 
current source set.. This operator set is used by any search field where the subject field is a list of items.
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• “is in the range” is used to find numeric or date-based metadata that resides within a 
specified range.

Date-specific fields have a few other operators in addition to some of the operators mentioned in the 
previous section, including:

• “is/is not in the last” finds photos taken in the last number of specified days.

• “is today/yesterday” finds photos taken on the current day or the previous day.

• “is in the last week/month/year” finds photos taken in the range specified by the chosen 
operator.

• “is repeated annually” will find all photos taken on a specific day, regardless of the year. This 
can be useful for finding photos taken on holidays, birthdays, and other recurring events.

Creating complex searches

While many of your searches might be simple ones—like finding photos from a certain date range, or ones 
with a specific keyword or rating—the real power of Advanced Search lies in its capability to perform 
complex, multilevel searches. You can use a many search criteria in the Advanced Search window as you 
wish to achieve the desired results.

For example, to search for photos taken in the past year with a 24-70mm lens and that have been edited in 
Effects, you’d use the following criteria:
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Or, if you wanted to look for raw photos from 2010 to 2015, with an ISO above 3200, that might benefit 
from Photo RAW’s NoNoise, you could use the following criteria:

With the above search, you might have a lot of photos that could use NoNoise’s noise reduction, and save 
the search as a style so you can perform it again at later date. Adding the Editing criterion, “NoNoise is not 
True” will remove any NoNoise-applied photos from the search results, letting you focus on images that 
could still benefit from NoNoise.

You can even have multiple instances of the same search field with different search options, although in 
most cases you’ll need to make sure that you have Meet Any of the Search Criteria set in the Match pop-up. 
For example, if you wished to find all RAW files and all DNG files, you would add two instances of the File 
Type criterion, one for each type, and change the Match pop-up to “Any of the following rules.” 
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Using Smart Organize to Manage Duplicates and More
Photo RAW’s Smart Organize feature is designed to 
help you get an unwieldy photo library under control. 
When you have a large library that contains thousands 
of photos, it can be difficult to find duplicates, or to 
manage images that are similar in appearance or date 
and time. Or sometimes, you wish to group photos 
from HDR brackets, slices for building panoramas, 
or photos to be focus stacked. Not only can Smart 
Organize find duplicates, but it can find and group 
photos that have similar appearance, location or time. 
It can help you cull your library to find just the best 
photos in a series.

To access Smart Organize, click on the icon in the 
Shortcuts list or choose Smart Organize from the File menu. This will open the start-up window, which has 
two sections, Search Options and File Info. The top of the Search Options pane lets you choose which part 
of your photo library you wish to search:

• The contents of the current view in Browse 
(Current Photos);

• All of your cataloged folders;

• A specific folder selected via your operating 
system’s file/folder selection dialog box; or 

• Any one of your individually cataloged folders.

The second portion of the Search Options pane lets you choose which search mode to use. There are four 
search types:

• Duplicate Photos. This option looks for potential duplicate images, based on name, date 
taken, file size, and dimensions.

• Similar Appearance. This option uses machine learning to find photos that are similar to each 
other, looking at similar tones and colors. This makes it easy to group and sort through series 
of photos, such as portraits of different people.

• Same Time. Selects photos that were shot in the same general time frame. When you wish to 
group panorama slices or HDR brackets, you can use this option to group sets of images. 

• Same Place. Uses GPS data to display photos taken in the same general vicinity of each other. 

Clicking the Find button will perform the search, and open the Smart Organize Results window, as shown 
on the following page.

NOTE: When working with large collections of photos, Smart Organize can 
take quite a bit of time to display results.
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THE SMART ORGANIZE RESULTS WINDOW

The Smart Organize results window contains the following elements:

A.	Results: the total number of photos found, and the number of sets.

B.	 Group heading: displays the group number and the number of photos marked in that group.

C.	 Preview area: displays search results as grid of thumbnails, by group. 

D.	View Selector: zoom factor (top left); switch between Grid and Compare views (bottom left); 
file path for the currently selected photo.

E.	 Reject/Delete and Auto Mark settings. 

F.	 Group-specific options: let you create a new subfolder with the selected images: reject/
delete marked photos in the group: and Skip the group and remove it from the window.

G.	Search Options: includes the original search type, but you can also perform a new search by 
selecting items from the pop-up menus in the panel.

H.	Info Panel: displays EXIF and size information for the currently selected photo. Works 
identically to the standard Info panel in ON1 Photo RAW 2023 (see page 38)

I.	 Settings Applied: shows all of the operations from the Edit module that have been applied to 
the current image (see page 15).

J.	 Close buttons: Reject/Delete All Marked closes the window and does either deletes/rejects 
the marked photos in all groups; Done closes the window without making any changes.
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Working through the search results

When you perform a search with Smart Organize, the results window is organized into groups, based on 
the search mode you chose. Groups can consist of a pair of photos, or larger numbers, based on your library 
and the type of search. You can use the view slider of the window to make the thumbnails larger or smaller, 
and you can view the photos in Grid or Compare modes (see page 22 and page 26, respectively), 
which work in the same manner as those views in the main Browse window. 

The idea behind the results window is that you’ll work group by group, evaluating the photos in that group, 
and making decisions on the group’s contents based on the type of search you originally made. Photos that 
you wish to do something with—remove in one form or place into subfolders—you apply a checkmark to. 
Then, you’ll move on to the next group. The top section of each group has the following items:

A.	Group Information: Displays the number of the current group (out of the total number of 
groups) and the number of photos marked in the group. You can also use the right and left 
arrows on the left side of the bar to move to another group.

B.	 New Subfolder: Creates a subfolder with the marked photos in the group.

C.	 Reject/Delete All: This will apply the reject flag or delete all of the photos in the group, based 
on the Reject Mode option chosen at the top of the search results window.

D.	Reject/Delete Marked: This will apply the reject flag to, or delete all of the marked photos in 
the group, based on the Reject Mode option chosen.

E.	 Skip Group: Removes the group from the results, without making any changes.

In each group, you mark photos you want to deal with—ones you wish to reject/delete or move to a 
subfolder—with the checkbox in the upper corner of that photo’s thumbnail. You can select multiple photos 
in a group, and when you choose one of the actions, it will apply to the checked photos. Clicking on the 
New Subfolder, Reject/Delete All, or the Reject/Delete Marked buttons will apply that action to the group 
and remove the group from the results list. Clicking on the Skip Group button will remove that group from 
the results window and not make any changes to those photos.

When you’re using Smart Organize to look for and group photos—for HDR, panoramas, focus stacking, or 
other organizational uses, use the New Subfolder option. Mark the photos that you wish to group, and click 
on the New Subfolder button. You’ll be prompted for a folder name; enter the name and click OK. Photo 
RAW will move the marked photos to that new folder. 

NOTE: If the marked photos do not reside in the same folder the New 
Subfolder button will be grayed out.

Using Auto Mark

When you have the Auto Mark option checked at the top of the results window, Photo RAW will mark the 
photos in each group that it believes should be checked, based on criteria found in the Auto Mark tab of 
the Preferences window. This tab can be opened in the search results window by clicking on the gear icon 
to the right of the Auto Mark checkbox.



ON1 Photo RAW 2023 User Guide	 Part 2: Organizing with Browse	 58

The Auto Mark preferences tab displays a collection of 10 criteria—file type, editing status, various image 
metadata items, and more—that you can set, and that Photo RAW will utilize when performing a Smart 
Organize search. For example, you can choose 
to prefer Raw files over ONPhoto, JPG or PSD 
files, and, when creating each group, Photo 
RAW will mark—or not in the case of finding 
duplicate files—the appropriate images.

Auto Mark is intended to be an aid in helping 
you select and mark photos, especially when 
you’re dealing with large groups of photos. It 
doesn’t, however, automatically delete or reject 
photos; in each found group, you can choose to 
accept its recommendations, change them, or 
ignore them completely and skip that group. If 
you prefer to mark images in groups by yourself, 
simply turn the Auto Mark option off at the top 
of the results window.

Advanced search options

If you would like to perform a different search than the one 
currently displayed in the Smart Organize results window, 
you can do so via the Search Options pane on the left side 
of the results screen. The top of that pane has pop-ups for 
the search locations and the four search types (duplicates, 
appearance, time and location). However, there are two other 
options you can change, depending upon the type of search 
operation you are making.

In all four search types, the bottom of the pane has a menu 
with three options related to the aspect ratio and size of the 
photos selected. You can choose to refine the selection to 
files of the aspect ratio, the same pixel dimensions, or none. 

When you are searching for photos based on similarity, time or location, an Advanced section will be visible 
in the Search Options pane. The three Advanced options (and which search type they work with) are: 

• Matching Level (Find Similar): This slider adjusts the results of grouped photos. The smaller 
the number, the less they have to match to be grouped. 

• Time Gap (Group by Time): This lets you adjust the time in between shots by which you wish 
images to be grouped.

• GPS Distance (Group by Location): Sets the range (in meters) by which location-based photos 
are grouped.

When you have set the parameters of your new search, click the Search button, and Smart Organize will 
generate a new results window.



ON1 Photo RAW 2023 User Guide	 Part 2: Organizing with Browse	 59

Editing Photos in Browse
While most of ON1 Photo RAW 2023’s image-editing power is found within the Edit module, you can 
perform many editing tasks on photos inside Browse. This includes changing metadata, labels and ratings, 
but you can also apply presets to an image or group of images, and can even copy Develop/Effects settings 
from one photo and paste them onto other photos directly within Browse. These operations are also 
available to any photos shared via ON1 Cloud Sync.

RATINGS, LABELS AND LIKES

Using a standard rating and label system, it is easy to sort and cull your favorites from the throw-away 
shots. Browse offers three ways, aside from keywords and subfolders, to mark and group similar images. All 
of these methods may be set several ways: from the Photo menu, the right-click contextual menu, clicking 
the badges on the image thumbnail or in the footer of Image view. There are also keyboard shortcuts 
associated with each classification option.

• Star ratings: Set from zero to five stars. Photographers 
often use five stars for their favorite images and one star 
for images they don’t want to keep, but you can use this 
system in whatever way works best for you. You can adjust 
the rating using the 1 through 5 keys on the keyboard. You 
can also clear the stars on any image with the ` (backquote 
or grave) key.

• Color labels: There are five color labels as well. Color 
labels are a great way to mark sub-sets of images for 
special handling. You can set the color ratings by pressing 
the following keys: 6 (red), 7 (yellow), 8 (blue), 9 (green), 0 
(purple).

• Likes: A common need for photographers is to mark their 
favorite images and the ones they want to delete. This is best accomplished with the Like 
classification. There are three options: Like (icon with a filled-in heart), Dislike (‘X’ icon) and 
Not Set (empty heart). By default, images are in the Not Set category until you change them. 
You can set your Liked images with the P keyboard shortcut, Dislikes with the X key, and clear 
settings with the U key.

Both star ratings and color labels are industry standards. When you use these tools, the settings are 
stored in the metadata and will be available in other photo editors and managers, like Lightroom. (Likes are 
proprietary and will only appear in ON1 Photo RAW 2023.)

TIP: You can change the information displayed in the image thumbnails via the 
Thumbnail Options function. See “Changing the thumbnail display options” on 
page 22 for more.

An example of a photo in Grid view with a 
ratings, color and favorite attached.
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Use Auto Advance when culling your photos

Photo RAW’s Auto Advance feature—which can be turned on or off via the Photo menu—was designed to 
help you rank a group of images quickly: with Auto Advance turned on, apply a rating, color label or flag to 
an current image and Photo RAW will make the change and automatically move to the next image.

APPLYING EDIT MODULE PRESETS IN BROWSE

ON1 Photo RAW 2023 has a preset system that lets you save your complete settings from the Edit module. 
These presets are always available in Browse, so you can apply your favorite presets quickly and easily to a 
photo or a group of photos.

To apply a preset to an image, click on the Presets panel. There you will see any built-in presets supplied by 
ON1, as well as any presets you might have created or installed yourself. The panel is divided into 
categories, like B&W Films and Cinema. Click on a category to open it and show that category’s presets.

To see a larger representation of what your selected photo will look like, click 
the Quick View Browser icon in the preset category’s title bar. That will display 
an overlay window with all of the presets in that category.

To apply a preset to a photo, simply click on the preset in either the Category 
preset browser or in Quick View Browser mode. Presets applied in Browse are 
not cumulative; after you’ve applied one preset, clicking on another preset will 
remove the previous one and apply the new one. (If you have applied edits in 
either Develop or Effects, those modules’ settings will be erased if the preset 
has settings in those modules.)

Because Photo RAW is non-destructive, going to any of the Edit module tabs 
will display all of the settings applied by the preset. Once in Edit, you can 

You can easily add a preset to any photo (or group of photos) in Browse, in any Preview mode (Grid, Detail, Filmstrip or Compare). Just click on the Presets tab, 
navigate to the category you wish to use, and click on the preset thumbnail to apply. If you don’t like the look, you can Undo, or choose another preset. You can 
also use the fade slider to reduce the amount of the effect.

The Presets panel has a broad 
range of preset types, all of 
which can be applied in the 
Browse module.
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adjust the settings, switch preset, or make any other editing changes.

To remove a preset from a photo, click on the photo and choose Reset All Settings from the Settings menu. 
You can also remove individual settings made in either the Develop or Effects tabs, if you prefer.

(For more detailed information about how to create and edit presets, see “Presets” on page 117.)

NOTE: If a photo has had a preset applied in Browse, 
or has otherwise been edited in one of Photo RAW’s 
editing tabs, you will see a small badge with a ‘+/-’ icon 
in the lower-right corner of the thumbnail. These badges 
are visible in the Grid, Filmstrip and Compare views. (See 
the image on the right for detail.)

COPYING SETTINGS AND SYNCHRONIZING EDITS

In addition to applying presets, you can copy all of the existing edits made in one photo and paste them 
directly onto other images in the Browse module. This includes every editing operation you can perform in 
the Edit module. There are two primary methods for 
doing this—Copy/Paste and Sync—but they achieve 
the same end goal: it’s more a matter of preference in 
which operation you choose.

To copy the edit settings from an image, click on the 
source file and choose Settings > Copy Settings. Then, 
click on the new image and choose Settings > Paste 
Settings. A window will appear, giving you the option 
of applying any or all of the edits on the original 
photo, or you can select which edits—everything from 
individual settings in Develop’s Tone and Color pane, 
to masks, cropping, and text if used—you wish to 
paste into the new photo. (You can also select a group 
of photos and paste the edit settings onto the group.)

The Copy/Paste Settings commands can be useful 
when you wish to paste settings across a number of 
photos in different folders. As long as your Browse 
session is active, Photo RAW will remember the last 
copied settings, and you can paste them onto other 
photos as you wish.

With the Sync Settings command, select the image 
you want to use as your source. Then, holding down 
the Shift key (if you are selecting an image or group 
that is contiguous with the source), or the Command 
(Mac) or Control (Windows) key, and click on the 
image(s) that you wish to apply the source file’s 
edits. Your selection should have the source image 

In the Apply Settings window—accessible from either Paste Settings or 
Sync Settings—you can apply nearly all Edit module operations to 
another image or group of images. Filled circles to the left of a setting 
mean that the setting will be applied; click the circle if you don’t wish 
that setting to be applied.
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highlighted in blue, and the target images highlighted in gray. If that is correct, click on the Sync button 
at the bottom of the Preview area, or choose Sync Settings from the Settings menu. The Apply Settings 
window will open, and you can follow the same procedure to synchronize your edits.

Sync All Settings

To sync everything from a source photo to another photo or group of photos Settings > Sync All Settings 
will bypass the Apply Settings window. Select your source and destination photos and select the command. 
Everything—including cropping, text and masks—in the source image will get synced.

RESETTING EDITS IN BROWSE

Any edits you have made with ON1 Photo RAW 2023 can be completely reset from within the Browse 
module. This includes photos you might have pasted or synchronized settings onto inside Browse, or 
anything done within the Edit module.

The Settings menu offers eight options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in the Edit module. (This 
option can also be accessed from the Reset All button at the bottom of the Browse window.) 

• Reset Develop Settings: Removes only the settings applied in the Develop tab.

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset Sky Settings: Removes only the settings applied in the Sky tab.

• Reset Portrait AI Settings: Removes only the settings applied in the Portrait tab.

• Reset All Retouching Tools: Resets any retouching applied anywhere in the Edit module.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Liquify Tool: Resets any application of the Liquify tool in the Edit module.

• Reset Crop: Returns the image to its original, uncropped size.

• Reset Text: Removes any text blocks.

You can undo any of these changes immediately after making them; otherwise resetting with the 
appropriate option will permanently reset the image.

NOTE: The Reset settings options—as well as the Copy/Paste and Sync 
options—are not available when you are working with layered photos in Browse. 
You can, however, Copy and Paste settings between layers in the Edit module.

SEND TO

Browse lets you send images you are viewing to other applications for 
editing. This is done via the Send to option, which is available from the 
right-click contextual menu or the Edit menu. Browse detects the following 
common photo managers or editors and lists the latest installed version:
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• Adobe Photoshop

• Adobe Photoshop Lightroom

• Adobe Photoshop Elements

You can set up any application you want to send your photos 
to. Simply select the Send to Other Application option. Then 
select the application you want to send your photos to. The 
application will be remembered and listed with your other 
Send to options. (For example, if you use an email client you 
can add it to easily email photos.)

When you send an image to another application, you will be 
presented with the Edit in dialog box from ON1 Photo RAW 
2023. There you’ll have the option to send either the edited 
photo or the original, unedited image. If you choose to send 
a copy, you’ll have options for choosing the file type, color 
space, bit depth and resolution. If you use the same set of 
options every time, you can check the “Don’t ask me again” box in the window, and you won’t be prompted 
again. (To change this setting, go to the Files tab in Photo RAW’s Preferences (see page 268).)

VERSIONS

ON1 Photo RAW’s Versions feature lets you create a ‘virtual’ copy 
of an image, which you can edit in a completely different manner 
than the original file, but without actually duplicating the image. 
This lets you easily try different preset treatments, crops, and 
retouching operations on a copy of the same image without having 
to lose any work—or see your disk space increase. 

Creating a version is easy: in any of Browse’s view modes, choosing 
Create Version from the Settings menu (or choosing Command-’ 
or Control-’) will create a new version of the currently selected 
(or viewed) photo. A copy of the image will be created next to 
the existing one in your library, with a ‘v1’ added to the filename. 
(Additional versions will be numbered sequentially.)

A version acts like most images inside Photo RAW. You can open it 
in any of the Edit module tabs; crop or make any adjustments with 
all of Photo RAW’s tools and filters; and you can edit its metadata independently of the original. You can 
even export a versioned photo or use it in Resize (Photo RAW creates a rendered file in those instances). 
You can not create a version of an .onphoto file that has layers in it, however. You must first flatten the 
image inside the Edit module. (See “Working with Layers” on page 190 for more.)

In Grid view, versioned photos will have a small square badge split into light and dark triangles.

The Edit In dialog, with the Copy Options section expanded.

A versioned photo will have a ‘v1’ (or higher) 
attached to the end of the filename, and a small 
badge, split into dark and light triangles, in the 
lower right corner of the thumbnail.
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Using ON1 Photo RAW 2023 with two displays

You can use Photo RAW’s Dual Mode feature to display a second copy of your photos in an added browser-
style window. Here, you can view folders of images as thumbnails, and navigate through them, while 
displaying the full-size images in the primary window. This can help your productivity when you have an 
additional monitor connected to your computer, reducing the need to switch between Grid and Detail, 
Filmstrip or Compare view. It can also be useful when you wish to present photos on a projector or TV, and 
don’t want to display the entire Photo RAW application window.

Dual Mode only works with the Browse and Edit modules. In Browse, you can choose how you wish the 
second window to act, either displaying in Grid view, with the primary window working in the three other 
primary view modes (Photo, Filmstrip or Compare), or vice versa. As you navigate images in the Grid, the 
other window will display the currently selected image.

When in the Edit module, the second window works solely in Grid view, displaying thumbnails of the 
current folder. If you click on another image in the grid, that image will be presented in the main window. 

TURNING DUAL MODE ON

To use this feature, chose Dual Mode > Show from the Window menu, or click the Dual Mode icon at the 
bottom left of the main window. The first time you use Dual Mode, the second window will open on your 
primary display. Simply drag the window to your secondary display, and from that point on, Photo RAW will 
remember the location of the second window. (When the window is placed in the second display, you can 
choose Dual Mode > Full Screen Mode from the window menu to have the window fill the entire screen.)

The icons at the bottom of the secondary window are a subset of the main application window: in Browse, 
you will see options for Grid, Photo and Compare views; in Edit, only the Grid view icon will be visible. The 
Size slider can change the size of thumbnails (in Grid view) or the zoom level (in Detail and Compare view).

Photo RAW’s Dual Mode lets you open a new browser-style window, which can be placed on a second display, or 
be used to present on a TV or projector.
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Using ON1 Cloud Sync with Photo RAW
ON1 Cloud Sync is an optional cloud storage service and sync technology that lets you 
capture, edit, and access photos seamlessly between multiple computers and mobile 
devices. The service is designed to share photos when you’re using the subscription 
versions of ON1 Photo RAW 2023 and ON1 Photo Mobile. Cloud Sync also lets you sync 
custom presets and extras between two installations of Photo RAW (Mac and Windows).

There are two storage options for ON1 Cloud Sync accounts, 200GB and 1TB, and multiple methods for 
signing up. If you have purchased an ON1 Photo RAW subscription, it will automatically be available in both 
Photo RAW or ON1 Photo RAW for Mobile after you have signed in to your ON1 account. 

From ON1 Photo RAW 2023, photos are published and synced to the ON1 Cloud via cataloged folders 
or albums, and you can choose to publish photos either as editable previews or in their original format 
(including raw). See “ON1 Cloud Sync File Formats” on page 67 for specifics on the different file types 
and why you would use one over the other.

When you’re using the ON1 Photo Mobile app on your smartphone or tablet, all photos on that device are 
published to the cloud in their original format, and reside in a single folder called Local Photos. (You can 
also create albums with ON1 Photo Mobile.)

VIEWING YOUR ON1 CLOUD SYNC STATUS

In the lower right section of the left sidebar is the ON1 Cloud Sync status icon, which has a small colored 
dot—in one of four colors—that indicates the status of ON1 Cloud Sync on the current computer. The 
indicator colors are:

• If there are no uploads or downloads in process, and the connection to the ON1 
Cloud is on, the dot will be green.

• When Photo RAW is in the process of uploading or downloading images or other 
information from the cloud, the dot will be blue.

• If there is a problem with the internet connection, you aren’t logged in, or if you are running 
low on available space, the dot will be red.

• It will be gray if you do not have an ON1 Cloud Sync account.

Clicking the status icon will bring up your ON1 
Cloud Sync dashboard (shown on the right). 
This window shows the status of any current 
uploads, your available cloud storage, and 
includes links to the iOS and Android versions 
of the ON1 Photo Mobile app. Clicking on the 
Account button will take you to your account 
page on the ON1 website. The Learn button 
displays a window with information on how to 
get started with ON1 Cloud Sync.

The Turbo button is used to speed uploads; it 
will take as much processing power as it can to sync photos, to the limit of your upload bandwidth.
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VIEWING OTHER ON1 CLOUD SYNC DEVICES IN BROWSE

When you have shared ON1 Cloud Sync devices, you can see a list of them by clicking on the ON1 Cloud 
Sync icon in the Shortcuts bar on the top left side of the Photo RAW window. 

ON1 Photo RAW 2023 will display your connected devices in the preview area as folders in Grid view. 
Clicking on one of those folders will open with a list of that device’s synced photos. For mobile devices, you 
will see a single folder, Local Photos, which contains all of the photos that are on that device. For Windows 
and Mac computers, you will see a list of all cataloged folders from that device. 

You can view and edit any of the photos on a synced device from within ON1 Photo RAW 2023, and you 
can drill down into the folders in the same manner you would for any other folder in Photo RAW. You can 
sort the photos, add them to new or existing albums, adjust metadata and add keywords to them. 

Clicking on the ON1 Cloud Sync icon at the bottom of the Shortcuts bar on the left will display a list of your connected devices. Each device 
will appear as a folder. Mobile devices will display a single folder, called Local Photos, while any Mac or Windows computer will display a list 
of the cataloged folders synced with the ON1 Cloud Sync service.

Photos synced to the ON1 Cloud from other devices will have a badge when you are viewing a folder or album in Browse’s Grid view. If 
the synced photo is an editable preview, it will have the Sync badge in the lower right corner of the thumbnail (image left, above). If it is an 
original, it will also have a badge with an ‘OG’ label (center). And, if the photo has been edited, you will also see the ‘+/-’ label (right).
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When viewing photos in Grid view, you can tell if a photo is synced from another device by the small Cloud 
Sync badge in the lower right portion of the thumbnail. If the photo in question is an original — as opposed 
to an editable preview — there will also be a badge with the initials ‘OG.’ These badges will be displayed on 
all published folders, devices and albums when you are working in Grid view.

ON1 CLOUD SYNC FILE FORMATS

With ON1 Photo RAW 2023, you have the option of publishing photos to the ON1 cloud in one of two 
formats, the original photo, or an editable preview, which uses a proprietary compressed-raw file format 
developed by ON1. This editable preview can be up to 75% smaller than the original raw file, while 
preserving the original’s tone and color fidelity. Using this option lets you keep more of your photos in the 
cloud, and, with either format, you can still edit a photo on one device, and your edits will be synced back 
to the originating computer, so that your original file is updated with those edits (and any other metadata 
changes you might have made).

As noted, the savings in storage space can be quite great. Use these basic guidelines for photo storage 
options:

• With a camera that creates 30MB raw files, you should be able to store more than 5,500 
raw originals in the cloud with a 200GB ON1 Cloud Sync service plan, and more than 27,000 
photos with the 1TB plan.

• If you are shooting JPGs with that same camera, we estimate that you would be able to store 
more than 20,000 JPG originals with the 200GB plan, and more than 100,000 photos on the 
1TB plan.

• If you chose to upload editable preview files instead of originals, you should be able to store 
more than 33,000 photos in the cloud with the 200GB plan, and more than 160,000 with the 
1TB storage plan.

Remember, while you can store photos in the ON1 Sync cloud using either format, and in any combination, 
your originals are always stored securely on the device that created or imported them. 

NOTE: Photos taken or imported with the ON1 Photo RAW for Mobile app are 
always uploaded in their original format. 

When to choose one sync format over another

In most cases, if you are working on two computers (a desktop and laptop, for example), working with 
editable previews should be more than sufficient for most workflow requirements. You can edit and update 
any metadata, including ratings, keywords and more, and work within all of the tabs in the Edit module. The 
fidelity and tonal range of the preview files is excellent, and all of your edits will be applied to the originals 
on the other device. 

You should sync folders and albums as originals when you want to work with an original photo on another 
computer. There are four primary reasons for this: you wish to create layered files; build HDR, panorama 
or focus-stacked composites; resize a photo with the Resize module; or you wish to print a photo at the 
highest-possible quality. 
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In these instances, if you have an original photo on another ON1 Cloud Sync device, you can download 
a copy of that original from the cloud to your current computer by right-clicking on the photo in Browse 
and choosing Download Original from the pop-up menu. If the original version is in the cloud, you will be 
prompted to save the copy in a location on your computer. 

Depending upon your intent, you can delete this copy later, or save it back to a published folder or album. 
For more information on these instances, see “Using Layers with Synced ON1 Cloud Files” on page 196, 
“Using Resize with ON1 Cloud Sync Files” on page 241, and “Printing photos from ON1 Cloud Sync 
devices” on page 208.

Managing sync options in Photo RAW

Photos published to ON1 Cloud Sync are managed in ON1 
Photo RAW 2023 at the folder or album level. What this 
means is that you can set up different folders or albums to 
sync as editable previews or originals, and you can change 
this option at any time by right-clicking on the folder or 
album and choosing the Sync Options item from the pop-
up menu. 

It is worth noting that you cannot change the sync option for individual photos: it can only be done at the 
album or folder level. You can however, selectively change the sync option for the subfolders in a cataloged 
folder.

BASIC CLOUD SYNC WORKFLOW WITHIN ON1 PHOTO RAW

As noted in the sections on cataloged folders (page 30) and 
albums (page 21), publishing photos from ON1 Photo RAW 2023 
is straightforward. When creating an album or cataloged folder, you 
have the option to publish and sync those photos as either originals 
or previews, or you can wait until a later time and publish them by 
selecting the item and choosing Publish to ON1 Cloud Sync from 
the pop-up menu. By default, when you publish via the pop-up, 
Photo RAW will upload editable previews to the cloud, but you can 
change this via the Sync Options menu item, as described in the 
previous section.

When you’re working with any photos that are based on a remote 
Cloud Sync device, regardless of whether it was created on a 
computer with Photo RAW or on a mobile device with ON1 Photo 
Mobile, you will be able to perform any changes to metadata, or make any edits in the Edit module, and 
those changes will be synced back to the original file on the original device. This doesn’t matter if the file in 
the cloud is an editable preview or an original.

Syncing presets and extras with Cloud Sync

You can also sync your Photo RAW presets and imported extras between your licensed computers 
with Cloud Sync. This option can be turned on or off via the Sync Presets checkbox in the Cloud Sync 
Preferences pane (see page 270).

You can publish (or unpublish) an album or cataloged folder at 
any time by right-clicking on the item name and choosing 
Publish/Unpublish to ON1 Cloud Sync from the menu.

To change the publishing status of an album or 
folder, right-click on the item and choose the 
appropriate format from the Sync Options pop-up 
menu.
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CLOUD SYNC, PHOTO RAW AND PHOTO RAW FOR MOBILE

On mobile devices, which includes both smartphones and tablets, the ON1 Photo RAW for Mobile app acts 
as a camera — with full raw-capture support — and an import device, which can add your photos 
immediately to ON1 Cloud Sync. ON1 Photo Mobile also has a subset of Photo RAW’s Edit module built 
into it. You can shoot photos with your phone, edit them using ON1 Photo Mobile, add them to existing 
Cloud Sync albums and they will automatically be shared to the cloud for viewing and editing. 

All of the photos shot and imported onto a mobile device with ON1 Photo RAW for Mobile are captured to 
a location on the device called Local Photos, which is what you see when you look at a mobile device in the 
ON1 Cloud Sync pane in ON1 Photo RAW 2023. (See “Viewing other ON1 Cloud Sync Devices in Browse” 
on page 66.)

There are four tabs in the ON1 Photo Mobile app:

• Local Photos, which displays the photos on that device;

• Cloud Sync, which displays your synced devices, and lets you drill down into them to view the 
photos on those devices;

• Albums, which displays synced ON1 Cloud Sync albums, and lets you create your own synced 
albums directly from your mobile device; and

• Camera, a full-featured, pro-level camera capable of capturing raw images and syncing them 
immediately to the ON1 cloud.

ON1 Photo Mobile uses the same RAW processing engine developed for ON1 Photo RAW, and has a 
non-destructive raw editor built into the app. The basic editing controls are similar to those found in 
the Develop tab of Photo RAW’s Edit module: there are adjustments for Exposure, Contrast, Shadows, 

The ON1 Photo Mobile app, available for both iOS and Android phones and tablets, is designed to share and edit your mobile photos, and access and edit 
photos on your other ON1 Cloud Sync devices. The app has four tabs, a Local Photos container (above left), which is where your photos from that mobile 
device reside; ON1 Cloud Sync (center left), which lets you access the photos from other shared devices; Albums (center right), which displays existing Cloud 
Sync albums (and lets you create new albums); and Camera (left), which is a full-featured smartphone camera capable of capturing raw photos.



ON1 Photo RAW 2023 User Guide	 Part 2: Organizing with Browse	 70

Midtones, Highlights, Whites, Blacks, White Balance, Noise, and Sharpening. The app also includes five 
filters from the Edit module’s Effects tab.

Viewing photos in ON1 Photo Mobile

You can view all of your photos — local or synced from the cloud — in ON1 Photo Mobile via standard 
gestures and taps. Tapping on an album, for example will display a grid of that album, and you can pinch 
two fingers together and apart to change the grid size. Tap on a photo to view it in Detail view, and pinch to 
zoom in. 

Photo Management and Editing with ON1 Photo Mobile

When you wish to share or edit a photo with 
ON1 Photo Mobile, tap on it from any Grid view 
screen. This will display the photo in Detail view 
with the photo’s name, and three icons at the 
bottom of the screen: one for sharing the photo, 
one for editing, and the other to delete the 
current photo (this only applies to photos that 
reside in that device’s Local Photos folder).

Sharing options include saving a copy of the 
photo to your camera roll, or to be shared via 
your device’s social media sharing options. The 
sharing window includes sizing options (medium, 
large, and full-size) for your exported photo.

Editing photos with the app is similar to editing 
photos in Photo RAW, although ON1 Photo 
Mobile doesn’t have all of the tools and filters 
found in the desktop app. ON1 is committed 
over time to bring the mobile app as close to 
parity with the desktop version as possible.

Tapping the Edit icon at the bottom center of the screen will display ten editing functions underneath the 
photo:

• Crop: resizes and levels your photo.

• Tone: for adjusting exposure, contrast, 
highlights, shadows, midtones, white 
and black points, and for adding structure or applying dehaze.

• Color: lets you adjust the color balance of the photo.

• AI Auto: performs an automatic tone adjustment on your photo using a proprietary ON1 
algorithm.

• Details: for applying sharpening and noise reduction.

• Presets: ON1 Photo Mobile includes a variety of presets in multiple categories, letting you 
achieve a great look with one click.

• Effects: lets you apply nine of Photo RAW’s Effects filters: Black & White, Color Adjustment, 
Curves, Dynamic Contrast, Film Grain, HDR Look, Glow, Split Tone, and Vignette.

When you’re viewing a photo in ON1 Photo Mobile, tapping the center icon at 
the bottom of the screen will take you into Editing mode.
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• Local Adjustments: In the same way that Photo RAW lets you apply targeted adjustments to 
portions of a photo, ON1 Photo Mobile has a Local Adjustments module, where you can fine 
tune portions of your photos, with the same masking tools found in the desktop app.

• Retouching Tools: includes the Perfect Eraser and Clone tools to fix blemishes, dust spots 
and more.

• Reset: The rightmost icon will reset all of your edits, returning your photo to its original state.

For more information about the various editing options available in ON1 Photo Mobile, and how they relate 
to the ON1 Photo RAW 2023 editing engine, see “Working in the Edit Module” on page 72. 

NOTE: ON1 updates Photo Mobile regularly, adding new effects and other 
features to the app. For an up-to-date list of features and enhancements, see 
the What’s New in Photo Mobile page on the ON1 website.

Mobile editing limitations with synced photos

While ON1 Cloud Sync and ON1 Photo Mobile have been designed to provide a seamless editing 
experience between desktop and mobile devices, there are two instances where you might run into an 
situation where you can view, but not edit a synced file inside ON1 Photo Mobile:

• When you’ve edited a synced ON1 Cloud photo with Photo RAW using any Effects filter that 
is not present in ON1 Photo Mobile.

• Any .onphoto file cannot be edited with ON1 Photo Mobile. This includes HDR, panorama 
and focus-stacked composites, as well as layered files.

Any photo synced with ON1 Cloud Sync that has not had editing adjustments made to it can be edited with 
any ON1 Photo RAW 2023 or ON1 Photo Mobile device, whether the photo in question is an original or 
an editable preview. And all ON1 Cloud Sync photos will be visible on all Cloud Sync devices, regardless of 
their originating format.
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ABOUT THE EDIT MODULE
ON1 Photo RAW 2023’s photo-editing power is found in the Edit module, which consists of five distinct 
editing functions, each separated into tabs:

• Develop is where you perform basic, global editing operations, such as adjusting tone and 
color, removing noise and repairing motion blur and camera shake—with ON1’s breakthrough 
NoNoise AI and TackSharp AI technology—and more. It is the perfect place to begin editing 
your photos. (See page 130.)

• Effects is the stylization center of Photo RAW, with 31 filters that can be stacked in any 
order, all with extensive blending and masking options. And, with Photo RAW’s Mask AI 
technology, you can apply Effects filters solely to specific regions in a photo with a single 
click. (See page 143.)

• Sky Swap AI lets you replace boring skies quickly and easily. Sky Swap AI automatically masks 
out the sky in your photo, letting you replace it with any of more than 100 included skies. You 
can even import your own skies directly from within the tab. (See page 170.) 

• Portrait AI uses machine-learning algorithms to automatically find and retouch all the faces in 
a photo, apply smoothing, reduce blemishes, and brighten eyes and teeth. (See page 176.)

• Local Adjustments are designed to apply basic, targeted edits to parts of your photos, letting 
you perform traditional photo-editing tasks—like dodging and burning—with ease. You can 
also add custom brush overlays to an image via the Local Adjustments tab. (See page 183.)

To help you fine tune the edits on your images, Photo RAW has more than 20 tools that perform everything 
from cropping (with content-aware fill) and transformation, the creation and refinement of selections and 
masks, and a suite of tools for applying sophisticated retouching operations. And, new tools like Super Select 
AI make the selection and application of Effects filters or local adjustments easier than ever before: you can 
simply point and click at an area of a photo and apply an adjustment in a single operation.

Switching between the different tabs in the Edit module is as simple as clicking on the appropriate tab. 
While you work on an image, all of your settings in each tab are saved while you edit. All edits you make to 
an image are preserved non-destructively, and you can go back to any image at any time and make changes 
or corrections to it. 

Photo RAW 2023’s Edit module also includes a Layers pane, which lets you stack multiple images together 
to achieve sophisticated composites that aren’t available in many standalone photo editors. And, because 
the Edit module is entirely non-destructive when you use Photo RAW as a standalone app, you can re-edit 
your compositions without worry. (See “Working with Layers” on page 190 for more.)

ON1 Photo RAW 2023 also includes a robust preset system that lets you save settings made in any of the 
editing tabs, along with some of the retouching tool operations and masks—including AI-generated masks—
for applying to other photos. Editing presets can be applied in the Edit module, or in Browse, and, like all 
other elements of Photo RAW 2023, are re-editable. (Presets are discussed in detail on page 117.)

In addition to presets, you can copy and paste Edit module settings from one file to another, or synchronize 
the edits on one photo to a group of photos. These operations can all be performed in any of the editing 
modules, as well as in Browse, adding to ON1 Photo RAW 2023’s extreme flexibility. (See “Copying settings 
and synchronizing edits” on page 123 and “Applying Edit Module Presets in Browse” on page 60.)

If you are using the ON1 Cloud Sync service, your synced photos are editable in Photo RAW, regardless of 
device. All of your edits will be synced back with the photos on their originating device, and will be fully re-
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editable in Photo RAW. The primary exception to this is when you are using Layers, which must be stored 
on the device that created the layered file. See “Using Layers with Synced ON1 Cloud Files” on page 196 
for a more detailed description of the workflow for Layers and ON1 Cloud Sync.

Using Photo RAW as a Raw Editor
ON1 Photo RAW 2023 offers true non-destructive raw editing capabilities. This means you can view your 
images in the Browse module, open a raw file in any part of the Edit module and apply edits—including 
cropping, healing and local adjustments—and Photo RAW will always be working with your original file. 
At any point, you can go back to Develop, Effects, Sky Swap AI, Local Adjustments or Portrait AI and 
change any or all settings you have made. What’s more, when you’re working with layers, Photo RAW 
will save your work in a non-destructive format as well, using a Photo RAW-specific ‘onphoto’ file format. 
This format retains all layer and editing information, and, when you wish to export a composited image for 
sharing or other uses, you can easily export it in any format supported by Photo RAW.

THE EDITING PIPELINE IN ON1 PHOTO RAW 2023

There are many editing operations you can make to a raw file (or other supported file format) with ON1 
Photo RAW 2023, from broad global adjustments for exposure and color, to the application of effects, to 
cropping and retouching, the addition of local adjustments to sections of a photo. Because there has to be 
some structure of how edits are applied to a raw file, it might be helpful to understand the order in which 
edits are applied to a raw file. Whenever you view an edited image without additional layers, this is the 
order in which ON1 Photo RAW 2023 applies edits:

1.	 The original, base image is always at the bottom of the stack. 

2.	 Since retouching—operations like removing dust spots, editing blemishes or skin 
imperfections—is often the first thing many photographers do to their images, Photo RAW 
applies these operations first. This way, all subsequent edits will incorporate these changes.

3.	 Next are most settings applied in the Develop tab. This includes the application of color 
profiles, global exposure, color correction, sharpening and noise reduction (unless NoNoise 
AI and/or TackSharp AI is used, in which case those settings are applied to the base image).

4.	 Local adjustments made to an image are applied next.

5.	 Any Transform operations are applied after local adjustments. 

6.	 Edits made in the Portrait tab are applied next.

7.	 Any filters applied in the Effects tab are applied last.

8.	 Text layers sit above the image stack. 

9.	 Finally, any cropping or rotation information made to an image is applied to the file.

When working with multiple layers, steps 1 through 7 are applied for each layer, with the bottom layer at the 
bottom of the ‘stack’, and the topmost layer at the top. After all the layers’ edits have been applied, Photo 
RAW adds any text, followed by cropping and rotation information, to complete the document pipeline.

You do not have to edit your photos in this order; this is just the way in which Photo RAW 2023 applies the 
edits you make to an image. You might find a dust spot, for example, only after changing exposure settings 
in Develop or applying a filter in Effects. You can then use the Perfect Eraser to remove the spot and 
continue with your editing, and Photo RAW 2023 will apply it at the proper place in the stack.
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ON1 Edit Module Main Screen Overview

Edit provides you with an easy-to-use work space for editing your photos. Below is an overview of the main 
window sections of the Edit module:

A.	Tool well: Tools for working within the Edit module.

B.	 ON1 Cloud Sync Status/Preferences/Help: Shortcuts to ON1 Cloud Sync status, preferences 
and help.

C.	 Preset panel: List of all installed presets (by category). When working in the Effects tab, a 
Filters panel is visible as well. 

D.	Search: Searches presets (and filters, when working in Effects) by name.

E.	 Window options: (from left to right) Open/close the Presets panel; toggle Dual Display Mode 
on/off; switch between Photo and Filmstrip views (Filmstrip shown).

F.	 Preview Window: Displays the current photo in detail view.

G.	Preview option toggles: Magnification slider for current image, compare (before/after) mode, 
show/hide mask, turn soft proofing and preview on or off.

H.	Tool Options bar: Options and settings for currently selected tool.

I.	 Photo Information pane: Navigator, Levels (histogram), Info, History, Snapshots.

J.	 Layers pane: Add, edit and manage layers here.

K.	 Edit tabs: Tabs for accessing the Develop, Effects, Sky Swap AI, Portrait AI, Local 
Adjustments. Clicking on each tab brings up the settings for that tab.
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L.	 Reset bar: Reset all (all Edit module settings), Reset (resets the current tab’s settings), Sync 
settings with previously edited photo (when in Filmstrip view)

M.	Module selector: Switches between Browse and Edit modules (if you are editing a photo as a 
plug-in, the Browse icon will be disabled).

N.	Output: Shortcuts for switching to the Resize module, as well as for printing, exporting and 
sharing the current photo.

The look of the Edit module in ON1 Photo RAW 2023 is similar to that of Browse, with slight variations that 
are specific to photo-editing tasks. The left side of the window contains a tool well with Edit-specific tools, 
and a Presets pane (when using the Effects tab, you will also see a Filters tab alongside Presets).

The right side of the screen contains the same panes at the top—Navigator, Levels/Histogram and Info—as 
well as a History pane, the Layers panel, and tabs for the four editing areas inside Edit: Develop, Effects, 
Portrait and Local. Clicking on a tab will bring up the options and settings for that area. When viewing 
images, you can work in either Photo or Filmstrip view, each view works the same as they do in Browse 
(See “Working in the Preview Area” on page 37 for more).  

Photo RAW provides several ways to navigate and view your image in the Edit module’s Preview window:

• By default, your image is presented in Fit view, which displays the image within the preview 
area, and the Zoom tool is selected. Clicking on the image with the Zoom tool will zoom in 
to 100%, and the cursor will change to the Hand tool. You can move around your image by 
clicking and dragging in the preview area. Clicking once will take you back to Fit view.

• You can also zoom in and out via the View menu and the Navigator pane. The Navigator pane 
displays a bounding box around the area currently on-screen, and you can reposition what is 
displayed in the preview area by clicking and dragging the box around the pane. Clicking on 
one of the buttons at the bottom of the Navigator pane will automatically zoom to Fit, 100%, 
50% or 25% views. (The buttons are visible in the Zoom tool’s Options bar.)

• When the preview zoom is larger than the viewable area, holding down the spacebar will 
display the Hand tool if any editing tool is selected. Clicking and dragging while holding the 
spacebar will reposition your image at the current view level.

Navigator, Levels, Info, History and Snapshots
At the top of the control panel on the right of the main window are the Navigator, Histogram, Info, History, 
and Snapshot panes. These tools can be useful for inspecting and viewing details of your image, for looking 
at all of the Edit module adjustments made during a session, and for saving a snapshot of an editing session 
in a specific place.

THE NAVIGATOR PANE

This gives you a thumbnail view of your image as it is 
displayed in the current view. The white square region 
marks the image area that is visible in the preview pane, and 
you can pan your image by clicking and dragging inside the 
square. (You can also use the Hand/Zoom tools to move 
around the image view, and the Nav pane will update.)
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At the bottom of the Navigator pane are several zoom buttons representing percentage zoom views (100%, 
50% and 25%). Click on one of the buttons to change the view. Fit zooms to fit the current canvas size, 
while 100 zooms to 100%, displaying the actual pixels.

NOTE: You can also use your mouse’s scroll wheel to pan and zoom inside 
your photos. See “Using Photo RAW with a Scroll Wheel” on page 14 for 
specifics.

THE LEVELS PANE

This gives you a color chart of the shadow, midtone and 
highlight areas based on the image RGB values (commonly 
known as a histogram). This is useful to show areas within 
the image that may be clipping. Clipping is when your 
image contains pure blacks or white and can signify loss of 
highlight or shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top of each 
end is a triangle. If the triangle is lit, there is clipping on that 
side of the histogram. If you click on the arrows, you will activate the clipping overlay on your image, which 
displays the areas that are clipped. Those areas with a blue overlay are pure black, while the areas with the 
red overlay are pure white. You can turn the clipping view off again by clicking on one of the triangles. You 
can also temporarily enable clipping view by holding down the J key at any time. The clipping view is useful 
when you are making adjusts to the brightness and contrast of your image. (See “Focus and Clipping Views” 
on page 21, for more information about using the clipping view.)

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

THE INFO PANE

The Info pane displays metadata for the current image in an 
easy-to-read format. This metadata includes camera make 
and model; lens focal length; capture date and time; file 
type; ISO setting; shutter speed; aperture; and exposure 
compensation.

The Info pane also displays file-specific data, including image 
dimensions and resolution. If any of the metadata fields are 
unavailable they will be left blank.

Settings Applied

At the bottom of the Info pane is a section that shows all of 
the operations from the Edit module that have been applied 
to the current image. Clicking on the right arrow to the left of 
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the label will display a list of every tab in the Edit module, as well as primary adjustment options, including 
cropping, retouching and sky replacement, and text operations. If an image has had any adjustments made 
to it, that section of the Settings Applied area will be represented in white type, and you can use the arrows 
to the left of the label to drill down further into the Develop, Effects, Portrait, and Local Adjustment tabs 
to see which adjustments were made to an image. (On an image that has had no adjustments, all of the 
settings will be grayed out.)

Double-clicking on any of the available items inside the Settings Applied area will take you to that specific 
setting inside the Edit module, where you can make any desired changes.

THE HISTORY PANE

ON1 Photo RAW 2023 has a robust Undo capability, 
which is helpful when you wish to back up a few steps 
during the editing process. When you want to go back 
further, it can be tedious to keep pressing Command/
Control-Z. That’s where the history pane can be 
extremely useful. It displays every adjustment made 
during an editing session. From the History pane, you 
can scroll through your edits, all the way back to the 
state of your photo when you opened it for editing.

As you work, the History pane tracks all of your edits, adding each change you make to the top of the pane. 
History displays not only the adjustment, but in many cases will display the settings of sliders in the various 
panes and filters. 

You can scroll through the list, and, if you click on an item, Photo RAW will “roll back” your edits to the spot 
you clicked. You can click up and down in the list, and, as long as you don’t make any changes, the entire 
Edit history is preserved. If you roll back to an edit and make a change, the History pane “resets” from that 
point on, losing any of the edits you made after the point you rolled back.

The History feature is designed to help you refine and understand the edits you made during an editing 
session; it not saved once you finish editing a photo. If you go back to Browse, open another image for 
editing from the Filmstrip, or switch to Resize, the History pane resets. If you would like to save your edits 
based on a specific editing state, use the Snapshots feature, described below.

TIP: If you click on an item in the History pane, and you wish to step up or 
down in the adjustment history from that point, you can use the Undo/Redo 
commands to quickly go through the list. If you are happy with your edits, click 
back on the top item in the History pane to preserve the state of the photo.

THE SNAPSHOTS PANE

Photo RAW’s Snapshots function lets you save a photo’s editing “state” at any point in the editing process, 
so that it can be returned to at a later time. When you create a snapshot, it saves all of the current photo’s 
edits as they are in that moment. Once saved, you can get back to that state in the editing process at any 
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time by clicking on the snapshot’s name in the pane. You can also create multiple snapshots and move from 
state to state by clicking on the appropriate snapshot in the list. 

Snapshots can be useful when you wish to save and 
compare different applications of effects, such as 
comparing color vs. black-and-white treatments. They’re 
also helpful when you’re not quite sure about where to 
take an edit, and you want to ensure that you can get 
back to a specific point in the editing process.

Snapshot basics

The top of the Snapshot pane for each photo will always 
have an item called “Original,” which is the original state 
of the photo as it was first opened in the Edit module. In 
addition, at the conclusion of every Edit module session 
for that photo, Photo RAW will automatically save the final editing state as a snapshot, with the date and 
time you closed the photo, and an “(Auto Save)” label at the end of the snapshot name. 

To create your own snapshot, go to the Snapshots tab and click the New Snapshot button. A window will 
open asking you to name the snapshot; by default, it will be the current date and time, but you can enter 
any descriptive text you would like. There is no limit to the number of snapshots you can create.

When you wish to return to the editing state defined by a specific snapshot, click that item in the Snapshots 
pane. You can also move from snapshot to snapshot, which can be helpful for comparing edits. To then get 
back to where you were at before you clicked a snapshot, choose Undo, or, if you’ve applied a number of 
edits from that snapshot state forward, you can use the History pane to roll back to the pre-snapshot state. 
(Alternatively, you could create a new placeholder snapshot, which would preserve that state, and return to 
it later.) 

Managing snapshots

There are a few snapshot-management options available, which can be called up by right-clicking on any 
item in the Snapshots pane. These options include:

• New Snapshot: creates a new snapshot with the current 
editing state.

• Delete Snapshot: removes the snapshot permanently 
from the pane.

• Rename Snapshot: renames the snapshot; this includes 
autosaved snapshots, although Photo RAW preserves 
the (Auto Save) label.

• Update Snapshot with Current Settings: saves the current editing state to the selected 
snapshot, overwriting the previously saved state.

• Create Version from Snapshot: creates a new, virtual copy of the photo, using the snapshot’s 
editing state (see “Versions” on page 63 for more on this feature).

 

When you create a snapshot, you are saving the state of a photo’s 
edits as it was at that point in the editing process. Clicking on a 
snapshot in the pane will return you to that state at any time.

Right-clicking on an item in the Snapshots pane 
gives you a list of management options for that 
snapshot.
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The Tool Well
The Edit module has 23 tools that are accessible via the Tool Well on the left side of the screen. Some 
tools—Transform, Crop, Text, Super Select AI, Faces, and View—are self-contained within the tool icons. 
Others—Local, Mask, Refine, Retouch, and Liquify—are nested within a tool group and are accessible via the 
Tool Options bar at the top of the screen when you click on one of those tool icons.

• Crop Tool: Trims an image to your desired size or ratio. Shortcut key: C

• Transform (Move) Tool: Moves and changes the size and rotation of your layer. 
Shortcut key: V

• Text Tool: Adds text blocks to your document. Shortcut key: T

• Super Select AI Tool: Lets you select regions in an image by clicking on them 
and then applies Effects filters or local adjustments automatically to those 
regions. Shortcut key: K

• Adjustment Brush (Local group): Paints in or out local adjustments. Shortcut  
key: Shift+K

• Adjustable Gradient (Local group): Applies a selective gradient in local 
adjustment mode. Shortcut key: Option+K

• Faces (Portrait) Tool: Opens the Portrait tab and finds faces; you can then paint 
skin in or out to fine-tune each face’s mask. Shortcut key: Shift-I

• Masking Brush (Mask group): Mask large similar areas quickly. (Includes Perfect 
Brush option.) Shortcut key: B

• Masking Bug (Mask group): Applies a selective gradient as a mask in any filter 
(or to the entire stack). Shortcut key: M

• AI Quick Mask Tool (Mask group): Similar in operation to the Super Select AI 
tool, this tool generates masks by clicking on regions in a photo. Shortcut key: W

• Original Quick Mask Tool (Mask group): Create high-quality masks with only 
a few strokes as guidance. Shortcut key: Command-Option-Shift W (Mac); Control-alt-
Shift W (Windows)

• Line Mask Tool (Mask group): Create masks using straight lines, with the 
capability to add curves and adjust mask points on the fly. Shortcut key: Shift-P

• Refine Brush (Refine group): Lets you refine an existing mask’s edges, to help 
mask difficult areas, such as hair. Shortcut key: N

• Chisel Tool (Refine group): Removes fringes from the edge of a mask. Shortcut 
key: Shift-H

• Blur Tool (Refine group): Blurs the edges of a masked area to help it blend more 
naturally. Shortcut key: L

• Healing Brush (Retouch group):  Non-destructively removes distractions from a 
photo using content-aware fill technology. Shortcut key: Q

• Perfect Eraser (Retouch group): Removes distractions like signs and power lines. Shortcut key: 
Shift-Q

• Retouch Brush (Retouch group): Removes blemishes like dust spots and acne. (Includes 
Perfect Brush option.) Shortcut key: R
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• Clone Stamp (Retouch group): Paints over an area from a sample of another area. Shortcut key: 
Shift-S

• Push Tool (Liquify group): Lets you push or warp areas of your photo with a brush in a 
manner similar to finger-painting. Shortcut key: Shift-L  

• Bloat Tool (Liquify group): Warps the brushed area and slightly enlarges that region. Shortcut 
key: Option-L  

• Pinch Tool (Liquify group): Warps the brushed area and slightly shrinks that region. Shortcut 
key: Shift-Option-L  

• View Tool: Adjusts the magnification of the image in the Preview area, and lets you move 
around the Preview window. Shortcut key: Z

ACCESSING AND USING TOOLS

To access a tool, click on the tool or use the shortcut key. When selected, the cursor will change, and you 
will see a set of options for the tool in the Tool Options bar above the Preview window. If the selected tool 
is part of a tool group, you will see the other tools in that group, on the left side of the Tool Options bar.

ADJUSTING TOOL SIZING PARAMETERS

When using any of the tools that have Size and Feather options, you have multiple ways to adjust those 
parameters:

• In the Options Bar for each of those tools, you can use the slider in the Size and Feather 
fields to increase or decrease the amount.

• You can use the left and right bracket keys on your keyboard — ‘ [ ‘ and ‘ ] ’ — to adjust the 
size; additionally, hold down the Shift key to adjust the feather. 

• You can also use your mouse’s scroll wheel. Press Command-Option (Mac) or Control-Alt 
(Windows) and scroll to change the brush size. To change the feather, press Option-Shift 
(Mac) or Alt-Shift (Windows).

• You can also use your pressure-sensitive tablet, if you have one. Settings to turn that option 
on will be found in the Tool Options bar’s Gear menu for the tool.

NOTE: More information about the different ways that you can use your 
mouse’s scroll wheel can be found on page 14.

Each tool in Photo RAW  has an Options Bar, where you can adjust the settings for that tool. Shown here are the options for the Refine Brush.
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CROP TOOL

This tool lets you crop your image, and is fully non-destructive in the Edit module. The tool also 
has a content-aware option that lets you expand the photo canvas, filling the edges of a photo’s 
frame with realistic detail.

To crop an image without content-aware fill, select the Crop tool from the Tool Well, which will display 
the crop overlay. Select any preset crop ratio you would like to use from the Options bar — the default is 
Freeform, which lets you crop in whatever size or ratio you would like. Choosing a preset size (like 4x6) will 
display the crop overlay at that chosen aspect ratio.  

Adjust the corner handles of the crop overlay to get the area you wish. (The area outside the crop box 
appears darkened for guidance.) You can resize and move the image inside the crop box. When you are 
satisfied with your settings, press the Apply button in the Options bar or press Enter.

To move the image inside the crop box, simply click and drag inside the box. You can also nudge the image 
using the arrow keys on your keyboard. To resize the crop box, click and drag on any of the handles. 
Clicking on a corner handle allows you to adjust two sides at the same time; clicking on a side handle allows 
you to adjust that side. If you hold the Shift key down while adjusting the size, the box’s proportions are 
maintained. To rotate the crop box, move outside a corner until the tool changes to rotate.

To straighten an image, you can use the Leveling Tool, which is found in the Tool Options bar when the 
Crop Tool is active. Click on it, and drag the tool across an element in your image that should be level.

The Crop interface, with a Diagonal overlay and the Crop Preset pop-up open.
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Content-aware cropping

The content-aware feature lets you extend the 
crop beyond the edges of the frame. To use 
this, click the Content-Aware option in the Tool 
Options bar, and move the crop handle past the 
desired edge. When you click Apply, Photo RAW 
will fill the expanded area with detail based on 
the content along the existing edge.

Crop overlays

When you select the Crop tool, Photo RAW has 
the option to display guidelines as an overlay on 
top of your photo. These overlays can be used as 
compositional aids for cropping. Photo RAW 
includes a number of overlays that you can 
display during a crop session, and they can be 
accessed from the overlay pop-up menu in the 
Tool Options bar when the Crop tool is active. 
There are seven options — Rule of Thirds, Grid, 
Diagonal, Triangles, Golden Ratio, Golden Spiral, 
and None — and you can easily go back and 
forth between them as desired while cropping. 

In addition to overlay type, there are two other sets of options in the pop-
up menu: 

• You can choose to have the overlay displayed all the time during 
a crop session, or to have Photo RAW only display the overlay 
when your cursor is in the preview area of the workspace.

• When working with the Triangles or the Golden Spiral overlays, 
the Flip Overlay options will be visible, letting you flip the 
orientation of the overlays horizontally (Golden Spiral only) or 
vertically (Golden Spiral and Triangles).

Crop Tool Options Bar:

• Overlay pop-up: Selects a crop overlay, sets overlay visibility, and flips the overlay.

• Preset pop-up: Lets you choose from Freeform, constrained or custom preset ratios.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Leveling Tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

When you select the Content-Aware option in the Tool Options bar, you can 
extend the canvas beyond the boundaries of the existing photo. Clicking Apply 
will fill the area based on the characteristics of the edges in the photo.

The Crop Overlay pop-up 
includes seven options for 
setting and displaying overlays.
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• Rotation tools: Rotates the photo 90° clockwise or counterclockwise.

• Reset: Resets the crop area to the size of your original photo.

• Cancel: Cancels the crop application.

• Apply: Applies the crop.

• Content-Aware: When clicked, will expand the canvas size, filling the edges of the photo with 
new detail, based on the area next to the expanded space.

Creating custom crop sizes

In addition to the preset crop 
ratios provided, you can create 
your own custom crop sizes. 
The bottom of the crop preset 
pop-up menu has a Custom 
submenu, which lists all of 
your custom ratios. To add a 
size, choose Manage Custom 
Sizes from the submenu. To 
add a new ratio, click the Add 
button, then enter a name, and 
the width and height ratio you 
wish to create (the units will always be “ratio” when you create a custom preset for the Crop tool). You can 
add as many as you’d like and click OK. The new crop ratios will appear in the Custom submenu.

NOTE: The Crop tool in the Edit module is non-destructive, while the one in 
Resize works destructively. Both modules can create custom crop presets, but 
the tool in Edit works solely as a crop ratio and has the label “ratio” in the Units 
column. If you change one of those preset sizes from “ratio” to a specific unit of 
measurement in Resize (such as “inches”) it will no longer be visible in the Edit 
module’s Crop tool Custom pop-up.

TRANSFORM (MOVE) TOOL

The Transform tool is used to manipulate the contents of a layer, and works even if the only 
layer you have is the base photo layer. A layer may be repositioned, sized or rotated using the 
Transform Tool. When the tool is selected, handles will appear on the edges of the selected 
layer. You use these handles to manipulate the image. When you are done, click the Apply 

button in the Tool Options bar.

The Transform tool is layer-dependent, and each document layer can have its own transform operations. 
It is useful when compositing photos, or applying backgrounds and textures in a multi-layered file. The 
Transform tool is disabled when using Photo RAW as a plug-in.

The bottom of the preset pop-up (above left) has a list of custom crop ratios that you can use in addition 
to the preset ratios. You can create your own presets via the Manage Custom Sizes submenu option, 
which opens the Custom Document Size Presets window (above right).
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Repositioning a layer

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction.

Resizing a layer

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center.

You can type in the size you desire in the Tool Options bar (see below) in the width and height fields. You 
can also size a layer to fill the canvas automatically by pressing the Fill button in the Options Bar.

Rotating a layer

To rotate a layer, move the Transform Tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use the opt (alt) left 
and right arrow keys to rotate a layer when the transform tool is selected. To rotate the layer quickly in 90 
degree increments, you can use the rotate left and rotate right buttons in the Tool Options bar.

Flipping a layer

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options bar.

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options bar or by pressing the Escape key.

Restoring a layer after a move

The Reset All command inside the Edit module will not reset transforms made with the Move tool. To reset 
your layer to its original, non-transformed state, click the Move tool and adjust any rotation you might have 
made, as well as any flip operations. Then choose the Fit to Canvas button. 

Transform Tool Options Bar

• Width: Changes the width of the layer, in pixels.

• Height: Changes the height of the layer, in pixels.

• Scale: Proportionally scales the layer, in percentage.

• Rotation: Rotates the layer, by degrees.

• Rotate Left/Right buttons: Rotates the layer 90° clockwise or counterclockwise.

• Flip Horizontal/Vertical buttons: Flips the horizontal or vertical axis.

• Fill Canvas button: Scales the layer contents to fit the document size. 
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TEXT TOOL

The Text tool lets you add blocks of 
text to your photo or composite, for 
everything from simple watermarks to 
more complicated text-based layouts. 

Within each block you have complete control over 
the font, type size, line spacing, letter spacing, 
color and alignment of the text. You can also add 
a background fill color and can set the opacity of 
each text block and background.

To add a text block, click the Text tool, and then 
the Add button in the Tool Options bar. A new text 
block will be added, with placeholder text selected. 
You can start typing, or first choose the font, sizing 
and other options you wish to use in that block. To 
add another text block, click the Add button again.

To edit an existing text block, choose the Text tool, and double-click in the block you wish to edit, then 
make your changes. If you would like to remove an existing block, click on the block with the Text tool and 
choose Delete from the Options bar.

Photo RAW will remember the last 
settings you used, which can be helpful if 
you like to use a specific font and size—in 
text for a watermark, for example.

The Text tool also lets you add metadata 
from the current photo into a text block. 
To do this, create a text block and right-
click inside the block. The Text from 
Metadata submenu contains a list of 
embeddable metadata items. You can add 
multiple items from the list, style them, 
and even add items to different text 
blocks. When you’re done adding metadata, click outside the block to see the final text (shown in the image 
on the right).

Text Tool Options Bar

• Font pop-up: Displays a list of available fonts on your system. 

• Size pop-up: Sets the font size for the block (or selected text).

• Color: Selects a color for the selected text or block.

• Style: Applies Bold, Italic or Underline styling to the selected text or block.

The Text tool lets you add multiple text blocks to a document, with full 
character-level control of font, size and styles. 
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• Alignment: Set the selected text to align left, or center.

• Text Options: Additional options for the text block, including line 
and character spacing, color fill for the background, and separate 
opacity controls for both the text and the background (right).

• Delete: Deletes the currently selected text block.

• Add: Adds a new text block.

NOTE: The Text tool can be used to add text-based 
watermarks to a photo, but Photo RAW’s Export feature is a 
better option for adding graphics- or text-based watermark to 
exported photos, especially if you use watermarks on a regular 
basis. See “Export” on page 229 for more information. 

SUPER SELECT AI TOOL

The Super Select AI 
tool is a specialized 
selection tool that 
lets you make a 

selection (or multiple selections) 
and automatically apply a local 
adjustment or any Effects filter to 
the selected area.

To use this tool, select it from the 
Tool Well and move your cursor 
over the photo. As you move 
around the photo, Photo RAW 
will display the various regions 
in your photo as red overlays; 
clicking on a region will create a 
selection and change the overlay 
for that area from red to blue. If 
there are additional regions you wish to select, hover over the new area and click. To remove a selection, 
click on it a second time.

When you have completed your selection, choose an option from the Apply pop-up menu in the Tool 
Options bar. The menu includes a Local Adjustment option, as well as all of the filters found in the Effects 
tab. Each option in the Apply menu includes all of the styles for that local adjustment or filter. You can see 
the effects of each option in real time on your photo as you scroll over each of the items. When you’ve 
selected your editing option, click Add, and Photo RAW will create that local adjustment or filter — in either 
the Local or Effects tabs — and apply the adjustment to the chosen selection. 

If you would like to add another filter or local adjustment to the photo, you can make a new selection and 
choose the effect you with to apply. Clicking Add will add that enhancement to the photo. When you are 

The Text Options pop-up includes 
spacing option, and settings for 
the background color and opacity 
of the text box.

When you pick the Super Select tool and hover over a region in a photo, Photo RAW will display that 
area in red. Clicking on the area will create the selection — changing the overlay from red to blue. 
From there, you can choose to add a local adjustment layer or any Effects filter from the Apply menu.
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finished adding adjustments, click the Done button; the Super Select AI tool will be deselected, and Photo 
RAW will choose the Zoom tool.

The Mode menu in the Super Select AI Tool Options bar has two options: Paint In or Paint Out. Paint In 
will apply the final adjustment to the selection you created with the tool, while Paint Out will apply the 
adjustment to the areas to the inverse of the selection (i.e. the areas that have not been selected).

While the masks created by the Super Select AI are generated automatically, they operate like any other 
mask created in Photo RAW. This means you can use any of the other masking and mask-refinement tools 
to adjust and refine the finished masks. (See “Masking Basics” on page 111 for more.)

Super Select AI Tool Options bar

• Apply: For choosing the local adjustment style (Local tab) or the Effects filter and style to be 
applied. 

• Mode: Sets the masking mode for selections when using the Super Select AI tool. Paint In 
means that the local adjustment or filter will be applied to the selection; Paint Out means that 
the adjustment or filter will be applied to all areas in a photo except for the selection.

• Feather: After you have added an adjustment or filter (by clicking on the Add button), this 
option will apply a feather to the edges of the selection.

• Add: Creates the adjustment layer or the Effects filter based on the current selection.

• Done: Quits the tool and selects the Zoom tool.

 ADJUSTMENT BRUSH (LOCAL GROUP)
The Adjustment Brush, which is used within the Local Adjustments tab, works like a standard 
masking brush tool, with adjustable sizes, feathering and opacity. You can paint an adjustment 
in or out via the Mode pop-up in the Tool Options bar, and adjust the size and feathering of the 
brush via the bar or with the bracket keys on your keyboard. The Adjustment 
Brush is especially powerful when used with the Perfect Brush option, 
represented by its icon at the right of the Tool Options bar.

The Perfect Brush incorporates a color-based, self-masking technology to help create 
precise selections and masks. When you turn the Perfect Brush option on, the Adjustment 
Brush collects the colors under the center of the brush and applies the effect only to those 
colors. This protects the adjustment from being applied across edges. A great of example of using the 
Perfect Brush would be if you wanted to darken the sky in an image, but didn’t want to darken a group of 
mountains on the horizon.

TIP: You can turn the Perfect Brush on and off using the Command-R keyboard 
shortcut (Control-R on Windows). You can also temporarily lock the color to 
remove by holding down the Control key (Windows) or the Command key 
(Mac). This is useful when brushing through areas with a lot of openings like 
tree branches.

Perfect 
brush icon.
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Photo RAW lets you mask with custom brush shapes when you are using either the Adjustment Brush or 
the Masking Brush. When you use a custom brush on an adjustment layer, in conjunction with that layer’s 
Paint with Color option, you can add overlays and other embellishments. When used with custom brushes, 
the Manual Spacing option lets you control the distribution of the strokes as you brush. (See “Masking 
Basics” on page 111 for more detailed information about masking brush techniques with any of the 
masking tools.

Adjustment Brush Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. 

• Opacity: You can control the opacity, or transparency of the brush color, with the Opacity 
pop-up in the Tool Options bar. The opacity has a range from 1 to 100 percent. You use a 
high opacity to paint quickly and hide large areas. You use a lower opacity for blending areas 
together or for subtle work. You can also control the opacity with a pressure-sensitive tablet, 
or by pressing Option (Mac) or Alt (Windows) on your keyboard and one of the number keys. 
Each number represents an opacity percentage from 10% (1) to 100% (0).

TIP: Opacity is really the shade of gray being painted onto the mask. White 
represents 100% of an effect showing and black represents no effect showing.

• Flow: Flow is the rate at which the brush color is applied, up to the Opacity setting. With a 
low flow number, as you brush back and forth across a stroke, the brush color will build up to 
the Opacity setting. At a flow of 100, the brush stroke color will be at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the default, round brush shape, this 
setting has no effect; it is more useful when working with custom brush shapes. You can also 
rotate the brush shape by pressing Shift-Option (Mac) or Shift-Control (Windows) and the left 
or right bracket keys (‘[‘ or ‘]’).
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• Perfect Brush: The Perfect Brush incorporates an automatic edge-detection technology to 
help create precise selections and masks. When you turn the option on—by clicking on the 
Perfect Brush icon in the Options bar—the Masking Brush 
collects the colors under the center of the brush and applies the 
effect only to those colors. This protects the adjustment from 
being applied across edges, such as tree branches. 
	 Further settings for the Perfect Brush can be found by clicking 
on the gear icon in the Tool Options bar. It has these options:

• Color Threshold: This option lets you control the balance 
between keep and drop colors, based on the area you 
are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar 
colors, while at other times you want it to paint away a 
broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect 
Brush based on color. To create a soft edge, increase 
the transition. To create a harder edge, decrease the 
transition amount.

• Manual Spacing: When checked, this sets the spacing of the 
brush tip as you apply a stroke. This is primarily used when painting with custom brushes. See 
“Using Custom Brushes to Add Overlays” on page 187 for more. 

• Pressure options: Photo RAW supports pressure-sensitive tablets with the Masking 
Brush. You can enable pressure sensitive controls for the brush size, brush opacity, or both 
simultaneously. To turn this support on, click on the gear icon in the Tool Options bar. You 
can activate pressure sensitivity for both size and opacity by clicking the appropriate buttons 
in the drop-down menu.

Detailed information on using Local Adjustments in ON1 Photo RAW 2023 starts on page 183. There is 
also a short section, “Masking Basics” on page 111, that includes best practices for using the different 
masking tools in Photo RAW.

NOTE: The Adjustment Brush can also be used to apply custom brushes to an 
adjustment layer. See “Using Custom Brushes to Add Overlays” on page 187.

ADJUSTABLE GRADIENT TOOL (LOCAL GROUP)

The Gradient Adjustment tool is very similar to the Masking Bug (see page 95 for more 
specifics), but it is solely for use within the Local Adjustments tab. It lets you create a linear or 
radial gradient mask across part of your image, The gradient mask goes from dark to light in 
tone, applying more of the adjustment where the gradient is lighter, and less of the adjustment 

where the gradient’s tone is dark. The most common use of gradient masks is to darken the sky in an image, 
while preserving the brightness of the foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

Perfect Brush, spacing and Wacom 
tablet options can be found in the gear 
menu  drop-down.
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You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Adjustable Gradient Tool Options Bar:

• Preset: The preset pop-up includes six settings for the Adjustable Gradient tool (top down, 
bottom up, left and right, and circular vignettes), and changes the current bug (if there is one) 
to match the preset.

• Shape: The shape pop-up controls the shape of the 
bug. In addition to the standard Gradient and the 
Reflected Gradient, there are two radial shapes: 
Center, which puts the light tones at the center 
and the dark tones on the outside of the mask, 
and Edges, which sets the gradient in the opposite 
direction.

• Opacity: Sets the maximum opacity or density of the 
mask.

• Color Range: When enabled, this detects the color under the gradient and applies the mask 
to only that color range. The higher the number, the wider the range of color that is selected.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating gradient masks

Once you’ve added a gradient to an image, you can modify it by accessing the parts of the gradient overlay:

• To move a gradient, click on the big circle at the center of the gradient and drag.

• To resize a radial gradient, click and drag on the solid line.

• To adjust the feather (hardness) of the mask, click and drag along the dashed line.

• To rotate the mask, click the smaller circle near the gradient center and drag.

Detailed information on using Local Adjustments in ON1 Photo RAW 2023 starts on page 183.

The Preset (left) and the Shape (right) options for the 
Adjustable Gradient tool.
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PORTRAIT (FACES) TOOL

Clicking on the Faces icon will open the Portrait tab, and search the photo for faces. Any faces 
it finds will be added to the tab as separate panes. When a face is selected, the tool works in a 
manner similar to the Masking Brush; it is designed to paint the face’s mask—the skin, in case of 
Portrait—in or out. More information on using Portrait starts on page 176.

Portrait Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up. The feather has a range from 1 to 100 percent. Use a small feather at high 
magnification for precise, hard-edged work and a large, soft-edged brush in Fit to screen 
mode for general work. Your feather is visualized by the outer concentric circle of the brush. 

• Opacity: You can control the opacity, or transparency of the brush color, with the Opacity 
pop-up in the Tool Options bar. The opacity has a range from 1 to 100 percent. You use a 
high opacity to paint quickly and hide large areas. You use a lower opacity for blending areas 
together or for subtle work. You can also control the opacity by pressing Option (Mac) or 
Alt (Windows) on your keyboard and one of the number keys. Each number represents an 
opacity percentage from 10% (1) to 100% (0).

TIP: Think of the opacity as the shade of gray you are painting onto your 
mask. While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. 

• Flow: This is the rate at which the brush color is applied, up to the Opacity setting. With a 
low flow number, as you brush back and forth across a stroke, the brush color will build up to 
the Opacity setting. At a flow of 100, the brush stroke color will be at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the default, round brush shape, this 
setting has no effect; it is more useful when working with custom brush shapes. You can also 
rotate the brush shape by pressing Shift-Option (Mac) or Shift-Control (Windows) and the left 
or right bracket keys (‘[‘ or ‘]’).
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• Perfect Brush: The Perfect Brush incorporates an automatic edge-detection technology to 
help create precise selections and masks. When you turn the option on—by clicking on the 
Perfect Brush icon in the Options bar—the Masking Brush 
collects the colors under the center of the brush and applies the 
effect only to those colors. This protects the adjustment from 
being applied across edges, such as tree branches. 
	 Further settings for the Perfect Brush can be found by clicking 
on the gear icon in the Tool Options bar. :

• Color Threshold: This option lets you control the balance 
between keep and drop colors, based on the area you 
are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar 
colors, while at other times you want it to paint away a 
broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect 
Brush based on color. To create a soft edge, increase 
the transition. To create a harder edge, decrease the 
transition amount.

• Manual Spacing: When checked, this sets the spacing of the 
brush tip as you apply a stroke. This is primarily used when painting with custom brushes. See 
“Using Custom Brushes to Add Overlays” on page 187 for more. 

• Pressure options: Photo RAW supports pressure-sensitive tablets from Wacom and other 
companies with the Masking Brush. You can enable pressure sensitive controls for the brush 
size, brush opacity, or both simultaneously. To turn this support on, click on the gear icon 
in the Tool Options bar. You can activate pressure sensitivity for both size and opacity by 
clicking the appropriate buttons in the drop-down menu.

Detailed information on using Portrait AI starts on page 176. There is also a short section, “Masking 
Basics” on page 111, that includes best practices for using the different masking tools in Photo RAW.

MASKING BRUSH (MASK GROUP)

The Masking Brush is one of two tools used for masking filters in Effects and creating masks in 
Layers. Selected, the Masking Brush cursor looks like two concentric circles, one representing 
the inner hard edge of the brush, the other, the soft outer, feathered edge of the brush. At the 
center of the brush is either a plus or minus. The plus means that you are painting “in” a filter’s 
effect, while minus means the brush mode is set to paint out. As is the case with the other 

masking brushes, you can use Photo RAW’s Perfect Brush to help create fine selections.

Masking Brush Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

Perfect Brush, spacing and Wacom 
tablet options can be found in the gear 
menu drop-down.
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• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

TIP: If you would like to invert the mask (turn it from black to white), in order 
to paint a filter’s effect into your image, select the Masking Brush tool, then 
choose Invert Mask from the Mask menu.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. 

• Opacity: You can control the opacity, or transparency of the brush color, with the Opacity 
pop-up in the Tool Options bar. The opacity has a range from 1 to 100 percent. You use a 
high opacity to paint quickly and hide large areas. You use a lower opacity for blending areas 
together or for subtle work. You can also control the opacity with a pressure-sensitive tablet, 
or by pressing Option (Mac) or Alt (Windows) on your keyboard and one of the number keys. 
Each number represents an opacity percentage from 10% (1) to 100% (0).

TIP: Think of the opacity as the shade of gray you are painting onto your mask. 
White in a mask represents 100% of an effect and black (0%) represents no 
effect, and opacity settings in between will show a percentage of the effect.

• Flow: The rate at which the brush is applied, up to the Opacity setting. With a low flow 
number, as you brush back and forth, the brush color will build up to the Opacity setting. At 
100, the brush stroke is applied at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the default, round brush shape, this 
setting has no effect; it is more useful when working with custom brush shapes. You can also 
rotate the brush shape by pressing Shift-Option (Mac) or Shift-Control (Windows) and the left 
or right bracket keys (‘[‘ or ‘]’).

• Perfect Brush: The Perfect Brush incorporates an automatic edge-detection technology to 
help create precise selections and masks. When you turn the option on—by clicking on the 
Perfect Brush icon in the Options bar—the Masking Brush collects the colors under the center 
of the brush and applies the effect only to those colors. This protects the adjustment from 
being applied across edges, such as tree branches. 
	 Further settings for the Perfect Brush can be found by clicking on the gear icon in the Tool 
Options bar:
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• Color Threshold: This option lets you control the balance between keep and drop 
colors, based on the area you are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar colors, while at other times 
you want it to paint away a broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect 
Brush based on color. To create a soft edge, increase 
the transition. To create a harder edge, decrease the 
transition amount.

• Manual Spacing: When checked, this sets the spacing of the 
brush tip as you apply a stroke. This is primarily used when 
painting with custom brushes. See “Using Custom Brushes to 
Add Overlays” on page 187 for more. 

• Pressure options: Photo RAW supports pressure-sensitive 
tablets with the Masking Brush. You can enable pressure 
sensitive controls for the brush size, brush opacity, or both 
simultaneously. To turn this support on, click on the gear icon in 
the Tool Options bar. You can activate pressure sensitivity for 
both size and opacity by clicking the appropriate buttons in the 
drop-down menu.

Detailed information on using the Masking Brush in Effects starts on page 93, while information about 
Layers starts on page 190. There is also a short section, “Masking Basics” on page 111, that includes 
best practices for using the different masking tools in Photo RAW.

TIP: You can turn the Perfect Brush on and off using the Command–R (MacOS) 
or Control-R (Windows) keyboard shortcut. You can also temporarily lock the 
color to remove by holding down Command (Mac) or Control (Windows)

MASKING BUG (MASK GROUP)

The Masking Bug is used for 
blending masks and layers by 
creating radial, gradient and 
reflected gradient mask shapes. 

It works in a similar manner to the Adjustable 
Gradient tool in the Local Adjustments pane. 
The mask goes from dark to light in tone, 
applying more of the adjustment where the 
gradient is lighter, and less of the adjustment 
where the gradient’s tone is dark. The most 
common use of gradient masks is to darken the 
sky in an image, while preserving the brightness 
of the foreground, similar to using a gradient filter on your camera lens, or to adjust the effect of a filter 
mask in Effects.

In this image, a Dynamic Contrast filter has been applied in Effects. To keep the 
effect out of the clouds, a Masking Bug has been added.
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To apply a standard gradient to a filter in Effects, click on the Masking Bug in the Tool well, then click in the 
image roughly where you wish the gradient to go. You’ll see the outline of the gradient, which is called a 
bug. You can use the handles on the bug to move your gradient around, increase or decrease the length of 
the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Masking Bug Tool Options

• Preset: The preset pop-up includes six settings for the bug’s mask (vignette, strong vignette, 
top down, bottom up, and linear left and right), and changes the current bug (if there is one) 
to match the preset.

• Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial 
shapes: Center, which puts the light tones at the 
center and the dark tones on the outside of the mask, 
and Edges, which sets the gradient in the opposite 
direction.

• Opacity: Sets the maximum density of the mask.

• Color Range: When enabled, this detects the color 
under the gradient and applies the mask to only that 
color range. The higher the number, the wider the range of color that is selected.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating a gradient mask

Once you’ve added a gradient to an image, you can 
modify it easily by accessing the following parts of the 
gradient overlay:

• To move a gradient, click on the large circle 
at the center of the gradient and drag.

• To resize a radial gradient, click and drag on 
the solid line.

• To adjust the feather (or hardness) of the 
mask, click and drag along the dashed line.

• To rotate the mask, click on the smaller 
circle near the center of the gradient and 
drag it up or down.

The Preset (left) and the Shape (right) options for the 
Adjustable Gradient tool.
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Working with multiple masking bugs

You can have up to six masking bugs per layer. Each bug is re-editable. 
To add another masking bug, press the Add button or click outside of 
the current bug while the Masking Bug tool is selected.

Only one masking bug may be adjusted at a time. You will see the 
overlay controls for the active bug while your mouse is over the preview 
area. Inactive bugs are marked with a small circle; to select an inactive 
bug clicking on this small circle marker.

Masking bugs are subtractive. Each bug hides more and more of the 
current layer. When masking bugs overlay each other they may hide 
more of the layer too. You can always use the Masking Brush to override 
and paint areas back in hidden by the masking bugs.

AI QUICK MASK TOOL (MASK GROUP)

The AI Quick Mask tool is functionally similar to the Super Select AI tool, but it is intended to 
create selections for the current filter, local adjustment, or layer — all it does it create a mask 
for that item. It does not create a new filter pane or local adjustment layer.

To use the Quick Mask tool, first create a filter in Effects, a local adjustment layer in the Local Tab, or the 
master layer mask, select the tool, and move your cursor over the photo. As you move around the photo, 

The Edges gradient shape lets you create 
such masking effects as customized, 
adjustable vignettes.

The AI Quick Mask tool is designed to be used when you have created a filter pane in Effects, a local adjustment in the Local tab, or 
a separate layer in Photo RAW. Here, a Tone Enhancer filter, with the Clarity style, has been applied to this image. To keep the sky 
from being affected by the filter, we have used the AI Quick Mask tool to select the sky and chosen Paint Out from the Mode 
pop-up to mask out the sky. Clicking Done will create a mask with the sky removed, 
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Photo RAW will display the various regions in your photo as red overlays; clicking on a region will create a 
selection and change the overlay for that area from red to blue. If there are additional regions you wish to 
select, hover over the new area and click. To remove a selection, click on it a second time.

The Mode menu in the AI Quick Mask Options bar has two options: Paint In or Paint Out. Paint In will apply 
the final adjustment to the selection you created with the tool, while Paint Out will apply the adjustment to 
the areas to the inverse of the selection (i.e. the areas that have not been selected).

While the masks created by the Quick Mask tool are generated automatically, they function like any other 
mask created in Photo RAW. This means you can use the other masking tools to adjust and refine the 
finished masks. This also includes the Mask Control options found in all Effects filters, local adjustments, 
and in the layer masks. (see “Masking Basics” on page 111 and “Masking control options” on page 113.)

AI Quick Mask Tool Options bar

• Mode: Sets the masking mode for selections. Paint In means that the local adjustment or 
filter will be applied to the selection; Paint Out means that the adjustment or filter will be 
applied to all areas in a photo except for the selection.

• Cancel: Cancels the operation, deselecting the tool and selecting the Zoom tool.

• Done: Creates the mask for the current filter, adjustment or layer and selects the Refine 
brush.

ORIGINAL QUICK MASK TOOL (MASK GROUP)

Powered by machine learning, the Original Quick 
Mask tool creates high-quality masks with just a few 
strokes. To use it, you paint areas you want to keep in 
green and areas you want to drop in red. Then, using 

its artificial intelligence, Photo RAW analyses the color, tone and 
texture of the marked regions to learn what you want to make out 
and then automatically finds the edges and creates the mask for 
you. Use it with layers to replace skies or with filters to selectively 
apply them. 

You can use this tool on a filter in Effects, a local adjustment, or on a layer. If you wish to use it on a filter, 
to mask some of the filter’s effects out of your photo, first add the filter in the Effects tab, and select the 
Original Quick Mask Tool. To use it on a layer, make sure that the only thing selected is that layer. In both 
cases, you’ll follow these steps:

1.	 First, you need to give the tool guidance as to what you want to keep and drop. This is done 
by loosely painting over the regions in your photo. There is no need to precisely paint the 
entire photo: just a few representative strokes of red and green are all that are needed. Paint 
with Drop mode—which is the default brushing mode—over the portions of your image that 
you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to 
Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas 
you want to keep. These strokes will show up as green.

When you first use the Original Quick Mask tool, 
Photo RAW will display a ‘HUD’ that explains what 
you need to do to use the tool.
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2.	 Now press the Apply button in either the Tool Options bar or the Original Quick Mask HUD. 
This will generate a temporary mask to preview the results. Areas that are filled with red will 
be masked out, areas in green will remain. Keep in mind the edges will appear rough at this 
point and will be smoothed out when you generate the final mask.

3.	 If the preview results look good, press the Done button in the Tool Options bar or the 
Original Quick Mask HUD. If there are areas that are incorrect, you can continue to improve 
the results by adding more Keep and Drop strokes. Press Apply each time to preview the 
improved results. When you press Done, the edges are refined with high precision and ON1 
Photo RAW switches to the Refine Mask tool.
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Original Quick Mask Tool Options Bar 

• Mode: This controls keeping (painting green) or dropping (painting red). Green areas are 
protected in your mask, and are the areas of a layer or filter that will remain. The areas 
marked in red will be removed or masked. In your layer these areas will become transparent. 
On a filter in Effects, these areas will have the filter’s effect removed.  
	 You can tell your current mode by looking at the plus or minus icon in the center of the 
Original Quick Mask brush. If the icon is minus, you are painting drop (red) areas; if the icon is 
a plus, you are painting keep (green) areas. You can change the mode in the Tool Options bar, 
or by pressing the Shift-X key, or by holding down the Option (Alt) key temporarily. 

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work.

Further settings for the Original Quick Mask tool can be found by clicking on the gear icon in the Tool 
Options bar. There, you can set the following options (shown right): 

• Pressure Adjusts Size: This option lets you control the size of the brush using a pressure 
sensitive tablet. The harder you press, the larger the brush becomes up to the current setting 
of the size slider.  

• Refine Edge: Applies the Refine Mask brush automatically to the edge of the resulting mask, 
creating a more natural transition. This the default and is recommended for most photos.

• Show HUD: This displays the Original Quick Mask HUD dialog (shown on page 98), which 
provides guidance on how to use the tool.

• Overlay: Sets the transparency of the red and green mask overlays on top of your image. A 
setting of 100 displays only the mask; the default setting is 50.

Once you click on the Done button, Photo RAW will create the finished mask (shown here as a red overlay), applied to the 
current filter. You can manipulate the mask further with any of the refine mask tools.
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LINE MASK TOOL (MASK GROUP)

The Line Mask tool lets you create masks by 
drawing straight lines in your image, with the 
added flexibility of letting you adjust each 
individual line segment into curves to better 

fit the object you want to mask. Masks created with this 
tool are re-editable, can be copied and pasted like any 
other mask inside Photo RAW, and you can have multiple 
Line Mask selections for each mask. 

To start, you click and drag along the outline of the area 
you wish to mask. Clicking your mouse button (or with a 
pen and tablet) adds a point to the line; you can continue 
to click along the edges of your desired selection, and 
the tool will add points along the way. These points will 
be represented by a small square. When you’re finished, 
hover your cursor over the first point and click on it to 
close the path created by the tool. This will close the selection and change the cursor to a paint bucket icon; 
click inside the area and Photo RAW will create and the display the mask. 

Once you’ve closed the mask, you can adjust the feather and opacity of the mask, and you can further 
adjust the points on the line in the following ways:

• You can click on any point in the selection and move it by dragging it.

• If you hover (or click) on a point, you’ll see a circle appear between that point and the 
previous point on the line. This circle can be dragged in all directions to curve the line to 
better fit the object you are masking.

• Add a point by holding down the Shift key and clicking on the line.

• You can delete any point by right-clicking on it and choosing Delete Point from the pop-up. 

• You can delete the entire mask by choosing Delete Line Mask from the pop-up menu.

While you’re creating the mask, the curve option is always available for the current point; move the cursor 
back over the line before the point and the circle will appear. You can then drag the curve in or out, and 
when you’re done, move the cursor and click on the next place you wish to add a point.

When you’ve made your adjustments to the selection, you can click the Done button in the Tool Options 
bar to quit the tool, or you can create another mask. 

To re-edit the mask at a later time, select the filter, layer, 
or adjustment layer that has the mask attached to it and 
choose the Line Mask tool. When you move your cursor 
over the area that contains the mask, the mask’s outline 
will appear in light blue. Click anywhere on the outline, 
and the mask’s points — both square and circle — will 
appear, and you can adjust it as you see fit, even the 
Opacity and Feather settings.

When you complete the mask area by clicking on the original 
point, the cursor will change to a paint bucket icon. Clicking in the 
area will generate the mask..

The curve option—visible when you hover over a point in the 
selection—lets you fine tune the line to make it better fit the 
object you’re masking. (Shown here exaggerated for effect.) 
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Line Mask Tool Options Bar

• Mode: The mode controls if you are painting out (hiding the effect inside the mask 
boundaries) or painting in (showing the effect).

• Opacity: This controls the opacity, or transparency of the finished mask, from 1 to 100 
percent. At 100 percent, all of the effect will be displayed in the mask area; as the opacity 
level drops, more of the layer underneath the mask will be visible.

• Feather: Controls the hardness of the mask edge. The feather has a range from 1 to 100; 
1 being a hard edge across the boundaries of the mask, 100 being a soft, wide edge that 
‘feathers’ the transition between the masked and unmasked boundaries. 

• Delete: Removes the currently selected line mask.

• Done: Saves the current line masks ad closes the tool, returning Photo RAW to the View Tool.

REFINE BRUSH (REFINE GROUP)

This tool, one of the most versatile in Photo RAW, can be used to clean up intricate areas and 
the borders along a mask. It is helpful for cleaning up a mask created with the Masking Brush, 
the Super Select AI tool, or other masking tools, or for creating a new mask entirely. 

When you paint with the Refine Brush, the brush strokes are displayed as a red overlay, and when you let 
up off the mouse button, Photo RAW will work to make the mask edge better defined. 

Refine Brush Tool Options

• Mode: Controls the refinement mode, either Paint Out, which refines to remove from the 
mask, Paint In, which refines to add to the mask, or Auto, which determines the best way to 
refine the mask edge. Paint Out is recommended in most cases.

• Size: This adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized 
brushes it will take longer to process and may yield lower quality 
results. You can use your mouse’s scroll wheel to adjust the size of 
the brush as well (see page 14). The Refine Brush’s maximum 
size is 500 pixels.

• Method: Lets you choose the refinement algorithm and settings 
based on the subject of the masked area. There are five method 
types, plus a user-defined setting that is created when you adjust 
any of the individual parameters found in the Gear menu:

• Original: Uses the refinement algorithm found in earlier versions of Photo RAW 
(referred to as Mode 1 in the gear menu).

• Hair/Branches: Optimized for fine detail, like hair, branches and other subjects.

The Method pop-up.
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• Hard Edges: Best method for refining masks with distinct edges between masked and 
unmasked areas.

• Diffuse Edges: Works best on areas where edge detail is not as well-defined.

• Noisy Images: Works well on photos that have higher degrees of noise in them.

The Gear menu includes a setting for controlling the size of the Refine Brush with pressure. It also can be 
used to adjust any of the refine methods in the Method menu. The parameters include:

• Mode (1 or 2): As noted above, Mode 1 is the Refine Brush 
algorithm used in previous Photo RAW versions; it remains 
useful in many masking situations. Mode 2 uses the new (2023) 
version of the Refine algorithm.

• Sensitivity (0-100): Refers to the edge sensitivity; low for 
diffuse edges, high for hard edges. (Works only with Mode 2)

• Locality (0-30): This parameter varies the search for similar 
scene materials; higher values expand the search zone along 
the brush edges. (Mode 2 only)

• Smoothness (0-100): Represents post-processing smoothing 
of the refine results. Higher numbers mean smoother edges. 
(Mode 2 only)

• Noise (0-100): This is a post-processing-based noise filter; use 
higher values with noisier images. (Works with both Mode 1 and 2)

When you change any of the parameters in the Gear menu, those results will be applied to the User 
Defined settings, and will be saved until you change them again. In general, however, most of your masking 
refinement work with the Refine Brush should be found in one of the five primary Method options.

Working with the Refine Brush

One of the biggest issues with masks is the transitions between edges, or in areas where one of the  
primary masking tools will miss some fine detail. You’ll notice these transitions when you apply an effect or 
adjustment to a masked area, and there will be halos on the mask edges, or areas where the effect should 
be applied, but isn’t. The Refine Brush, and, on occasion, the Chisel and Blur tools, can be used to help you 
fine-tune your masks and better transitions, ultimately creating more realistic masks. 

The Refine Brush is often the first place you’ll want to go when working with masks that could use some 
tuning. Some of the most common operations include:

• You can paint along the edges of a mask that might have areas where the mask isn’t complete, 
or where the transitions between masked and unmasked areas could be smoother. 

• You can paint over large areas of a masked area where there might be fine edges that could 
use further refinement, like trees or hair.

• You can also “encircle” an area in a photo where you wish to add to or subtract from a mask, 
or even create a new mask altogether. 
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For simple areas where you wish to refine an edge that has some halos or is otherwise a bit less than ideal, 
set the brush size a bit larger than the area you wish to tune set the appropriate method, and brush over 
the edge. This is shown in the enlarged area below. 

With tree branches, hair and other areas of fine detail, you can paint over the entire area that you wish the 
mask to refine, as shown in the following graphic.

The Refine Brush’s “encircling method” lets you add to or subtract from an existing mask, or you can use it 
to create your own mask. To do this, use the brush to draw an outline 
around the object you wish to select and mask. What happens next 
depends upon what your intent is, and whether there is already a mask in 
the local adjustment or Effects filter you are currently working with:

• If there is a mask already created, and you wish to remove the 
stroked area, choose Paint Out before applying the brush. If you 
wish to add to the existing mask, choose Paint In.

• If there is no mask already present in the adjustment or filter, 
using the Refine Brush and drawing around an object or area 
will create a mask of the encircled space.

For more information about masking inside Photo RAW, see “Masking 
Basics” on page 111. 

In the photo above, a local adjustment on the sky, masked with Mask AI, left some ugly halos along a treeline. Using the Refine Brush, set to the 
Diffuse Edges method, smoothed the transition properly, making for a better mask. (Effect exaggerated for demonstration purposes.) 

The Refine Brush is a great choice for adjusting masks with fine details that are often obscured when building masks with some of Photo RAW’s 
primary masking tools. In the screen shots above, you can see the mask of a tree generated automatically with the Mask AI pop-up in a local 
adjustment layer (left). The tree’s interior branches are completely masked. Selecting the Refine Brush, with the Method set to Hair/Branches, 
we’ve painted broad strokes in and around the area where the branches are (center). Photo RAW then refines the mask so that the branches are 
properly masked against the sky, making for a much more realistic mask.

The encircling method.
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CHISEL MASK TOOL (REFINE GROUP)

The Chisel tool, accessible vie the Refine Tool Options, bar works to remove fringes or 
halos along the hard edges of a mask; just click and drag along the edges of a mask you wish 
to refine. Fringes are common when the background to be removed is brighter than the 
foreground. The chisel works like a chisel or plane in a wood shop: It removes just a sliver along 

the edges, and, because it only works on the edges, you don’t have to be too careful when using it.

Chisel Mask Tool Options

• Mode: Select remove or add

• Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. 
The size of the chisel does not affect how much is chiseled off.

• Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-click on the Chisel tool icon to apply the chisel to the entire mask.

BLUR MASK TOOL (REFINE GROUP)

The Blur Mask tool softens edges of the mask where you paint; all you need to do is run the 
tool over the edges you wish to blur. Softening the edges on blurred or semi-transparent 
subjects like hair can make them blend with a new background in a more realistic manner. 

Blur Mask Tool Options

• Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs 
and lightens the mask, Add blurs and darkens the mask, Normal blurs both light and darks.

• Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The 
size of the brush does not affect the blur amount.

• Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-clicking on the Blur tool icon applies the blur to the entire mask.
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HEALING BRUSH (RETOUCH GROUP)

The Healing Brush is a tool for 
removing distractions like dust 
spots, power lines and unwanted 
people from your photos, using 

sophisticated content-aware fill technology. 
Like the other retouching tools, you can 
apply the brush to multiple portions of an 
image. Unlike the other tools, however, the 
Healing Brush is fully non-destructive: each 
area you apply the brush to is individually 
editable (and removable).

To use the brush, paint over a distraction 
and a matching area of your photo will be 
blended on top to replace it, using content-
aware technology. You’ll see two circular 
markers: red, which is the area that has been 
removed, and green, which is the area that was used to fill the source. Each marker is movable by clicking 
and dragging; sometimes, you’ll want to try a different area to match to your source. Non-active markers 
will be displayed as gray squares until you click on them. (Press the Delete key to remove the current area.)

The Healing Brush has four modes, Heal, Stamp, Copy and Move. Each mode has a different approach:

• Heal mode applies content-aware matching from a nearby area to mask the object or area 
being painted out.  

• Stamp mode acts like the Clone Stamp tool (see page 109), applying the actual pixels from 
the area used to mask the object out; unlike that tool, however, this option is non-destructive.

• Copy mode is similar to the Heal mode, except that it makes a copy of the brushed area or 
object instead of masking it out.

• Move mode is similar to Copy mode, except that it masks the brushed area and moves the 
original area to a new location.

Healing Brush modes cannot be changed once they have been applied; if you wish to change the 
application in an area, you must select the old marker, choose Delete from the Tool Options bar, set the 
new mode, and re-brush the chosen area.

Healing Brush Options

• Brush Size: Adjusts the overall size of the brush.

• Brush Feather: Adjusts the hardness of the brush. 

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften it.

• Mode: sets the type of healing that will be applied when brushing — Heal (content-aware), 

Areas that use the Healing Brush will be displayed as a gray marker. Clicking on a 
specific marker will display the source and area used to fill the source. You can then 
readjust its placement, or delete the area.
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Stamp (pixel-exact), Copy (content-aware) or Move (content-aware).

• Overlay: Sets the display of the markers designating retouched areas. Auto displays all the 
markers in the photo, with the current marker highlighted in red and green, and the others as 
gray. Selected will only display the current marker (in red and green); the other markers will 
only be visible as you move over the photo with your mouse.

• Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots 
more easily.

• Pressure Adjusts Size (gear icon): If you have a pressure-sensitive tablet, you can adjust the 
size of the brush according to the pressure. Click the button to activate.

Transforming retouched areas

As noted, all applications of the Healing Brush are non-destructive, meaning that you can adjust the source 
and destination areas for each marker, and you can delete markers by clicking on the appropriate market 
and choosing Delete from the Tool Options bar (or by pressing the Delete key).

You can also transform individual destination markers in a photo by holding down the Option/Alt key (Mac/
Windows) and hovering over the area. When you do this, a box will appear over the currently selected 
destination marker. You can resize the selection by adjusting the handles on the box; to resize 
proportionally, hold down the Shift key. You can also rotate the selection by clicking outside the box and 
pressing the mouse key, or you can flip the selected area vertically or horizontally by clicking the icons 
underneath the box.

When you hold down the Option or Alt key and hover over the currently selected Healing Brush marker, a box appears, which lets you adjust the 
size, rotation and orientation of the marker. When used in conjunction with the Healing Brush’s Copy or Move modes, you can easily duplicate and 
transform individual subjects within your frame, as shown by the copy of the pronghorn above..
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PERFECT ERASER (RETOUCH GROUP)

The Perfect Eraser can be used to remove distracting elements and blemishes from your image. 
It uses a content-aware algorithm that replaces the pixels with a natural-looking result within 
the boundaries that are painted.

Use the tool to paint over an area you wish to remove, covering the entire area. A red overlay appears 
where you paint. If the first attempt does not give you a perfect result, paint over it again and it will 
improve with each pass. You can also fine tune the area after by using the Retouch Brush (see below).

Perfect Eraser Options

The Perfect Eraser’s Tool Options bar consists of three options; brush size, a dust-spot overlay, and 
pressure-sensitive tablet support.

The default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller by clicking 
on the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your keyboard. 
The maximum brush size is 500 pixels.

The Visualize Dust item displays a high-contrast overlay to help find and eliminate sensor dust spots. 

If you have a pressure-sensitive tablet, select the Pressure Adjusts Size item, which is in the gear icon. 
The gear icon also includes a Legacy option, which is solely used to preserve compatibility with previous 
versions of Photo RAW.

RETOUCH BRUSH (RETOUCH GROUP)

Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the brush 
on areas that contain spots or other imperfections, such as acne, sensor dust, power lines and 
more. The tool looks at the neighboring areas in your image and fills in the brushed area with an 
area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush 
strokes. If you dab with the Retouch Brush and don’t like the results, use the Undo command and try using 
a smaller brush or vary your brush stroke and try again. The Retouch Brush is also great for retouching skin.

Retouch Brush Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.
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• Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots.

• Pressure Adjusts Size (gear icon): Click on the button to activate the sensitivity controls for 
your pressure-sensitive tablet.

CLONE STAMP (RETOUCH GROUP)

Use the Clone Stamp tool to replace an area of a photo with an area from a different part. Hold 
down Option (Mac) or Alt (Windows) and click the area you want to clone from. Then click and 
drag on the area you want to clone over and it will clone from the point you selected.

Clone Stamp Tool Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots.

• Pressure Adjusts Size (gear icon): If you have a pressure sensitive tablet, you can adjust the 
size of the brush according to the pressure. Click the button to activate.

LIQUIFY TOOLS (PUSH, BLOAT, PINCH)

The three tools of the Liquify group all have 
different warping characteristics, but they 
share the same options, and all adjustments 
made with the tools are non-destructive, 
in a manner similar to the Healing Brush. 
The “active” marker (the one currently 
selected) will be displayed as a blue square. 
Non-active markers will be displayed as 
gray squares until you click on them to 
make them active. (Press the Delete key to 
remove the current area.)

You can easily adjust the individual regions 
made by any Liquify tool after the fact, by 
moving the stroke, or by adjusting the Size 
and Pressure settings for each stroke. You 
can’t apply multiple strokes over the same 
region, however.

You can use the Liquify tools to move items in a scene slightly, and enlarge or contract elements that need 
greater or lesser prominence. Like any other adjustment, it can be easy to overdo any of these tools, and 
you might find that it takes a bit of time to find the best use for each tool, but they can be quite useful for 
many retouching and editing needs.

The Liquify tools can be used to push, enlarge, and shrink areas of a photo to reduce 
flaws or reshape regions for emphasis. Here, we’ve used a combination of the Bloat 
and Pinch tools to reduce the size of some of the background tulips, while enlarging 
the prominence of the foreground one. All of the regions created by the tools are 
represented as gray squares; clicking on any of them will let you reshape that region or 
delete it.
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Liquify Tool Descriptions

The Push tool lets you reshape areas of a photo by “pushing” and warping the pixels in the region 
being brushed. The result is akin to finger painting. Of the three Liquify tools, Push is the one that 
is closest in operation to a brush, where you apply strokes to warp the area being reshaped.

The Bloat tool works to “enlarge” the area under the cursor; you can click and hold the mouse 
button (or click it multiple times) to increase the effect until it reaches the maximum limit of 
pressure. While you can apply a brush stroke with the Bloat tool, you might find that playing with 
the brush size can be more helpful when enlarging an area than creating a larger stroke.

The Pinch tool works to “shrink” the area under the cursor; like the Bloat tool, you click and hold 
the mouse button to increase the effect until it reaches the maximum limit of pressure. While you 
can apply a brush stroke with the Pinch tool, you might find that playing with the brush size and 
using multiple regions can be more helpful when trying to reduce a region with a longer stroke. 

Liquify Tool Options

• Size: This adjusts the overall size of the brush.

• Pressure: Sets the strength of the warped area.

• Show Mesh: Displays a grid overlay of the warped area made by the tool.

• Overlay: When set to Selected, displays only the currently selected push stroke. When set to 
Auto, it displays all of the Liquify tools’ strokes; the selected one will be highlighted in blue; 
the others will be represented as gray. 

• Tablet Adjusts Size (gear icon): If you have a pressure-sensitive tablet you can control the 
size of the brush with pressure when this setting is turned on.

• Tablet Adjusts Pressure (gear icon): If you have a pressure-sensitive tablet you can control 
the pressure amount when this setting is turned on.

• Delete: removes the currently selected region.

The Show Mesh grid overlay can be useful as a live map of the Liquify adjustments made to an image. Areas 
of the grid that have had one of the three tools applied will be distorted, and can help determine whether a 
region needs additional refinements in either Size or Pressure.

VIEW (ZOOM) TOOL

This is the default tool selected when opening an image in the Edit module. It adjusts the 
magnification of the image in the Preview window. With the Zoom tool selected, click in 
the Preview window to zoom in and center the image at the location clicked. Hold down the 
Option/Alt key to display the Hand tool, which lets you pan around the magnified image. You 

can also double-click the Zoom tool in the Tool well to set the image to 1:1 (or 100%) magnification view, 
which shows every pixel. This is best when examining small details.
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Masking Basics
One of Photo RAW’s most powerful features is its masking 
capabilities. Every filter in Effects, every adjustment panel in 
the Local tab, and every layer can have a mask associated with 
it. And, when you’re retouching a face in Portrait AI, that face 
has had a mask automatically generated for it.

At its simplest level, a mask shows or hides the effect of the 
filter or adjustment. Masks have no color: they are grayscale, 
and the tones range from pure white to pure black. A mask 
that is completely white displays the entirety of the effect 
being used, a mask that is completely black hides that effect. 
(A common way to remember it is via the phrase “black 
conceals, white reveals.”) Shades of gray are in effect the 
opacity of the mask. Darker shades reduce the effect, lighter 
shades let more of it through.

The beauty of the masks is that you can paint with black, white 
or any shade in between, so you can “mask” portions of your 
photo so that they will not have that effect—or will have a 
reduced effect. You can also copy masks from one filter and 
past them into other filters. Using this feature, you can mask 
out the sky in one filter, copy the mask, paste it into another 
filter and invert it, applying a different effect to everything but 
the sky. Photo RAW even lets you create luminosity masks, 
which are masks that are solely based on the brightness of 
the pixels in the image. And, while working on your images, 
you can press the ‘O’ key and view your masks, either as a red 
overlay or as the grayscale version of the actual mask, which 
can be helpful when you wish to check the edges of mask, or 
want to make sure an area is completely masked.

Creating masks can be as simple as choosing the Super Select 
AI tool and clicking on a region in a photo; using the Mask 
Sky option from the Mask menu; or dropping a gradient on a 
photo. You can also create complex masks by using multiple 
tools and masking functions. For instance, you can drop a 
gradient on a photo, and use the Masking Brush to paint out 
areas where you don’t want the gradient applied, or you can use the Color Range function (in the Masking 
Control Options area) to select portions of an image based on specific colors and tones. 

THE MASKING TOOLS AND VIEW OPTIONS

Inside ON1 Photo RAW 2023, there are five basic tools that can be used to create masks: the Super Select 
AI tool, the Masking Brush, the Masking Bug, and the AI Quick Mask and Line Mask tools. There are 
variants of the first two that are specific to Local Adjustments (Adjustable Brush and Adjustable Gradient), 
while the Portrait AI brush is a version of the Masking Brush specifically for use in retouching portraits. The 

Three views of a mask (A-C), along with the 
Masking Control Options section, here shown 
attached to a HDR Look filter in Effects. When you 
first add a filter (or a layer), the mask is empty (A). If 
you click on the empty mask, Effects will 
automatically generate the mask, here shown filled 
with white, which means all of the effect will come 
through (B). When you use any of the masking 
tools, the areas masked out (partially or 
completely), will be shown in the filter’s mask view 
(C). And, whenever you click on the mask icon in 
the pane, it includes options for displaying, copying 
and pasting, and fine tuning that mask (D)
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Super Select AI and AI Quick Mask tools — along with the Mask AI tool in Effects’ filter browser (see page 
145) — generate masks automatically, based on known regions in your photos. You can also use the Refine 
Brush in many instances to create a mask, as well as refine edges and other masked areas.

You can use the gradient and masking brush tools cumulatively, meaning that you can add to or subtract 
from the current mask. However, if you select the AI Quick Mask tool, it will replace any existing masks on 
that pane or layer. However, once you’ve created a mask with the AI Quick Mask tool, you can add and 
refine that mask with the other tools.

The Refine group of tools—Blur, Chisel and Refine—are designed to help work with edges and halos that can 
crop up when you have areas of strong contrast between a masked area and an unmasked one.

In addition to the masking 
tools, each mask has a set 
of controls you can use 
to manipulate the mask 
to refine it further (see 
“Masking control options” 
on page 113 for more). 

When you add a filter or a 
layer, the mask is 
technically hidden. You can 
create a mask by either 
using one of the masking 
tools, or by clicking the 
Show/Hide Mask icon in 
the title bar of the pane, to 
the right of the filter name. 
The contents of the Show 
Mask icon will represent 
the mask on that layer. 
(Local Adjustment panes automatically create a black layer mask, so you can ‘paint in’ the adjustment to the 
image.)

Photo RAW has two 
primary options for viewing 
the contents of a mask: 
either as a red overlay on 
top of your image (the 
default) or a view only of 
the mask itself, represented 
as grayscale. You can turn 
the mask overlay on or off 
by pressing the ‘O’ key on 
your keyboard. 

The grayscale view can 
be helpful when checking 
edges, or when refining 
some of the advanced 

Here is a local adjustment—using the Adjustable Gradient tool—that has been applied to a photo to darken the 
sky. The Show Mask option has been turned on, so you can see where the effect has been masked out (shown in 
red). The gradient mask is softer at the top of the gradient, and entirely opaque at the bottom of the gradient. 
These smooth transitions can create a better look for your photos.

The two Mask View options help in different ways. The Red Overlay option (above left) can give you an idea 
of what portions of your photo are successfully masked in or out. The Grayscale option (above right) lets you 
view the mask solely as luminance values, where pure black indicates portions that have been masked out 
completely, pure white is where the effect is applied completely, and the levels of gray indicate partial 
application of the effect. The Grayscale option is especially useful when you wish to check the edges along a 
mask border.
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masking controls. These mask view options are available from the Mask menu; select Show Mask to see the 
mask, while the View Mode option lets you switch between the two modes. You can also set the app to 
display the red overlay only when you are brushing with the Masking Brush and its cousins.

When you’re viewing a mask in either overlay or grayscale modes — or even when you aren’t actually 
viewing it — you have access to all of the tools in the Edit module. You can zoom in, to view the mask in 
greater detail, can use the Refine masking tools to adjust the fine edges of your mask. You can also use any 
of the other masking control options found in the Mask control options, as described below.

MASKING CONTROL OPTIONS

When you click on the Mask icon at the top of a pane or in a layer, Photo RAW will display a set of options 
for that mask. This section has the following contents, as shown, using the Color Enhancer filter as an 
example:

A.	The Show/Hide Mask icon, which displays 
the contents of the current mask. The 
default mask is white when you add an 
effect, and black when you add a local 
adjustment layer.

B.	 Buttons for opening the blending options, 
resetting the filter, and removing the filter.

C.	 Sets the overall opacity of the effect.

D.	Mask AI pop-up (Effects and Local tabs 
only) for selecting an area based on region.

E.	 Larger display of the current mask, option 
to invert, reset, copy, paste, create a 
luminosity mask, and view/hide the mask.

F.	 Density adjusts the overall density from 
black (100) to white (0). Feather blurs the 
mask. Levels and Window let you adjust 
the black and white points of the mask, fine 
tuning them in different ways.

G.	The Color Range option lets you choose a 
color and make or tune the mask based on 
the range of the color selected.

The buttons at the top portion of the Mask Options 
can be quite helpful, especially when you’re working 
with complex masks, or when you wish to reuse 
masks in other parts of Photo RAW:

• Invert reverses the contents of the mask, 
swapping the tones.

• The Reset button erases the current mask, leaving it filled with white. 

• The Copy and Paste buttons let you copy the current mask, to paste it into another filter, 
local adjustment or layer. 

Overview of the Mask Options section, shown with  a Color Enhancer 
filter in Effects. The Mask AI pop-up for that photo is displayed 
beneath the options. Mask Options is also applicable when working in 
the Local Adjustments tab, or on a layer in the Layers pane.
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• The View button toggles the Mask View on and off.

• The Lumen button creates a luminosity mask of the image (see page 114). 

Color Range selections

The Color Range option lets you create a mask using a specific color, either one inside your image, or one 
via your system’s color picker. To use this option, click the On button next to the Color Range section, and 
click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the 
slider to expand or contract your mask based on that color: lower numbers means that fewer colors (related 
to the chosen color) will be selected, higher numbers mean a wider range of colors will be selected.

The Color Range option found in the Gradient masking tools can be controlled from the Mask Options 
section of the pane. When you add a gradient mask and click on the Color Range option in the Tool Options 
bar, the color chosen is sampled from the center of the gradient control, but you can open the Mask 
Options pane and sample a different color using the eyedropper. Note that if you do this, and move the 
masking bug, it will resample using the color from the center of the bug.

Luminosity masks

A luminosity mask is a specialized mask type you can create anywhere you can create a mask inside Photo 
RAW. This mask uses the brightness (or luminance) values in your image to let you target specific tonal 
ranges with an effect (or to hide the effect from those tones). It is ideal for subtle enhancements to very 
specific areas of an image. They can be used for targeted sharpening and contrast operations, highlights 
control, and much more.

To add one of these masks, click on the Lumen button in the Mask options area or choose Create 
Luminosity Mask from the Mask menu. Because luminosity masks take the brightness levels of a photo, 
when you view the mask, it will look like a grayscale version of the image. With a luminosity mask, your 

Here, we’ve created a mask using the Color Range option in the Mask Options section for this Color Enhancer filter in Effects. We 
clicked on a blue color in the sky to use as the base for the selection range. Adjusting the Color Range slider while viewing the mask lets 
us fine tune the selection.
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effect will be applied in an increasing amount depending upon the brightness value of the pixel underneath: 
if the pixel is black, none of the effect will be applied; if it is white, it will be entirely applied; for all other 
tones, the effect will get applied as a percentage of the pixel’s brightness, from 0 (white) to 100 (black).

You can use the Levels or Window controls to further target tones with your luminosity mask. The Levels 
setting lets you set the black (left triangle) and white (right) points of the mask, with the midpoint, or 
gamma, setting being adjusted by the middle triangle. This lets you refine the mask to focus on narrow 
bands of luminance values in an image; for example, if you wanted to focus an effect on the midtones, 
bringing the white and black points into the middle of the Levels slider, and adjusting the midpoint, will 
achieve this much quicker than you could with the Masking Brush.

The Window slider is similar to the Levels slider, in that it works like a black point slider from both sides. 
When you move the right and left triangles, all of the tonal ranges outside the points will be black, leaving 
those areas affected that are within the ‘window’ of the mask. For example, if you wanted only the shadows 
in your image to have an effect, you would move the right slider over towards the left by about two-thirds.

MASKING TIPS

Here are a few tips for working with the various options in the Mask pane:

• You can use multiple masking tools to create, modify and refine masks. For example, you can 
start with a luminosity mask, adjust the tonal range of the mask with the Levels or Window 
sliders, and then further refine your mask by painting in or out with the Masking Brush or 
Masking Bug. Adding a luminosity mask always overrides the current mask (as is the case with 
the AI Quick Mask tool), however, so you should start there.

• While the AI-based masking tools can be quite good when building selections, they aren’t 
perfect. You should inspect your AI masks after applying them, and use the other masking 
tools, the Refine Brush, and Chisel or Blur tools, or Mask Options to fine-tune your 
selections.

• Use the Feather slider to smooth transitions between masked and unmasked sections.

Viewing a luminosity mask is similar to a black-and-white version of your photo; the lighter the tones, the more the 
intended effect will be, and the darker the tones, the lesser the effect.
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• Lowering the Density slider helps intensify an effect after you’ve created a mask. Think of it 
like a ‘reverse fade’: at the 100, all of your mask is viewable, at 0, the mask is entirely white.

• Don’t forget that masks aren’t just for Effects filters and Local Adjustments; you can create 
a master layer mask that will apply your selection to the cumulative adjustments made in the 
Edit module. To do this, click on the Mask icon to the right of the layer.

• It can sometimes be helpful to use the same mask on different filters, so use the Copy button 
to grab the contents of a mask from one filter and the Paste button to paste that onto the 
mask of another filter. The Invert command can be invaluable when you wish to apply a filter 
to the opposite portion of a photo, such as a sky and your foreground.

• Because masks are tied to the actual pixels of the current photo (or layer), they cannot be 
copied from one photo to another, or between layers in a multi-layered document.
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Presets
Presets are stored “recipes” that include sets of Edit module adjustments, and can be applied to one or 100 
images with ease, in Browse or Edit. Presets are a fast way to get consistent results when editing a group of 
images, helping you hone your own look. You can easily create your own presets, even presets that 
incorporate Photo RAW’s Mask AI and Sky Swap AI technology to apply masks automatically to regions in a 
photo (See “Creating and Using AI Adaptive Presets” on page 120).

Three different views of the Preset panel. On the left is the List view, in the center is Thumbnail view; these views display the categories of presets. (The 
view options can be set in the View > Preset Browser submenu.) On the far right is an expanded category, displaying the various presets, with a thumbnail 
of the current image with the preset applied. From there, you can apply a preset to the current image.

As you hover over a category, the Quick View Browser icon appears on the left side of the category’s name.(B&W Films is shown above in the preset 
category list.) Clicking on that icon will open a full-screen window showing your photo with that category’s presets applied to it. (See the following page for 
a screen shot of the Quick View Browser.

Photo RAW lets you create your own custom presets and categories, and you can also create subcategories of presets. (See “Managing Presets and 
categories” on page 120 for more.)
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ON1 Photo RAW 2023 comes with more than 200 built-in presets, in more than a dozen categories, ranging 
from landscapes to portraits, color grading, film looks and much more. You can create your own presets, or 
import presets from other ON1 users and photographers.

You can create presets that apply any Edit module operation: Develop adjustments, Effects settings, sky 
swaps, Portrait operations and local adjustments, and any combination of these.

Presets can also store the camera profile used, Develop’s Auto settings, crop settings and retouching 
information, as well as masks created with any of the masking and selection tools  including the AI-based 
selection tools. If you apply a preset that contains these options, you should check to make sure that you 
have the desired result; if not, you can reset the various individual operations via the Settings menu. 

APPLYING PRESETS

To apply a preset to an image, click on the Presets panel. There 
you will see any built-in presets supplied by ON1—ordered by 
category—as well as any presets you might have created or 
installed yourself. Clicking on a category name will open it and 
display any presets within that category, with a tiny thumbnail showing your selected image with that 
preset applied to it. To change the size of the thumbnails in the Presets panel, select the Browser Mode 
option from the View menu and choose One, Two or Three Column View.

To help you view the effects of a specific preset, Photo RAW will display a real-time representation of that 
preset over your current photo when you hover your cursor over a preset in the subcategory view. To see a 
larger representation of what your 
selected photo will look like with 
all of a category’s presets, click on 
the Quick View Browser icon in 
the category’s title bar. That will 
display a window with all of the 
presets in that category. (Press 
the Escape key to close the Quick 
View Browser.)

To apply a preset to a photo, click 
on the preset in the mini-browser 
or in the Quick View Browser. It 
is worth noting that, by default, 
presets are not cumulative; 
clicking on another preset will 
remove the previous one and 
apply the new one to your photo. 
See page 119 for information on 
how to insert a preset into a photo that already has a preset applied to it. 

NOTE: Real-time preview of presets is only available when working in the Edit 
module. To preview presets in Browse, use the Quick View Browser.

A preset category with the Quick View Browser 
icon shown.

Clicking on the Quick View Browser icon in the Panels pane (or choosing Open Quick View Browser 
from the Window menu) will open a full-screen representation of that category’s presets, giving you 
a larger representation of how that preset will look on your image.
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Once you’ve applied a preset, you can reduce its overall effect by hovering over the chosen preset. There, 
you will see a Fade slider, where you can lower the opacity of any Effects filters applied with the preset. 
(Develop, Portrait, and local adjustments are not reduced.)

After you have applied a preset, you can still make changes to any of the settings—
in Develop, Effects, and Local Adjustments—add or remove adjustments, switch to 
another preset, perform any retouching or more. 

If you don’t like a preset, clicking on another one will replace the settings of the 
previous preset with the settings of the new preset. To remove a preset entirely, 
choose one of the reset options from the Settings menu, or remove the individual 
settings from the appropriate panes in Develop and Effects. (The latter approach 
is recommended if you have created masks or local adjustments that you wish to 
preserve.)

You can save a preset as a favorite by hovering over its thumbnail in the browser, and clicking on the 
heart icon. This will add that preset to a Favorites category that resides at the top of the Presets panel. To 
remove a favorite, click again on the heart icon.

Inserting presets (Effects tab only)

When you click on a preset, Photo RAW’s default behavior is to remove 
any existing adjustments and apply the newly chosen preset to your 
photo. Sometimes, however, you would like to add a preset on top of your 
adjustments. To do this, open the Presets pane, right-click (Option-click on 
MacOS) on the preset you wish to add, and choose Insert Preset from the 
pop-up. This will add the preset’s filters above the currently selected filter 
pane and preserves edits you made in the Develop or Local tabs. 

Inserting a preset will only add that preset’s Effects filters to your currently edited photo. Develop 
adjustments and local adjustment layers will not be added.

CREATING YOUR OWN PRESETS

Once you have a group of edited settings that you wish 
to save, go to the Settings menu and select Save Preset. 
The Save Preset dialog will appear, with options for which 
module’s settings you wish to save, naming the preset, 
and adding it to an existing or new category. Nearly all 
of the Edit module settings can be saved as a preset, 
including cropping, retouching, text blocks and masks. To 
save your masks — AI adaptive or otherwise — check the 
Apply Masks option for each tab in the Edit module. 

If you have applied a preset to an image, and 
subsequently updated any of the edit settings (or add or 
remove adjustments), you can update the preset with the 
new settings by choosing Update Preset with Current 
Settings from the Settings menu. This will only change 
the preset moving forward; any images that used the 
previous version of the preset will keep those settings 

The Fade slider reduces the 
opacity of Effects filters 
applied with a preset. To 
find it, just hover over the 
applied preset in the 
Presets pane.

The Inset Preset option is only available  
when working in the Effects tab.

The Save Preset window is similar to the Sync Settings window 
(see “Copying settings and synchronizing edits” on page 61), 
and includes all of the operations possible in the Edit module, 
with the exception of layer operations. Filled circles to the left of 
a setting mean that the setting will be saved in the preset; click 
the circle if you don’t wish that setting to be saved.
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unless you reapply the preset. (You can also update a preset by right-clicking on the preset in the Preset 
Browser.) 

If you would like to create a new preset category—which will be added to the Presets panel throughout 
Photo RAW—choose Add New Category from the category pop-up. 

CREATING AND USING AI ADAPTIVE PRESETS

When you use the Super Select AI tool, the Sky Swap AI tab, 
or when you use the Mask AI options in the Effects, Local 
Adjustments or in the Layers panel, you can save those region 
selections when you create a new preset, by clicking on the Apply 
Masks item in the appropriate tab. Then, when you apply the 
preset to a new photo, anything (Effects filter, sky swap or local 
adjustment) that had an AI-generated mask region — such as a sky 
— will be applied to those regions with the same name in the new 
photo. These preset types are called “adaptive,” meaning that they 
are applied to a photo based on Photo RAW’s AI models.

NOTE: When you apply an adaptive preset to a photo, the named AI masks will 
be visible in the Mask AI area in the Masking Control Options section (see page 
113) of the appropriate filter or local adjustment.

Here are a few tips to think about when working with adaptive presets:

• It’s best to create an adaptive preset that only uses AI-generated masks. If you save a preset 
where any filters or local adjustments have masks that have been created by the standard 
masking tools (like the Masking Brush or Masking Bug), those masks will be regenerated 
based on the precise location of the mask in the image that was used to create the preset.

• Any changes to the mask made via the Mask control options pane (see page 113) are saved 
with the preset.

• After you apply an adaptive preset to a photo, check the masks that the preset created. Quite 
often, you’ll find that you might need to use some of the mask refinement tools — or even the 
Masking Brush — to fine-tune your mask.

• ON1 includes a set of adaptive presets with Photo RAW 2023. Feel free to add your own 
adaptive presets to that category, or create your own category (see below for how to do that). 
It’s best, however, to name or categorize them (or both) such that you know which presets 
contain AI-generated selections.

Clicking Apply Masks in the Save Preset window 
will save your AI-generated regions. When you use 
that preset, those masks will be applied to similarly 
named regions.
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MANAGING PRESETS AND CATEGORIES

You can perform a variety of operations on presets and preset categories, including importing and 
exporting presets (individually or by category), deleting individual presets, and hiding categories.

Importing & Exporting Presets

You can import presets you have downloaded from the ON1 website or other source. Some files will be 
individual presets, while others might be preset “packs,” which will include more than one preset.

A preset will have an ‘.ONP’ extension, while a preset pack has an ‘ONPreset’ extension; all you need to do 
is double-click on the file—or choose Import Preset from the Settings menu—and Photo RAW will ask you 
to pick a category where you wish to place the preset or pack, and it will copy the presets into the app. You 
can delete the downloaded files, if desired.

To export an individual preset, click on it and choose Export preset from the Settings menu. You can also 
export an entire category of presets, via the category preset menu (shown below).

Deleting presets

To remove a preset if you no longer want to have access to it, select the preset you wish to remove in the 
Preset panel, and choose Delete Preset from the Settings menu. You can also right-click on an individual 
preset and click Delete Preset from the pop-up menu.

You can delete any preset, including the presets that came pre-installed with ON1 Photo. If you think you 
might wish to save a preset, export it first, then delete it.

Managing categories

In addition to creating your own preset categories, which get 
displayed in the Presets pane, you can also perform other operations 
on categories, including deleting, renaming or exporting. These 
options are all available via the Preset Category pop-up menu, which 
is available when you hold right-click on a category name:

• To remove a category—and its presets—from the Presets panel, choose Delete Category.

• Choose Rename Category if you wish to change the name of the category.

• To export a category and all of the presets within it as an ONPreset pack, choose Export 
Category from the pop-up menu.

TIP: Many preset options can also be performed by right-clicking on a preset’s 
name in the Preset panel. This is helpful if you want to update, export or 
rename a preset without applying it to the current image in the Edit module.

Creating nested presets

To help manage large groups of presets, Photo RAW’s Extras Manager lets you nest preset categories. See 
“Organizing Presets” on page 10 for details on how to create and manage preset category subfolders.

Right-click on a preset category to get the 
category pop-up menu.
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CAMERA-BASED PRESETS

In addition to using presets in the Browse and Edit modules, you can also have Photo RAW automatically 
apply a preset to any new photos from a specific camera, even down to the serial number.

This can come in handy if you have created a custom camera profile or if you have converted a camera to 
infrared. Camera-based presets are automatically applied to photos in cataloged folders, imported photos, 
and any time you open a folder in Browse. It’s important to note that any photo that has already had any 
adjustments made in the Edit module will not have the preset applied to it.

So, if you always find yourself making the same basic adjustments to most photos from a specific camera, 
just make a preset and it will apply to all photos from that camera. You can also choose to have the preset 
applied to Raw or JPG photos from that camera, or both if you shoot Raw+JPG.

Setting up camera-based presets

To use this feature, first define the preset you wish to use. Because presets are applied globally to all of 
that camera’s images—except for those that have been edited previously—you probably want to keep the 
adjustments within a narrow range of categories, like a specific camera profile, Develop’s Tone and Color 
and Details settings, and minimal Effects filters, if any at all.

To connect the preset to the camera, open the 
Files tab of the Preferences screen (page 268). 
At the bottom of the window is the Default 
Processing section, which contains a list of all 
the cameras that Photo RAW knows you have 
shot with. The list includes the camera name, 
serial number (if your camera records that in the 
image metadata), preset and file types. Scroll 
down to the camera you wish to use and click on 
the Preset pop-up, which contains a hierarchical 
list of your presets, and select the one you wish to use. The default file type is Raw; if you wish to apply the 
preset to JPG files, or both Raw and JPG files, choose the appropriate setting from the File Types menu. 

When you close the window, Photo RAW will update your database and apply that preset to all of the 
photos created by that camera. And from that point on, when you add photos taken with that camera, 
Photo RAW will apply the preset automatically to all those photos.

Editing photos with camera-based presets

Because Photo RAW is non-destructive, any photo with a camera-based preset applied to it can be edited 
and changed in the Edit module, or have a new preset applied via Browse. However, you must either apply 
a new preset, or change the individual settings in the Edit module. You can’t choose the Reset All Settings 
option from the Settings menu, because the default settings for that camera’s images are now those applied 
by the preset.
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Copying settings and synchronizing edits
In addition to applying presets, you can copy 
all of the existing edits—of any operation you 
can perform in the Edit module—made in one 
photo and paste them directly onto other 
images. There are two primary methods for 
doing this—Copy/Paste and Sync—but they 
achieve the same end goal: it’s more a matter 
of preference in which operation you choose.

To copy the edit settings from an image, 
click on the source file and choose Settings 
> Copy Settings. Then, click on the new 
image and choose Settings > Paste Settings. 
A window will appear, giving you the option 
of applying any or all of the edits on the 
original photo, or you can select which 
edits—everything from individual settings in 
Develop’s Tone and Color pane, to masks, 
cropping, and text if used—you wish to paste 
into the new photo or group of photos.

The Copy/Paste Settings commands can be 
useful when you wish to paste settings across 
a number of photos in different folders. As 
long as your Edit session is active, Photo 
RAW will remember the last copied settings.

With the Sync Settings command, select 
the image you want to use as your source. 
Then, holding down the Shift key (if you 
are selecting an image or group that is 
contiguous with the source), or the Command 
(Mac) or Control (Windows) key, and click 
on the image(s) that you wish to apply the 
source file’s edits. Your selection should have the source image highlighted in blue, and the target images 
highlighted in gray. If that is correct, click on the Sync button at the bottom of the Preview area, or choose 
Sync Settings from the Settings menu. The Apply Settings window will open, and you can follow the same 
procedure to synchronize your edits.

NOTE: When you copy and paste settings or sync settings from one photo to 
another (or a group), with the Apply Mask option turned on, and you include 
AI-generated masks from the appropriate Edit tab, Photo RAW will apply the 
masks based on the regions you masked. This is similar to the way that AI 
adaptive presets are applied (see “Creating and Using AI Adaptive Presets” on 
page 120 for details).

In the Apply Settings window—accessible from either Paste Settings or Sync 
Settings—you can apply nearly all Edit module operations to another image or group 
of images. Filled circles to the left of a setting mean that the setting will be applied; 
click the circle if you don’t wish that setting to be applied.
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If you’re sure that you want to sync everything from a source photo to another photo or group of photos, 
the Settings > Sync All Settings command will let you bypass the Apply Settings window. Select your 
source  and destination photos and select the command. Note that all settings—including cropping, text and 
masks—in the source image will get synced.

RESETTING EDITS

Any edits you have made with ON1 Photo RAW 2023 can be completely reset from within the Edit module. 
This includes photos you might have pasted or synchronized settings onto inside Browse, or anything done 
within the Edit module.

The Settings menu offers eight options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in the Edit module. (This 
option can also be accessed from the Reset All button at the bottom right of the Browse and 
Edit windows.) 

• Reset Develop Settings: Removes only the settings applied in the Develop tab.

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset Sky Settings: Removes only the settings applied in the Sky Swap AI tab.

• Reset Portrait AI Settings: Removes only the settings applied in the Portrait tab.

• Reset All Retouching Tools: Resets any retouching applied anywhere in the Edit module.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Liquify Tool: Removes all applications of any of the Liquify tools.

• Reset Crop: Returns the image to its original, uncropped size.

• Reset Text: Removes any text blocks.

You can undo any of these changes immediately after making them; otherwise resetting with the 
appropriate option will permanently reset the image.

NOTE: The Copy, Sync and Reset settings are only applicable on a layer-by-
layer basis. As such, these options are not available when you have selected a 
layered photo in Browse. When working in the Edit module, the Reset, Copy/
Paste and Sync settings work only on the currently selected layer. 
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Soft Proofing
ON1 Photo RAW’s soft proofing feature lets 
you see how a photo will look when printed, 
using the color profiles that get installed with 
your printer. Soft proofing helps you determine 
where there might be issues when you print, so 
that you can adjust your tone, color and effects 
to give you a print that is closer to your editing 
vision.

Normally, when you’re viewing an image in 
Photo RAW, you are viewing it through the 
lens of your monitor’s display profile. The color 
gamut of your computer’s display is wider than 
that of most photo printers, which means that 
some colors you are able to view on-screen 
are not reproducible when you print. When 
this happens, the color profile conversion 
that happens in the print engine will cause 
substitutions of colors that the printer cannot 
print to the closest color that it can. This means 
that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or 
by clicking on the soft proofing icon to the left 
of the Preview button at the bottom of the main 
Photo RAW window. You soft-proof various 
paper types by choosing an installed printer 
profile from the Profiles submenu. The image 
will change to approximate the color of the 
paper you’re profiling. You can also turn on an 
overlay that will display out-of-gamut colors.

The primary soft-proofing options are available 
underneath the Enable Soft Proofing item in the 
View menu. The options are as follows:

• Gamut warning: When checked, this 
displays colors in the image (via a 
red overlay) that don’t correspond to 
the current printer profile being soft 
proofed.

• Profiles: The Profiles submenu lists the currently available printer profiles. Choosing one 
will change the on-screen display to use that profile. You can also import profiles via this 
submenu.

• Intent: Photo RAW offers two different rendering “intents” when soft proofing, which are 

These three screen shots show the results of soft proofing options, as viewed 
in the Edit module. The top image is with soft proofing off (and is using the 
display color profile). The middle image is with soft proofing turned on, and 
using a printer profile for Epson’s Exhibition Matte Paper. The bottom image 
has the Gamut warning turned on; out of gamut colors are highlighted by the 
bright red overlay.
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used to convert the color from display to print. Perceptual shrinks the color gamut during the 
conversion, which works to preserve the relationship between colors in the image. The other 
intent type, Relative, only converts colors that are outside the current color gamut, but this 
can sometimes cause two colors, one in gamut, and one outside, to be identical after 
conversion.  
	 Neither rendering intent is perfect or desired; it often is a 
matter of the makeup of the image, your editing intent, the 
paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, 
seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause 
Photo RAW to use the white point for the chosen paper type 
(instead of the white point of your monitor), and the paper’s 
actual black density (instead of the display’s black point). 
If you’re trying to match a print, you will usually want this 
setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. 
It’s easy to get caught up in eliminating out-of-gamut colors, but most 
modern photo printers—both home printers and online print services—
do a pretty good job of properly approximating colors. 

The biggest thing you want to be looking for when viewing a soft proof 
is tone, contrast and color accuracy between screen and print. When 
using a home printer, use test prints to hone in on the right mix of 
Edit module adjustments. Photo RAW’s Versions feature can be extremely helpful when you’re tweaking 
settings to get a print just right (see page 63 for more on working with Versions).

Other Edit Module Preview Options
In addition to soft proofing, ON1 Photo RAW 
2023 offers a few other previewing options 
in the Edit module, which can be found in the 
previewing section at the bottom of the Photo 
RAW window. With these options, you can 
compare the before and after views of a photo—in either split-screen or full-screen views—see the current 
mask, and turn soft proofing on or off. 

CHANGING THE MAGNIFICATION VIEW 

Photo RAW includes various options for zooming in or out of a photo while you’re working on it. In addition 
to the Zoom tool and the Navigation pane (see page 110 and page 76, respectively), you can change 
the zoom view by moving the magnification slider. You can either click on the control and slide it to the 
right to zoom in and to the left to zoom out, or you can click on the boxes at the ends of the slider.

The Profiles submenu displays the installed 
printer profiles for any installed photo 
printer. You can also import your own color 
profiles.

The Preview area at the bottom of the main Photo RAW window includes 
options for adjusting the preview magnification, turning compare (before/after) 
view on or off, viewing the current mask, turning soft proofing on or off, and 
for viewing the original photo, with all edits removed.
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BEFORE/AFTER PREVIEWS

As you work in the Edit module, it can be helpful to see how individual edits—via items in the different edit 
tabs—affect your photo, as well as to see the cumulative changes made to the original image. The Edit 
module’s Compare mode displays a side-by-side view of your photo, with the original version on the left, 
the edited version on the right. There is a movable slider in the middle of the screen, which lets you view 
more or less of each view; click on the box at the center of the slider and drag it to the left (to view more of 
the edited image) or to the right (to view more of the original. While working in Compare view, you can use 
the magnification slider to zoom in or out of the image, which can be useful when you wish to see the 
effects of your edits on smaller sections of your photo.

You can also view your original image full-screen by clicking the Preview button at the far right of the 
previewing toolbar. When you click this button, the original photo is displayed with a “Preview Off” overlay. 
To return to your edited version, click the Preview button again. (You can also use the backslash key—‘\’—to 
show and hide the full-screen preview.)

SHOW/HIDE MASK

ON1 Photo RAW 2023 has extensive masking capabilities throughout the Edit module. While you’re in the 
process of creating a mask, you have two options for displaying the contents of a current mask: 

• As a transparent red overlay, where the masked sections of your photo are shown in red.

• As a grayscale mask, where you do not see the photo, but see only the mask. Masked areas 
are shown in shades of gray, with pure black meaning that those pixels are completely 
masked. Gray values (from 1% to 99%) represent the opacity of the those pixels relative to 
the mask, and areas of pure white are not masked.

Edit’s Compare view displays a before/after view of your current photo, with a movable slider (circled, above) for expanding and contracting 
the different views.
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The overlays can be set in the Mask menu’s View Mode submenu while you are working in the Edit module. 
You can also, via this option, show the mask as a red overlay only when you are brushing a mask. 

You can toggle the current mask view by clicking on the Show Mask icon in the previewing toolbar, or by 
pressing the O key.

For more information on the varying aspects of masking in ON1 Photo RAW 2023, see the details on the 
respective masking tools, starting on page 93, and “Masking Basics” on page 111.

FOCUS AND CLIPPING VIEWS

Two additional previewing tools that can be quite powerful aids when you are editing photos are the 
Clipping and Focus Mask overlays. These options can be displayed in any of the Edit module tabs (as well as 
in the Browse module).

Clipping

Clipping occurs when the shadow and highlight tones in an 
image are suddenly cut off to completely white or black, 
rather than fading smoothly. (Large expanses of white pixels 
in a photo are often referred as ‘blown’ highlights, and can be 
quite distracting to a viewer.) One of the benefits of shooting 
in raw format is that, while many photos will have areas of 
pure white or black when originally viewed on-screen, there 
is still recoverable data in the raw image. The Clipping overlay 
can help determine how big a problem you might have with a 
photo, and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press the J key; 
to turn it on permanently as you move from photo to photo, 
choose View > Show Clipping, or press Alt (Windows) or 
Option (Mac) J on your keyboard.

The Clipping view overlay displays the areas that have either pure white or pure black in them. Those areas 
with a bright blue overlay indicate pure black pixels, while the areas with the bright red overlay indicate 
pure white pixels.

The two options for viewing a mask are with a red overlay (left), which shows the masked areas in red, and a grayscale mask (right), which shows only the mask, in a 
range of tones from white (not masked) to black (completely masked). Tones in gray represent varying percentages of the mask’s opacity.

Clipping view displays pure white pixels with a bright red 
overlay, and pure black pixels with a bright blue overlay.
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Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a lot 
of photos from a shoot, it can be a bit tedious to check focus 
at that level. Luckily, Photo RAW’s Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt-J (Windows) or Shift-Option-J (Mac). The 
sharpest areas in your image will be represented by a bright 
green overlay. As you move from photo to photo in a folder, 
you’ll be able to tell whether you have an acceptable level of 
sharpness where you need it by the strength of the overlay. 
The mask will be displayed even as you zoom in on a photo.

Showing or Hiding Edit Module Adjustments
You can also show or hide many individual 
adjustments made throughout the Edit 
module. Most of the panels in the Develop, 
Effects, Portrait and Local tabs have a 
Show/Hide control in the upper left-hand 
corner of the panel. You can make your 
adjustments, and can click the control to 
turn the effect on or off. 

That this option is not solely for previewing 
an effect; if the adjustment is turned off, 
it will not be present in the edited image. 
This can be helpful if you’re trying different filters in Effects, for example, and you want to see if one looks 
better than another, or if you wish to see if it truly helps the photo or not. To turn the adjustment back on, 
click on the Show/Hide control so that the circle is filled.

The only adjustment inside the Edit module that cannot be turned off in this way is the Tone & Color panel 
in the Develop module. If you wish to view your photo without those adjustments, you need to press the 
Reset icon, which is represented by ‘⟲’ at the top right side of the panel. 

For a complete description of the controls in most Edit module panels, see “Filter Overview” on page 144.

Saving Your Work
Photo RAW saves your non-destructive settings for the photo you are editing when you return to Browse. 
If you would like to periodically save your settings without returning to Browse, you can use the Save 
Settings command. This saves your work in the off chance the application encounters an error. To save the 
current state of your actions, choose Save Settings from the Settings menu, or press Command-S (MacOS) 
or Control-S. 

To turn an effect or other adjustment off, click on the Show/Hide control in the upper 
left of an adjustment’s panel. If the control’s circle is empty, that effect is not 
implemented. Clicking the control will turn it back on.
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BASIC GLOBAL EDITING WITH DEVELOP

Develop is the module for performing basic global editing operations—adjusting tone and color, removing 
noise, sharpening and applying transforms to a photo. It is the perfect place to begin editing your photos. 

Develop Adjustment Panes
To edit your images, the Develop tab has four adjustment panes found in the Overall Settings panel. Unlike 
the Effects tab, which lets you stack filters in any order, the Develop tab’s adjustments are applied in the 
following order:

1.	 Tone & Color

2.	 Noise & Sharpening (which includes ON1’s NoNoise AI and TackSharp AI technologies)

3.	 Lens Correction

4.	 Transform

WORKING WITH PANES

The Tone & Color pane is at the top of the stack, followed by the Noise & Sharpening, Lens Correction and 
Transform panes. These panes are not removable from the stack, although you do not have to apply any 
of these operations to a photo. The remaining panes can be applied based upon what you wish to do with 
your photo. Clicking on the button to the left of the pane’s name will turn that pane on or off, which can 
be helpful if you want to see the effect in the context of other edits you have made. The Reset button—
designated by the circular arrow icon at the top right of each pane—will reset that pane’s settings to their 
default state.
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TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the bar, but the entire title bar 
is clickable). If you don’t want to have to scroll up and down the Settings panel 
when you have a lot of open panes, choose Solo Mode from the Window menu. 
This will leave only the current pane open, and will hide all the other panes. 
Clicking on another pane will open that one and collapse the previous one.

TONE & COLOR

This pane adjusts the tonal and color characteristics of an image, 
letting you correct and enhance exposure, contrast, detail and 
color. It is split into two sections, Tone and Color, with a Color 
Profile option at the top of the pane.

Camera Profile

Camera profiles apply alternative interpretations of the raw data in 
an image based upon different genre types or intents. The pop-
up menu displays Photo RAW’s built-in profiles: ON1 Standard, 
Landscape, Portrait, Vivid and Neutral. If your camera has its own 
embedded profiles, you will see those profiles in the list as well, 
and you can also import your own custom camera profiles using 
Photo RAW, and X-Rite’s ColorChecker and ColorChecker Camera 
Calibration software. (See page 141 for more information on how 
to create and import custom camera profiles into Photo RAW.)

Photo RAW’s camera profiles are non-destructive, and work 
independently of any changes you make to tone or color.

Tone

The Tone sliders control the global tonality, or brightness and  
contrast of the image. You can adjust each of the following:

• Manual, AI Match and AI Auto buttons: The AI 
Match button uses artificial intelligence technology to 
automatically adjust the controls in the Tone panel to 
closely match your photo as you saw it on the back of 
your camera’s display. The AI Auto button performs 
an automatic tone adjustment on your photo using a 
proprietary ON1 algorithm. If you don’t use either of 
these options, or if you make subsequent adjustments, 
the Manual button will be highlighted.  

• Auto Tone slider: This option is only available when using the AI Match or the AI Auto option. 
Using this slider will let you ‘fade’ the effect of those options.

• Exposure: Adjusting this slider to the right will lighten your image. Adjusting to the left will 
darken your image.
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• Contrast: Increase or decrease the contrast in your image.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing contrast in the shadows.

• Recover Highlight Hue: When checked, Photo RAW will attempt to recover highlights while 
maintaining subtle hues in areas like the sky.

• Structure: Adjusts the detail in your image by changing the local contrast.

• Haze: When moved to the left, this will remove haze or fog from your photos; moving it right 
will enhance fog or haze.

NOTE: The AI Match and AI Auto buttons only affect the tone and saturation 
of your image; they don’t adjust the white balance. 

Color

The Color sliders control the Temperature, Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. By default, when working with raw (or DNG) files, the color temperature is 
measured in degrees Kelvin (°K), which gives you a larger and more accurate range to make adjustments. 

The settings in this section of the Tone & Color pane include:

• Auto Button: The auto button attempts to detect and remove a color cast. It makes 
adjustments to the Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. Click the icon to activate, then click 
on an area in the image that should be gray.

• White Balance presets: This pop-up lets you change the white balance according to common 
color temperatures (As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, 
Custom). The default is As Shot, which is the color temperature that the camera recorded 
when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow). When editing 
a raw file, the °K button will be blue, which means that the temperature is measured in 
degrees Kelvin. Clicking the button will change the slider to a relative color ramp. (The Kelvin 
ramp is only available when working with raw photos; other formats use the relative slider.)

• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases/decreases the color of muted tones, leaving more saturated colors alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.
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Adjusting Tone & Color settings via hotkeys

When you’re working in any tab inside the Edit module, 
you have the capability to adjust the basic tone and color 
settings for your current image directly from the keyboard, 
based on the hotkeys found in the Keyboard Shortcuts 
window. These include the following sliders: Exposure, 
Contrast, Highlights, Midtones, Shadows, Whites, Blacks, 
Temperature, Tint, Saturation and Vibrance.

To use this feature, first invoke the setting you wish to 
change with the appropriate keyboard shortcut. An on-screen 
overlay label will appear, indicating that you are changing 
that setting. Use the Up/Down arrow keys to increment or 
decrement the chosen slider. When you’re done, press the Escape key, or click in the window.

This feature can be helpful when, for example, you apply a set of filters in Effects and feel that they caused 
the shadows to darken in your image. Using the keyboard shortcut for the Shadows adjustment, you can 
make changes dynamically without having to go back to the Develop tab.

Photo RAW has a set of pre-assigned keys for these adjustments in the Develop section of the Keyboard 
Shortcuts window, but you can change them easily. See page 110 for more. 

NOISE & SHARPENING

The Noise & Sharpening pane incorporates the two adjustments that often compete with each other when 
working on a photo, and that generally need to be balanced in order to achieve satisfactory results in your 
edits. There are four options for noise reduction and sharpening in the pane, split into tabs: 

• Classic, which offer Photo RAW’s traditional noise reduction and sharpening settings. 

• NoNoise AI, which uses AI-based machine learning to remove luminance and color noise from 
photos shot at higher ISOs.

• TackSharp AI, another AI-based tool that can be used to deblur or sharpen soft photos. It can 
detect and remove motion blur and will even save out-of-focus shots.

You can view (and change) the hotkeys for the primary Tone 
& Color adjustments from the Keyboard Shortcuts window, 
which is found in the Edit menu.

Develop’s Noise & Sharpening pane offers traditional noise reduction and sharpening options in the Classic tab (above left); while the NoNoise AI (second from 
left) and the TackSharp AI (second from right) tabs incorporate ON1’s AI-based noise reduction and focus-enhancement and sharpening technologies. The Both tab 
(above left) lets you apply both NoNoise and TackSharp to an image at the same time. 
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• Both, which includes the NoNoise AI and TackSharp AI tabs, letting you apply AI-based noise 
reduction and focus-sharpening applications at the same time.

The Classic sliders are applied in real time on your image, while NoNoise AI and TackSharp AI are applied 
at the base image level, demosaicing each image from its raw data and applying its noise reduction and 
sharpening to the base image. Because it is applied at the raw level, you must process the image and then 
apply it, which ‘locks’ the settings to the base image, although you can adjust the settings at any point in 
time. It also takes a bit longer to process a photo with NoNoise or TackSharp than the Classic method. (See 
page 74 for details about the order in which editing operations are applied to a photo.)

For most images, you’ll want to use the Classic option first, unless you know that the images were shot at 
high enough ISOs that noise will be a problem in your final edit, or that your photo contains soft or out-of-
focus details that you wish to correct.

Using the Classic tab

For most images, you’ll want to use the Classic tab in the Noise & Sharpening pane; which is the default tab 
in the pane when you open it.

NOTE: When you are adjusting the sharpening or the noise in a photo, it is 
best to be working at 100% view. To do this, you can click on the 100 button in 
the Navigator pane, choose View Actual Pixels from the View menu, or press 
Command-Option-0 (Mac) or Control-Alt-0 (Windows) on your keyboard. 

Noise Reduction

The Noise Reduction section reduces luminance and color noise, 
while maintaining image detail. By default, Photo RAW applies 
a small amount of noise reduction on your photo, based on the 
camera type used. You can then further refine both luminance 
and color noise, as defined below:

• Luminance: Adjusts the strength of the noise 
reduction applied to the image’s luminance. Hold the 
Alt/Option key to see the luminance while adjusting 
this slider.

• Color: Controls the amount of noise reduction applied 
just to the color noise or chroma, of the image.

• Detail: Controls how much edge detail is protected for 
each type of noise reduction (Luminance and Color). 
Hold down the Alt/Option key to see the edge mask 
while adjusting this slider.

• Remove Hot Pixels: If you have any individual, blown-out pixels in your image, turning 
this setting on will remove them, changing that pixel’s color to one that blends in with the 
surrounding pixels. This setting can also be helpful in reducing noise in long exposures.

• Version: This is set by default to 2020, when ON1 last revised its Classic noise reduction 
algorithms. Photos edited in earlier versions use the 2017 model, while newer photos will 
default to the new model. You can change any image to the other model via the pop-up. 
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Sharpening

The sharpening section of the Details pane is designed to visually sharpen an image based on its initial 
state from your camera—for example, to bring back some sharpness that might have been lost. It has two 
basic controls: Amount and Threshold. Amount controls the strength of the sharpening applied, while 
Threshold reduces sharpening in areas of low detail via a threshold mask. Hold down the Option (Mac) or 
Alt (Windows) key as you adjust the Amount slider to display your photo in grayscale, which can make it 
easier to view the degree of sharpening you’re applying.

With the Threshold slider, a setting of 0 means that the sharpening amount gets applied to every 
pixel. As you increase the amount, it focuses the sharpening only where there is a difference between 
neighboring pixels. To help you determine which edges are sharpened, you can use the same Option/Alt 
key trick mentioned above. In this view, as you adjust the Threshold slider, everything that is white will get 
sharpening applied to it; everything displayed as black will not have sharpening applied.

If you wish to apply further sharpening for printing or other output uses, you can add more targeted 
sharpening and noise reduction in the Effects tab, or the Resize module, if you wish to sharpen for output. 

Using NoNoise AI

To get started, click on the NoNoise AI tab in the Noise & Sharpening pane. When you click on the NoNoise 
AI tab, Photo RAW analyzes your image and applies ON1’s AI-driven noise-reduction technology, based on 
the contents of the image. NoNoise initially presents your image at 100% view, with a split screen 
displaying your original file on the left side, and the denoised version on the right (shown below). 

When you open a raw image for processing inside NoNoise AI, the app will apply initial noise reduction based on the contents of the image 
and your noise-reduction preferences (High, Medium or Low). The image will be displayed at 100%, with a preview slider that can be 
dragged left or right; the original image is on the left side of the slider, while the right side displays the denoised image with the current 
settings in the NoNoise AI tab.
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The advanced AI neural networks behind NoNoise AI work at the deep raw level. They are trained to detect 
and reduce the noise before the raw data is even converted to a photo, preventing noise from propagating 
further up in the image processing pipeline. As a result, NoNoise can clearly differentiate between what is 
noise and what are small details, helping to maintain sharper details and reduce false color.

NoNoise AI automatically applies noise reduction based on the contents of your image and your preferred 
level of reduction, but you can adjust the amount of noise reduction and detail preservation—as well as add 
sharpening—to your taste, by adjusting the sliders in the Noise & Sharpening pane. The controls consist of 
two primary sections in the main section of the pane, and an action area on the top right side of the pane:

A.	Noise Reduction: This section adjusts 
the amount of Luminance (brightness) 
and Color noise reduction on the current 
image. Enhance Detail works to preserve 
details that would have been lost in 
traditional noise-reduction processes. 
Color is always set to 100, but the amount 
of Luminance reduction is set based on 
the image contents and your Auto settings 
level (see below). The Method pop-up 
offers two options: Original, which is the 
preferred option for raw files, and High 
Detail, which is optimized for non-raw files. 

B.	 Sharpening: This adjusts the amount 
of sharpening applied to the processed 
image. The sole slider, Micro Sharpening, 
enhances small details in your image. 

C.	 Reset: The top button resets the tab to its default state. Click this if you would like to reset 
any changes you’ve made here. 

D.	Apply/Adjust: This button has two states: Apply (blue) and Adjust (red). Apply is the default 
state when you open the image: NoNoise has applied noise reduction, and you can fine tune 
the settings as you’d like. When you’re done, clicking the Apply will ‘lock’ your settings in, 
changing the state to Adjust. To re-edit your settings, click Adjust, and the button will revert 
to Apply, with the current settings available.  

E.	 Auto On/Off: When you have applied NoNoise to an image with the default reductions 
settings, this button will read Auto On. If you adjust the Luminance slider, the button will 
change to Auto Off, meaning that the slider has been adjusted from the auto value. Clicking 
the button in this state will return the Luminance setting to its original value.

NoNoise’s Default Noise-Reduction Settings

We know that noise reduction is as much about personal taste as it is about technology. Some people 
prefer a light touch, while others like a much more processed result. In Photo RAW’s Preferences, you can 
configure NoNoise AI to use one of three automatic noise-reduction settings—Low, Medium or High—when 
you click on the NoNoise AI tab (or Both). This setting only affects the Luminance slider; the Color slider’s 
default is always set to 100, the Enhance Detail’s default setting is 50, and the Sharpening Amount is 20.

The Noise & Sharpening pane, with NoNoise AI active.
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The default Auto setting is High, but you can change it to Medium or Low in the General tab of Photo 
RAW’s Preferences window; choose the desired 
setting in the NoNoise AI Default pop-up at the 
bottom of the window.

Our recommendation would be to play around with 
a group of representative images from your library, 
looking at the types of noise reduction that work 
best for you, and then change your setting to the 
range that you like best.

Fine Tuning the Image

Work the Noise Reduction section of the NoNoise 
AI pane first, if you need to. When thinking 
about adjusting the noise reduction amounts, 
detail enhancement and sharpening, use the 
Preview window at a zoom level that lets you see 
the important details, and use the Hand tool to 
move you around the image. Then, work with the 
Luminance and Enhance Detail sliders to zero in on 
the best look. 

A good methodology, especially as you are getting to know the app and its settings, is to set the Luminance, 
Detail Enhancement, and Sharpening all to zero. Then start by adjusting the Luminance slider up, examining 
an area that has both detail and smooth areas. Adjust the Luminance until you see the desired amount of 
noise reduction in the smooth areas. Depending on your tastes, this will usually be in the 80 to 100 range.

Next, increase the Enhance Detail slider until you have the desired amount of enhancement. Values 
between 20 and 50 are common. High amounts on this slider may bring back some noise in the smooth 
regions, so you may need to balance how much you use by comparing high-detail and low-detail areas. 

Last, adjust the Sharpening Amount in the same fashion as the Enhance Detail slider. Values between 20 
and 50 generally give the best results. 

If you want to apply sharpening to the image, make sure you’re working at 100% or higher, so you can see 
the results of the three sharpening controls. Watch out for halos generated from oversharpening, and use 
the Threshold slider to keep large, smooth areas from getting sharpened; the higher the Threshold amount, 
the more your sharpening is focused on edge detail. Typically, a Threshold setting of 2-4 will give the best 
results

When you’re done with NoNoise AI, click the Apply button to lock the settings. 

NOTE: Because NoNoise AI works best at the raw image level, we recommend 
that you process your images in NoNoise before you apply basic editing 
(exposure, color balance, etc.) or finish editing. Ideally, you want to work with 
the raw data as much as possible. Use the High Detail option (in the Method 
pop-up) when processing non-raw files, even high-resolution, 16-bit formats 
like PSD files or TIFFs.

Photo RAW’s General Preferences pane has an option to configure 
NoNoise AI’s automatic noise-reduction settings—to Low, Medium or 
High—based on your taste. The default is High.
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Using TackSharp AI

The TackSharp AI tab is much simpler than the NoNoise AI tab, consisting of two sliders:

A.	The primary slider, Tack Sharp AI Deblur, 
is designed to enhance focus and reduce 
motion blur. The default setting is 100; in 
most cases, you shouldn’t have to touch 
the slider, but feel free to do so if you feel 
that the sharpening is too aggressive.

B.	 The Micro Sharpening slider is identical 
to the one found in the NoNoise AI pane. 
It is designed to enhance the small details 
in your image. This slider defaults to 0; as you adjust the slider, zoom in to an area with small 
details, like hair or feathers, and pay attention to the effect. A little bit can go a long way. 

C.	 Reset: The top button resets the tab to its default state. 

D.	Apply/Adjust: This button has two states: Apply (blue) and Adjust (red). Apply is the default 
state when you open the tab. When you’re done, clicking the Apply will ‘lock’ your settings in, 
changing the state to Adjust. To re-edit your settings, click Adjust, and the button will revert 
to Apply, with the current settings available.  

When you open a raw image for processing inside TackSharp AI, the image will be displayed at 100%, with a preview 
slider that can be dragged left or right; the original image is on the left side of the slider, while the right side displays the 
sharpened image with the current settings in the TackSharp AI tab.
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Using both NoNoise AI and TackSharp AI together

The Both tab in the Noise & Sharpening pane is designed for those times when the lack of sharpness and 
increased noise are an issue in a photo. By applying both NoNoise and TackSharp technologies to your  
image simultaneously, you can work to achieve the right balance between the two. 

When working in the Both tab, the only difference you’ll find is that the Micro Sharpening slider is listed 
in the TackSharp section of the tab and is not available in the NoNoise section. Otherwise, it functions 
identically to the individual tabs. 

LENS CORRECTION

The Lens Correction pane uses the lens metadata embedded 
in a photo and searches Photo RAW’s internal lens database 
for an appropriate profile. If found, the profile will be applied 
automatically, reducing distortion, color fringing (chromatic 
aberration) and peripheral fall-off. You can also make your own 
manual lens-correction adjustments, if you prefer.

Photo RAW detects embedded lens profiles in modern lenses from 
Panasonic, Fujifilm, Canon, Nikon and Sony. The lens database 
also has hundreds of profiles for many third-party lenses from 
companies like Tamron, Sigma, Tokina, Zeiss, Voigtländer and 
others. It will automatically apply a profile when the camera and 
lens models are from the same manufacturer. 

When working with third-party lenses and your specific camera, 
you can use the Lens Profile section of the Lens Correction pane to 
find the appropriate lens profile from the database and apply it to 
your image. When you do this, you will be asked if you wish to 
apply this lens profile to any other images for that lens. If you say 
yes, the profile will be saved as a custom style in the Lens 
Correction pane, and will be applied automatically every time Photo RAW sees this combination.

If Photo RAW doesn’t have a built-in profile for your lens, 
it will automatically attempt to correct the image in real 
time, based on a comparison between the embedded 
JPG of the raw image and the raw data itself. In this case, 
there is no need to save the correction as a style—if 
you feel that this representation is accurate. If it needs 
tweaking, you can further adjust the correction in the 
Manual section of the pane (see below), and then save 
the correction as a style and apply it to other images 
taken with that lens and camera combination. (They will not be applied automatically, however.)

Applying Manual Lens Correction

To apply your own lens correction to a photo, click on the Manual triangle at the bottom of the pane and 
choose the manufacturer of the lens (or the camera make, if you don’t have that). The Manual section lets 
you adjust the following parameters:

The Lens Correction pane, with the Manual section 
expanded. Most of the time, when you’re working 
with standard lenses, Photo RAW will automatically 
apply the correct lens profile. The Manual section 
of the pane lets you further adjust distortion, color 
fringing strength and light fall-off, if you so desire..

When you pair a camera with an existing lens profile from a 
third-party lens manufacturer, Photo RAW will ask if you would 
like to use that profile on an all images than have this camera-lens 
combination. 
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• Pincushion (where lines in a photo curve inward) or barrel (lines curve outward) distortion;

• Purple or green color fringing that might occur along edges in an image shot with that lens/
camera combination; and

• The light fall-off (vignetting) that can occur at the outer edges of a lens at certain focal 
lengths or aperture. Once you’ve adjusted the sliders as needed, choose Save New Style from 
the Style pop-up to use this profile on other lenses. 

NOTE: Lens corrections are applied automatically inside Photo RAW, but you 
can turn this setting off via Default Processing section of the Preferences’ 
File tab (see page 268). If you have this setting turned off and wish to apply 
corrections to an image, you must enable the Lens Correction pane in the 
Develop module.

A list of the currently supported lens profiles can be found on the ON1 support website, via this link.

TRANSFORM

Transform applies distortion and perspective correction to your 
image, and offers rotation and scaling options as well. You can 
use these settings to make small adjustments to perspective or 
distortion.

The three icons at the top of the pane let you apply specific 
transforms to the current photo:

• Keystone lets you project your image as if it were on an 
angled surface. This type of effect is often used to help 
adjust the perspective in architectural photos. Selecting 
the Keystone option will give you a box with four handles 
at the corners. You can extend the handles in any 
direction. Once you’re done, click on the Apply button at 
the center of the keystone box.

• Level works in a similar fashion to the one found in the Crop tool (found on page 82). 
Select the tool and click and drag across an element in your image that should be level.

• Move lets you adjust the image’s position on the canvas. Click and drag to reposition.

Keystoning can be helpful when you want to adjust the perspective in a photo; just adjust the four corners 
to align with an object that should have parallel lines, like a window or door, then click the Apply button. 
The Transform pane doesn’t apply a crop when you apply a transformation; use the Crop tool to do that.

In addition to the above tools, the following options will apply specific transform operations:

• Vertical: Adjusts the vertical perspective.

• Horizontal: Adjusts the horizontal perspective.

• Rotation: Rotates the canvas up to 45° clockwise or counterclockwise.

https://on1help.zendesk.com/hc/en-us/articles/4409706974733-Supported-Lens-Correction-Profiles-ON1-PHOTO-RAW-2022-5
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• Scale: Scales your image up from the center, to 100%.

• Aspect Ratio: Stretches your image horizontally (slider moves to the left) or vertically (right).

• Shift: Translates the image left or right.

• Rise: Translates the image up or down.

The Grid pop-up menu at the bottom of the Transform pane lets you displays a grid overlay while you are 
adjusting the pane’s sliders. The default for the pane is No Grid, but you can also choose between 10% 
(large), 5% (medium) or 1% (fine) grid settings.

The Transform tool works best most of the time in small amounts. It’s not necessarily going to fix a photo 
with an extreme perspective, but it can often help with slight adjustments, especially if you fine-tune them 
with some of the Transform panel’s other controls or the Manual section of the Lens Correction panel. In 
addition, the tool does not apply a crop after an operation; if you are happy with the transform results, use 
the Crop tool to finish your work.

CREATING AND ADDING CUSTOM CAMERA PROFILES

As noted in the section on the Tone & Color panel (page 131), you can create your own custom camera 
profiles and import them into Photo RAW. Custom camera profiles can help improve the fidelity of color 
reproduction in your photos, and for some photographers, this can be a useful tool. 

The Transform pane’s Keystone option can help with perspective issues in a photo. Clicking the Keystone icon gives you a box that you can use to align the four 
corners of an object that should have parallel lines (above left). Once you have the edges of the object aligned, click the Apply button in the center to create the 
transform, and apply a crop as necessary. (Sometimes, you’ll find that using the manual section of the Lens Correction pane can help reduce some of the distortion 
that the Keystone operation can create.)
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To build a new profile, you’ll require a color profiling target and special software that creates the profile. 
ON1 worked with X-Rite Inc. during the development process to create a workflow that helps ease this 
process and ensure consistent results when building camera profiles. In addition to ON1 Photo RAW 2023, 
you’ll need a reference target, such as one of the ColorChecker series, and X-Rite’s ColorChecker Camera 
Calibration app, which is a free download for owners of the X-Rite color targets. 

NOTE: You can find the different ColorChecker options on the X-Rite website 
at xritephoto.com/camerasolutions.

The process for creating a custom profile is as follows:

• Turn off automatic white balance on 
your camera; set it to the lighting 
conditions—daylight, tungsten, flash, 
fluorescent—in which you are shooting 
the target.

• Place the color reference target in the 
center of your scene, with even light. 
Take the photo.

• Open the photo in Develop.

• In the Camera Profile section of the 
Tone & Color panel, choose the Linear 
Raw profile from the pop-up.

• Click on the dropper icon in the Color section of the Tone & Color panel (see page 132), and 
click on one of the light gray patches in the target. This will neutralize the image.

• Using the Export feature, export your photo as a TIFF, 
selecting the Camera Calibration color space from the 
pop-up under the file type option. (See page 229 if you 
need help with exporting photos from Photo RAW.) 

• Using X-Rite’s ColorChecker Camera Calibration 
software, open the exported TIFF. The 
app should find and align the target; if 
so, click the Create Profile button, and 
save the exported profile. If it doesn’t 
find the target, follow the guidelines 
in the software to help improve your 
chances with a new photo.

• In Photo RAW, go to the Develop 
module with a photo created with the 
camera you profiled. In the Tone & 
Color panel, click on the Import Profile 
item in the Camera Profile pop-up 
menu. Find the exported profile and 
choose Open. Your profile is now 
installed.

When you open the photo with the color target, set the camera profile to 
Linear Raw, and use the gray dropper to neutralize the photo, by clicking on 
one of the light gray targets (circled, above).

When exporting your neutralized target, set the 
file type to TIFF, and the color space to Camera 
Calibration Space.

Using X-Rite’s ColorChecker Camera Calibration app, you can open the 
exported TIFF file, and create your own custom camera profile. Then, import 
the profile via the Camera Profile pop-up in Develop to use it with any photos 
taken with that camera.

https://xritephoto.com/camerasolutions
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STYLIZING WITH ON1 EFFECTS

If Develop is the base from which you start editing your photos, Effects is the finishing school. With 31 
filters that can be stacked in any order, and with extensive blending and masking options, Effects lets 
you create stunning, pro-level photos with ease. And, since it is built upon ON1 Photo RAW 2023’s non-
destructive editing engine, you can go from Browse to Develop to Effects and back again, preserving your 
edits, masks and more without having to worry about saving multiple versions of your files.

While Develop and Effects share the same tools, Effects is much more customizable in how adjustments—
called filters in Effects—are applied. The editing stack inside Develop is fixed, while the stack in Effects is 
extremely flexible. Here are just a few of the things you can do with an image in Effects:

• You can add filters in any order (even multiple instances of the same filter).

• Move filters up and down in the stack.

• Use blending options with all or some of the filters and set the opacity of each filter 
individually.

• Selectively apply a filter to specific portions of an image by creating complex masks using 
any of Photo RAW’s masking tools, including the AI-based tools like the Super Select AI or 
AI Quick Mask tools. Or, you can use ON1’s innovative Mask AI technology to create masks 
directly from within the Add Filter window.
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In addition to creating and using presets, you can copy and paste Edit module settings from one file to 
another, or alternatively, synchronize the edits on one photo to a group of photos. These operations can 
all be performed in any of the editing modules, as well as in Browse, adding to ON1 Photo RAW 2023’s 
extreme flexibility. (See “Copying settings and synchronizing edits” on page 123 for details on how to 
copy edits between photos.)

Filters
Filters are the building blocks of Effects’ editing power. Each filter is an adjustment type, much like the 
basic adjustment panes inside Develop, but Effects filters have much more functionality than the Develop 
panes. The Effects tab has 31 filter types, added either by the Add Filter button found at the top of the 
Effects tab, or via the Filters pane on the left side of the window. You can apply filters in any order, and 
you can have more than one instance of a filter in the stack. This can be helpful when you are creating 
complicated masks on an image and wish to apply the same filter differently in parts of the photo. And, like 
everything else in Photo RAW, filters can be added, adjusted and removed easily, and they never affect the 
base image that you start with.

Each filter is like a movable, editable layer over the base image you are working on. You can use Effects’ 
masking tools to apply a filter to only part of an image and can change the blending mode (and opacity of 
the filter) to alter the way the filter interacts with those above and below it in the stack. And, when you add 
a filter via the Filters window (see below), you can use Photo RAW’s Mask AI technology to select a region 
in your photo and apply the filter to that area automatically — without using any of the built-in masking 
tools.

FILTER OVERVIEW

Each filter pane has a different set of adjustment 
options and controls, but every filter pane has the 
same five sections:

A.	Filter on/off button (left); Show/Hide 
Mask (right)

B.	 Displays blending mode options (left); 
Resets filter (middle); Deletes filter from 
the stack (right).

C.	 Filter opacity setting.

D.	Styles pane for filter presets.

E.	 Control area for adjusting that filter’s 
specific settings (dependent upon the 
filter chosen).

APPLYING FILTERS WITH THE ADD FILTER BUTTON

If you click the Add Filter button at the top of the Effects tab, the Filters window opens up, with a list of all 
30 filters on the right side of the window, and the Mask AI pane on the left. If you run your cursor over a 
filter name, the right side of the window will have a small before/after thumbnail, a short description, and a 

Overview of a filter—in this case, the Cross Process filter—inside Effects.
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list of keywords that relate to that filter. To add a filter, click once on the filter name, and it will add it to the 
stack, above the current filter. If there aren’t any filters in the stack, the new filter will be at the top of the 
stack. You can click and drag the title bar in any filter to move it up or down in the stack.

If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. Photo RAW will then narrow down the search to those filters that 
match your search terms.

Using Photo RAW’s AI-based tools to mask regions automatically

Normally, when you add a filter, Effects puts the 
filter in the Effects stack, and applies it to the 
entire image. If you’d like to selectively apply a 
filter automatically to specific areas in a photo, you 
have three options:

• You can use a tool like the Super Select 
AI tool to select a region and create 
a filter in Effects (see page 87 for 
information on using this tool).

• To add a filter from within the Effects 
tab, choose the Add Filter button, and 
select the region in the Mask AI section 
on the right side of the Filters window.

• If you have an existing filter, you can also 
select a region from the masking control 
options section of the filter.

In addition to these options, you can also use an AI 
adaptive preset when you wish to create selections 
based on regions in a photo. (See page 120 for 
more on presets and their application.) 

When you click on the Add Filter button in the Effects tab, Photo RAW displays the Filters window, which consists of the Mask AI controls 
(left), the list of filters (center), and a description (right) of the filter your cursor is currently hovering over, with a sample preview (including 
a before and after split view).

In addition to using the Super Select AI tool to add filters selectively to a 
photo, Photo RAW’s Mask AI technology can be found in the Add Filters 
window (above left), and in the masking control options section of the filter 
itself. (Click the mask icon in the filter to open the mask options section.)
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APPLYING FILTERS WITH THE FILTER BROWSER

In addition to the Presets panel found 
throughout the Browse and Edit modules, 
Effects has an additional Filter panel on 
the left side of the screen. This panel lets 
you browse all of the filters inside Effects, 
and display previews of the available styles 
for that filter, and, if you hover your cursor 
over a filter style in this view, Photo RAW 
will display a preview of the filter style’s 
application in the main window. 

To choose the Filters panel, click on 
the Filters tab. A list of the filters will 
appear, and clicking on a filter will display 
thumbnails of your image with that filter’s 
available styles. To choose one, click on the 
style, and Effects will add that filter to the 
Overall Settings pane. Note that this will 
replace the currently selected filter in the 
stack; to add a new one on top of the stack, 
click the Add Filter button at the top of the 
Effects tab on the right, then choose a filter 
from the list. (You can also click and drag 
the title bar of any filter and move it up or 
down in the stack.)

If you’d like to see a larger representation 
of what your selected photo will look like 
with a filter’s styles, click on the Quick View 
Browser icon in the category’s title bar (see 
the following page for a representation of 
the Quick View Browser). That will display 
a window over the entire Photo RAW 
interface with all of the presets in that 
category. (Press the Escape key to close the 
Quick View Browser.)

To change the size of the thumbnails in 
the filter styles panel, select the Browser 
Mode option from the View menu and choose One, Two or Three Column Thumbnail View. (If you choose 
Thumbnail from the Browser Mode submenu, the Filters and Presets panels will display as thumbnails.)

If you’d like help with what the different filter operations do, click on the Info button at the top right of 
the panel. With that button checked, when you hover over a filter, Photo RAW will display a small pop-up 
window containing the same description (with before/after thumbnail) found in the Add Filter window. 
Click the Info button again to turn off this display.

The Filter Browser has a list of all the filters available in Effects (left). Clicking on a 
filter will display thumbnails of the filter’s styles using your photo (right). And, when 
you move your cursor over a filter style, in the main preview window, Photo RAW will 
display a live preview of the filter applied to your current image.
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Searching for filter styles inside the Filter Browser

To search for styles inside the Filter Browser, type in the name you’re looking for in the search field at the 
bottom of the panel. The search results will appear in a new sub-folder called search results, which will be 
selected automatically.

Saving filter styles as favorites

If you hover over a filter style’s thumbnail in either the Filter Browser or 
the Quick View Browser, you’ll see a heart icon. Clicking the icon will fill the 
heart in and add that style to your Favorites category. This category resides 
at the top of the filter list, and contains all filter styles you have selected as a 
favorite. To remove a favorite, open the Favorites category, and click again in 
the heart icon.

To apply a filter style to a photo, simply click on the style in either the Filter 
Browser or in the Quick View Browser.

WORKING WITH FILTER PANES

By default, the filter stack is empty, although, if you have applied a preset that uses filters from Effects, you 
will see those filters in the stack. Clicking on the button in the top left corner of the filter pane will turn that 
effect on or off, which can be helpful if you want to see the effect in the context of other edits you have 
made. If you don’t like the effect, click on the ‘X’ icon in the pane’s title bar to get rid of it. The Reset button, 
which is next to the Delete button, represented by ‘⟲,’ will reset that pane’s settings to their default.

The Filter panel’s Quick View Browser option works identically to the one for the Presets panel: click on the icon to the right of the filter name, and Photo RAW 
will display the current photo with that filter’s styles applied.

A filter style that has been marked 
as a favorite will be displayed in the 
Favorites category.
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To move a filter up or down in the stack, click on the pane’s title bar and drag it up or down. A heavy white 
line will appear between panes as you drag; let go of the mouse at the location you wish the filter to go.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the title bar, but the entire title 
bar is clickable). If you don’t want to have to scroll up and down the filter stack 
when you have a lot of open panes, go to the Window menu and choose Solo 
Mode. This will leave the current pane open, and will hide all the other panes. 
Clicking on another pane will open that one and collapse the previous one.

STYLES

All of the Effects filters have a set of built-in styles in the 
top part of the pane. Styles are like preset adjustments 
for a pane: they provide a group of settings to help you 
get started in the pane, or to apply a specific effect.

You use a style by clicking on the style’s icon in the pane, 
and then can adjust the sliders as desired to get the right 
effect for your photo.

You can also save your own settings as a style. Simply click on the More icon 
on the far right side of the styles list for that pane, then choose Save New 
Style from the pop-up. Name your style, and it will then be added to the top 
of the More menu (see right). To apply a saved style, choose the style from the 
More pop-up menu. To adjust the settings for a saved style, apply it, make any 
changes you would like to the sliders or other options, then right-click on the 
More pop-up and choose Update Style with Current Settings from the menu.

FILTER MASKS

Every filter has a mask associated with it, which lets you apply that filter’s effect to specific areas of an 
image, using the Masking Brush and Masking Bug tools. By default, the mask is white, which means that the 
effect is visible in every part of the image. Using the Masking Brush, for example, you can ‘paint out’ the 
effect in areas that you wish not to be affected by the filter. Alternatively, you can invert a filter’s mask and 
choose to ‘paint in’ the filter where you would like it to be.

When you add a filter, the mask is technically hidden. You can add one by either selecting and using one of 
the two masking tools, or by clicking the Show/Hide Mask icon in the title bar of the filter pane (this icon 
will initially be represented with a plus sign in the middle of it). When you add a mask in either way, the 
contents of the Show Mask icon will represent the mask on that filter layer.

Photo RAW has two options for viewing the contents of a mask: either as a red overlay on top of your 
image (the default) or a view only of the mask itself, represented as grayscale. These options are available 
from the Mask menu; select Show Mask to see the mask, while the View Mode option lets you switch 
between the two modes. To display the current filter’s mask, press the ‘O’ key; to turn it off, press the key a 
second time. 

Styles for the Split Tone filter.

Saved styles appear at the top of 
the More menu.
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The Mask Options section of any effect or local adjustment has the following contents, as shown below 
(using the Color Enhancer filter as an example):

A.	The Show/Hide Mask icon, which displays the contents of the current mask. The default 
mask contents are white when you add an effect, and black when you add a local adjustment 
layer.

B.	 Buttons for opening the blending options, 
resetting the filter, and removing the filter from 
the stack.

C.	 Sets the overall opacity of the masked effect.

D.	Mask AI selection pop-up. Displays a list of the 
known regions in the current photo. To create 
a mask with any of the specified areas, click on 
the item and choose Apply

E.	 Larger display of the current mask, with buttons 
to invert, reset, copy, paste, create a luminosity 
mask, and view/hide the mask contents.

F.	 Mask adjustment tools. Density adjusts the 
overall mask density from black (100) to white 
(0). Feather blurs the mask. The Levels and 
Window settings let you adjust the black and 
white points of the mask, fine tuning them in 
different ways.

G.	The Color Range option lets you choose a color 
(selected via the dropper tool), and make or 
tune the mask based on the range of the color 
selected.

For more details about creating and manipulating masks 
in Photo RAW, see “Masking Basics” on page 111; 
information on the masking tools starts on page 87. 

DELETING A FILTER

You remove a filter by selecting it and pressing the ‘X’ icon in the top right area of the filter’s pane.

FILTER OPACITY

Every filter has an opacity setting, which effectively adjusts the strength of the filter. The Opacity slider, 
which is found at the top of each filter’s pane, ranges from 0 (no effect) to 100 (full effect). What this 
means is that at 100, all of the filter is applied to the image in the stack. At 50, the filter strength is half, and 
the effect is much less strong. Playing with a filter’s opacity can often help soften an effect in a way that 
you wouldn’t be able to get otherwise.

For example, if you add a Black & White filter to an image, but would like a faded, muted color effect, 
simply reduce the opacity of that filter. The more you reduce the opacity, the less effect the Black & White 
will have.

Overview of the Mask Options section of a filter pane in Effects, 
showing a luminosity mask. The Mask AI menu for a photo is 
shown underneath the options screenshot. Mask Options is also 
applicable when working in the Local Adjustments tab, or on a 
layer in the Layers pane.
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By default, when you add a filter, the opacity will be set to 100. You can create presets, however, with 
whatever opacity you wish for a given filter.

BLENDING MODES

In addition to opacity, you have one other very powerful option for adjusting the strength and effect of a 
filter: blending modes. Blend modes determine how a filter interacts with the filters below it in the image 
stack. Blend modes can darken or lighten an image, depending upon the mode chosen, while others adjust 
contrast or color. ON1 Photo RAW 2023’s blend modes also let you apply a blend mode to specific colors 
or tones in your image, making them a very useful tool for precision editing of your images. You can apply 
sharpening, for example, only to the midtones in an image, which can be very helpful in a landscape image.

To see the blending modes, click on the Blending Options gear icon at the top of a filter’s pane. The 
Blending Options area will drop down from the top of the panel. The blending option controls are:

• Blending Options: A pop-up list of blending modes. There are 24 common blending modes 
available in the list, including Normal, Lighten, Darken, Screen, Multiply, Soft Light, Hard 
Light, Overlay and Color.

• Apply To: This lets you apply the blending mode to a specific color or tonal range. The 
options are; All (the default), Highlights, Midtones, Shadows, Reds, Greens, Blues, Magentas, 
Cyans, Yellows, Flesh Colors, Vivid Colors and Neutrals. (You can also manually choose a 
color range by selecting the Dropper Tool in the pane and clicking on a color in your image.)

When you choose one of the options in this menu, the adjustment is only applied to that part of the image 
that is based on the lightness, hue, or saturation range specified. The Range slider expands or contracts the 
selected option, and the Highlights, Shadows, and Skin sliders protect those settings from your adjustments.

How blending modes work

At their basic level, blend modes determine how 
the pixels on one layer interact with the layers 
below it. With 24 blend modes in ON1 Photo 
RAW 2023, it might be difficult to know which 
ones to use in any given situation, but they can 
easily be grouped into Normal (the default mode) 
and five categories: Darken, Lighten, Contrast, 
Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies 
the effect to all of the pixels in the adjustment 
(or effect), assuming the layer opacity is 100%.

The other modes apply different levels of that 
category’s effect using various mathematical 
formulas, and sometimes it can be hard to know 
which mode will work best with what photo. 
Most often, when you know how you want to 
apply an effect —by darkening, for example—
you’ll need to perform a bit of experimentation 
with the different modes in that category to determine which mode works best.
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MASTER OPACITY, BLENDING AND MASK OPTIONS

Effects also has master opacity and master blend mode options 
for the entire image stack, and includes a Master mask option. The 
Master Opacity slider, found at the top of the Effects tab, controls 
the strength of the composite filter stack against the original 
image—if you haven’t performed any other editing operations on 
it—or against the image as it has been inside the Edit module.

The Master Blend Mode options can be accessed via the gear icon 
at the top of the Edit tab. It has the same blending options found 
in the individual filter panes, although it does not have the more 
advanced options, such as Density and Feather.

To create a Master mask, click on the mask icon next to the Save 
Preset icon in the Edit tab. This mask works on the entire effects 
stack. Note that this master mask does not have Mask AI options 
pop-up found in the individual filters.

Filter Types
Effects has 31 filter types available for you to use inside ON1 Photo RAW 2023. Each filter has a set of 
styles in the top row, providing a range of popular or useful options for using that filter. You can also save 
your own preset styles by clicking the More pop-up at the end of the Styles row.

ANTIQUE

The Antique filter gives your image an aged look; unlike the 
Vintage filter, this filter focuses more on a monochromatic or hand 
colored look.

• Color: Displays a list of color options that are similar in 
tone to the Split Tone filter, providing a duotone-style 
effect.

• Brightness: Adjusts the overall brightness of the image.

• Fade: Adds a white fill to the image, giving the illusion of 
a faded photograph.

• Saturation: Adjusts the color saturation. Moving the 
slider to the left decreases the saturation; moving it to 
the right increases it.

• Film Grain: Amount controls the strength and size 
dictates how large the grain appears.

In addition to masking, opacity and blend mode 
options for each filter in the Effects  stack, you can 
set the opacity and blending modes for the entire 
stack. You can also create a master mask  for the 
entire stack.
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BLACK & WHITE

This pane is used to turn a color image into a monochromatic 
image, and, includes additional toning features. The styles at the 
top of the pane represent different filter types often applied to an 
image, while the Auto button selects the black and white points of 
your image automatically. To manipulate the tones manually, move 
the color range sliders to the right (increasing brightness) or the 
left (decreasing). Alternatively, you can choose the Channel Mixer 
option from the Conversion pop-up, and use the slider to choose a 
look that accentuates the color tones you are most interested in.

To change the tones directly inside a photo, choose the Color 
Response tool in the pane: click on it to select the tool, then click 
and drag in the image to increase or decrease the brightness of the 
selected color range.

Tone

The Tone section of the Black & White pane lets you adjust 
brightness, contrast, highlights and shadows, whites and blacks, 
and detail directly within the filter pane.

Toner

The Toner section of the filter is designed to approximate many 
traditional and popular darkroom-based paper toners, from sepia 
tones to platinum, selenium, coffee and more. You can choose 
from more than 20 toning options via the Type pop – up menu, 
and adjust the combination of paper (which is represented by 
the Highlights section of the pane) and silver (represented by 
the Shadows). To tune your options, you can adjust the Hue or 
Amount of each setting, and use the Swap tones icon (next to the 
Highlights color well) to swap the highlights and shadows colors. 
The Preserve Whites and Blacks button keeps the pure whites and 
pure blacks neutral, instead of taking on the color of the toner.

Film Grain

The last section of the Black & White pane is Film Grain, which, 
like the Toner section, is designed to add a classic film grain look 
to your photos. To add film grain, choose from the drop-down list 
of popular black and white films. The Amount slider controls the 
strength of the effect, while the Size slider adjusts the scale of the 
grain.
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BLEACH BYPASS

This filter is based upon an old color film processing technique 
where the bleaching step was skipped. It reduces the saturation 
and increases the contrast.

• Amount: Controls the strength or amount of the bleach 
bypass appearance.

• Brightness: Adjusts the overall brightness of the image.

• Contrast: Increases or decreases the global contrast.

• Detail: Enhances the details by increasing the micro 
contrast.

• Saturation: Adjusts the underlying saturation.

• Tint: Choose a new color by clicking in the color icon or 
by using the Hue slider.

• Amount: Adjusts the strength of the tint.

BLUR

This filter has five options for adding blur to your images: Gaussian, 
Motion, Radial, Surface and Box. Each blur has its own look:

• Gaussian: This is a simple Gaussian blur applied to your 
image. It has one slider, Amount, which controls the 
strength of the blur by adjusting the radius.

• Motion: This adds the appearance of movement.

• The Amount slider controls the strength of the 
blur, and Distance controls the blur relative to the subject and camera. Angle sets the 
angle of the blur, and the Smoothing slider softens the lines created by the motion.

• Radial: These blurs are circular, zooming out from a central point.

• Amount controls the strength of the blur. Quality controls how noisy the blur is, with 1 
being grainy and 100 smooth. Smoothing softens the lines created by the motion.

• The Radial blur type includes a center spot selector at the bottom of the pane. Click on 
the icon, then click on the part of the image you want to make the center of the blur.

• Surface: These blurs preserve edges while blurring the rest of the image. This blur type can 
give you a “simplified” effect. The Amount slider controls the strength of the blur, while 
Threshold sets how similar colors are grouped.

• Box: A Box blur is similar in concept to a Gaussian blur, but it bases the blur on contrasting 
edges. Box blurs tend to retain edges a bit more clearly than Gaussian blurs.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the Amount slider instead.
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BORDERS

ON1 Photo RAW 2023 has a large collection of pre-made borders 
and edges that you can add to your photos. These borders range 
from classic film borders to viewfinders to artistic effects to 
emulsion transfers and many more.

The Borders filter also has an extensive set of controls for 
manipulating the size, color, and blending mode of the borders you 
choose.

You can also import your own borders, either directly into the 
Borders filter pane, or via the Extras Manager (available in Browse). 
Border files need to be a standard PNG file type with a large 
central transparent area

The Category and Border pop-ups at the top of the pane are used 
to select the border category and the specific borders within each 
category. There are 8 built-in categories, sorted by type. Any user-
imported borders will also appear in this list.

Once you have chosen a border to add, you can adjust its blending 
mode and opacity, and, if the border has color, you can adjust its 
hue, saturation and brightness. Alternatively, if the border is black 
or white, you can colorize it.

The Transform section at the bottom of the Borders pane lets you 
scale the border up or down in size, to help you get the look you’re 
after, and the Fit Image slider adjusts the size of the image under 
the border.

You can rotate or flip the currently selected border by clicking the 
buttons at the bottom of the screen.

NOTE: See “Extras” on page 9 for information on how to use the Extras 
Manager to import borders, textures and other extras, along with additional 
information for preparing files for the Borders and Textures filters.
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CHANNEL MIXER

The Channel Mixer filter adjusts the intensity and color of the 
individual red, green and blue channels in a photo. You can use it 
for black and white conversions, channel swapping for infrared 
shots, or to shift entire color ranges.

Click on the channel icons to select a specific channel, and use 
the Red, Green and Blue sliders to increase or decrease the pixel 
values for that channel. 

The Constant slider affects the luminosity of the currently selected 
channel. 

COLOR ADJUSTMENT

This pane lets you adjust specific ranges of color in your photos. 
The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky).

In the pane underneath are color swatches for eight colors: red, 
orange, yellow, green, aqua, blue, purple and magenta. Clicking 
on one of the colors will let you adjust the hue, saturation and 
brightness of the selected color range. Other settings include:

• Range: This slider lets you narrow or widen the range of 
the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color 
range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to adjust the hue, saturation or brightness dynamically. 
To do this, click on the tool and choose which parameter you would like to adjust. Then click in your image 
on a color you would like to adjust and drag the cursor to the left or right to decrease or increase the effect.
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COLOR BALANCE

This filter lets you adjust the colors in a photo’s highlights, 
midtones and shadows tones. This can be useful when you wish 
to color grade a photo, remove color casts from shadows or 
highlights, or to create duotone- or tritone-style images.

To use the pane, click on the tone you wish to adjust (Highlights, 
Midtones, Shadows) and raise the Amount slider. After that, use 
the Hue and Brightness controls to adjust the look you wish to 
achieve. 

The Color patch, which will originally be represented as 18% gray, 
will change, representing the combination of all three sliders for 
that tone.

COLOR ENHANCER

The Color Enhancer is designed to give you complete control over 
color manipulation in your image, whether it is on a globally across 
your entire image, or by adjusting different color ranges. 

The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky). To adjust global 
color in an image, work in the Color section of the top half of the 
filter pane; to work with individual color ranges, use the Color 
Range section at the bottom of the pane.

Color

The Color sliders in the top half of the pane control Temperature, 
Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. The settings in this section of the 
Color Enhancer pane include:

• Auto Button: The auto button attempts to detect 
and remove a color cast. It makes adjustments to the 
Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. 
Click the icon to activate, then click on an area in the 
image that should be gray. The sliders will automatically 
adjust according to the sample you have selected.

• White Balance: This pop-up lets you change the white 
balance according to common color temperatures 
(As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, 
Florescent, Flash, Custom). The default is As Shot, the 
color temperature that the camera recorded when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow).
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• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases or decreases the color of muted tones, leaving more saturated colors 
alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.

Color Range

In the Color Range section of the pane are swatches for eight colors: red, orange, yellow, green, aqua, blue, 
purple and magenta. Clicking on one of the colors will let you adjust the hue, saturation and brightness of 
the selected color range. Other settings in the pane include:

• Range: This slider lets you narrow or widen the range of the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to click on a section of your photo and adjust the hue, 
saturation or brightness dynamically. To do this, click on the tool and choose which parameter you would 
like to adjust. Then click in your image on a color you would like to adjust and drag the cursor to the left or 
right to decrease or increase the effect.

CROSS PROCESS

This filter simulates the effect of processing film deliberately 
with the incorrect chemistry. It creates unnatural colors and high 
contrast.

• Color: A drop-down list of cross-processing types (Blue, 
Green, Yellow, with Strong options).

• Amount: Controls the overall strength of the filter.

• Brightness: Adjusts the overall brightness.

• Contrast: Adjusts the overall contrast.

• Saturation: Adjusts the underlining saturation.
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CURVES

The Curves pane is a powerful—and advanced—tool for adjusting 
contrast, tone and color in your image. 

The main section of the pane displays the histogram of the current 
image in the background; the gradient behind the histogram is 
designed to give you a sense of how the tones will change as you 
adjust the curve. 

The center line is a linear representation of the image’s tonality, 
ranging from 0 to 255; the point at the bottom left represents the 
darkest tones in a photo (minimum of 0), while the point at the 
upper right represents the lightest tones in the photo (maximum 
of 255). By clicking along the line at the center of the pane and 
dragging it up or down you adjust specific tones by making them 
lighter (up) or darker (down). 

By default, the pane shows the composite RGB channel, but you 
can view and adjust each channel separately by clicking on the 
appropriate tab (Red, Green, or Blue). When looking at the individual channels, the background gradient will 
indicate what color shifts will occur when you adjust the curve. For example, raising the points on the curve 
in the Red channel will move the data more towards red, while lowering the points on the curve will move 
the data more towards green. 

Moving the line adjusts the tonality by adding control points along the line (turning the line into a ‘curve,’ 
hence the name):

• Inside the pane, clicking anywhere along the center line will add a point, and you can drag 
that point up or down to change the tones.

• You can also click on the Dropper tool to the left of the channel tabs, then click and drag 
inside the photo at a location where you would like to adjust the tonality. This adds a point at 
the precise tonal location on which you clicked.

You can add multiple control points to the curve, and readjust 
them at any time by clicking on the point in the pane. You can 
“slide” a point along the curve, or you can click and drag up or 
down. If you are familiar with numeric-based color values, you also 
click on a point and use the In or Out boxes to adjust the input or 
output values of the tones at that point. 

To remove a point, right-click on it and choose Remove Control 
Point. Note that there is always at least one control point selected.

Working in the individual RGB channels alters the tonality of each 
specific channel, but the adjustments are similar. To reset any 
curve adjustments made in a channel (or in all channels), right-click 
in the grid, and choose Reset Channel (or Reset All) from the menu.

The Style pop-up for the Curves filter has preset options, including settings for color negatives, matte-style 
looks, and more. If, for example, you regularly apply a classic S-curve to your photos, you could set the 

Right-clicking on a control point gives you the 
option of removing that point. You can also reset 
curve adjustments made to one or all of the 
channels.
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curve the way you like it, and then choose Save New Style from the pop-up. If you apply a style and make 
adjustments to it that you would like to save, select Update Style with Current Settings from the menu.

NOTE: The Curves section of the Tone Enhancer filter (page 167) operates in 
the same way as the Curves filter, with the sole exception being that there are 
no curve-specific style options available.

DYNAMIC CONTRAST

Dynamic contrast adds clarity—also known as tonal contrast—to 
your image, making it pop. It can be a strong effect, so it is often 
combined with masks to help lessen the effect in certain areas of 
an image (clouds in a sky, for example, often look surreal with too 
much Dynamic Contrast applied to them).

The top portion of the pane adjusts the contrast in areas of small, 
medium and large detail; moving the slider to the left decreases the 
contrast, while moving the sliders to the right increases them.

Because adjusting the contrast in extreme ways can affect an 
image’s tonal qualities, the bottom section of the pane lets you 
make adjustments to the highlights and shadows to recover detail, 
in the white and black areas, and increase vibrance.

FILM GRAIN

The Film Grain filter is designed to add a classic film grain look 
to your photos. It operates identically to the section found in 
the Black & White filter, but lets you add grain without having to 
convert your photos to black and white. 

ON1 Photo RAW 2023 has a wide range of grain types from classic 
black-and-white negative films from Kodak, Ilford and Fujifilm. To 
add grain, choose from the Film drop-down menu.

The Amount slider controls the strength of the effect, while the 
Size slider adjusts the scale of the grain.
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GLOW

This pane adds a soft-focus glow to the image, which can be 
accentuated by using different blending modes. The Styles section 
and the More pop-up include a number of different glow types. 
Adjustable settings for the Glow pane include:

• Amount: Controls the overall strength of the glow.

• Halo: Sets the radius of the glow effect; higher numbers 
create more ‘fuzziness’ to your image’s edges.

• Mode: Lets you set the blending mode for the glow 
effect.

GRUNGE

This filter is used to add a dirty or grungy look to your image. 
Settings in this pane include:

• Amount: Adjusts the overall strength of the grunge.

• Brightness: Adjusts the overall brightness of the image.

• Saturation: Adjusts the underlying saturation.

• Detail: Adjusts the amount of detail.

• Glow Amount: Adds a glow to the grunge.

• Mode: Selects the glow blending mode.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.
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HDR LOOK

This filter recreates the HDR style of tone mapping, with 
accentuated edges and sharpening. Like the Dynamic Contrast 
filter, HDR Look will often benefit from masking or via blend 
modes. Settings include:

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast of details and edges.

• Clarity: Increases the global contrast.

• Highlights: Recovers detail in the highlights.

• Shadows: Recovers detail in the shadows.

• Vibrance: Adjusts the vibrance of muted colors.

• Glow: Adds a bright glow.

• Grunge: Adds a dark gritty look.

LENS BLUR

This filter creates a blur, based on a camera lens such as a tilt-shift 
or a shallow depth of field look. You can use the Masking Bug to 
adjust the amount of blur through your image, or brush in or out 
the effect where you want it. The filters settings include:

• Amount: Adjusts the overall strength of the blur.

• Optic Quality: Controls the aperture shape in the inner 
and outer feather.

• Sides: Sets the number of blades in the lens aperture, 
which changes the shape of the bokeh.

• Curvature: Sets the curvature of the aperture blades.

• Blooming: Adjusts the highlight bokeh.

• Brightness: Controls the overall brightness of the blur.

• Contrast: Controls the contrast of the blurred areas.

• Noise: Adds simulated film grain to the blurred areas.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the Amount sliders instead.
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LUTS

The LUTs filter applies a color look-up table (LUT) to transform 
the underlying color of an image. LUTs were first used with video 
applications to provide color-grading (and other) effects to film, 
and they are increasingly popular in still photography. The Styles 
section has  a few default effects you can apply, and you can also 
import your own LUTs, by clicking the Import button inside the 
filter. 

Photo RAW can import common LUT file formats, including .3DL 
and .CUBE file types.

• Category: This pop-up menu lets you choose from one 
of the pre-installed LUT categories, or any categories you 
have imported into Photo RAW.

• LUT: Displays the available LUTs within the chosen category.

• Contrast: Lets you adjust the underlying contrast.

• Saturation: Adds or reduces saturation.

NOTE: See “Extras” on page 9 for information on how to use the Extras 
Manager to import LUTs into Photo RAW.

NOISE REDUCTION

Use this pane to reduce luminance and color noise, while 
maintaining image detail. The styles section includes a number 
of different noise reduction options, based on the type of image 
you’re working on.

• Luminance: Adjusts the overall strength of the noise 
reduction applied to the luminance or detail of the image. 
Hold down the Alt/Option key to see just the luminance 
while adjusting this slider.

• Color: Controls the amount of noise reduction applied 
just to the color or chroma of the image.

• Detail: Controls how much edge detail is protected. Hold 
down the Alt/Option key to see the edge mask while 
adjusting this slider.

• Apply to: Allows you to limit the noise reduction to just a portion of the image based on 
color or brightness values. Options include highlights, shadows and midtones, as well as color 
ranges. To set a custom color range, click the Dropper icon and click on a color area that has 
the noise you wish to remove. Use the Range slider to adjust the range (or ‘fuzziness’) of the 
color range where you with to apply the noise reduction.
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PHOTO FILTER

This filter recreates traditional color lens filters used for warming, 
cooling, gradients and more. You choose the filter type from the 
pop-up menu at the top of the pane, then adjust the settings to 
your liking. Each type offers different options for selecting a filter 
color (or colors, in the case of the Bi-Color type), adding saturation 
or polarization, and more.

There are four Filter Types: Solid, Graduated, Bi-Color, and Center. 
The Solid option includes a section for choosing the single color 
you wish the filter to be, and an Amount slider for how strong 
you want the effect, as well as a Saturation slider for boosting 
or reducing overall color. The Polarizer slider adds a polarization 
effect, which can sometimes help clear haze or enhance the blues 
and greens in an image.

The Bi-Color and Graduated filter types let you choose filter color 
(or colors), feather for the filter transition, and a direction for the 
effect.

The Center type works much like the Graduated option, with the 
difference being that the filter radiates from the center of your 
image, and you can choose the center to be either clear or colored.

REPLACE COLOR

This filter lets you select a color range and replace that range with 
one of a completely different color. When used with filter masks, 
you can achieve targeted color changes in a photo with ease, while 
retaining the other colors in the image.

The top section of the filter is used to select a target color, and the 
bottom section is where you pick a replacement color. 

First, use the eyedropper tool to select a color from your photo, or 
click on the color swatch to pick one from the color wheel. Adjust 
the Range slider to add or remove colors similar to your target. The 
Amount slider is similar to an opacity setting: anything less than 
100 (the default) will blend the new color with the original color. 
You’ll see the results in real-time, so you can get a good idea of the 
selection.

In the Color Change section, click on the swatch to set a new color, 
or use the Hue, Saturation and Brightness sliders to get the color you’re after. If you have areas where you 
don’t want the source colors changed, use the masking tools to paint the effect out.
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SHARPENING

This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 Photo RAW 2023 offers three algorithms 
for sharpening, High-Pass, Progressive and Unsharp Mask. Which 
one you use depends upon the image or your personal preferences. 
The styles section and the More pop-up have a wide range of 
sharpening styles to help you get started.

• Type: Chooses the sharpening method. Each sharpening 
method has its own set of sliders.

• Amount (all types): Controls the overall strength of the 
sharpening for each sharpening type.

• Halo (Unsharp Mask, High Pass): Sets the radius of the 
sharpening effect. Smaller amounts keep fine detail, 
while larger amounts can exaggerate edge detail.

• Threshold (Unsharp Mask, Progressive): Controls the sharpening effect based on contrast in 
your photo. Larger settings means that smoother areas do not get sharpened.

• Detail (Progressive only): Controls sharpening in small details.

• The Protect section protects highlight, and shadow areas and skin tones from having 
sharpening applied.

SKIN RETOUCHING

The Skin Retouching pane is used to reduce blemishes, smooth 
skin and reduce shine on skin. The styles at the top of the pane 
represent a range of adjustments, from subtle to strong, and the 
More pop-up menu has a number of additional styles for you to 
choose from, depending upon your image. Other settings include:

• Blemishes: Adjusts the strength of acne, pores and fine 
lines.

• Smoothing: Adjusts the strength of smoothing similar to 
makeup foundation.

• Shine: Adjusts the strength of the skin shine.

• Evenness: Adjusts skin color consistency across the 
entire face. It is great for correcting overly yellow 
highlights, shadows that may be green or reducing 
redness in noses and ears.

• Skin Color: Use the Color Dropper icon to select the skin color. Click the icon to activate it 
and single click again on the color of the skin in the image.

• Color Well: This will display the color you have chosen with the Color Dropper. Clicking on 
the well will let you choose a different color to represent the skin.

• Range: Adjusts the precision of the color selected.
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SPLIT TONE

This filter applies a duotone-style effect by using a gradient map 
that tints the dark and light portions of the image in different hues. 
This can be used to age an image and give it an antique or vintage 
look. The styles section has a selection of popular split-tone 
effects, and you can create your own by manipulating the sliders to 
choose a map for the highlight and shadow colors.

To use the pane, you can use the Hue slider in each of the sections 
to choose the colors you want for highlights and shadows. The 
Amount slider controls the strength of the color, and Balance sets 
the balance between the shadow and highlight colors, letting you 
make one of the colors more dominant. You can swap the Highlight 
and Shadow Colors by clicking the button to the right of the 
Highlight color.

The Mode pop-up sets the blending mode for the split tone. The 
options you can choose from are Normal (no blending), Color, 
Lighten, Darken, Multiply or Screen.

SUN FLARE

This filter adds realistic-looking sun flares, sun stars and bokeh 
overlays to a photo. You can resize, move and adjust the tone 
and color of the effect, and can also add toning similar to the 
standalone Sunshine filter. The Type pop-up lets you choose 
between the three options (bokeh, flare or star), and the Texture 
menu displays a range of options for the chosen type.

The Tone & Color section of the filter lets you adjust the 
brightness, saturation and hue of the current texture.

To move the position of the texture, click the icon next to the 
Transform label, then click and drag on the overlay to the desired 
spot. You can use the Scale slider to enlarge the overlay, and you 
can rotate or flip it by clicking on the icons to the left of the Fit to 
Canvas button.

The bottom of the Sun Flare pane includes a version of the 
Sunshine filter, letting you adjust the warmth and saturation of the 
overall effect. The Fade slider gives a matte look to the final effect.

NOTE: See “Extras” on page 9 for information on 
how to use the Extras Manager to import Sun Flare 
files into Photo RAW.
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SUNSHINE

This filter increases the appearance of sunshine in a photo, and can 
help to make a flat, cloudy day more vivid. The controls are fairly 
straightforward, including adjustments for the strength (Amount), 
warmth and saturation. You can use the Glow slider to add a bright 
glow to your image.

TEXTURES

The Textures filter places a texture over the image to add a stylized 
look and is similar to the Borders filter in scope and functionality. 
ON1 Photo RAW 2023 comes with an extensive set of textures 
that you can add to your photos, ranging from fabric, metal, stone, 
text and more. You can also import your own textures directly into 
the Borders filter pane, or via the Extras Manager. Texture files can 
be almost any image format (JPEG, TIFF, Raw or Photoshop).

When loading a texture file, it will be rotated automatically to 
match the orientation of your image. You can override this with 
the rotate and flip tools, and use the Transform option to scale the 
texture’s size over your image.

The Textures pane has Category and Texture pop-ups at the top 
of the pane, used to help you narrow your texture search. There 
are nine texture categories, sorted by type, and any user-imported 
textures will also appear in this list.

Once you have chosen a texture, you can adjust its blending mode 
and opacity, and, if the texture has color, you can adjust its hue, 
saturation and brightness. Alternatively, if the texture is black or 
white, you can colorize it by clicking on the Colorize button in the 
bottom half of the pane.

The Transform section at the bottom of the pane lets you scale the 
texture up or down in size. You can also rotate or flip the texture 
by clicking the buttons at the bottom of the screen, which can be 
helpful to achieve the look you desire.

NOTE: See “Extras” on page 9 for information on how to use the 
Extras Manager to import textures (and other extras), along with additional 
information for preparing files for Borders and Textures.
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TONE ENHANCER

The Tone Enhancer controls the brightness and contrast, or tone, 
of the image and lets you recover detail in the highlights and 
shadows, and adjust the white or black point. It offers similar 
controls to the Tone section of the Tone & Color pane, and also 
includes a curves dialog.

• Auto Button: The auto button sets the white and black 
points automatically, adjusting all of the primary tone 
settings to balance the histogram.

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast.

• Highlights: Darkens or lightens the highlights.

• Shadows: Darkens or lightens the shadows.

• Whites: Adjusts the white point, adding or removing 
contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing 
contrast in the shadows.

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast in the image.

• Clarity: Enhances large edges to add clarity.

• Curves: The curves section is a powerful, advanced 
tool for adjusting contrast and color in your photos. For 
specifics on how to work with this feature, see “Curves” 
on page 158.
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VIGNETTE

The Vignette pane creates flexible vignettes which focus a viewer’s 
eye toward the center of the image by darkening the edges of the 
frame. The buttons at the top of the pane let you quickly apply a 
vignette and then customize the look with the advanced controls. 
Styles apply common vignette types.

• Brightness: Controls how light or dark the vignette is.

• Size: Controls the size of the vignette.

• Feather: Controls the hardness of the edge of the 
vignette.

• Roundness: Controls the shape of the vignette from 
square to round.

• Type: This menu lets you select a Normal, Subtle, or Soft 
vignette effect. The Priority option will let you preserve 
highlights when applying the vignette.

The Center Tool at the bottom left of the pane lets you to select the center point of the vignette. Click 
on the tool icon to activate and then click on the area in the image you wish to make the center of your 
vignette.

VINTAGE

The Vintage filter is for adding an aged, vintage look reminiscent of 
films and photographic papers from the mid-to-late 20th Century. 

• Color: A drop-down menu of various color styles to apply 
to your image.

• Amount: Controls the overall strength of the filter.

• Saturation: Adjusts the saturation of the original image.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.
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WEATHER

This filter adds weather-inspired overlays to a photo. The 
Precipitation section at the top lets you add rain or snow overlays, 
by choosing a type from the Texture pop-up menu. You can adjust 
the opacity of the effect, and can scale, flip or rotate the overlay 
via the Transform section of the panel.

You can also add fog effects to a photo. To turn this effect on, 
raise the Amount slider in the Fog section at the bottom of the 
pane. The Position pop-up menu includes a number of gradients 
for applying the effect (choose All to apply the effect to the entire 
image). Choose the one that is the best starting place for your 
photo.

The Distance and Transition sliders act upon the gradient, letting 
you choose the intensity and length of the Position gradient, while 
the Rotation slider lets you adjust the angle.
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REPLACING SKIES WITH SKY SWAP AI

The Sky tab makes replacing or enhancing a dull sky a breeze, by automatically detecting the sky in your 
photo and masking it out. Once the mask has been built, you can select a replacement from one of the over 
100 skies included with Photo RAW, or you can or import your own directly from within the Sky tab. 

Photo RAW gives you full control over the mask used to blend the sky and you can use any of the other 
the masking tools to adjust it as needed. You can adjust the sky to blend better with your foreground, even 
blur the sky to simulate a long exposure. Not only does it replace the sky, but it can adjust the foreground 
lighting and color as well as add a reflection of the sky to water found in the foreground.

It’s easy to get started with swapping out a sky: in Browse, select an image you would like to put a different 
sky into and choose Edit in Sky from the File menu, or, if you’re in the Edit module, click on the Sky tab. 
Photo RAW will automatically generate a mask of the sky and open the Sky Swap AI panel. There, you can 
choose from multiple categories of sky images, ranging from sunsets, storms, night skies and much more. If 
you have your own sky that you’d like to use, you can click the Import button to add it.

Once your original sky has been masked, and you’ve added a replacement that you like, you use the 
controls in the Sky Swap pane to fine tune the placement, intensity foreground, lighting (and reflection, if 
desired). If there are portions of the mask that you’d like to work on, all of Photo RAW’s masking tools—
with the exception of the AI Quick Mask, which overwrites any mask—are at your disposal.

Lastly, if you would like to continue to work on the sky and foreground separately, just copy the Sky Swap 
AI mask and paste it into an Effects filter mask, new layer, or local adjustment.

Replace a lackluster sky (above left) with a beautiful replacement (right) in the Sky tab of the Edit module.
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Inside the Sky Swap AI Pane
When you click on the Sky tab, Photo RAW automatically 
generates a mask of the sky in your current photo and 
opens the Sky Swap AI pane, which consists of the 
following sections:

A.	Pane controls: on/off button (left) turns the 
replacement on or off; Mask view (right) opens 
the Mask options section for fine-tuning the 
mask. (See “Masking control options” on page 
113 for more.)

B.	 Reset button: returns the Sky pane to its 
original state.

C.	 Styles section: for choosing a specific preset 
sky from within one of the categories, or create 
and apply your own style via the More menu.

D.	Sky selection area: includes pop-up menus for 
the different sky categories, and the skies that 
are part of the currently selected category.

E.	 Import button: launches the Extras Manager 
(see page 9) for importing skies directly 
into Photo RAW.

F.	 Position: lets you choose one of two sky swap 
methods (A or B), shift the horizon line of the 
new sky; set the opacity of the sky; fade and 
shift the edge of the mask; scale the size of the 
new sky to better fit the final image; and apply 
a leveling adjustment to the new sky.

G.	Appearance: sets the warmth and brightness 
of the replacement sky, applies dehaze, and 
lets simulate motion by blurring the clouds and 
setting the blur angle.

H.	Foreground Lighting: lets you adjust the 
intensity and color of the light on the 
foreground.

I.	 Foreground Reflection: when working with images that have bodies of water in the 
foreground, you can add a reflection, adjusting both the blending mode, the amount 
(strength) of the reflected sky, and apply a vertical shift. 

THE POSITION SLIDERS

After you’ve chosen your sky from the Category and Sky pop-up menus, use the Position section to adjust 
the placement and the blending of the new sky. You can flip the sky horizontally—which can be helpful 
when you wish to change the direction of the light in the sky to match the foreground—by clicking on the 
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triangles to the right of the Position label. The Shift Horizon slider will move the imported sky up or down 
inside the masked area, while the Fade Edge and Shift Edge sliders can be used to blend the new sky more 
realistically with the foreground. The Opacity slider will default to 100, which means that none of the 
original sky will show through, but you can lower the opacity to blend the new sky into the image as well. 

The Scale slider will enlarge the new sky’s size inside the mask, which you might do because you want to 
add some drama with larger clouds, or want to emphasize a specific group of clouds, or because the size of 
the size of imported sky doesn’t quite meet the boundaries of your original image.

Method setting

Photo RAW has two types of algorithms that it uses to select skies, Method A and B. For most photos, 
the default option, Method A, will offer the best results, but you might find that there are some instances 
where that option gives you less than optimal results. In those situations, try Method B; Photo RAW will 
re-analyze the scene and will create a new mask.

THE APPEARANCE SLIDERS

The sliders in the Appearance section adjust the look of the replacement sky to help better match the sky 
with the existing foreground, and their purpose is straightforward. The Warmth slider lets you apply a 
warmer or cooler look to the new sky, while Brightness adjusts the luminance of the sky, making it brighter 
or darker. Moving the Haze slider to the left removes haze or fog from the sky (by adding contrast), while 
moving it right will enhance it. 

The Blur Amount and Blur Angle sliders let you apply a motion-blur-style effect to the clouds in the 
replacement sky, to simulate a long exposure. 

THE FOREGROUND SLIDERS

As the name of the section implies, the Foreground Lighting and Reflection sliders apply their settings 
to the foreground and help further blend the new sky realistically into the scene. To turn on one of the 
groups, click the on/off button to the left of the Lighting and Reflection labels.

The Lighting sliders attempt to apply 
some of the color of the light in the 
replacement sky to the foreground. 
By default, when you turn the 
Lighting section on, Photo RAW will 
automatically sample a color from 
the sky and apply a slight color fill 
effect to the foreground. If you’d 
like to change the color, click on the 
eyedropper icon next to the color 
patch, and choose another. The 
Amount slider sets the intensity of 
the light, while the Distance slider 
adjusts the effect to fill more or less 
of the entire foreground, almost like 
a gradient.

The Reflection option in the Foreground section of the Sky Swap AI pane is designed to add a 
reflection of your replacement sky to water in the foreground (shown on the right above in 
split-screen preview mode), even if it’s not completely calm.
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There are two blend mode options you can use when adjusting the lighting: Multiply and Screen. Multiply 
will darken the lighting effect, while Screen will lighten it. 

The Reflection group is designed for those times when you have a body of water in the foreground, and 
wish to blend in a slight reflection of the sky into the foreground. 

This option includes a few more of Photo RAW’s blending modes, and you’ll find that different modes work  
better than others, depending upon the scene. (See “Blending Modes” on page 150 for more information 
on the various blending modes used in Photo RAW and their usage.

The Amount slider adjusts the intensity of the reflection, while the  Shift Vertical slider works in a manner 
similar to the Shift Horizon slider does in the Position section of the Sky Swap pane: it moves the reflection 
of the replacement sky up or down across the foreground area.

Generating Realistic Sky Replacements
Adding a new sky to an image is easy, but getting a sky that looks like it belongs in the image is another 
thing. Here are a few tips for creating realistic-looking sky replacements:

• Quite often, the biggest issue in replacing a sky is matching light, whether it be the direction 
of the light cast by the sun, or the time of day. As you work through the list of skies looking 
for a replacement, ask yourself if the movement of light makes sense in the blended pair. 
Sometimes, you can use the Flip Horizontal toggle in the Position section of the Sky Swap 
pane to fix a directional issue; other times, the potential replacement sky, as much as you 
wish it to work, will just look out of place.

• It will be rare that you pop a sky into an image and that it works perfectly. If the light does 
seem to fit, play with the controls in the Position, Appearance, and Foreground sections to 
get a better sense of how the sky works in the scene.

You can easily copy and paste your Sky Swap AI mask and apply it to other places inside Photo RAW. Here we pasted the mask into a Dynamic 
Contrast filter in Effects, and inverted the mask so that the filter would only be applied to the foreground.
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• As you play with different skies and are trying to get a sense of how one works better than 
another, make use of Photo RAW’s Undo capability; better yet, work with the History pane 
(see page 78) to jump back and forth between different places during your editing session.

• Don’t forget to pay attention to the mask. While the Sky Swap AI technology is excellent, it 
won’t be perfect in every instance. Use Photo RAW’s masking tools to refine and adjust the 
mask in places where your sky might intrude into the foreground or vice versa. 

• Use the mask! Copy the mask and use it in your finish editing elsewhere in Photo RAW. For 
example, you might want to apply a Dynamic Contrast filter to your foreground, but know 
that the filter will not look great on the sky. Copy the mask from the Sky Swap AI pane by 
choosing Copy Mask from the Mask menu, then open the Dynamic Contrast filter in the 
Effects tab and choose Paste Mask from the Mask menu. Because the mask’s contents are set 
to the sky, you’ll want to also choose Invert Mask from the menu. Once you do that, the 
filter’s settings will only be applied to the foreground. You can copy, paste and invert the 
mask as many times as you’d like.

Paying attention to light, and its direction, is one of the keys to getting realistic-looking sky replacements. As 
pretty as the as the sunset sky is (top left), the direction of the light in the foreground (from behind and to the left) 
is all wrong for the sunset. The sky on the top right is a bit better fit, but the light is coming from the right, clashing 
with the foreground. Flipping that sky (bottom left) feels more integrated, but it still feels dark for the scene, even 
when adjusting the Brightness slider. Choosing a sky taken at roughly the same time of day (bottom right) feels 
more harmonious with the foreground, and, with a little bit of adjustment, ends up looking fairly realistic.
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• Shoot your own skies and import them via the Extras Manager. When you’re out and see a 
gorgeous sky, photograph it with as much of the sky as you can catch. Because you’ll have 
shot the sky, you’ll have a better idea of the lighting direction and time of day, which will be 
quite helpful when you are trying to match a sky.  

• Finally, remember that, like all other aspects of Photo RAW, everything done in the Sky tab 
is non-destructive and re-editable. If you don’t like your replacement, or need to tweak its 
settings as you apply other edits, click on the Sky tab and your work will still be there. (And 
you can always get back to your original image’s sky by resetting the Sky Swap AI pane.)
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RETOUCHING WITH PORTRAIT AI

Portrait AI was designed to help you retouch faces quickly and naturally, and with as little user intervention 
as possible. When you open a photo in the Portrait tab, Photo RAW automatically finds each face in your 
photo, analyses it individually, and adds just the right amount of retouching, based on your preferences.

Despite all the automation, you have full control over all aspects of retouching and finishing. Each face in 
your photo has independent settings and adjustments. You can manually adjust eye and mouth positions in 
each face, paint to refine the skin mask and use brushes to remove blemishes.

Portrait AI’s skin retouching uses frequency-separation techniques, which help to maintain natural skin 
texture while reducing color and tonal changes across the skin. It creates flawless, natural-looking skin.

In addition to skin smoothing and blemish removal, you can use Portrait AI to correct common errors in lens 
choice and lighting by adding fill-light to brighten the face or resculpt the face to thin the jawline. You can 
even adjust the eye size on each individual face.

The whites of eyes can be brightened and the iris can be sharpened, and there are automatic red eye 
removal options as well.  You can easily brighten the smile and adjust the color and saturation of the lips.

Portrait AI is easy to use: Faces tool in the Tool Well can be used to paint skin in or out—and the Portrait 
pane that contains settings for adjusting the skin, eyes and mouth in a face. Each face in your photo has its 
own pane, so you can adjust each face on an individual basis. 
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Inside the Portrait Pane
Each face in a photo will have its own Portrait pane, 
which contains the mask for the face, and settings for 
smoothing the skin, and adjusting aspects of the face, 
eyes and mouth.

You can view a face’s pane by clicking on the appropriate 
photo at the top of pane. (You can change the name of 
each pane by double-clicking on the ‘Portrait AI’ label at 
the top.) The top of the pane has the following items:

A.	Face selection: This includes the Add Face 
button and any faces found (or added) in your 
photo. Clicking on the face will select that 
face’s portrait pane.

B.	 Face and mask icons: The first icon is a small 
representation of that pane’s face, to help 
with identification in photos that have many 
faces in them. The mask is for that person’s 
face. To turn off all of the settings for that 
pane (to preview that face before and after, for 
example), click the control circle to the left of 
the face. If the circle is empty, it means that the 
adjustments are not currently applied.

C.	 Blending options, Reset and Delete: These 
icons are for changing the blend mode, to reset 
the pane to its original state, or to delete that 
portrait layer altogether.

D.	Opacity: Sets the overall opacity of the pane’s 
settings.

E.	 Style: Pop-up list of preset settings for that 
pane. The Default style uses Portrait’s Auto 
AI technology applying either Subtle or Strong 
retouching. (Subtle is the default AI approach, 
but this can be changed to Strong in the 
General Section of the Preferences window.) 
You can also save your own styles, based on 
individual preferences.

The bottom part of the Portrait pane includes four sections: Skin, Face, Eyes and Mouth. Each section 
has an on-off control circle immediately to the left of the label, which can be helpful if you don’t need to 
retouch the skin or the eyes, for example. The Skin section settings include:

F.	 Retouching: The amount of skin retouching, based on Portrait’s AI analysis of the face.

G.	Retouching Details: Clicking the triangle will give options for further adjustments to the 
overall skin retouching. (See page 178 for information on the options in the Details section.) 



ON1 Photo RAW 2023 User Guide	 Part 3: Working in the Edit Module	 178

The Face section has four adjustments:

H.	Brightness: Adds to or removes brightness from the current face. 

I.	 Slim Face: Resculpts the face, slimming it along the jawlines.

J.	 Left Eye Size: Increases overall the size of the left eye.

K.	 Right Eye Size: Increases overall the size of the right eye.

The Eyes section has five adjustment options:

L.	 Brightness: Brightens the entire eye area; can be helpful when your subject is wearing a hat.

M.	Whitening: Whitens the eyes.

N.	Detail: Adds sharpness to the pupils.

O.	Dark Circles: Brightens circles and/or bags under the eyes.

P.	 Brow Enhance: Darkens the eyebrows.

Q.	Auto Red-Eye Removal: Clicking this button will apply red-eye removal to the eyes.

Clicking the icon to the right of the Eyes label will display an overlay with the eye control points when you 
move your cursor over the face. (See page 181 for information on adjusting the eye overlays.)

The Mouth section has four settings:

R.	 Teeth Whitening: Whitens the teeth.

S.	 Lip Vibrance: Increases the color in the lips.

T.	 Lip Brightness: Adjusts the brightness of the lips.

U.	Lip Hue: Adjusts the hue of the lips.

Clicking the icon to the right of the Mouth label will display an overlay with the mouth control points when 
you move your cursor over the face. (See page 181 for information on adjusting the mouth overlay.)

DETAILS

Most of the time, Portrait’s automatic AI-based skin-
retouching algorithms should do a good enough job 
that you shouldn’t have to do much more than adjust 
the strength of the Retouching slider to dial in your 
final settings (if at all). If you wish to adjust some of 
the parameters in the Skin section, click the Details 
triangle, and you’ll see a set of controls under the 
Frequency Separation section. 

These options include:

• Blemishes smooths facial elements, like 
fine lines and wrinkles. 

• Detail brings back some detail that might 
have been lost in the smoothing process. 

• Smoothing applies additional skin 
smoothing.

Clicking the triangle to the right of the Details label will open an 
additional set of controls you can use to fine tune the smoothing of the 
currently selected face.
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• Texture controls the amount of artificial texture applied as an overlay to the face.

• Shine lessens hot spots, evening out the skin’s tones.

NOTE: The Details pop-up contains two options, Frequency Separation and 
Surface Blur. The Surface Blur option is based on previous versions of ON1 
Photo RAW, and is solely included to provide backward-compatibility with 
presets created for those versions.

Portrait AI Workflow
Portrait AI was designed to automatically give you perfect retouching every time you open an image. As 
such, the basic workflow, for most images you will work with, is relatively simple:

1.	 Perform basic global edits in Develop (or your chosen image editing app, when using Photo 
RAW as a plug-in). This includes tone and color adjustments, as well as any noise reduction 
and lens correction. It’s best to leave sharpening to the final stages of editing.

2.	 Go to the Edit module and click on the Portrait tab, or, when using as a plug-in, choose 
Portrait AI from the appropriate menu in your editing app.

3.	 Go through each individual’s portrait pane and adjust individual settings as desired.

4.	 Use the retouching tools to remove or repair blemishes.

5.	 Apply any manual adjustments to the skin mask, or reshape the eye and mouth overlays, if 
necessary.

SUBTLE VS. STRONG PROCESSING OPTIONS

When Portrait AI applies its automatic retouching to a face in a photo, it uses one of two AI-based 
processing options, Subtle and Strong. As its name implies, the Subtle setting—which is the default 
option—opts for a lighter touch when retouching. Strong applies a bit more processing than Subtle, but it 
still shouldn’t be over the top. Some situations might call for the Strong setting, or you might find that you 
prefer that setting. 

To change the default option, go to the General tab of the Preferences window, and choose the option you 
wish to use in the Portrait AI Default pop-up (see page 266).   

WORKING THE INDIVIDUAL PORTRAIT PANES 

Once Portrait has found the faces in your photo, select each face in turn by clicking on it in the face section 
at the top of the Portrait AI panel, or click on the pane itself. Work your way down the pane from the Skin 
section at the top, down to the Face section, and on to the Eyes and Mouth at the bottom. Making broad 
movements of the different sliders can give you an idea of how a setting gets applied, but be careful in 
making adjustments too strong, which can give your models a plastic look. Work in 100% view, so you can 
see the effects of your changes up close.

Portrait AI generally will do a good enough job in the basic skin smoothing and retouching that you 
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shouldn’t have to dig into the Details section; adjusting the Retouching slider left or right should often be 
all you need to do to fine tune the skin.  

NOTE: When working with multiple faces, you can name each Portrait layer 
individually by double-clicking on the word ‘Portrait’ in the title bar. 

USING THE RETOUCHING TOOLS

If you have portions of a face that have specific retouching needs (blemishes and other marks), use the 
Perfect Eraser, Retouch Brush, Clone Stamp or Healing Brush to make those changes. (See the Retouching 
Tools section, starting on page 106, for detailed information using on working with these tools.)

MAKING MANUAL ADJUSTMENTS IN PORTRAIT AI

Portrait uses sophisticated technology to find faces, but it’s not always perfect. Luckily, you have some 
tools to use to make further enhancements or adjustments beyond the controls in the Portrait pane. These 
include adjusting a face’s mask, to add or reduce the area that the retouching applies to, or making small 
adjustments to the areas around the eyes and mouth. In some very rare instances, you might find a ‘face’ 
that really isn’t a face, or that Portrait was unable to find a face. 

Fine-tuning a face’s mask

To keep Portrait’s retouching localized to each face, the app builds a mask for the face. Only inside the 
contents of the mask are the parameters of that face’s portrait pane applied. The rest of the image is 
‘masked out,’ meaning that the adjustments don’t apply to those pixels. The mask is represented by the 
mask icon at the top of each pane.

If you want, you can fine-tune a face’s mask retouching by painting skin in or out on your model as necessary with the Portrait AI brush. To 
view the mask, click the View Mask icon at the bottom of the window.
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When building a face mask, Portrait AI looks closely for the general contours of the face, but doesn’t 
include other skin. You might want to smooth some skin under the chin or on the neck, or you might want 
to paint out some areas—hair over the forehead—from the mask, so that they won’t be softened. 

You can view the mask for each face by selecting the appropriate pane and clicking the Show Mask icon at 
the bottom of the main Portrait AI window (to the right of the Before/After button). This will display the 
mask for the face, with a red overlay representing the area untouched by that pane’s settings. It will also 
select the Portrait AI brush, which you can use to ‘paint in’ more skin (enlarge the area), or ‘paint out’ areas 
that you might not want to have retouching applied. 

Next, you set the painting mode (Paint In/Paint Out), brush size, feathering, and opacity to make the 
changes to your mask. Performing your brushing with the mask view turned on helps show your progress. 
Use the Option key (Mac) or Alt (Windows) to change the brush mode in real time, to paint in and out with 
ease.

Adjusting the skin mask works best with the view mode on, and at 100% view (or larger, in some instances). 
When you’re done refining the mask, choose another tool and click the View Mask icon at the bottom of 
the screen to turn the mask off. 

Working with eye and mouth overlays

Portrait AI does an excellent job finding the eyes and mouth for each face in a photo, even three-quarter 
and side shots. For each feature, Portrait creates an overlay that functions similarly to the face mask. The 
eyes (or eye, if only one is in the photo) and mouth overlays define the boundaries of those features, and 
only the controls in the respective sections of each face’s pane are applied to those areas.

To view the different overlays on a face, click on either the Eye or Mouth icon to the right of that section’s 
label. When you move your cursor over the face, you’ll see the overlay for that feature.

Each overlay consists of a nodal point (in blue) and control points that define the boundaries of each 
feature. You can rearrange or modify the overlays: clicking and dragging the point lets you adjust the center 
of the overlay; clicking and dragging on any control point lets you readjust the boundaries of that area.

The mouth overlays are a bit more complex than the eye ones; they include control points for the top and 
bottom of each lip, which lets you adjust for the teeth. In most cases, you won’t need to adjust the overlays, 
but if you feel that you could get a better mask for either the eyes or the mouth, it’s best to zoom in fairly 
close, so you can adjust the overlay precisely.

Clicking the icon to the right of the Eye or Mouth label in a portrait pane will display the overlay for that feature. You can 
adjust the control points for each overlay by clicking and dragging them to reshape the area.
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Dealing with missing or ‘ghost’ faces

In the rare instance when Portrait doesn’t find one of the faces in your photo, click the Add Face button 
at the top of the Portrait tab. Then, position and size the box around the face you wish to add, and press 
Return, and the portrait pane will be created (and selected). When adding a face in this manner, you’ll need 
to manually add the eyes and mouth, and enable the different sections of that face’s pane. 

To add the eyes, click on the Eye icon to the right of the label. Then click the cursor in the center of 
each eye. When you’re done, Portrait will create the overlay for each eye, and you can readjust them as 
necessary. 

Adding the mouth is similar; click on the icon to the right of the Mouth label, and click on the corners of 
the mouth. Portrait will create the overlay, and you can adjust the control points to fit the contours of the 
mouth as needed.

Once you’ve added the eyes and mouth, you can work through the pane in the same manner you would 
with an automatically generated face.

Sometimes, you’ll find a pane that’s been generated for something that clearly is not a face. If you find one 
of these ‘ghost’ faces, right-click the ghost icon at the top of the Portrait AI panel and choose Delete Face.
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LOCAL ADJUSTMENTS
You can easily make local adjustments to portions of an 
image in ON1 Photo RAW 2023. You can apply these 
adjustments using the Adjustment Brush or the Adjustable 
Gradient, or with the Super Select AI or AI Quick Mask 
tools. You can also use the Mask AI selection feature in the 
Masking Options area of each adjustment pane (see page 
113 for a discussion of the Masking Options section and the 
use of Mask AI to create automatic selections). 

You can create as many local adjustments as you need on an 
image by clicking on the Add Adjustment button at the top of 
the Local Adjustments section. If you’d like to use the Mask 
AI feature, hold the mouse button down on the button, and 
choose the appropriate region for which you wish to apply a 
local adjustment. Photo RAW will create the mask and open 
the new pane in the Local Adjustments stack.

Local adjustments can be used to apply a gradient filter to 
darken a sky, for example, or to add a more complicated 
vignette to an image. Local adjustments are in essence a 
mask that is applied to a portion of your image, and you can 
manipulate those masks in powerful ways with both the 
blending modes and the luminosity options in the Local tabs.

Operations you can perform with local adjustments include 
tone (exposure, contrast, highlights and shadows, detail), 
color (white balance, saturation and vibrance) and detail 
(structure and noise). Each local adjustment layer can have 
completely different settings and work on different parts of 
your image. You can also use local adjustments to paint with 
color over part of a photo, to perform specialized tasks such 
as skin retouching or to replace the color of an object. 

Like the rest of the Edit module, local adjustments are 
independent from the Develop, Effects, Sky Swap and 
Portrait tabs; you can create a local adjustment while 
working in Develop, switch to Effects, and when you click on 
the Local tab, your local adjustments remain intact.

LOCAL TAB

To create a local adjustment, click on the Local tab. If there 
are no local adjustment layers present, Photo RAW will add 
one. If you want to add additional adjustment layers, click the 
Add Adjustment button. If you wish to use Mask AI to create 
an adjustment for a specific region (or regions in a photo), 
click and hold on the Add Adjustment button. This will 
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display a list of regions in the photo, and you can select the appropriate regions directly from the pop-up.

• Opacity: Sets the opacity of the adjustment.

• Styles: The pane has a number of canned styles for you 
to start with, including ones for lightening or darkening 
(dodging and burning), adding vibrance, fixing teeth or 
red eye, and many more. (You can also save your own 
styles via the More pop-up menu.)

The main section of the Local tab has all of the same options 
found in the Tone & Color pane in the Develop tab: Exposure, 
Contrast, Highlights, Shadows, Detail, and Color Temperature, Tint, 
Saturation and Vibrance. In addition to those settings, the local 
adjustment pane includes a Noise slider, designed to help reduce 
noise on a targeted level (most often seen in the shadows).

These controls work the same way inside the Local Adjustments 
panel. One difference is that, since a local adjustment is actually a 
layer that sits on top of your global adjustments, ON1 Photo RAW 
2023 provides you with a number of blending options for each 
adjustment. Blending modes determine how the selected layer 
blend with the items below it in the image stack.

TIP: You can name each adjustment layer by double-clicking on the word 
‘Adjustment’ in the pane. This can be helpful when you have a lot of adjustment 
layers and wish to remember which adjustment did what.

Click on the Blending Options gear icon at the top of the Local tab to drop down the Blending Options:

• Blending Options: A pop-up list of blending modes. 
There are 24 common blending modes available in 
the list, including Normal, Lighten, Darken, Screen, 
Multiply, Soft Light, Hard Light, Overlay and Color.

• Apply To: This lets you apply the blending mode 
to a specific color or tonal range. The options are; 
All (the default), Highlights, Midtones, Shadows, 
Reds, Greens, Blues, Magentas, Cyans, Yellows, 
Flesh Colors, Vivid Colors and Neutrals. (You can 
manually choose a color range by selecting the 
Dropper Tool and clicking on a color in your image.) 
 When you choose one of the options in this 
menu, the adjustment is only applied to that part 
of the image that is based on the lightness, hue, 
or saturation range specified. The Range slider 
expands or contracts the selected option, and the 
Highlights, Shadows, and Skin sliders protect those 
settings from your adjustments.

You can use the Mask AI feature to add a new local 
adjustment layer by clicking and holding on the Add 
Adjustment button at the top of the Local tab. The 
regions in the current photo will be labeled.

The Adjustment pane’s Blending controls give you extensive 
options for applying local adjustments to targeted tonal and 
color ranges in an image.
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For detailed information on how the various blending modes work, see page 150.

Painting with Color

The Paint with Color option at the bottom of the local 
adjustment panel lets you use the Local Adjustment 
brush to select a color and paint it into your image. It 
is designed for two situations: when you wish to apply 
softening (or evening out) to portions of an image by blending existing color, and to replace the color of an 
existing object. 

The Paint with Color section has three options, Solid Paint, Replace Color, and Classic, and a color swatch 
for the chosen color. You can choose a color from your image by clicking on the eyedropper icon, or you 
can click on the swatch and choose a color from the system color picker. 

Solid Paint will paint over anything you brush with the chosen color; think of it as painting with a Normal 
blending mode. Replace Color will replace the hue, but not the luminosity, of the color you are brushing 
over; it is essentially painting with a Color blend mode, in which whites are preserved. 

The Solid Paint option is an ideal skin softening tool; use the eyedropper to select a midtone section of skin, 
and, using a low opacity setting, paint over parts of the skin with the brush. This option is also useful when 
you are using custom brushes to add overlays to a photo. See page 187 for more on this.

CREATING LOCAL ADJUSTMENTS WITH THE SUPER SELECT AI TOOL

Photo RAW’s Super Select AI tool can also be used — from any tab in the Edit module — to select a region 
in a photo, apply a preset local adjustment style, and open it in the Local tab. For detailed information on 
the Super Select AI tool and how it works, see page 87.

WORKING WITH LOCAL ADJUSTMENTS

When adding a local adjustment layer, click on the tool you wish to use in the Tool Options bar at the top 
of the window. The Adjustment Brush is perfect for working with specific subjects or areas in an image: 
a person or primary object that you wish to brighten, shadow areas that you wish to darken, and more. 
It works in the same manner as the regular Masking Brush: you set the paint mode (in or out), brush size, 
feather and opacity, and brush in the areas you wish to paint an effect in or out.

The Adjustable Gradient is designed to apply a gradient mask over a section of an image: most commonly 
to darken a sky, for example. Because the local adjustment tools are for working on a mask, you have all of 
the masking and blending options you have throughout Photo RAW, and you can use one or both tools—in 
addition to the Refine, Chisel and Blur Mask tools—to refine your adjustment mask as desired. 

TIP: To see the mask created by the Adjustable Gradient, choose Show Mask 
from the View menu. 

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.
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You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Manipulating a gradient mask 

Once you’ve added a gradient to an image, you can 
modify it by accessing the parts of the gradient overlay: 

• To move a gradient, click on the big circle at 
the center of the gradient and drag. 

• To resize a radial gradient, click and drag on the 
solid line. 

• To adjust the feather (hardness) of the mask, 
click and drag along the dashed line. 

• To rotate the mask, click the smaller circle near 
the gradient center and drag. 

When working with local adjustment masks, all of the tools in the Refine group—the Refine Mask, and the 
Chisel and Blur tools—can be used to help give you create smoother and more realistic masks.

Other masking options

Every local adjustment has its own mask, and it uses the same masking options and controls found 
in throughout the Edit module. To access the mask, click on the mask icon in the title bar of the local 
adjustment layer. There you can copy and paste masks, create luminosity masks, and create masks based on 
color ranges or even AI-based selections. For specific details on how to work with these masking options, 
see “Masking Basics” on page 111, and “Masking control options” on page 113.
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USING CUSTOM BRUSHES TO ADD OVERLAYS TO PHOTOS

One specialized use for local adjustment layers and the Paint With Color’s Solid Paint option is to add 
overlays with custom brush shapes. You can paint in stamps, watermarks, and other shapes to create 
specialized creations or enhanced photos. For example, you could use a custom cloud brush to add interest 
to a lackluster sky, or you could create your own watermark and apply it precisely. Photo RAW comes with 
a collection of custom brushes of all kinds, and you can import any black-and-white TIF file or Photoshop-
compatible brush file (.abr) for use in the app, via the Extras Manager (see ”Extras” on page 9).

Creating basic overlays with a custom brush is easy:

1.	 Create a new local adjustments layer by clicking on the Local tab.

2.	 If the Adjustment Brush isn’t selected in the Tool Options bar, select it, and choose a new 
brush from the Shape menu in the options bar.

3.	 Set the brush size and angle. In general, you’ll want to keep the 
Opacity and Flow high, and the Feather low (or 0), but that will 
depend upon the brush and the application.

4.	 From the gear menu, turn the Manual Spacing option on. Depending 
upon the brush type and the application, you’ll have to play with the 
Amount slider, but the general rule of thumb is, for stamped brushes, 
where you wish the shape to be applied singly, set the spacing low. If 
you wish to apply the brush multiple times with a stroke—and have 
clear definition between the brush shapes—set the spacing higher (see 
the spacing chart below for an illustration of the different settings).

5.	 Turn the Paint With Color option on and set to Solid Paint. Choose a 
color for brush, and paint as desired on the image.

Using custom brushes, available via the Brush Shape pop-up in the Adjustment Brush’s Tool Options bar, you can easily add realistic shapes as 
overlays to your photos.

The Manual Spacing option is 
key when using custom 
brushes as stamps.
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Tips for using custom brushes

• The best way to begin working with brush overlays is to practice. Use some of the default 
brushes, and play with them by adding them to a photo or blank canvas.

• Use the Brush Styles option (in the Tool Options bar) to save your favorite brushes and their 
optimal settings.

• The maximum brush size in Photo RAW is 2500 pixels.

• If you’re applying a brush as a single stamp here and there on a photo, start with a feather of 
0, and Opacity and Flow set to 100. Once you’ve set your brush size and angle, click once on 
the image.

• The Paint With Color option applies to all brush strokes made on that adjustment layer. You 
can easily change the color via the color patch in the panel. If you want to apply the same 
stamp with different colors, create a new adjustment layer for each color.

This chart shows the effect of the Manual Spacing on a brush stroke for a star custom brush. With a spacing of 100, 
as you stroke, the stroke will be applied with plenty of space between the brush shape. With a spacing of 0, the 
shape will meld together as you apply the stroke. Depending upon the brush type, this might be acceptable for your 
purposes.
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PART 4: COMBINING PHOTOS WITH ON1 
PHOTO RAW 2023

For many photographers, editing in post-production doesn’t just mean working on a single image at time. 
When shooting out in the field they might capture multiple shots of a scene, to blend them later to achieve 
a greater dynamic range, to create expansive panoramas, or to build a perfectly focused scene from front to 
back. Or, they might be interested in creating sophisticated composites that can only be created within a 
layered workflow. For those photographers, ON1 Photo RAW 2023 includes a full set of combination tools 
to help them achieve their photographic vision with ease: 

• Layers: Photo RAW’s Edit module offers a full layered workflow, letting you create 
collages, perfectly blended composites from multiple images, and much more. (See 
page 190.)

• Panorama: The Panorama feature can create amazing, expansive views of a scene 
from two to 25 photos blending them together into a seamless whole. It can even 
create great panos from a handheld set of shots. You can even batch process a 
group of panorama shots. (See page 198.)

• HDR: This feature takes a group of photos shot at different exposure values 
and blends them to create photos that include a wider range of tones—from 
deep shadows to bright highlights—than can be achieved with a single shot. Like 
panoramas, Photo RAW’s HDR feature supports batch processing. (See page 
201.)

• Focus Stacking: Like the HDR feature, Focus Stacking takes multiple shots of the 
same scene, each shot with a different focus point, and blends them together into 
a perfectly focused final result. (See page 204.)

• Time-Lapse: Create beautiful, flicker-free time-lapse videos from sequences of still 
photos. (See page 206.)

As is the case with all of the editing functionality in ON1 Photo RAW 2023, these features 
work non-destructively. Your original photos are not changed, and the resultant, blended 
photos have all the re-editability found throughout Photo RAW.
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WORKING WITH LAYERS

The Layers functionality inside ON1 Photo RAW 2023’s Edit module lets you create quick 
composites, blend multiple images together, paint in new skies or backgrounds, align layers 
based on their content, and much more. And, because Layers is tightly integrated within the 
Edit module, all of your work remains re-editable at all times: you can go back and add, change 
or update any setting made inside the Edit module, on any layer.

You can combine multiple photos or copies of the same photo as layers. Each layer can be moved, sized and 
masked on its own, and each layer has its own non-destructive settings—just like any photo in Photo RAW, 
all the way back to the original raw data. That means you can use all of Photo RAW’s editing features—basic 
exposure changes, camera profiles, portrait retouching, Effects filters and more—as part of a layered photo.

When you add a layer to a photo, Photo RAW automatically creates a new document with an .onphoto 
extension, leaving your original photo intact. 
This document type, which is visible inside 
Browse, contains all the layer information 
and non-destructive editing operations made 
inside Photo RAW. (For information about the 
implications of using layered files with ON1 
Cloud Sync, see page 196.)

Layers can be as simple as copies of the current photo, to apply more complex adjustments to portions of 
an image than you could with local adjustments. You can also add other documents as a layer inside the 
current document, for replacing skies or other backgrounds, for adding textures, or for when you wish to 
create complex collages. Photo RAW supports up to 14 layers in a document.

The Layers feature inside ON1 Photo RAW 2023 is fully non-destructive. This means you can use all of the Edit module’s tools, tabs and filters, along with 
layer-independent masking capabilities, and still preserve your original photos—and can come back at any time to further enhance your creations. 
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Once you have added a layer, the entire Edit module is available for that layer. When you click on a layer, 
you can add any adjustment from the four edit tabs, create masks, and more. You can use the Transform 
tool to move, rotate, and scale the contents of a layer independently from the complete document. 
(Because the Crop tool works at the document level, you can’t crop individual layers.)

ADDING A NEW LAYER

The easiest way to add a new layer to an existing image is to choose Add Layer from File item in the Layer 
menu. This will open the Add Layer window, which will two tabs in it: Extras and Folders. The Extras tab 
will display two folders, ON1 Extras and My Extras. The ON1 folder will include all of the Extras installed 
with your copy of Photo RAW, including backgrounds, textures, borders, skies, and more. The My Extras 
folder will include any similar files you have added to Photo RAW via the Extras Manager (as described on 
page 9).

If you wish to open a different file, click on the Browse button at the top of the Add Layer window, which 
will open your computer’s file selection dialog box, where you can navigate to the specific file. Any file 
compatible with ON1 Photo RAW 2020 can be opened and added as a layer.

Opening a layered Photoshop file

ON1 Photo RAW 2023 can open most layered Photoshop files in the Edit module. What happens depends 
upon the composition and type of layers in the document:

• If the layered document has basic Photoshop layers and masks, Photo RAW will open the 

When you choose Add Layer from File, a window appears with Extras and Folders tabs. The Extras tab contains backgrounds, textures (shown above) 
and borders supplied by ON1 with Photo RAW, as well as any extras you might have added via the Extras Manager. Clicking on the Folders tab (or the 
Browse button at the top right of the window) will let you browse your computer for photos and other supported files.
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document inside Edit, with each layer and mask visible in the Layers pane. 

• If the Photoshop file has specialty layers—smart objects, text layers, layer styles—Photo RAW 
will flatten the visible layers and will open the file as a composite image, with a single layer.

In either case, Photo RAW will convert the file to an .onphoto file, preserving your previous document.

Creating an empty layered file

You can also start with a blank canvas, in either the Browse or Edit 
modules. Choosing New Canvas from the File menu opens a dialog box for 
creating a new file at whichever custom size you choose. When you click 
OK, Photo RAW creates a new .onphoto file with a single, transparent layer 
in it. You can then use any of the options detailed below to add photos and 
other extras to the file. (You can change the size of an existing canvas by 
choosing Canvas Size from the File menu inside the Edit module.)

Creating a Color Fill Layer

In addition to opening other document types, Photo RAW can create a new layer filled with a solid color, 
which can be quite useful when working with sophisticated composites or blend modes. Choosing Add 
Color Fill Layer from the Layer menu (or clicking on the Color Fill icon in the Layers tool bar) will open the 
system color picker, where you can choose a color for your new layer. You can change the color of any color 
fill layer by selecting it in the Layers pane and choosing Edit Color Fill from the Layers menu.

WORKING WITH THE LAYERS PANE 

The Layers pane has three sections:

A.	Layer Opacity: Reflects the opacity of 
the currently selected layer.

B.	 Layers: All of the layers in your 
document are listed here, with a 
thumbnail of the layer contents and the 
layer mask (if there is one); the currently 
selected layer has an colored outline 
around it (based on the Accent Color 
chosen in the System Preferences’ 
General tab). You can rename a layer by 
double-clicking on the title.

C.	 Layer Tools: The toolbar at the bottom 
of the Layers pane includes buttons for performing basic layer operations (described in more 
detail below). 

Layer Visibility 

A layer’s visibility can be turned on or off by clicking the button to the left of the layer thumbnail. When 
turned off, the layer has no effect on the composite image. 

Changing Opacity 

The New Canvas menu item is 
available in Browse and Edit.

The Layers pane in Photo RAW. This photo has three active layers.
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The opacity slider controls how opaque or how strong the selected layer is. The default is 100%. At lower 
settings, the layer will blend with the layer(s) under it. Altering the blending mode and opacity of a layer can 
create a wide range of color and tone effects. 

Changing the Layer Order 

You may change the order of layers by dragging and dropping layers into the order you prefer. 

Renaming Layers 

You can rename a layer by double-clicking on it. The name turns into an editable field. Type in your 
preferred name and press Enter. 

Layer pane toolbar

All of the layer commands in Photo RAW can 
be accessed via the Layers menu and a pop-up 
menu that you get when you right-click on any 
layer. The toolbar at the bottom of the Layers pane, however, contains the basic commands you need when 
working with layers. From left, the icons represent:

• New Layer: Adds a new layer, opening the Add Layer from File window.

• Duplicate Layer: Makes a duplicate layer, including any Edit module adjustments made in the 
original photo.

• New Color Fill Layer: Creates a new color fill layer.

• Delete Layer: Deletes the currently selected layer.

• Merge Layer: Merges the currently selected layer with the one directly beneath it in the 
Layers stack.

• Blending Modes: Lets you select a blending mode for the current layer. (See page 150 for 
more about working with blend modes inside Photo RAW.)

Other layer commands, available via the Layer menu or pop-up, include:

• Reset Layer Properties: Deletes any layer masks or transform operations you have made to 
the current layer. To reset Develop, Effects, or Portrait settings or local adjustments made to 
a layer, click the Reset Layer button at the bottom right of the main Edit module window.

• Merge Visible: Unlike the Merge Layer command, this will merge all of the visible layers—
ones with the layer visibility status set to on—in a file into a single composite layer, with all of 
the merged layers’ effect applied.
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• New Stamped Layer: When you have the top layer in the stack 
selected, this option will create a new composite layer at the top of the 
stack, with all of the layers’ effect applied.

• Align Visible Layers: This will align the visible layers, based on the 
content of the layers. See page 196 for more information. 

Changing Blending Modes 

Blending modes determine how the selected layer blend with the layer(s) below it. 
The default blending mode is Normal. This maintains the full opacity of the upper 
layer. Layers also supports many other blending modes which can be used to alter the brightness, contrast 
and color of the image. See “Blending Modes” on page 150 for more detailed information on this topic. 

Layer Masks 

If you use any of the masking tools — including 
the AI-based Super Select AI and AI Quick 
Mask tools — a layer mask will be created 
automatically. Clicking on the layer’s mask icon 
will display the standard Photo RAW mask 
options, and you can use all of the Edit module’s 
masking tools to create or modify layer masks, 
including the Mask AI feature used in the Effects 
and Local Adjustments tabs. You can also copy 
and paste layer masks—including masks from 
Effects filters—via the Mask options section or 
via the Mask menu. See “Filter Masks” on page 
148, “Using Photo RAW’s AI-based tools to 
mask regions automatically” on page 145 and 
“Masking Tools,” starting on page 87 for more 
on using Photo RAW’s masking tools.

Adding layers via Filmstrip view

In addition to the Add Layer options detailed above, if you are in Filmstrip view inside the Edit module, you 
can also drag photos from the strip at the bottom of the screen into the main window. This will create a 
new layer with that photo on it. (See “Working in Filmstrip View” on page 25 for more.)

NOTE: If the file you add is larger or smaller than the pixel dimensions of 
the document, use the Transform tool to resize it as desired. If you wish to 
preserve the original aspect ratio of the placed file, use the Shift key to resize it 
proportionally. 

Right-clicking on a layer 
brings up a list of available 
Layers operations.

You can create layer masks for any layer in Photo RAW in the same way that 
they can be created in the Effects and Local Adjustments tabs. Layers also 
supports ON1’s Mask AI technology — you can add a mask based on the 
regions in your photo by clicking on the Mask AI pop-up (shown above right).
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USING THE TRANSFORM TOOL WITH LAYERS

Use the Transform tool (see page 84) at the top of the Toolbar to manipulate layers. A layer may be 
repositioned, sized or rotated using the tool. When selected, transform handles will appear on the edges of 
the selected layer. You use these transform handles to manipulate the image. You can only transform one 
layer at a time. 

Repositioning a Layer 

To reposition a layer, simply click and drag inside the transform box. You can also use the keyboard arrow 
keys to nudge a layer one pixel in any direction. 

Resizing a Layer 

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle allows you to 
adjust two sides simultaneously. Clicking on a side handle allows you to adjust that side. If you hold the 
shift key down while adjusting the size, the proportions of the layer are maintained. If you hold down the 
Option (MacOS) or Alt (Windows) key while resizing, your image will resize from the center instead of from 
the edge. You can hold down Shift-Option (or Shift-Alt) to resize proportionally from the center. 

You can type in the size you desire in the Tool Options bar in the width and height fields. You can also size a 
layer to fill the canvas automatically by pressing the Fill button in the Inspector. 

Rotating a Layer 

To rotate a layer, move the Transform tool just outside a corner transform handle. Notice that the tool 
cursor changes to a rotate cursor. Now click and drag to rotate the layer. You can also use Option/ 
Alt with the left or right arrow keys to rotate a layer when the Transform tool is selected. To rotate the 
layer quickly in 90 degree increments, you can use the rotate left and rotate right buttons in the Tool 
Options bar. 

Flipping a Layer 

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options Bar. 

When you have completed your transforms you need to commit the changes. You can do this by pressing 
the Apply button that appears in the Tool Options Bar or by pressing the Enter key. You can cancel a 
transform by pressing the Cancel button in the Tool Options Bar or by pressing the Escape key. 

NOTE: For detailed specifics on the Transform tool’s options, see page 84.

ALIGNING LAYERS

One of Photo RAW’s most advanced features is the ability to align multiple layers based on content. This 
can be a great aid when you’ve hand-held a group of shots, and want to blend portions of one image onto 
another, to use a better sky, for example. 
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To align layers, open them in the Layers pane, and choose Align Layers from the Layer menu or pop-up 
menu. Photo RAW will then analyze the contents of the layers, and aligns them to the one with the most 
commonality. When you look at the individual layers after aligning them, you’ll see that some layers have 
been moved or rotated slightly to match the content.

An example of Photo RAW’s layer alignment can be seen in the photos on the following page, which are 
handheld shots taken two days apart from the same location. The top photo is the base layer, shown after 
alignment, but with the second layer hidden.

The bottom photo shows the aligned layers, with a gradient mask blending the top part of the base layer 
with the bottom part of the other photo.  Despite the fact that the photos were shot days apart, Photo 
RAW has aligned the photos almost perfectly.

USING LAYERS WITH SYNCED ON1 CLOUD FILES

If you wish to create a layered file with ON1 Photo RAW 2023 using a synced photo that resides on device 
other than the current device, you should be aware of two restrictions. 

First, because Layers requires the creation of a new file in ON1’s proprietary .onphoto format, this new file 
must be saved to the device it is being edited with. If you save this new file to a published folder or album, 
it will be synced. You will be able to edit the layered file on another computer running ON1 Photo RAW 
(see the section on working with existing layered files below for more).

Second, if the synced photo you wish to use is synced as an editable preview (as opposed to the original 
photo), Photo RAW will warn you that you will 
be working with a photo that has less fidelity 
than the original (see the dialog box on the 
right). For some uses, working with the preview 
might be good enough, but if you want to be 
sure that you are using the highest-quality base 
layer, either copy the file to your current 
computer, or change the sync option for the 
photo’s folder or album to Originals, and download that from ON1 Cloud Sync.

For more information on these settings, see “Managing Sync Options in Photo RAW” on page 68.

Using Existing Layered Files with ON1 Cloud Sync

If you create a layered file inside ON1 Photo RAW 2023 and sync it to the ON1 Cloud in any manner (folder 
or album, preview or original), that layered .onphoto file is fully editable on another synced device running 
Photo RAW. Any Edit module changes you make to that layered file on that device (on any existing layer), 
with the exception of adding or removing layers, will be synced back to the original file. If you add or remove 
layers, you will be prompted to save the newly edited file to the current computer.

Layered photos that have been synced to the ON1 Cloud are not editable on mobile devices using ON1 
Photo Mobile; they are viewable, however.
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The final aligned photos, blended together with a gradient mask from top to bottom. 

The base aligned layer. 
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STITCHING PANORAMAS
ON1 Photo RAW 2023 lets you stitch multiple images together to create a panorama, directly 
from within Browse. You can even batch process a group of panoramas. 

Panoramas are composite photos created from multiple individual frames of a scene (also 
known as ‘slices’). While they’re often thought of as wide, narrow images, panoramas can be 

horizontal or vertical, wide or compact. They give you a much higher quality final image, with added detail 
and a greater point of view. Photo RAW can create a panorama with as few as two images or more than 25. 

To create a panorama with Photo RAW, go to Grid or Filmstrip view in Browse and select the images you 
wish to use for your merger—or select a folder that contains the frames you wish to build into a panorama—
and click the Pano icon on the right side of the screen. 

Photo RAW will then display the Create Panorama window, which has two components: the Preview area, 
which displays the merged panorama, and the Options panel, which lets you adjust the type (spherical or 
collage) and the edges of your panorama; choose an output size (either 100% or 50% of the stitched file 
dimensions); choose a module to open the panorama after merging, and add panoramic metadata.

With most landscape-oriented panoramas, you will want to use Auto or Spherical projection type, which 
merges the photos as if they were mapped on the inside of a sphere. The Collage projection type lays 
merged photos flat (as opposed to mapping them on a curved surface), and is often called “scrapbook style.”

There are three cropping options available in the Edges pop-up menu: None, Crop and Warp to Fill:

• None will merge the panorama without cropping the finished image. 

• Crop trims the edges of your panorama to fit the best rectangular crop. 

• Warp to Fill uses ON1’s content-aware fill technology to stretch the edges of your scene to 
fill as much of the entire frame as it can, giving you bigger cropped area. 

ON1 Photo RAW’s Create Panorama window displays the projected panorama, and includes options for the type of merger, cropping options, file size and adding 
panorama-specific metadata. You can also specify which Photo RAW module in which you wish to open the finished panorama.
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Remember that no content-aware technology is perfect: If you use Warp to Fill option, make sure to check 
the edges of the frame after the panorama is built, making sure that there aren’t any smudged areas or bad 
fills. (It often works best on scenes with skies and large vistas, and less so on scenes with lots of detail at 
the edges.)

The Open In section of the Options Bar lets you choose what to do when your panorama has been built. 
You can stay in Browse, or open your finished panorama in either the Develop or Effects tabs.

The Add Panoramic Metadata option, when checked, will take advantage of the exploration features found 
in panorama-aware websites—like Facebook and Google—and apps, letting users click and spin around your 
panorama in real time.

When you click Save, Photo RAW will build your panorama, blending the exposures as necessary, saving 
the resultant file as an .onphoto file; it will then open it in the module of your choice (as determined by the 
Open In menu in the Panorama window.)

BATCH PROCESSING PANORAMAS

Processing a group of panoramas inside Photo RAW is easy: create a separate folder for each panorama 
you wish to build, putting the slices for that panorama in the folder. Then, in Browse, select the folders you 
wish to build, and Photo RAW will automatically go through each folder, building the panoramas using the 
default options: Auto, with edges cropped and built at 100% size. 

Each completed panorama will be placed in the same folder as the component slices.

TIPS FOR CREATING GREAT PANORAMAS

Creating panoramas can be a lot of fun, and can capture the grand vistas in a way that a single capture 
cannot. There are certain best practices that will help ensure you can create a great panorama:

• Use a tripod, and ensure that it—and your camera—are level throughout the entire arc of your 
scene.

• Lock your metering and your focus before you shoot: use the same aperture, shutter speed 
and ISO for all of the shots in your panorama.

• Overlap each shot by 50 percent, to give you plenty of data for which to build your final 
panorama.

• If your panorama isn’t quite what you had hoped for—especially in terms of exposure—
and you have enough overlapping frames, try removing a few frames and rebuilding the 
panorama.

• Once you’ve got your images in Photo RAW, perform basic edits on them in Develop and turn 
Lens Correction on. (Save styling for after your panorama has been merged.)
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PHOTO RAW PANORAMA EDGE OPTIONS

These panoramas demonstrate the three different edge options available via the Create Panorama feature. 
The top panorama was set to None, the middle to Crop, and the bottom the Warp to Fill. Because the scene 
included skies and grasslands at the edges, the Warp to Fill was able to add enough pixels to fill out the top 
of the panoramic frame.
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BLENDING HDR IMAGES
In addition to panoramas, ON1 Photo RAW 2023 has a second photo-merge feature: high 
dynamic range (HDR) photo creation. This feature lets you take multiple shots of a scene, at 
varying exposure levels—accurately capturing shadows, midtones and highlights in different 
frames across the series—and then blend them together to create a final image that has a 
much wider tonal range than a single shot could do. And, as is the case with the panorama 

feature, you can create multiple HDR composites via Photo RAW’s batch processing option.

To create an HDR image, go to the Grid or Filmstrip view in Browse and select the set of images that you 
wish to blend. Then click the HDR button underneath the module picker (or choose Create HDR from the 
File menu). You will then see the Create HDR window, which has the following options:

A.	The Preview window displays a rendition of your merged HDR image (and is resizable).

B.	 The Options bar has settings for adjusting ghosting, choosing a default look, and which 
module you wish the resultant image to open in.

C.	 The Reference panel includes the images used to build the HDR, with their exposure values 
relative to the base image. The image with the outline is the base version used for deghosting; 
the base image for exposure is represented by the lens aperture icon next to the checkmark.

D.	The Tone & Color pane from Develop (see page 131) and the HDR Look pane from Effects 
(page 160) are present to help you tune your image.

E.	 Save/Cancel buttons.
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Once the Create HDR window is open, you can use the various options to tune your image. You can adjust 
the base image: clicking on the different frames in the Reference panel will choose a different base image 
for deghosting; to select a different base 
exposure image, click on the small lens aperture 
icon in a different image of the series. (By 
default, Photo RAW chooses the image it felt 
was closest to the middle of the series for both 
exposure and deghosting.)

The Default Look options are also designed to 
help get you started, corresponding to style 
options in the Tone and HDR Look panes. 
Natural and Surreal use those styles from the 
HDR Look pane, and the Natural Auto and 
Surreal Auto options also add the Auto Tone 
option from the Tone & Color pane. They are only designed to be a starting point: You can override any of 
the options by adjusting the settings in the two editing panes.

The deghosting section of the Options bar has options to blend portions of the frame that might have 
shifted during the image series (things such as clouds, flowing water or moving branches). Depending upon 
the amount of ghosting, you can choose from four levels of deghosting (or none). If you wish to see those 
areas in your image that will need deghosting applied to them, click the Show Ghosting button. Those areas 
that have ghosting issues will be shown with a red overlay. Depending upon how much movement there 
was in your scene, you can then choose the appropriate level of deghosting, or, in some instances, cancel 
and choose a different set of images to blend into an HDR.

The Align button in the Options bar is on by default, which means that, during the HDR generation process, 
Photo RAW will attempt to automatically align the images, based on their contents. Turn the Align button 
off when the alignment process results in a bad composite, or when you don’t want Photo RAW to align the 
images (when working with star photography, for example). With the Align feature off, Photo RAW will use 
the selected base image for the HDR process.

The Open In section of the Options Bar lets you choose what to do when your merged HDR file has been 
built. You can stay in Browse, or open your finished panorama in either the Develop or Effects tabs.

Once you have your settings adjusted to the 
way you’d like them, you can click Save and 
Photo RAW will build your HDR, saving it in 
the .onphoto file format and opening it in the 
module of your choice. The beauty of Photo 
RAW’s HDR engine is that any of the edits 
you make to your image in the Create HDR 
window are reflected in the Tone & Color pane 
in Develop and the HDR Look pane in Effects. 
Because ON1 Photo RAW is non-destructive, 
you can re-edit your HDR to fit your wishes. If 
you decide that you wish to use a different HDR 
Look style, or want to add additional effects to 
your photo, you simply open the image in the 
appropriate module and edit.

The first time you launch Photo RAW’s HDR feature, you’ll be presented with 
this window, showing the different HDR toning options found in the Create 
HDR window. Once you’ve built your HDR file, you can go into the Edit module 
and edit any of the settings, add other filters and more.

The Create HDR preview window, with the Show Ghosting option turned on. 
Areas that have ghosting issues will be shown with a red overlay.
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BATCH PROCESSING HDR IMAGES

The HDR batch processing option lets you take a folder containing multiple sets of bracketed shots from 
a shoot, and automatically turns them into HDR photos ready for editing. The process creates separate 
.onphoto files that can be opened directly in the Edit module. 

To do this, create a separate folder for each HDR composite you wish to build, putting the different 
exposures into that folder. Then, in Browse, select the folders, click the HDR button and Photo RAW will 
automatically go through each folder, building the HDR composite using the default options. Each 
completed HDR image will be placed in the same folder as the component photos.

To batch process a group of different bracketed shoots for HDR creation, put the bracketed images into separate folders, and in Browse, select the 
group and click on the HDR button.
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FOCUS STACKING
When working in the field, achieving perfect focus in a photo from the foreground to the 
background can be difficult, if not impossible to achieve. With ON1 Photo RAW 2023’s Focus 
Stacking feature, you can blend a series of photos taken at different focus distances, giving  
you more depth of field than any single photo. And, you can adjust the focus in real-time, just 
like changing the focus on your lenses. Think of it like HDR, but for focus instead of exposure.

Like the Panorama and HDR features, you generate a focus-stacked photo in the Browse module. Simply 
select the photos that you wish to blend and click on the Focus icon in the selector on the right side of the 
window. This will launch the Focus Stacking dialog, which has the following components:

A.	The resizable Preview window displays a rendition of your blended focus-stacked photo.

B.	 The Options bar has settings for aligning photos; an option to create a final layered file (with 
masks); which module you wish the resultant image to open in; adjusting the depth of field; 
and for fixing problem areas between the base photos in similar areas.

C.	 The Reference panel includes the images used to build the focus-stacked image, with their 
focus values (taken from the photo’s metadata, if available). Clicking the check box on an 
image removes it from the focus operation.

D.	Save/Cancel buttons.
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If there is focusing metadata in the source images, Photo RAW will display the sources from closest to 
furthest, with the focus distance listed, and the Preview window will show the suggested final photo. Photo 
RAW will automatically try to create the greatest amount of depth of field possible, but you can use the 
Depth of Field slider to constrict the depth of field in the blended result. For example, if you wanted less 
sharpness in the areas that are closer, move the left slider; for less sharpness in the distance, move the right 
slider in. To get back to the maximum focus, click on the Max button.

The Despeckle slider can be used when you have some movement in parts of a scene between your base 
images, such as movement of leaves in a stand of trees. Increasing the Despeckle amount can sometimes 
help in removing ghosted elements or distractions.

The Threshold slider reduces noise in smooth areas of the image set, although it may knock out subtle 
detail if driven too hard. Sensitivity biases the decision of final “winner” (which image is declared sharpest) 
for each pixel. Low values rely more on low-frequency portions of the image, where high values leverage 
high-frequency aspects of the image and may help reduce noise. Adjusting these are similar to adjusting 
noise reduction, you are looking for the best compromise of the the two.

When you have the result you desire, click the Save button, and Photo RAW will blend your source photos 
together and create a new photo saved in the .onphoto format. Depending upon your choice in the Open In 
portion of the Focus Stacking window, the photo will open in Browse or the Develop or Effects tab. If you 
chose the Layered Results option, all of the separate images will be displayed in their own layer, with the 
layer masks attached. 

Like all other image types inside Photo RAW, you can edit focus-stacked photos non-destructively in any of 
the Edit module tabs.
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TIME-LAPSE
ON1 Photo RAW 2023’s Time-Lapse feature lets you take a series of still images and turn 
them into stunning, flicker-free HD or 4K movies with the click of a few buttons, from directly 
in Browse. You can preview your results right in the dialog and create quick proof versions or 
high-quality final results. 

When processing a time-lapse sequence, Photo RAW can detect when the camera is bumped and will filter 
out misaligned frames. It can also detect changes in exposure and even them out automatically during 
processing, letting you create you “holy grail” style day-to-night videos. You can even increase or decrease 
the speed of the final videos to stretch out short sequences into longer, smooth videos.

To use the Time-Lapse feature, go to Grid view in Browse and select the photos to be used in the time-
lapse sequence, then click the Time icon from the group of icons on the right side of the Browse window. 
This will bring up the Time-Lapse window, shown below: 

A.	Title bar: Includes the number of frames in the sequence, and the estimated length of the 
generated time-lapse movie at the current Speed setting.

B.	 Preview area: Displays a small preview of the movie to be generated from the sequence. Use 
the Frame slider to scrub through the sequence.

C.	 RAW Input: Lets you set the type of proxy file used to generate the time-lapse movie. 
Options are Embedded JPEG (Fastest), Fast RAW (uses Detail view from the Browse cache), 
and Full RAW (uses the full raw file).

D.	Size: Settings for the final movie size—HD 720p (1280x720), HD 1080p (1920x1080), 4K 
(3840x2160), and 4K (4096x2304).

E.	 Movie generation settings: Adjust the codec used to process the final movie (H.264 or 
ProRes), quality (High, Medium or Low), and the frame rate (FPS).

F.	 Speed: Slider to compress or expand the movie length.

G.	Options: Detect Camera Movement will look for misaligned frames, removing them from 
processing; Reduce Flicker will adjust exposure settings on the fly during processing.

H.	Create Video/Cancel/Process in the Background buttons.
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When you click Create Video, Photo RAW will build your time-lapse video from the sequence using the 
settings in the Time-Lapse window. When the movie file has been created, the video file will be saved 
in the same folder that the sequence resides, and will be visible in Browse. Double-clicking on the file in 
Browse will launch your computer’s default video-playback app.

BUILDING EFFECTIVE TIME-LAPSE MOVIES

Unlike Photo RAW’s other image-combination tools, you’ll want to perform your finish editing on the 
sequence before you click on the Time icon. For some sequences, you can finish edit the first image in 
the sequence—or a representative image in the sequence—in the Edit module, and use the Sync Settings 
command to synchronize all of the edits across the sequence (see “Copying settings and synchronizing 
edits” on page 61). Then, turn the Reduce Flicker option on to let Photo RAW to adjust the frames’ 
exposure settings during the time-lapse generation process.

With more complex sequences, you might want to think of the sequence as different subgroups of 
exposure settings, edit a select frame from each group and sync that group’s settings throughout the 
sequence. You’d still want to use the Reduce Flicker setting, but in some instances, doing a little bit more 
subtle processing across a long sequence can help you create a better final product.

The settings in the Time-Lapse window have been designed to give you great flexibility when building 
time-lapse movies. When you go to create your initial movie from a sequence, think about creating ‘proof’ 
versions to check your movie’s settings and results. For example, use the Embedded JPEG or Fast RAW 
setting in the RAW Input pop-up, along with a smaller 720p or 1080p output size, for those first time-lapse 
movies. They’ll generate much more quickly, and you can get a good idea about your sequence and your 
final edits before producing that 4K masterpiece from the full set of raw files.
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PART 5: OUTPUT AND SHARING
While editing and organizing your photos are probably the most important tasks you’ll do on a regular basis 
inside ON1 Photo RAW 2023, there will be times when you want to “do something else” with your photos. 
Whether it’s enlarging photos for high-quality prints, sharing your photos with others or on social media, or 
printing to your desktop printer, Photo RAW has all the functionality you’ll need to get your photos where 
you want them to be. 

In this section, you’ll find detailed information on the following topics:

• Resize: The industry standard for image enlargement and printing. (See page 209)

• Export: The power of Resize in a quick and easy-to-use panel, letting you export your photos 
with flexibility, ease and control. (See page 229)

• Print: Print your photos in any size, as individual photos, or in contact sheet form. (See page 
240)

• Share: A quick way to share your photos, including via SmugMug. (See page 246)

• Send To: Edit photos in other photo apps. (See page 247)

• Other Sharing Options (MacOS only). (See page 248) 
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RESIZE AI
Resize AI is ON1’s professional-quality resizing tool. Rebuilt from the ground up with an entirely 
new resizing engine, Resize uses state-of-the-art AI neural networks to create the highest-
quality photo enlargements of any resizing tool on the market.

Existing enlargement methods create new pixels or resolution by copying those around them, 
leading to photos with less detail, soft edges, and more noise. Resize’s super-resolution technology enlarges 
photos while maintaining and recovering detail and sharpness. Its primary features include:

• Create large prints. Resize excels at making stunning poster-sized prints. Easily crop to a 
specific paper size, resize the photo with the ultimate detail, and then print it directly or save 
the file to send to a photo lab.

• Crisp details. Resize upscales your photo to any size and sharpens the final details incredibly 
well. You can even crop a portion of your photo and still have amazing quality and detail. It 
can equate to having a longer lens without the expense or weight.

• Breathe new life into old photos. The size and quality of old digital photos don’t compare to 
that available today. Now, remaster old images, making them bigger, sharper, and cleaner.

• Face recovery. Resize uses an advanced machine-learning model that detects small faces and 
enhances them with realistic detail. It can virtually reconstruct a face from modest details, 
adding realistic features and textures. 

• AI-based noise reduction. For original photos with high levels of noise — or photos with JPG 
artifacts — you can Resize’s built-in noise reduction, powered by ON1’s NoNoise AI, to reduce 
noise and artifacts during the resizing process, which leads to higher quality enlargements.

• Gallery Wraps. Resize’s gallery wrap feature can add reflected or stretched wings to the edge 
of your photo so you can make a canvas gallery wrap without losing image area.

• Tiling. Divide the photo into tiles or strips to make it easier to print a mural. You control the 
size of the tiles and how much they overlap for trimming.

• Batch processing and export. The powerful batch-processing engine in Resize lets you 
enlarge a group of photos all at once and save them using Photo RAW’s Export function. You 
have full control over how files are named, where they are saved, their file type, and much 
more. You can even add custom graphic- or text-based watermarks in the process.

• Print presets for easy automation. When it comes to preparing photos for print, knowing 
the proper resolution for your printer and the correct amount of sharpening for your paper 
choice can be daunting. Resize’s built-in presets make this a breeze. Just pick the kind of 
printer, the type of paper, and the size. 

• Complete printing support. You can print directly from Resize module, and can even use 
Photo RAW’s soft proofing feature to see how your photo will look when printed using 
specific printer and paper profiles.

NOTE: A fuller discussion of resolution and print size can be found in “How Big 
Can I Print?” and “How Much Resolution Do I Need?”, starting on page 227.
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Resize Main Screen Overview

Below is an overview of the main sections of the ON1 Resize window:

A.	Tool Well: Icons for switching between the Crop and View tools.

B.	 ON1 Cloud Sync Status/Settings/Help: Icons for displaying ON1 Cloud status, preferences 
and help. The button at the bottom shows/hides the Presets pane.

C.	 Presets: Contains a library of presets for different printers, paper types and print sizes.

D.	Search: Lets you search for presets by name.

E.	 View Selector: (Icons from left) Toggle Dual Display Mode on and off; switch between Detail 
and Filmstrip views (used to batch-process groups of photos or work on images within the 
same folder).

F.	 Preview option toggles: Magnification slider for current image, and buttons for comparing 
before/after views side by side, using soft proofing and previewing the original and edited 
versions on-screen.

G.	Preview Window: This is the main section where you preview and work on images.

H.	Tool Options bar: Lists options for the current tool. 

I.	 Navigator/Levels/Info Pane: Navigator, levels (histogram) and general photo information.

J.	 Photo Size: Displays the pixel dimensions of your photo.

K.	 Resize to: Lets you adjust the dimensions for the resized image.

L.	 Settings: For selecting the resizing method and adjusting smoothness in the final image.

M.	Noise Reduction: Applies noise reduction during the resizing process. 
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N.	Sharpening: Sets sharpening options for the resized photo.

O.	Face Recovery: Enhances the details in small faces in a photo. 

P.	 Film grain: Adds realistic film grain to the final image. 

Q.	Tiling: Lets you tile the finished image into a series of individual files for assembling into a 
mural or other oversized print piece. 

R.	 Gallery wrap: Sets a custom border on the finished image for use when printing on canvas.

S.	 Reset bar: Reset all settings (returns to original state); Sync copies the current image’s Resize 
settings with selected images (when in Filmstrip view); Cancel closes the current image and 
returns to Browse without saving your changes; Done saves the current image (when working 
in Detail, or single-image, mode) or opens the Export window (when working in Filmstrip 
mode). 

T.	 Module Selector: Takes you to Browse or Edit.

U.	Print/Share/Export Buttons: Print the current image or image group; share your image 
(MacOS only); or export the current image or group via the Export function (see page 229).

Basic ON1 Resize AI Workflow
The power of Resize is in the concept of resolution on demand;  Resize should be used as one of the last 
steps in your workflow before printing. You can work with a modest size file, which makes your editing 
faster and takes less hard drive space and memory. Then when you are ready to output your file, enlarge 
it with Resize to the desired size and sharpen it for output. This means you don’t have to keep multiple 
versions of a file at different print sizes; you just create what you need on the fly. 

You can access Resize from anywhere within Photo RAW by clicking on the Resize icon in the module 
selector: you can select an image—or group of them—from within Browse, or move directly to Resize while 
you’re working on an image in the Edit module.

Once you’re in the Resize module, you have multiple options for resizing:

• You can use the Crop tool to crop to a specific paper size (see page 214 for details);

• You can adjust the output size (with or without cropping) by using the Photo Size pane at the 
top of the Resize panel (see page 216); or

• You can use Resize’s built-in presets to crop and resize images to a specific printer, paper 
type and print size. Presets can include everything from specific crop and paper sizes, output 
sharpening parameters, film grain settings and more (see page 223).

All of these methods can be edited and changed as you work. Once you’ve set your output dimensions, 
use the Sharpening, Film Grain, Tiling or Gallery Wrap panes as needed. The Preview window updates as 
you adjust your settings, and you can go back and forth between the original and edited versions of your 
image as you work, either in a direct before/after view (by clicking the Preview button at the bottom of the 
screen), or in an adjustable split-screen view (via the Compare button in the same section).

When you’ve finished making your adjustments on your photo, pressing the Done key will prompt you 
to save your image (with a name and file format) and return you to Browse. You can also use the Export 
window to fine-tune the file format or to export different versions of the current photo.
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If you’re working with a group of photos, either to batch-process them identically, or to work on them 
separately, the workflow is slightly different. Clicking Done will automatically open the Export window for 
saving the currently selected photos and will then return you to Browse. (See page 224 for information on 
working with multiple images.)

USING RESIZE WITH ON1 CLOUD SYNC FILES

To use Resize with a file that resides on device other 
than the current device, you should be aware of two 
restrictions. First, Resize requires the creation of a 
new file, and this new file must be saved to the device 
it is being edited with. 

Second, if the synced photo you wish to use is an 
editable preview, Photo RAW will warn you that you 
will be working with a photo that has less fidelity than the original. If you want to be sure that you are using 
the highest-quality base layer, either copy the file to your current computer, or change the sync option for 
the photo’s folder or album to Originals, and download that from ON1 Cloud Sync.

For more information on these settings, see “Using ON1 Cloud Sync with Photo RAW” on page 65.

Navigating the Preview Area
The Preview area is the main section where you preview and work on images. You can use the View tool for 
navigating this window. This tool adjusts the magnification of the image in the Preview window. With the 
Zoom tool selected, click in the Preview window to zoom in and center the image at the location clicked. 

Hold down the Option/Alt key to pan around the magnified image. You can also double-click the View tool 
in the Tool well to set the image to 1:1 (or 100%) magnification view, which shows every pixel. This is best 
when examining small details, and when previewing Resize’s sharpening and resampling on your photo. 

As you adjust settings in the Resize panel on the right side of the screen, the preview will be updated in real 
time. If you’re performing a significantly large resize operation, it can take a few seconds for the preview to 
be updated completely. 
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You can use the Split Screen control at the bottom of the main window (shown above) to split the screen 
into two panes: the one on the left will display the original image; the one on the right will display the image 
with Resize settings applied. You can use the square in the center of the screen to make one of the panes 
larger, and can use the Zoom and Hand tools to view more detail or scroll around the image. (Click the Split 
Screen button at the bottom of the window to turn it off.)

NAVIGATOR, LEVELS AND INFO

At the top of the control panel on the right of the main window are the Navigator, Levels, and Info panes. 
These panes can be useful for inspecting and viewing details in your image.

The Navigator Pane

This gives you a birds-eye view of your image. The white square region marks the image area that is visible 
in the preview pane. You can pan view by clicking and dragging inside the white region.

At the bottom of the Navigator pane are several Zoom 
presets. Click on a Zoom preset to activate.

• FIT: Zooms to fit the current canvas size.

• 100: Zooms to 100% or actual pixels.

• 50: Zooms to 50%

• 25: Zooms to 25%

The Levels Pane

This gives you a color chart of the shadow, midtone and 
highlight areas based on the image RGB values (often called 
a histogram). This is useful to show areas within the image 
that may be clipping. Clipping is when your image contains 
pure blacks or white and can signify loss of highlight or 
shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top of each end is a triangle. If the triangle is lit, there is 
clipping on that side of the histogram. If you click on the arrows, you will activate the clipping overlay on 
your image. The areas of your image with a blue overlay are pure black, while the areas with the red overlay 
are pure white. You can turn the clipping view off again by clicking on one of the triangles. You can also 
temporarily enable clipping view by holding down the J key at any time. The clipping view is useful when 
you are making adjusts to the brightness and contrast of your image.

The Levels pane also displays the RGB values under the cursor at the bottom of the pane.

The Info Pane

The info pane displays photo metadata, including:

• Camera type

• File type

• Focal length and lens information
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• Date and time captured

• Exposure information

• ISO

• Shutter Speed

• Aperture

• Exposure Value

• Filename

• Color Space

• Dimensions

• File Size

CROP TOOL

The Crop tool is used to crop and resize the entire image for output. Unlike the non-destructive Crop tool 
in the Edit module, Resize’s Crop tool does not support content-aware fill. It also removes pixels outside the 
crop box and changes the canvas size at the same time.

To crop the image, select the Crop tool. Then adjust the corner handles of the crop tool overlay. The area 
outside the crop box appears darkened for guidance. You can resize and move the image inside the crop 
box. When you are satisfied, press the Apply button in the Tool Options bar or press Enter.

Working with the Crop Tool Overlay

• Moving the Image: To move the image inside the crop box, click and drag inside the box. You 
can also nudge the image using the arrow keys on your keyboard.

• Resizing: To resize the crop box, chose a preset from the pop-up, and click and drag on any of 
the resize handles. The box will resize based upon the print size you have selected in the Tool 
Options bar. To rotate the crop box, move outside a corner until the tool changes to rotate.

The Crop Overlay in Resize.
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Crop overlays

When you select the Crop tool, Resize has the option to display guidelines as an overlay on top of your 
photo. These overlays can be used as compositional aids for cropping. There are a number of overlays that 
you can display during a crop session, and they can be accessed from the overlay pop-up menu in the Tool 
Options bar when the Crop tool is active. There are seven options — Rule of Thirds, Grid, Diagonal, 
Triangles, Golden Ratio, Golden Spiral, and None — and you can easily go back and forth between them as 
desired while cropping. 

In addition to overlay type, there are two other sets of options in the pop-
up menu: 

• You can choose to have the overlay displayed all the time during a 
crop session, or to only display the overlay when your cursor is in 
the preview area of the workspace.

• When working with the Triangles or the Golden Spiral overlays, 
the Flip Overlay options will be visible, letting you flip the 
orientation of the overlays horizontally (Golden Spiral only) or 
vertically (Golden Spiral and Triangles).

Crop Tool Options Bar

• Overlay pop-up: Selects a crop overlay, sets overlay visibility, and flips the overlay.

• Preset pop-up: Pop-up controls the crop tool mode as well as aspect ratio and document size 
presets. The Custom option lets you create your own preset crops.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Units: Determines the unit of measure: Pixels, inches, centimeters, etc.

• Leveling tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotate: Rotates the image 90 degrees.

• Cancel: Resets the crop tool.

• Apply: Applies the crop and resizes your photo.

Crop Tool Modes

The Crop tool works in three modes, which are all accessible via the Preset pop-up in the Tool Options bar:

• Freeform: In this mode you can adjust the crop box any way you like. The image will not be 
resized. Any area outside the crop box will be trimmed off. Use this mode if you just want to 
change the shape or recompose your image for general use.

The Crop Overlay pop-up 
includes seven options for 
setting and displaying overlays.
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• Aspect Ratio: You can lock the crop box to an aspect ratio. This makes sure the crop box 
shape doesn’t change, just the size. Use this option to trim existing pixels while maintaining a 
ratio without resizing the image.

• Document Size Presets: These let you crop and resize your image at the same time. If you 
know your intent is to print the image at a certain size you can crop and resize the image at 
the same time. Many common sizes are included plus you can create your own.

Leveling the Image

The Crop tool has a Leveling tool for applying rotation to your image to make it level. To access it, first 
select the Crop tool, then perform the following:

• Select the Leveling tool from the Crop Tool Options bar. Your cursor will change to the 
Leveling tool.

• Click and drag a line across your image that should be level, either horizontally or vertically. 
When you release the mouse the image will be rotated automatically to the correct angle.

Creating custom document sizes

You can create document sizes by choosing the Custom option at the bottom of the preset pop-up. Resize 
comes with many commonly used print, paper and video document size presets but you can also create 
your own:

• From the Preset pull-down, select Custom > Manage Custom Sizes. This opens the Custom 
Document Size Presets window.

• Click on the Add button.

• Double-click on the highlighted untitled name and name your preset.

• Double-click on the width and height and fill in the proper values.

• Click on the units and select the proper unit.

• Click on the OK button.

PHOTO SIZE PANE

The Photo Size pane is the core of the Resize engine. It 
has two sections. The top portion displays the file size and 
pixel dimensions of the photo as you edit it. The bottom 
section provides multiple options for resizing your photo.

When you first open an image, the information in the top 
section of the Photo Size pane will be that of the original 
file; as you adjust the resizing options — via a preset, 
the Crop tool or the ‘Resize to’ portion of the Photo Size 
pane — that information will change, reflecting the size 
and dimensions of the resized image. (The original pixel 
dimensions and file size for the current image can be 
viewed in the Info pane.)

The ‘Resize to’ section of the Photo Size pane has seven 
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options for resizing your images: Dimensions, Long Edge, Short Edge, Width, Height, Megapixels and 
Percentage. Most of the ‘Resize to’ options will scale your image proportionally; the Dimensions option is 
the only one that will open the Crop tool, because you are choosing a specific output/paper size for the 
resized file. 

Here are the specifics for the different scaling options in the ‘Resize to’ pop-up:

• Dimensions. Similar to the document size preset pop-up in the Crop 
tool’s Options Bar (see page 216), Dimensions lets you size your 
image to common paper and photographic print sizes, as well as any 
custom sizes you have created via the Custom Document Size Presets 
window. When you chose an option from the Common Sizes pop-
up, Resize will open the Crop tool, so you can crop your image to the 
appropriate paper size.

• Long Edge and Short Edge. These options are useful when you want 
to lock one edge to a specific length or width and don’t care about the 
sizing of the other edge. Simply choose which option is the important one for your photos, 
and enter the desired amount in pixels, inches, centimeters or millimeters. These options can 
be helpful when batch-processing a group of photos that have different orientations, and you 
want them all to have the same dimension on the long or short edge.

• Width and Height. Using this option will scale the current image based on your choice of 
either the width or the height metric. 

• Megapixels. Scales the current image to a specific megapixel count.

• Percentage. This option enlarges or reduces the size of the exported 
images based on specific percentages. Numbers below 100 will reduce 
the image, while those above 100 will enlarge the image.

All of the options in the ‘Resize to’ menu include a Resolution section, 
represented either as pixels/inch or pixels/cm. To the right of the field is a pop-
up menu with common settings for various printers and other output formats. 
(See “How Much Resolution Do I Need?” on page 228 for more information on 
choosing the proper resolution and sizing for your photos.)

You can readjust any of the options in the resizing section at the bottom of the Photo Size pane. You can 
move between options, use the Crop tool, or even choose a preset, and Resize will recalculate based on 
your new choices.

SETTINGS PANE

The Settings pane contains the controls for selecting the resizing 
method (or algorithm) and its settings. There are four options in the 
Method pop-up:

• Resize 2022 (Standard). This is the default (and 
preferred) option when resizing images. It provides the ideal combination of noise reduction 
and micro-contrast, giving you the best results for most photos.

• Resize 2022 (Faithful). This option provides slightly less noise reduction and micro-contrast 
than Standard, although the differences will be subtle.

The ‘Resize to’ pop-up menu.

The Resolution pop-up has 
common print resolutions.
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• Genuine Fractals. This is the classic, fractal-based algorithm used in previous versions of 
Resize. It is included solely for backward compatibility. 

• Bicubic. This option is for downsizing images. It has no settings.

The two Resize scaling methods have a Smoothness slider, which is designed to reduce artifacts that might 
appear in overly sharp areas of a resampled image. By default, this slider is set to 0. 

Genuine Fractals settings

As noted, the Genuine Fractals resizing method is included solely for backward compatibility with previous 
versions of ON1 Resize. If you wish to use it, there are three sliders for adjusting the resizing parameters:

• Texture. This controls the amount of detail in flat, non-edge areas of an image. Smaller 
numbers (1-2) are good for images with large areas of continuous tone, while larger numbers 
(3-5) are good for images with lots of small detail. Settings beyond 5 will often introduce a 
bumpy noise pattern; it works best when your original image was from scanned film.

• Threshold: This controls the amount of hard edge detail that is enhanced. The default 
setting is 25. Decreasing the threshold will focus the Genuine Fractals algorithm on edge 
information. This may be useful for portraiture or for reducing noise in your image. Settings 
higher than 25 will increase the amount of small detail in flatter areas of the image. Settings 
as high as 100 are useful for highly detailed images (hair or feathers). 

• Smoothness: The smoothness slider is used to reduce artifacts along hard curved edges. Use 
the lowest setting needed.

NOISE REDUCTION PANE

The Noise Reduction pane incorporates some of the AI-based 
technology behind ON1’s NoNoise AI product (without the 
TackSharp sharpening component). You can use it to reduce 
an original photo’s noise or JPG artifacts as part of the resizing 
workflow, which in turn can lead to higher quality enlargements.

The Amount slider adjusts the overall strength of the noise reduction applied. When adjusting the effect, 
you should view the photo at 100% view.

NOTE: You should not use the Noise Reduction pane on photos that have had 
noise reduction applied previously to them.



ON1 Photo RAW 2023 User Guide	 Part 5: Output and Sharing	 219

SHARPENING PANE

The Sharpening pane contains the controls to add additional 
sharpness to your image. ON1 Resize features three 
sharpening methods:

• Unsharp Mask: Good for general sharpening. 
Similar to Photoshop’s Unsharp Mask function. 
Resize’s sharpening is different in that it is only 
applied to the luminance of the image, to prevent 
color artifacts.

• High Pass: High Pass sharpening is helpful when 
the original image is not sharp.

• Progressive: Similar to Unsharp Mask, except it 
sharpens different amounts depending on the 
size of the details in the image. Small details are 
enhanced more than large ones.

Using the Sharpening controls can save you the workflow 
step of adding additional Sharpening before printing and can help compensate for loss of sharpness due 
to dot gain from your printer. Sharpening should only be applied at the end of your workflow just before 
printing. If you plan to do additional retouching or compositing work after resizing your image, you should 
disable the Sharpening controls.

To sharpen your image for output, use these steps after you have adjusted the Document Size pane 
controls:

1.	 Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in 
the Navigator pane.

2.	 Enable the Sharpening controls by toggling the on/off control in the pane’s title bar.

3.	 Select the sharpening method that will provide the best results for your image. You may 
need to experiment to determine this.

4.	 Adjust the amount slider to determine the amount of sharpening desired.

5.	 Use the Highlight and Shadow sliders to limit the sharpening from being applied to the 
darkest and lightest areas of the image which can prevent sharpening of noise.

6.	 Similarly, adjusting the Skin slider can help protect skin tones from being oversharpened in 
the resizing process.
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FACE RECOVERY PANE

ON1 Resize’s Face Recovery feature is designed for times when 
you have a photo with a group of people, and some of the smaller 
faces in the photo have less detail in them. Previously, if you used 
any resampling technology to upscale such a photo, those less-
defined faces could appear even softer than the original photo. 
With ON1’s face-recovery technology, you can resize these types of photos and have those faces appear 
with more realistic features and textures.

To use Face Recovery, click the button to the left of the pane’s label to turn on the setting. Resize will 
analyze the photo, recognize the faces in it, and apply the resampling algorithm to the smaller-sized faces 
(ones less than 512 pixels square in the original) in the photo, using the Strength slider’s setting. 

To view the faces in the image, click on the 
Select Faces button at the bottom of the Face 
Recovery pane. This will display a box around 
each found face in the photo. If the face is 
standard-sized, the box will be white, and 
that face will not have the recovery algorithm 
applied to it. All smaller-sized faces in the photo 
will have a green box around them, and those 
faces will have recovery applied, at the level 
determined by the Strength slider. (The Strength 
setting is applied globally to all of the selected 
faces; you cannot apply different settings to 
each face.) 

Here are a few tips for working with Face 
Recovery:

• With most photos, you should verify 
that the recovery algorithm is being 
applied to the selected faces, and at 
the correct strength for the photo. 
Click the Select Faces button to 
display the faces, and view them at 
100% to make sure you are satisfied 
with the results.

• You can turn each face on (green) or off (white) by clicking inside that face’s box.

• When judging the recovery results, you should look at each face at 100% view. Adjust the 
Strength slider as desired.

• Sometimes, you might find that Face Recovery helps with larger faces in a photo (for example, 
when dealing with faces that are slightly out of focus). Toggle that face’s box on and off at 
100% to see if it improves the results.

• When you’re done with the pane, click the Done button. To work in the pane again, click the 
Select Faces button. Photo RAW remembers all of the faces selected, as well as their on/off 
state.

When you click the Select Faces button, Resize will analyze the photo and put a 
box around every face it finds. Boxes in green indicate smaller faces that will 
be processed with the recovery technology; Boxes in white will not. You can 
fine-tune which faces you wish to have the recovery effect applied by clicking 
in the boxes. 
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FILM GRAIN PANE

The Film Grain setting controls the amount of simulated Film 
Grain (noise) to your image. Adding a modest amount of grain 
can make your image appear sharper visually and can help hide 
imperfections (such as JPG artifacts).

Adding film grain can be especially useful for monochrome 
images, and should be added just before printing. If you need to 
do other retouching or compositing work in Layers after resizing 
your image, you should disable the Film Grain controls in Resize.

To add Film Grain to your image, first zoom in on your image to 1:1. You can do this easily by using the 1:1 
Zoom preset located in the Navigator pane. Then, enable the Film Grain controls by toggling the on/off 
control in the pane’s title bar. Adjust the slider up or down until the desired amount of Film Grain is added.

You can preview just the effect of the Film Grain by toggling the on/off control in the pane’s title bar.

TILING PANE

The tiling feature in Resize divides an enlargement into smaller pieces so that the image can be printed 
on a smaller printer. For example, you might want to create a mural that is 8 feet tall by 12 feet wide, but 
your printer can only print 24-inch wide strips. With the tiling feature you could automatically create four 
separate files that are 24 inches wide and 8 feet tall, to create your mural in sections.

With the tiling feature all you do is specify the size of paper you have to print on and if you would like the 
pages to overlap. Then ON1 Resize will resize your image and section it down into the individual tiles.

When you want to print big, but lack the big printer, Resize’s Tiling feature lets you create flexible, tiled prints on smaller paper sizes.



ON1 Photo RAW 2023 User Guide	 Part 5: Output and Sharing	 222

To use the Tiling pane:

1.	 Turn Tiling on by toggling the on/off switch in the pane header.

2.	 Set the Width and Height fields to the size and orientation of paper that you wish to print 
on, or you can select the number of rows and columns instead.

3.	 Set the Overlap size. The overlap makes each tile overlap so you can tape multiple panels 
together and corrects for printer margins if you are not printing borderless.

The preview will show cyan guide lines for each tile that will be created. The bottom of the Tiling pane will 
tell you how many tiles will be created.

GALLERY WRAP PANE

The Gallery Wrap feature is designed to help you print on canvas. When making enlargements for canvas it 
is common to wrap a portion of the image around wooden stretcher bars, commonly called gallery wraps. 
However, if you had important detail near the edges of the image, it might be lost in the wrapping process. 
The Gallery Wrap feature automatically creates extended margins by reflecting or stretching the areas near 
the edge of the image without having to sacrifice any of the original image. You can select the thickness of 
the mounting bars and use different options for creating additional margins.

To use the Gallery Wrap feature:

1.	 Turn on the Gallery Wrap feature by toggling the on/off switch in the pane’s title bar.

2.	 Set the Thickness control to the amount of margins you would like to add. A good rule of 
thumb is to use the thickness of the stretcher bars, plus half an inch.

3.	 Select the Type you would like to use (see the list below for details on the different options).

4.	 If you wish to add a color overlay to the gallery wrap wings set the color and opacity.

The Gallery Wrap feature lets you choose from four different wrap types,with adjustable thickness and opacity settings for the wrapped edges.
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The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general-purpose technique.

• Reflect Soft: Does the same as the Reflect method but softens the added margins.

• Stretch: The Stretch method takes a small area around the edge of the image and stretches it 
to add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

You can darken the wrap or add a solid color to the wrap area with the Overlay Color and Opacity sliders. 
(The Opacity’s default is 0, which means that there is no color overlay added.)

PRESETS

Resize has a preset system built into it, much like the one used by 
Develop and Effects, but which is designed to help you get very 
specific crops for a wide range of paper and printer types. These 
include settings for photo lab print sizes, and many Epson, Canon and 
HP large-format printers, with multiple media types.

In addition to being able to set document size and settings, and 
settings in any of the other panes, Resize presets always contain a 
Crop adjustment: any time you apply a preset, Resize selects the 
Crop tool and places the crop overlay on-screen. You can resize the 
crop, or move the overlay to a appropriate crop area.

To apply a preset, choose the category you would like to use from 
the Presets panel. The category will expand to a list of the available 
presets for that group. Click on the preset you wish to apply.

Saving a Preset

Once you have your settings that you wish to save, go to the Preset menu and select Save Preset, 
and choose a category you would like to save it in. If you have applied a preset to an image and make 
adjustments to any of the settings in the left panel, you can update that preset with the new setting by 
choosing Update Preset with Current Settings from the Preset menu.

To delete a preset, right-click on the preset in the Presets Browser and choose Delete Preset.

NOTE: You can also import and delete Resize presets from within the Extras 
Manager. See “Extras” on page 9 for more.
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Working with Multiple Images in Resize
You can resize multiple images in a folder from within Resize by using Filmstrip 
view. Clicking the Filmstrip icon in the View Selector at the bottom of the 
screen (to the right of the Detail view icon) will display a strip of the photos 
contained in the current image’s folder. Once the folder is open, you can resize 
each image individually, or you can adjust the settings for one image and sync 
those settings to all (or some) of the images in the selection. When you’re 
finished with your session and click the Done button, Resize AI will save your 
resized photos via the Export window (see page 229 for more on Export).

When you are working on a group of images in Filmstrip view, each image is 
displayed with its original pixel dimensions and its resized dimensions (once 
you have applied Resize settings). You can move between images by clicking 
on them in the filmstrip or by using the arrow keys.

With the open images, you can adjust the resize parameters for each image individually, by moving from 
image to image, or you can edit one image, select any images in the filmstrip that you would like to copy 
those settings to, and click the Sync option at the bottom of the Resize window.

When you use the Sync Settings option, all of the properties of the current image — including crop and crop 
position — will be applied to the selected images in the filmstrip. The crop is re-editable on any image 
during the session. Just click on the image you wish to change, and make your changes.

Turn the Filmstrip view on by 
clicking the icon to the right of 
the Detail view. This will let you 
resize multiple image in Resize. 

When you use the Filmstrip view inside Resize AI, all of the photos in the current folder on disk will be displayed at the bottom of the main window. You can 
select all of the photos by choosing Command-A (Mac) or Control-A (Windows). The current image being worked on will have a bolder highlight around it.
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Some additional notes about batch-processing images and working with the filmstrip:

• If you are using Browse’s Filmstrip view to select multiple images and then click on the 
Resize icon in the module selector, that selection will be maintained inside Resize AI, and the 
Filmstrip mode will open automatically inside the module. If you select a group of images 
in Browse’s Grid view and open them in Resize AI, the selection will remain, but you’ll be in 
Detail (single-image) view. Click the Filmstrip view icon in order to work on other images in 
that folder. 

• To select multiple images in the filmstrip, Control-click (Windows) or Command-click (Mac) on 
each image you wish to select. To select a sequence of images, click on the first image, then 
Shift-click on the last image in the sequence. To select all of the images in the folder, use the 
Select All command (Control-A for Windows, Command-A for Mac). 

• To deselect an image from a group, use the same Control-click (Windows)/Command-click 
(Mac) mechanism. This can be helpful if you wish to sync only some images in a group, or 
remove any images from the export group (see below).

• When you click Done, only the selected images in the filmstrip will be exported. If you have made 
changes to the selection during your session, and want to export the entire group, use Select 
All.

• The Reset All command only works with the currently selected image. If you need to reset all 
of your work, either choose Cancel, which will take you back to Browse , and reopen the 
batch. Alternatively, you can click on each image, choose Reset All, and move to the next 
image.

After you have resized your photos, either individually, or via the Sync command, the new pixel dimensions for each image will be 
displayed at the bottom of each thumbnail in the filmstrip.
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SOFT PROOFING IN RESIZE

ON1 Photo RAW’s soft proofing feature lets you see how a photo will look when printed, using the color 
profiles that get installed with your printer. Soft proofing helps you determine where there might be issues 
when you print, so that you can adjust your tone, color and effects to give you a print that is closer to your 
editing vision.

Normally, when you’re viewing an image in Photo RAW, 
you are viewing it through the lens of your monitor’s 
display profile. The color gamut of your computer’s 
display is wider than that of most photo printers, which 
means that some colors you are able to view on-
screen are not reproducible when you print. When this 
happens, the color profile conversion that happens in 
the print engine will cause substitutions of colors that 
the printer cannot print to the closest color that it can. 
This means that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or by 
clicking on the soft proofing icon to the left of the 
Preview button at the bottom center of the main Resize 
window. The background of the main preview window 
will change to approximate the color of the paper you’re 
profiling. 

Additional soft proofing options are available 
underneath the Enable Soft Proofing command in the 
View menu. The options are as follows:

• Gamut warning: When checked, this displays 
colors in the image (via a red overlay) that 
don’t correspond to the current printer profile 
being soft proofed.

• Profiles: The Profiles submenu lists the 
currently available printer profiles. Choosing 
one will change the on-screen display to use 
that profile.

• Intent: Photo RAW offers two different 
rendering “intents” when soft proofing, 
which are used to convert the color from 
display to print. Perceptual shrinks the color 
gamut during the conversion, which works to 
preserve the relationship between colors in 
the image. The other intent type, Relative, only 
converts colors that are outside the current 
color gamut, but this can sometimes cause 
two colors, one in gamut, and one outside, to 
be identical after conversion.  

These three screen shots show the results of soft proofing options, 
as viewed in Resize. The top image is with soft proofing off (and is 
using the display color profile). The middle image is with soft 
proofing turned on, and using a printer profile for Epson’s 
Exhibition Fiber Paper. The bottom image has the Gamut warning 
turned on; out of gamut colors are highlighted by the bright red 
overlay.
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Neither rendering intent is perfect or desired; it often is a matter of the makeup of the image, 
your editing intent, the paper being printed on, and so forth. Often, you’ll want to switch back 
and forth between Relative and Perceptual, seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause Photo RAW to use the white point 
for the chosen paper type (instead of the white point of your monitor), and the paper’s actual 
black density (instead of the display’s black point). If you’re trying to match a print, you will 
usually want this setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. It’s easy to get caught up in eliminating 
out-of-gamut colors, but most modern photo printers—both home printers and online print services—do a 
pretty good job of approximating colors properly. 

NOTE: Since you can’t edit the tones in your photo from within Resize, it’s a 
good idea to perform a soft-proof check in the Edit module before taking an 
important image into Resize. 

The biggest thing you want to be looking for when viewing a soft proof is tone, contrast and color accuracy 
between screen and print. When using a home printer, use test prints to hone in on the right mix of Edit 
module adjustments. Photo RAW’s Versions feature can be extremely helpful when you’re tweaking 
settings to get a print just right (see page 63 for more on working with Versions).

Understanding Resize AI: How Big Can I Print?
People often ask how big you can print with ON1 Resize AI. The simple answer is this: if your original photo 
is sharp, with good details and little noise, you can print almost as big as you desire. The limitations are the 
size of your printer or the capacity of your computer to work with large file sizes. In practice, however, even 
the largest prints are rarely more than 400 percent larger than the original photo. 

Historically, the standard viewing distance for photographic prints is generally considered to be twice the 
diagonal measurement of a print. For example, the ideal viewing distance for an 8x10-inch print would be 
slightly more than two feet away, while the viewing distance for an 80x100-inch print would be over 21 
feet. That last distance might seem like a lot, but that’s the kind of mural — almost 9 feet tall — you would 
see at an airport or shopping mall. (Keep in mind too that many photographers scrutinize their images closer 
than standard viewing distances; most people don’t get that close.)

Photos are perceived in color, tonality, textures, and sharpness. Other interpolation techniques maintain 
color and tonality but sacrifice textures sharpness by “inflating” the image uniformly. The image still looks 
similar, but will not be crisp. Depending on the amount of interpolation, this can be severe and noticeable 
even at standard viewing distances. ON1 Resize AI maintains the color, tonality, textures, and sharpness of 
a photo at all sizes. It can actually create new detail at the proper scale.
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How Much Resolution Do I Need?
To answer this, you need to know two things:

1.	 The size of the print you wish to make.

2.	 The resolution that your printer needs for best results.

The size of the print can be as large as you would like, although, obviously, you will be limited by the 
maximum print size of your printer (although tiling can help). 

Resolution is the density of the pixels for a given measurement, usually in pixels or dots per inch (or 
cm). Most modern inkjet printers print anywhere from 1200 to 4800 dots per inch, but what the printer 
manufacturers really mean is 1200-4800 droplets of ink per inch. A common mistake is to set the 
resolution of the file to the resolution of the printer. In all but a few specialty printer types (like dye-
sublimation) this will lead to huge files that will not print well, if at all.

The secret is that the human eye cannot see more than 250-300 pixels per inch, and the ideal resolution for 
your files should be close to this. Once you know the print size and resolution, it is easy to use Resize AI to 
scale your file to the desired output size. Simply enter the resolution and the output specifics in the ‘Resize 
to’ section of the Photo Size pane. You’ll see that the corresponding dimension is automatically computed 
by Resize AI based on the proportions of your image.

Keep the proportions in mind because the proportions of film, digital camera sensors, and paper can all be 
different. For example, most digital camera sensors are proportioned so that the height is two-thirds the 
width or 1:1.5; While the most common paper size, in the US, is the letter which is 8.5×11 inches or about 
1:1.25. These kinds of proportion mis-matches are common and require that the original image be cropped 
to fit the proportions of the paper size. If your image cannot be cropped without ruining the composition, 
then you will need to adjust your print size to a longer dimension.

Resizing an image larger than the original size requires new pixels to be created. This process is called 
interpolation or resampling. There are many mathematical ways, called algorithms, to do this. The most 
common method used by many pixel-editing apps is called bicubic interpolation. Bicubic along with its 
newer variants bicubic smoother and bicubic sharper work by averaging a small group of neighboring 
pixels to determine the color value of the new pixels to be added. While this technique is fast, it does not 
distinguish edges so there is a uniform loss of sharpness and detail across the image.

Resize AI uses a neural network trained on millions of examples of photos. It is fundamentally different 
from bicubic or other interpolation methods. It can analyze the photo and faithfully recreate textures in 
nature, at the proper scale, all while maintaining the sharp details and reducing noise and artifacts. All this 
number crunching may take a bit longer than the single pass interpolation methods like bicubic, but good 
things come to those who wait and the reward is far superior results.
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EXPORT
Export is a special function that is available throughout ON1 Photo RAW 2023, whether 
you’re working from within Browse, Edit or Resize AI. The Export window gives you much of 
the power of Resize in an easy to use panel, letting you export your photos with incredible 
flexibility, ease and control.

The Export window is separated into two panels: Export Presets and Export Options. The Options panel 
contains specific types of options—file renaming, destination folders, file type and more—that you can use 
when you are exporting images from Photo RAW. If you find that you are using a specific set of options all 
the time for your workflow, you can create a preset and apply that whenever you use Export.

The contents of the Export window include:

A.	Export Presets: The current preset (if used), will be represented with a selection box around 
it, and the filled circle to the left of the preset name means that it will be used when the 
Export button is pressed. To use the Export Options panel without any preset applied, turn 
off all of the presets in the list, and click in the current preset once.
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B.	 Save Preset: Lets you save the current set of export options as a preset.

C.	 Naming: Renames the exported file based on criteria added to the rename box in the panel.

D.	Destination: Lets you set the destination of the exported files. (required)

E.	 File Type: Sets the file type for each exported file. (required)

F.	 Resize: Adjusts the size for each image. (not available when exporting from the Resize AI module) 

G.	Sharpening: Applies sharpening to the exported images.

H.	Metadata: Adds/removes metadata from the export. 

I.	 Watermark: Lets you add a text or graphic watermark to an exported image. 

J.	 Export/Cancel: Starts the exporting, or cancels it and returns you to Photo RAW.

 Export Options

NAMING

The Naming pane gives you extensive controls for creating customized filenames using tokens in the entry 
box inside the pane, as well as with any custom text entered directly into the entry box. You can use any 
combination of tokens and text in the entry box, and the Example label directly above the box will display 
what your new filename will look like, using the 
first item in the export group.

To use this feature, click the control circle to the 
left of the label in the panel. Add any custom 
text, or click the Add Token pop-up menu to add 
tokens based on information associated with the 
image, including filename data, date and time 
information, and associated metadata There are 
four submenus in the Add Token menu:

• Filename, which includes options for using the original filename, number suffix (taken from 
the image as recorded by the camera) and enclosing folder name.

• Date/Time, which includes a list of date (year, month, day) and time data that can be 
combined in various ways.

• Sequence, which adds an incremented number to each renamed file in the batch, as well as 
the total number of files in the batch, with options for leading zeros in the resultant filename. 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file. Each change you make will be updated automatically in the Example label.
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The Presets pop-up menu at the top of the Rename window includes a set of common batch combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Photo RAW will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found on page 236.

DESTINATION

The Destination pane is where you set the 
desired location for the exported images. At 
minimum, you must specify a destination folder 
for your export, but the pane has a number of 
options for adjusting the export location:

• The Folder pop-up menu lets you 
choose the same folder as the original 
images, another folder, or, can be set 
to ask for a destination every time, 
which can be helpful when you’re 
using an export preset.

• Checking the Put in Subfolder option 
will export the images to the folder—
or, create a new folder, if it doesn’t 
exist—specified by option’s text field.

• The Existing Photos pop-up is for 
those times when there might be a 
naming conflict within the destination 
folder. Replace will overwrite the file 
with the new one being exported, Skip 
will leave the destination file alone 
and not export the new file, and Keep 
Both will add a number ‘1’ to the end of the filename of the exported file, preserving both 
files.

• Generate Subfolders will subdivide the export based on the exported file’s metadata, 
creating subfolders as necessary—or, if the folders exist, placing the exported file into the 
appropriate subfolder. This option uses the same token-driven scheme (and presets) used in 
the Naming pane.

• After Export lets you determine what to do when Photo RAW completes the exporting 
process. Options include displaying the image location in the MacOS Finder or Windows 
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Explorer, to create a ZIP archive of the exported group, to open in another editing application, 
or to run a script.

FILE TYPE

Like Destination, File Type is the other required 
element for using Export. Photo RAW can 
export in DNG, PSD, TIFF, JPG and PNG 
formats. With the exception of DNG and PNG, 
each file format has specific options in the pane:

• Original includes options for embedding metadata and saving an ON1 sidecar file with the 
exported images.

• JPEG includes options for JPEG quality and for attaching a color profile.

• Photoshop includes options for attaching a color profile, bit depth, and whether to flatten 
any layers in the original image.

• TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit 
depth, and to preserve transparency.

• DNG and PNG have no additional options.

The File Type pane also includes an estimated file size for the first item in the group.

RESIZE

The Resize pane lets you adjust the finished 
dimensions of the exported photos, using the 
ON1’s Resize AI technology found in Photo 
RAW’s Resize module. It has seven options for 
export: Dimensions, Long and Short Edge, Width 
and Height, Megapixels and Percentage. Each 
option has a different range of settings, and all 
have a setting for resolution (in pixels per inch, or ppi), as well as a Don’t Enlarge option, which, when set, 
will not upscale a file past its native image dimensions (but will still export the file).

NOTE: The Resize pane is not available when using Export from within the 
Resize AI module, as the resizing parameters are driven by the module itself.

The Dimensions option is the most complex of the six Resize options, letting you set the exact pixel 
dimensions of the exported files, in terms of width and height. This option is best for when you are 
exporting single images, when all of your exported files have the same aspect ratio and orientation, or 
when you wish to fit the exported images to an exact size. 

The Common Sizes pop-up menu at the top of the pane options lets you set the final dimensions to any of a 
broad array of common paper, photographic ratio, square and video formats. You can also create your own 
specific sizes for re-use via this menu.

The Resize pane, with the Dimensions option open.
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Click the lock to resize the images proportionally as you enter either the width or the height, or, if you wish 
to fit the images to an exact width and height, click the lock icon to turn it off. If an exported image doesn’t 
exactly fit the dimensions you set for Width and Height, Export will do one of two things, depending upon 
whether you have Fit in Dimensions or Fill Dimensions set in the pop-up to the right of the Resolution box.

• Fit in Dimensions will fit the file inside the boundaries of the width and height settings.

• Fill in Dimensions will zoom the exported image to completely fill the boundaries of the 
width and height settings, essentially cropping the exported image. If the image’s aspect ratio 
is different from the width and height settings, the image will be filled from the center. 

The Dimensions options include one more setting, Rotate to Match Photo, which, when checked, will rotate 
an exported photo to maximize its orientation. For example, if you exported a group of images to fit a 
landscape orientation (longer width than height), any image that was in portrait orientation (longer height 
than width) would be rotated during export.

The remaining options in the Resize pane include:

Long Edge and Short Edge are useful when you want to lock one edge to a 
specific length or width and don’t care about the sizing of the other edge. 
Simply choose which option is the important one for your photos, enter the 
dimension, and Export will resize your images proportionally based on the 
chosen setting. When you’re exporting a group of images with different 
orientations (landscape or portrait), these options will ensure that all images 
have the same long or short edge dimension.

Width and Height will resize all of the images proportionally to the width 
or height defined, regardless of orientation. Exporting photos with different 
orientation will result in the width or height of every image being the same, 
depending upon the setting chosen.

Megapixels will export images to a specific megapixel count, while Percentage will enlarge or reduce the 
size of the exported images. Percentages below 100 will reduce the image, while those above 100 will 
enlarge the image.

SHARPENING

The Sharpening pane has two modes, Sharpen 
For and Manual. The Sharpen For pop-up 
menu lets you choose from six options, based 
upon your final intent. There are four options 
designed for print output, Glossy Paper High 
and Low, and Matte High and Low, and two 
option for display output (for social media or 
online sharing), Screen High and Low.

The Manual setting provides a bit more control 
over the output sharpening, letting you adjust 
the Amount (overall strength), Radius (detail) and Threshold (masks out areas that shouldn’t be sharpened 
based on contrast). 

For more specifics about the Manual sharpening options, see the Sharpening filter on page 73.

Resize has seven options for 
exporting images.
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METADATA

The Metadata pane lets you set which pieces of 
metadata are exported—or not exported—with 
the images in the export set. You can choose to 
export all Metadata or by clicking the control 
circle to the right of the All Metadata label. 
If you click that label off, you can then select 
which metadata items you wish to save by 
clicking the appropriate label.

The metadata information exported is the same 
data found in the Metadata pane in Browse, and any metadata presets you have saved will be available 
from the Presets pop-up menu. For specifics on the different types of data represented in the Metadata 
pane, see page 39. 

When checked, the Remove Unmanaged XMP button only exports metadata that is represented in Photo 
RAW’s Metadata pane; any other unmanaged image metadata from other apps will not be included. 

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for 
size and positioning, opacity, font type, and more. 
You can import your own logos and save either 
watermark type as a preset for frequent use. 

The Watermark pane also gives you a representation 
of your chosen watermark (on the first image in your 
export group), so you can adjust the parameters of 
the watermark precisely.

To create a new watermark, turn on the pane by 
clicking on the control circle to the right of the label. 
Choose either a preset from the Presets menu or 
click on the Add Watermark button in the lower 
right of the pane and choose either Text or Logo 
from the pop-up menu. Once you’ve selected a type, 
the bottom of the pane will open with settings for 
the chosen option. If you change your mind, click the 
Cancel button to the right of the Logo or Text labels.

Using graphics-based watermarks

The Logo section of the Watermark pane lets you 
use either watermark files imported via the Extras 
Manager (see page 9), which will be displayed 
in the File pop-up at the top of the Logo section, or 
by clicking on the Import button to the right of the 
menu (which will add them to the menu). 
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Use the Position grid at the bottom of the pane to place your watermark, and use the Size and Inset sliders 
to move it within the area chosen. The Opacity slider adjusts the transparency of the watermark on the 
final image.

The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen 
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections 
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for 
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting 
to social media—it needs to be the same size as what you are exporting for the web, typically over 1000 
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because 
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency, 
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text 
section of the pane has an entry box for your 
watermark text, a font selection area, and the same 
Appearance and Position options found in the Logo 
section.

The text entry box can contain multiple lines of 
custom text, and has the same token-based naming 
options found in the Naming pane (discussed on 
page 230), which can be helpful when exporting 
informational slides or for other data-driven uses.

You can set the font from the pop-up menu, and 
the font color by clicking the swatch on the left side 
underneath the font name. The text style can be 
set to bold, italic or underline, and the alignment to 
left, center or right. If you’d like to add a background 
color to the text box, turn on the Color Fill button 
on the right side of the pane.

Use the Position grid at the bottom of the pane 
to place your watermark, and use the Size and 
Inset sliders to move it within the area chosen. 
The Opacity slider adjusts the transparency of the 
watermark on the final image.

Saving watermark presets

Both watermark types can be saved as a preset 
for re-use later. To save a preset, adjust your Logo 
or Text settings as desired, and choose Save New 
Preset from the Presets menu. If you wish to adjust 
an existing preset at a later time—with a new logo 
file, for example—choose the appropriate preset 

With text-based watermarks, you can not only create simple, single-line 
watermarks showcasing your business, but you can also create 
data-driven watermarks (using tokens) for presentations and the like.
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from the Presets menu, make your changes, and choose Update Preset with Current Settings from the 
Presets menu. You can also rename and delete watermark presets from this menu.

Exporting and Export Presets
The Export window has been designed to offer as much or as 
little complexity as you would like. At its simplest, you can set the 
Destination and the File Type to your desired settings, leave all of 
the other panes alone, and click Export. Photo RAW will remember 
your last Export setting—including anything you did in the Naming 
pane—the next time you export, so you don’t have to worry about 
which settings need to be set, and which ones don’t. You can use 
the Show/Hide buttons in the title bar of each pane of the Export 
Options panel to display only those settings you want to see.

Once you have your settings the way you’d like, you can save them 
as a preset by clicking the Save Preset option in the Preset panel 
on the left. Then, when you click that item in the Preset panel, the 
Export Options will be set to the specifications of that preset.

The Export Presets panel will display a list of the currently 
available presets. If you have selected a preset, it will have a 
selection box (in the app’s accent color) around it, and if the control 
circle is filled, the preset is on, meaning that clicking the Export 
button will export using that preset. If you don’t wish to use a 
preset, click the control circles off on all of the presets in the list.

By default, each preset will have up to three lines of explanatory 
text underneath the preset name, displaying the file type—DNG, 
PSD, TIFF—and the Destination information. This can be helpful 
when you’re scanning presets for a specific destination, but you 
can also collapse the preset to its title by clicking the Hide button 
in the title bar.

When you change the settings for a selected preset, Photo RAW 
will ask you if you wish to update the preset with the new settings 
either when you click the Export button to start the process, or 
when you switch to another preset with the Export window.

It is possible to export more than one preset at a time. Every preset 
in the Presets panel that has the control circle set to On (filled) will 
be included in the export operation. This might be helpful to create backups on another disk, for example, 
or to build proxy versions for use while the original is being edited.

About Photo RAW’s File-Naming Tokens
When using the Naming option in the Export window—or with Browse’s Rename File (page 47) and 
Import Photos (page 44) functions—Photo RAW includes a broad set of tokens that you can use as part 

All presets include an informational view that lists 
the export file type, the destination folder, and 
resize information. If you don’t wish to see that, 
click the Hide button to collapse the view to just 
the preset title.



ON1 Photo RAW 2023 User Guide	 Part 5: Output and Sharing	 237

of the strings to build complex file names, in conjunction with any custom text you wish to enter. These 
tokens draw on image metadata, including filenames, dates taken, and EXIF and IPTC metadata fields, and 
can be used in any number of combinations.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence, 
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the 
filename or the enclosing folder that the file resides 
in. There are three options, Filename, which adds the 
current filename of the file being worked on; Filename 
Number Suffix, which takes the index (shot) number 
from the original raw file, if available; and Folder Name, which grabs the name of the folder in which the 
renamed (or imported) file resides.

DATE/TIME

This submenu consists of 17 combinations of date and 
time data, as taken from the image’s metadata. There 
are prebuilt date and time combinations (20220104, for 
example, for a year-month-date token) in the list, or your 
can build your own combinations out of the subtokens 
listed in this menu. 

Year data can be presented in either 4- or 2-digit 
numbers, and Month data can be presented in month 
number, full name, or 3-letter abbreviations.

You can use a combination of tokens and custom text to rename files (in Export or Browse) to exacting 
specifications, all drawn from file information, metadata and more.
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SEQUENCE NUMBER

The Sequence Number tokens come into play when 
exporting, importing or renaming a group of image files. 
There are essentially two tokens here, Sequence and Total, 
with options for padding zeros into each item. Sequence will 
take the group of images being worked on and, starting with 
the first item in the selection, will start at 1 and increment 
by one as each image is processed. The Total token will 
always be a single number—the number of items in the group 
being processed.

The combination of Sequence and Total tokens lets you 
create strings like ‘filename_07 of 22’ as part of the new filename.

METADATA

This submenu has five items, each with its own submenu. 
All of the items create the chosen token based on the 
embedded metadata for each image being renamed, 
imported or exported. The specific text pulled from the 
Camera and IPTC tokens will be visible in the Metadata 
pane’s EXIF (for camera-specific data) and IPTC (for IPTC 
data) tabs. The Ratings and Labels tokens are taken from any 
you have applied in Photo RAW. 

NOTE: If there is no information in the specified Metadata token, it will be 
ignored during processing.

Camera

The Camera submenu includes 21 items, all of which are 
directly taken from an image’s EXIF data. Not all cameras 
capture all of the items listed, but most of them save essential 
items like exposure information, focal length and more.

To look at the available camera information of any image, click 
the EXIF tab in Browse’s Metadata pane (page 39).
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Ratings and Labels

The three tokens in the Ratings and Labels submenu pull 
information from any rating, label and like information you’ve 
made to images in Photo RAW.

The Rating token will add the number of stars an image is rated, 
while the Label token will add any color label information (red, 
yellow, green, blue, purple), and the Likes token will add Liked, Not Set, or Disliked to the image name.

IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers 
much more detailed metadata information than EXIF. It historically has been used by journalists and stock 
photographers to catalog and tag photos, as well as add copyright information, captions, and other data. 
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact, 
Content, and Image. All of these fields are visible in the IPTC tab of the Metadata pane in Browse (page 
39), and can be added during the import process as well. 

Using IPTC information makes the most sense when you have a strict method for importing and 
categorizing image data during import (or shortly thereafter).
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PRINTING
ON1 Photo RAW 2023 has a flexible print engine that can print photos at any size. You can print photos 
individually; multiple photos package style, on a single piece of paper; and contact sheets for evaluating 
images. You can print from any module at any time. 

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A.	Preview: Displays the photo or photos being printed.

B.	 View Selector: Lets you view the photos being printed individually, in facing-page view, or in 
grid view. The icon on the far right turns soft proofing on and off.

C.	 Filmstrip: Shows all of the photos that have been selected for printing, with check marks to 
turn printing on or off. (The Filmstrip is not visible when a single image has been selected for 
printing.)

D.	Page view: Displays the number of pages being printed, and lets you move from page to page.

E.	 Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

F.	 Print Area pane: Contains options for fitting and selecting the print image size.

G.	Watermark pane: For adding a watermark to printed photos.

H.	Sharpening: Options for sharpening during the print process.

I.	 Print/Cancel: Print One (current image), Print All, or Cancel.
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Printing Options
The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that 
has between 240 and 360 ppi. (Photo RAW will use its internal 
resampling engine to ensure that your photo is at the print 
resolution you choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. 

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. (You can use Photo RAW’s Soft 
Proofing feature to look at out-of-gamut colors in your photos. See “Soft Proofing” on page 73 for more.)

NOTE: Photo RAW’s Print feature will work with borderless printing options 
as well. Be sure to choose your printer’s borderless options in the page setup 
pop-up. Different printers will have specific borderless settings, so check the 
manual to see how to turn borderless printing on.

Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, click 
on the File icon at the top of the pane. Photo RAW will ask you for a filename and a location to save the 
file. Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When 
you choose Print, Photo RAW will create a PDF of the photo (or photos) and save it with the name and 
destination you specified earlier.

The Printer pane sets printer-specific options for 
the current print job. You can also choose to render 
the print job to a PDF file.
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PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually, package-style, or to 
create a contact sheet for evaluative purposes. 

The top of the pane includes preset styles for either fitting the 
current photo inside the print size, or filling the entire print size;  
options for printing at common print sizes, including 8x10, 5x7, 
4x6; and options for printing to a contact sheet. You can also 
create custom print sizes via the Custom section at the bottom 
of the pane; just set the width and height of the print size, and 
whether you wish to fit the image to the print size, or to fill the 
frame with it. If you would like to save this print size as a style, 
click on the More pop-up at the top of the pane, and choose Save as New Style from the menu. You’ll then 
be able to recall that style from the More pop-up whenever you print.

If you are printing multiple photos, Photo RAW will attempt to put as many photos at your chosen print size 
on the paper size as defined in the Printer pane. To print only one photo per page, click that option at the 
bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print 
size of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, and is 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs to be at least 600 pixels wide. Otherwise, 
it could appear pixelated on the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in the Edit module. 

The Sharpening pane lets you select a type of sharpening that will 
be applied to your photos during the printing process. The pop-up 
menu has a set of options for general sharpening, including ones 
for a standard print, glossy papers, details, high-pass sharpening, 
and many more. Depending upon the image, you might need 
to play with the settings here; performing test prints on small 
sections of a photo can often be quite helpful in determining the proper level of sharpening in a print.

Basic printing with Photo RAW
Printing is available throughout the ON1 Photo RAW 2023 interface. If you are viewing a photo in either 
the Edit or Resize modules, or if you have an image selected in Browse’s Grid or Detail views, clicking the 
Print icon will open the Print window with that image. There, you can set any of the options in the four 
panes on the right, and click the Print button to output your photo. 

Use the Sharpening pane to add additional 
sharpening to your printed image.
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If you wish to get an on-screen proof of the final image before you print, using the chosen color profile for 
the media type you are using, click the soft proofing icon underneath the preview area.

PRINTING PHOTOS FROM ON1 CLOUD SYNC DEVICES

Any photo that can be displayed on your computer can be printed, even proxies of photos that reside on 
one of your ON1 Cloud Sync devices. In most cases — especially at smaller print sizes (8x10 and under), the 
proxy photo will have more than enough resolution to print at high quality. If you are printing at larger sizes, 
or wish to use all the available image data for your photo, either copy the file from your synced device to 
your computer, or change the sync setting for the photo’s enclosing folder on the synced device, so that the 
original is in the ON1 Cloud.

PRINTING MULTIPLE PHOTOS

To print multiple photos—as a package or contact sheet—select the images you wish to print from the Grid 
or Filmstrip views (in Browse or Edit), and click the Print icon. The photos you’ve selected will be displayed 
in the filmstrip at the bottom of the window, and the preview area will display the current page (at the 
printer’s page size) and print size settings. If you are printing a lot of photos at one time, you can flip from 
page to page via the Page View buttons under the preview. To see more pages,  click on the Facing Pages or 
Show All Pages icons at the bottom left of the window.

The Print feature gives you extensive options for printing multiple pages package style. Here, we have selected 24 photos to 
print at 5x7 inches on a letter-size sheet, on an Epson P600 printer. Clicking on the View All Pages button underneath the 
preview window, you can see all of the photos to be printed. Clicking Print One will print the currently selected page; clicking 
Print All will print the collection.	
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If you decide that you don’t want to print a photo, click the checkmark for that photo in the filmstrip. To 
print all of the photos currently selected, click Print. If you would like to try a test print, with a single page, 
click on the Print One button, which will print the currently selected page, as found in the Page View listing.

Printing contact sheets

When you wish to evaluate a group of images but don’t want to waste larger sheets of photo paper, use the 
Contact Sheet feature in the Print window. Select the photos you wish to print, set the paper size in the 
Printer pane, and click on the Contact icon in the Print Area pane.

When you switch from Package to Contact mode, you have two options, as found in the Custom section of 
the Print Area pane:

• Columns: lets you set the number of columns across the page width. The smaller the number 
of columns, the larger the individual cells.

• Captions: Currently, Photo RAW lets you add the filename as a caption underneath the 
printed photo. Click the button to the left of the label to turn this on or off. (We will be 
adding additional caption options in future releases.)

You can use the Page View controls underneath the preview area to move between pages, and, when 
you’re ready to print, click the Print All button to print the contact sheets.

The Contact Sheet option lets you evaluate a large group of photos in a high quality print, with captions.
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SHARING TO SMUGMUG
If you are a member of the SmugMug photo sharing and hosting service, ON1 Photo RAW 2023 
offers an easy to use mechanism for posting one or multiple photos to the service. This is 
accessed via the Share menu, which is found throughout Photo RAW in the lower right section 
of the Module selector. On Windows, the Sharing button’s pop-up contains only the SmugMug 

option; on MacOS, there are additional sharing options beyond SmugMug (see page 247 for more 
information on these options). 

You can share a the currently selected photo or a group 
of photos by choosing SmugMug from the Sharing pop-up 
menu. The first time you access the service, you’ll receive an 
authorization window inside Photo RAW; fill out your account 
information and password, and then click on the Authorize 
button. 

Once authorized, you’ll be presented with a window that lets 
you upload your photo or photos. The window contains a 
handful of options:

• Click the “Use photo metadata” control to include 
the photos’ metadata for use in the title, caption and 
keyword.

• The Gallery pop-up lets you add the photos to an 
existing gallery, or lets you create a new gallery. 

• The Open Gallery link to the left of the pop-up will 
open the currently selected gallery in your default 
web browser.

• The Size pop-up has three options, full-size, and 
either 4000 or 2000 pixels (on the long side).

Once you have selected the appropriate options, click the 
Share button. Photo RAW will create high-quality JPEGs of the 
chosen photos and publish them to SmugMug.

More information about SmugMug can be found at smugmug.
com.

The first time you share to SmugMug, you’ll be asked to 
log in to your account, and verify that you want to let 
Photo RAW post to your galleries on the site.

When you post to SmugMug from Photo RAW, you can 
include metadata, choose the gallery to you want the 
photos to go into, and the size of the uploaded photos.



ON1 Photo RAW 2023 User Guide	 Part 5: Output and Sharing	 247

SEND TO OTHER APPLICATIONS
The Browse module inside ON1 Photo RAW 2023 can send images you are 
viewing to other applications for editing. This is done via the Send to option, 
which is available from the right-click contextual menu or the Edit menu. 
ON1 Browse automatically detects the following common photo managers 
or editors and lists the latest installed version:

• Adobe Photoshop

• Adobe Photoshop Lightroom

• Adobe Photoshop Elements

You can set up any application you want to send your photos to. Simply 
select the Send to Other Application option. Then select the application you 
want to send your photos to. The application will be remembered and listed 
with your other Send to options. (For example, if you use an email client you 
can add it to easily email photos.)

When you send an image to another application, you will be presented with 
the Edit in dialog box from ON1 Photo RAW 2023. There you’ll have the 
option to send either the edited photo or the original, unedited image. If you 
choose to send a copy, you’ll have options for choosing the file type, color 
space, bit depth and resolution. If you use the same set of options every 
time, you can check the “Don’t ask me again” box in the window, and you 
won’t be prompted again. (To change this setting, go to the File pane in 
Photo RAW’s Preferences.) The Send To... section is available 

when you right-click on a photo inside 
Browse pop-up menu. 

The Edit In dialog, with the Copy Options section expanded.
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OTHER SHARING OPTIONS (MAC ONLY)
In addition to SmugMug publishing, the MacOS version of ON1 Photo RAW 2023 includes other photo-
sharing options, including:

• Mail: Creates a new email message in Apple Mail with the shared 
photo.

• Messages: Shares photo to Apple’s Messages app.

• AirDrop: Uses Apple’s AirDrop networking feature to share with 
local MacOS or iOS devices. 

• Notes: Adds the shared photo to Apple’s Notes app. You can choose 
to create a new note, or add the photo to an existing note.

• Add to Photos: Adds the photo to Apple’s Photos app.

• Reminders: Adds to the Reminders app.

• SmugMug: Post photos to the SmugMug service (see page 246 for details).

All of the sharing options perform the same operation: Photo RAW exports a full-size JPEG of the selected 
photo and shares it with the selected target from the list. 



PART 6: 
ON1 PHOTO RAW 2023 

REFERENCE
• Menus (page 250)

• Preferences (page 266)

• Moving Your Lightroom Classic Catalog to Photo RAW (page 272)

• Backing Up and Restoring Photo RAW (page 276)

• Keyboard Shortcuts (page 277)
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Browse menus
ON1 Photo RAW (MacOS Only)

• About ON1 Photo RAW 2023: Opens the About box, 
displays your version number. (In the Help menu on 
Windows)

• Preferences: Opens the preferences dialog. (This is in 
the Edit menu on Windows)

• Quit ON1 Photo RAW: Quits ON1 Photo RAW 2023.

File Menu

• New Canvas: Creates a new .onphoto file at the 
dimensions you choose and opens it in Layers.

• Browse Folder: Opens the browse dialog where you can 
select which folder you would like to browse.

• Browse Home: Navigates to your home Pictures folder.

• Browse Desktop: Navigates to your desktop.

• Advanced Search: Opens the Advanced Search window.

• Import from device: Opens the Import window.

• Add Cataloged Folder: Lets you choose a folder to add 
to the Cataloged Folders section of the Folders pane.

• Copy to My Catalogs: Copy or move a group of selected 
photos to a specific cataloged folder.

• Remove Cataloged Folder: Removes the selected folder 
from the Cataloged Folders pane.

• Manage Extras: Opens the Extras Manager for 
importing and exporting backgrounds, presets, textures 
and more.

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format.

• Smart Organize: Opens the Smart Organize window, 
which lets you search for duplicates, and images similar 
in appearance, date, or time.

• Edit in (module): Opens the currently selected photo in 
the specified module.

• Open as Layers: Opens the selected files as layers.

• Edit Single Photo: Opens the selected files in Edit’s 
Single Image mode.

• Fire Camera: Triggers the shutter of a connected 
camera when Tethered Shooting mode is active.
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• Send to (list): Sends your image to the selected 
application in the list.

• Group RAW Plus JPG: Stacks RAW and JPG pairs 
together, reducing clutter.

• Merge to Panorama: Takes the selected images and 
opens the Create Panorama window.

• Create HDR: Takes the selected images and opens the 
Create HDR window.

• Create Focus Stack: Takes the selected photos and 
opens the Focus Stack window.

• Timelapse: Takes a sequence of photos and converts 
them into a time-lapse movie.

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using 
a preset from the hierarchical menu, bypassing the 
Export window.

• Export with Previous: Exports the current selection 
with the last-used Export setting, bypassing the Export 
window.

• Print: Opens up the print window.

• Restore Data: Restores your ON1 Photo RAW 2023 
system settings and environment to a previous backup.

• Back up Data: Backs up your current Photo RAW 
system settings and environment.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available 
if the last thing you did was an undo.

• Select All: Selects all the images in the current folder.

• Select None: Deselects all the images in the current 
folder.

• Deselect: Deselects the current item.

• Copy: Copies the currently selected items.

• Paste: Pastes the items in the clipboard to the current 
location.

• Duplicate: Makes a physical copy of the selected file, in 
the same location as the original.

• Rename Files: Renames the selected file or folder.

• Delete: Moves the selected files and/or folders to the 
trash.
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• Add Subfolder: Adds a new empty subfolder inside the 
current selected folder.

• Keyboard Shortcuts: Lets you add or modify the 
hotkeys for many of Photo RAW’s commands.

Album Menu

• Create Album: Creates a new Album.

• Rename Album: Renames selected Album.

• Delete Album: Deletes selected Album.

• Remove from Album: Removes selected photo(s) from 
Album.

Photo Menu

• Rating: Sets star rating (0 to 5 stars)

• Color: Sets the color rating of a photo (None, Red, 
Yellow, Green, Red, Purple)

• Like: Sets a photo to Like, Reject or Not Set

• Auto Advance: When checked, any color, rating or like 
setting applied to a photo will save it for that photo, 
then move on to the following photo.

• Rotate 90 Degrees CW: Rotates an image clockwise by 
90°

• Rotate 90 Degrees CCW: Rotates an image 
counterclockwise by 90°

• Edit Capture Date: Let’s you adjust the date captured 
metadata, including a setting to take account for time 
zone changes.

• Set Location from GPS Coordinates: Looks up the place 
name information from the stored GPS coordinates and 
embeds it in the appropriate IPTC metadata fields.

• Embed Metadata: Stores adjusted metadata to the 
selected photo. (Only applicable to certain file formats.)

• Read Metadata from Photo: Reads the embedded 
metadata from a raw file, overwriting any data that 
might be in the XMP sidecar files. (Useful for times 
when the metadata appears out of sync with different 
apps.)

• Save Metadata Preset: Lets you save some or all of the 
current image’s metadata fields as a preset.

• Delete Metadata Preset: Lets you delete a saved 
metadata preset.

• Refresh Preview: Rebuilds the preview of the selected 
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images. (Helpful if there are issues that are causing an 
image to display incorrectly.)

Settings Menu

• Reset All Settings: Resets all the applied settings on a 
photo.

• Reset Develop Settings: Resets only the settings 
applied in the Develop tab.

• Reset Effects Settings: Resets only the settings applied 
in the Effects tab.

• Reset Sky Settings: Resets the Sky Swap AI tab.

• Reset Portrait Settings: Resets Portrait settings.

• Reset All Retouching Tools: Resets any retouching 
applied in the Edit module.

• Reset Local Adjustments: Removes all local adjustments 
made to a photo.

• Reset Liquify Tool: Resets any application of the Liquify 
tools made to a photo.

• Reset Crop: Resets the current image’s crop to its 
original state.

• Reset Text: Removes all text blocks.

• Copy Settings: Copies all of the Edit module settings 
applied to a photo.

• Paste Settings: Pastes the copied settings (with options)

• Paste Settings from Previous Edit: Applies the Develop, 
Effects and Local settings from the last-edited file.

• Sync Settings: Selectively applies Edit settings from 
the primarily selected image (represented by the 
superselection) to the rest of the images in a selection 
(with options).

• Sync All Settings: Syncs all Edit module settings from 
the primarily selected photo to the rest of the images in 
a selection.

• Create Version: Makes a virtual copy of a photo, 
without duplicating the file on your hard drive.

• Save Settings as Preset: Saves the editing settings of 
the selected photo as a preset.

• Update Preset with Current Settings: If an image with 
a preset has had some settings changed, this lets you 
update the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.
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• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1.com’s Photo Presets 
page.

Cloud Sync

• Configure Cloud Sync: Opens the Cloud Sync 
Preferences window.

View Menu

• Bigger Thumbnails: Increases the size of the thumbnails 
in Grid view.

• Smaller Thumbnails: Decreases the size of thumbnails.

• Zoom In: Zooms into your image in Detail, Filmstrip or 
Compare view, displaying more detail.

• Zoom Out: Zooms out, fitting more of your image in the 
window.

• Fit to Screen: Resizes your image on-screen, to fit it 
entirely in the preview window.

• Actual Pixels: Zooms in to the 100% view.

• Preset Browser Mode: Sets the Preset panel browser 
view to 1, 2 or 3 columns.

• Thumbnail View Options: Lets you  change the display 
of thumbnails in Grid view..

• Filter Text: Puts the cursor in the text-search box at the 
bottom of the Browse window. 

• Filter by Rating: Filters images by star rating.

• Filter by Label: Filters images by color.

• Filter by Likes: Filters images by likes/dislikes.

• Reset filter: Resets any of the above filters (text, rating, 
label, likes).

• Show Clipping: Shows the clipping overlay view, 
displaying the pure white or black pixels. (Photo, 
Filmstrip and Compare views only.)

• Show Focus Mask: Displays a green overlay on those 
portions of the current image that are in focus. (Photo, 
Filmstrip and Compare views only.)

• Sort: Sort by filename, date, rating, label and more.

• Sort Subfolders at the Top: When sorting, puts 
subfolders at the top of the grid.

• Show Subfolder Contents: Will display/hide the 
contents of subfolders when viewing cataloged folders.
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• View Mode: Select from Thumbnail (grid), Photo (detail), 
Filmstrip or Compare views.

• Preview Quality: Select from Fast (uses embedded JPG) 
or Accurate (builds preview from the raw photo).

• Preview Background Color: Change the preview 
background color.

Window Menu

• Minimize: Minimizes ON1 Photo RAW 2023.

• Zoom: Zooms your window.

• Full Screen Mode: Enters or exits full-screen mode.

• Dual Mode: Adds new browser window for use in a 
second display.

• Full Screen Preview: Displays the current photo full-
screen, without any additional interface elements.

• Quick Slideshow: Displays the current group of photos 
in a slideshow, with customizable time and transition 
effects.

• Folders: Opens and hides the Folders pane.

• Albums: Opens and hides the Album pane.

• Tethered Shooting: Opens/hides the Tethered Shooting 
pane.

• Recent: Opens and hides the Recent pane.

• Info: Open and hides the Info pane.

• Metadata: Open and hides the Metadata pane.

• Keyword List: Opens and hides the Keyword List pane.

• Show Bumper Labels: Hides/reveals the text labels in 
the module selector.

• Show Browser Panel: Hides/reveals the Browse Panel.

• Show Photo Panel: Hides/reveals the Photo Panel.

• Hide Panels: Hides/reveals both left and right panels.

Help
• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub inside Photo 
RAW. 

• ON1 Photo RAW 2023 Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training page 
in your default web browser.

• Getting Started: Opens the initial Photo RAW startup 
screens.
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• Check for Updates: Checks the ON1 update server to 
see if you are running the current version; it notifies you 
about updates and will walk you through the update 
process.

• Sign-In/Sign-Out: Uses your ON1 account login 
information to authenticate your copy of Photo RAW.

• Provide Feedback: Opens the default web browser and 
goes to the feedback page of the ON1 website.

• About ON1 Photo RAW 2023 (Windows Only): Opens 
the about box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with ON1 Photo 
RAW 2023.
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Edit Menus
ON1 Photo RAW (MacOS Only)

• About ON1 Photo RAW: Opens the About box and 
displays your version number. (This is in the Help menu 
on Windows)

• Preferences: Opens the preferences dialog. (In the Edit 
menu on Windows)

• Quit ON1 Photo RAW: Quits ON1 Photo RAW 2023.

File Menu

• New Canvas: Creates a new layered .onphoto file at the 
specified dimensions.

• Canvas Size: Lets you change the size of the current 
layered file.

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format.

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using 
a preset from the hierarchical menu, bypassing the 
Export window.

• Export with Previous: Exports the current image with 
the last-used Export setting.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available 
if the last thing you did was an undo.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to the 
current location.

• Delete: Deletes the current image (Filmstrip mode only).

• Revert: Reverts to the original state of the current 
photo.

• Preferences (Windows): Opens the Preferences dialog.

• Keyboard Shortcuts: Lets you add or modify the 
hotkeys for many of Photo RAW’s commands.
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Layer Menu

• Add Layer from File: Lets you add a new file to the 
current document as a layer.

• Add Color Fill Layer: Adds a new layer consisting of a 
solid color.

• Edit Color Fill: Lets you change the color of a selected 
color fill layer.

• Delete: Deletes the currently selected layer.

• Duplicate: Duplicates the currently selected layer.

• Reset Layer Properties: Removes any applied layer 
masks or transforms to the current layer.

• Merge Layer: Merges the current layer with the one 
beneath it.

• Merge Visible: Merges all of the visible layers into a 
new, merged layer.

• New Stamped Layer: Merges the visible layers into a 
new, composite layer, leaving the visible layers intact.

• Align Visible Layers: Aligns visible layers based on their 
content.

• Filters: Contains a list of installed Photoshop  plugins. 
Selecting an item sends the current layer to the plugin 
and returns it in a new layer. 

Photo Menu

• Auto Advance: When checked, any color, rating or like 
setting applied to a photo will save it for that photo, 
then move on to the following photo.

• Rotate 90 Degrees CW: Rotates an image clockwise 90°

• Rotate 90 Degrees CCW: Rotates an image 
counterclockwise 90°

Mask Menu

• Invert Mask: Inverts the mask, what was hidden is 
revealed and vice versa.

• Reset Mask: Resets the mask to plain white.

• Copy Mask: Copies the mask.

• Paste Mask: Pastes the mask.

• Create Luminosity Mask: Creates a luminosity layer 
mask based off of a photo’s black or white tonal values.

• Mask Sky: Automatically creates a mask of the sky in 
the current image.



ON1 Photo RAW 2023 User Guide	 Part 6: Photo RAW Reference	 259

• Show Mask: Displays the current mask either as a red 
overlay or as grayscale.

• View Mode: Sets the Show Mask mode to either red 
overlay or grayscale.

Settings Menu
• Reset All Settings: Resets all Edit module settings.

• Reset Develop Settings: Resets all Develop settings.

• Reset Effects Settings: Resets all Effects settings.

• Reset Sky Settings: Resets any sky replacement.

• Reset Portrait AI Settings: Resets Portrait AI settings.

• Reset All Retouching Tools: Resets any retouching 
applied in the Edit module. 

• Reset Local Adjustments: Resets all local adjustments.

• Reset Liquify Tool: Resets any application of the Liquify 
tools made to a photo.

• Reset Crop: Resets cropping made to a photo.

• Reset Text: Resets text blocks added to a photo.

• Copy Settings: Copies all of the settings (Develop, 
Effects, retouching) applied to a photo.

• Paste Settings: Pastes the copied settings (with options)

• Paste Settings from Previous Edit: Applies (to the 
current photo) any Edit module adjustments made to 
the previous photo.

• Sync Settings: Selectively applies the Edit module 
settings from the primarily selected image to the rest of 
the images in a selection.

• Sync All Settings: Applies all of the Edit module settings 
from the primarily selected image to the rest of the 
images in a selection.

• Create Version: Makes a virtual copy of a photo, 
without duplicating the file on your hard drive.

• Save Settings as Preset: Saves the editing settings of 
the selected photo as a preset.

• Update Preset with Current Settings: If an image with 
a preset has had some settings changed, this lets you 
update the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1’s Photo Presets web 
page.
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• Save Settings: Saves the current state of your edits in 
the Edit module, in case of crash.

• New Snapshot: Creates a new snapshot of the current 
editing state.

View Menu

• Zoom In: Zooms the preview window in one increment. 
This will make the preview image larger.

• Zoom Out: Zooms the preview window out one 
increment. This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the 
entire image is on screen at once. Think of this as an 
overview of the entire image. This is the setting you will 
use most of the time.

• Actual Pixels: This sets the preview image so that it 
zooms to actual pixels or 1:1 also called 100%. This 
setting allows you to see every pixel in the image. This is 
useful when making precision adjustments.

• Preset Browser: Sets the Preset panel browser view to 
1, 2 or 3 columns.

• Show Clipping: Shows the clipping overlay view, 
displaying the pure white or black pixels.

• Show Focus Mask: Displays a green overlay on those 
portions of the current image that are in focus.

• Show Preview: Toggle to enable or disable the preview.

• Compare: Displays an adjustable split-screen view of 
the current image, with the Before view on the left side 
of the preview area.

• View Mode: Toggles between Filmstrip and Detail view.

• Preview Background Color: Lets you set the 
background color options.

• Enable Soft Proofing: Turns on soft proofing for the 
current image.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display 
profiles; choosing a profile will apply soft proofing for 
that profile’s paper type.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, Photo RAW 
will set the white point and black point of the display to 
account for that of the chosen profile.
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Window
• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size.

• Full Screen: Toggles full-screen mode (hides menus).

• Dual Mode: Turns on dual-display mode

• Navigator: Hides or shows the Navigator, Loupe, 
Histogram and Info pane.

• Layers: Collapses the Layers pane.

• Solo Mode: Keeps only one pane open at a time.

• Show Layers: Completely hides/shows the Layers pane.

• Open Quick View Browser: Opens the Quick View 
Browser overlay for the selected preset category.

• Show Bumper Labels: Hides/reveals the text labels in 
the module selector.

• Show Browser Panel: Hides/shows the Browser Panel.

• Show Control Panel: Hides/shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit 
depth of the open image.

Help
• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub. 

• ON1 Photo RAW 2023 Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training page 
in your default web browser.

• Getting Started: Opens the initial Photo RAW startup 
screens.

• Check for Updates: Checks with the ON1 update server 
an updated version. If there is a newer version, you will 
be notified and be walked through the update process.

• Sign-In/Sign-Out: Uses your ON1 account login 
information to authenticate your copy of Photo RAW.

• Provide Feedback: Opens the default web browser and 
goes to the feedback page of the ON1 website.

• About ON1 Photo RAW (Windows Only): Opens the 
about box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with Photo RAW.
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Resize Menus
ON1 Photo RAW (MacOS Only)

• About ON1 Photo RAW: Opens the About box and 
displays your version number. (This is in the Help menu 
on Windows)

• Preferences: Opens the preferences dialog. (In the Edit 
menu on Windows)

• Quit ON1 Photo RAW: Quits ON1 Photo RAW 2023.

File Menu
• Done: Saves the current image and returns to Browse 

(or external source).

• Cancel: Cancels any Resize operations and returns to 
Browse (or external source).

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using 
a preset from the hierarchical menu, bypassing the 
Export window.

• Export with Previous: Exports the current image with 
the last-used Export setting.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu
• Undo: Removes the last file operation.

• Redo: Redoes the undo operation.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes the items in the clipboard.

• Preferences (Windows): Opens the Preferences dialog.

• Keyboard Shortcuts: Lets you add or modify the 
hotkeys for many of Photo RAW’s commands.

Photo Menu

• Rotate 90 Degrees CW: Rotates an image clockwise 90°

• Rotate 90 Degrees CCW: Rotates an image 
counterclockwise 90°
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Settings Menu
• Reset all Settings: Resets any settings made in Resize 

(current image only).

• Copy Settings: Copies all of the Resize AI settings 
applied to a photo. (Copy is kept as long as Resize remains 
open.)

• Paste Settings: Pastes the copied settings to the current 
photo. (Kept as long as Resize remains open.)

• Paste Settings from Previous Edit: Applies any Resize 
AI adjustments made to the previous photo to the 
currently selected photo. (Only applicable when using 
Resize AI in batch-processing mode.)

• Sync All Settings: Applies all of the Resize settings from 
the primarily selected image to the rest of the images in 
a selection. (Only applicable when using Resize AI in batch-
processing mode.)

• Save Settings as Preset: Saves a new preset.

• Update Preset with Current Settings: If an image with a 
preset applied has had some settings changed, this lets 
you update the preset to reflect those new settings.

• Rename Preset: Renames the current preset.

• Delete Preset: Deletes the currently selected preset.

• Export Preset: Exports the current preset as an .onr file.

• Import Preset: Imports ON1 Resize preset files.

View Menu

• Zoom In: Zooms the preview window in one increment. 
This will make the preview image larger.

• Zoom Out: Zooms the preview window out one 
increment. This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the 
entire image is on screen at once. Think of this as an 
overview of the entire image. 

• Actual Pixels: This sets the preview image so that it 
zooms to actual pixels or 1:1 also called 100%. This 
setting allows you to see every pixel in the image. This is 
useful when making precision adjustments.

• Show Clipping: The clipping overlay view displays the 
pure white or black pixels in the current image.

• Preview Background Color: Lets you set the 
background color options.

• Enable Soft Proofing: Turns on soft proofing.
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• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of printer and display profiles; 
selecting a profile applies soft proofing for that profile.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: Sets the white point and black 
point of the display for that of the chosen profile.

Window

• Minimize: Minimizes your screen.

• Zoom: Zooms window to full-size.

• Full Screen: Toggles full-screen mode (hides menu bar).

• Navigator/Loupe/Histogram: Hides or shows the 
Navigator, Loupe, Histogram (Levels) and Info pane.

• Document Size: Toggles the Document Size pane.

• Settings: Opens or closes the Settings pane.

• Sharpening: Opens or closes the Sharpening pane.

• Film Grain: Opens or closes the Film Grain pane.

• Tiling: Opens or closes the Tiling pane.

• Gallery Wrap: Opens or closes the Gallery Wrap pane.

• Solo Mode: Keeps only one control pane open at a time.

• Show Control Panel: Hides or shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit 
depth of the open image.

Help

• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the ON1 Learning Hub. 

• ON1 Photo RAW 2023 Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training page.

• Getting Started: Opens the Photo RAW startup screen.

• Check for Updates: Checks with the ON1 update server 
for an updated version.

• Sign-In/Sign-Out: Uses your ON1 account login 
information to authenticate your copy of Photo RAW.

• Provide Feedback: Opens the default web browser and 
goes to the feedback page of the ON1 website.



ON1 Photo RAW 2023 User Guide	 Part 6: Photo RAW Reference	 265

• About ON1 Photo RAW (Windows Only): Opens the 
about box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with ON1 Photo 
RAW 2023.
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Preferences
Photo RAW has a number of system-wide settings that you can set via the Preferences window. To access 
Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences from 
the ON1 Photo RAW 2023 menu (Mac) or the Edit menu in Windows.

The Preferences window has seven tabs: General, Files, Plug-Ins, System, Services, ON1 360 and Auto 
Mark. The settings in each tab are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings for 
the Photo RAW workspace, including background 
color, scrolling controls and more.

Font Size

Sets the size of the text in the basic Photo RAW 
workspace (labels, panes and pop-up menus) to one 
of three general sizes: Small, Medium, Large. 

When changing the font size, you must quit and 
restart Photo RAW for the new setting to take 
effect.

Preview Background Color

You may select the color of the background behind 
the preview image. The default color is black. There 
is options for black, white, light gray, dark gray and 
custom. The custom option has a color picker where 
you can select your own background color.

Accent Color

Lets you choose the display color for highlighted items in the Photo RAW interface.

Application Language

Lets you change the display language for Photo RAW. Auto will use your system’s default language.

Legacy Browse Tab

Checking this will change the separate My Catalogs and Browse panels to the single Browse panel found in 
earlier versions of ON1 Photo RAW. (See “My Catalogs, Browse and Presets Panels” on page 15.) 

Show Folder Previews

When checked, will display a thumbnail of an image from the enclosing folder in Browse.
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Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.

Open External Files

When double-clicking a photo in Photo RAW from either MacOS Finder or Windows Explorer, specifies 
whether to open the file in the Browse module (default) or the Edit module, the latter by using Edit a Single 
Photo mode (see “Edit a Single Photo” on page 18).

Double-Click in Browse

Sets the behavior when double-clicking on a photo in Browse’s Grid view. The default is to zoom in to the 
photo; the alternative is to open the photo in the Edit module.

Default Browse Location

By default, the Pictures short cut in Browse is either Pictures (Mac) or My Pictures (Windows). You can 
change that location via this setting.

Portrait AI Default

Sets the strength of Portrait AI’s retouching algorithms when you open a photo in the Portrait tab. There 
are two options, Subtle and Strong. The default is Subtle. (See page 179 for information on the options.)

NoNoise AI Default

Sets the strength of NoNoise AI’s noise reduction when you open a photo in the Portrait tab. There are 
three options, Low, Medium and High. The default is High. (See page 135 for information on the options.)

Enable Split Screen Compare when in NoNoise AI

Lets you set the default option for working in the NoNoise panel in Develop. When checked, Photo 
RAW will automatically switch to before/after Compare mode when you click on the NoNoise tab. When 
unchecked, you must click on the Compare button at the bottom of the screen to turn on the before/after 
view.



ON1 Photo RAW 2023 User Guide	 Part 6: Photo RAW Reference	 268

FILES

The Files tab is used to determine what file type 
ON1 Photo RAW will create when opening a file 
in Resize, or when creating copies to send to an 
external editor from within Browse. It also lets 
you apply camera-based presets.

What to Edit

There are five options in this tab:

1.	 File Format: Sets the file type you 
wish to create: PSD, TIFF, or JPEG. If 
you wish to use a layered workflow, 
you must choose PSD.

2.	 Color Space: Sets the default color 
space when opening a copy of a file; 
the list includes Adobe RGB 1998, 
Apple RGB (MacOS), sRGB, ProPhoto 
RGB, or ColorMatch RGB. (If you 
imported a profile, it will also be 
available here.)

3.	 Bit Depth: Sets the bit depth for the 
file when opening a copy of a file.

4.	 Resolution: Sets the resolution when opening a copy of a file.

5.	 Show these options every time: If you do not wish to use a predefined set of file 
characteristics for opening photos from Lightroom or Photoshop, click this box.

Sidecar Options

Click this box if you wish ON1 Photo RAW 2023 to create ON1-specific ‘sidecar’ files when you are editing 
images. This is helpful if you are using the same image library with multiple computers (on an external hard 
drive, for example), and want your edits to be visible on each machine. 

Treat RAW+JPG Pairs as a Single Photo

If you shoot RAW+JPG, you can use this option to ‘stack’ both photos inside Browse. (RAW+JPG pairs are 
shown with a small icon in the lower left corner of the thumbnail.)

Default Processing

The Default processing section contains three options, for lens correction, base level raw-file corrections, 
and applying camera-based presets. The first, Apply Lens Correction Automatically, will use the lens 
correction automatically on any raw photo when you view it in Detail, Filmstrip or Compare modes. The 
Disable Base Corrections option turns Photo RAW’s basic raw-file correction settings off. This can be 
helpful for scientific/technical photography, time-lapse, and other specialized applications.
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The Camera-Based Presets section at the bottom of the Files pane will contain a list of known cameras you 
have shot with. You can have Photo RAW automatically apply any preset to a specific camera by choosing 
the preset from the appropriate pop-up. (See page 122 for more about using camera-based presets.)

PLUG-INS

The Plug-Ins tab is used to load third-party 
Photoshop plugins for use within Photo RAW. 
To install them in Photo RAW’s default location, 
click the Open Default Folder button and 
copy the plugin files there. You can also have 
a secondary plugin folder; to use this, click the 
checkbox, and then choose the folder by clicking 
on the Choose button.

See “Using Photoshop Plugins with Photo RAW” 
on page 8 for information.

SYSTEM

The System tab displays performance-related 
characteristics of Photo RAW 2023.

AI processor

Sets the processing option for Photo RAW’s 
AI-based operations. By default, the option is 
set to Auto, which uses the best combination 
of system resources to process tasks. If you are 
noticing some performance issues with NoNoise, 
Sky Swap, or other AI-based tasks, you can try 
setting the options to either your CPU or your 
graphics card.

Memory Usage

• System Usage: Specifies the amount 
of RAM that is used by the application. 
The maximum (default value) is 80%.

• VRAM Usage: Specifies the amount 
of video memory (VRAM) used. The 
maximum (default) is 80%.

Scratch Folder Location

Lets you move or reset your memory cache, to speed editing operations while you’re running Photo RAW. 
This is helpful if your system drive has limited space and wish to use a faster external drive as a cache. This 
cache information is purged each time you quit the application.
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Browse Cache

ON1 Photo RAW 2023 stores thumbnails previews on disk so that the next time you browse a folder it 
loads much faster. This setting lets you adjust the memory cache size as well as empty the cache, move it to 
another location, or reset it if you are having issues with Browse. 

TIP: If you use cataloged folders and have a small SSD boot volume, move the 
Browse cache to another drive for performance and space considerations.

Performance

The Performance section is designed to help you optimize Photo RAW for your specific setup:

• Video Card Strength balances updating the preview of the image and the movement of 
brushes and gradient tool overlays. If your brush is sticking try turning it down. If you have a 
high-end video card try turning it up for faster preview updating.

• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to 
improve performance of panning.

• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, 
sharing and caching. This can greatly improve performance. It is on by default for systems 
that support it. It may be disabled on lower-end GPUs.

Lightroom Migration Cache

If you run into problems with the Lightroom Migration Assistant, you can clear the cache here. (See 
“Moving Your Lightroom Catalog to Photo RAW” on page 272.)

CLOUD SYNC

If you have subscribed to the ON1 Cloud Sync 
service, this tab lets you set the name for your 
device (which will be displayed on your other 
synced devices), as well as whether or not you 
wish to publish RAW+JPG pairs and your presets 
and imported extras.

The Reset Cloud Sync button will return your 
sync setup to its original state, removing all 
photos and devices. 

Detailed information about Cloud Sync can be 
found starting on page 65.
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AUTO MARK

This tab lets you set the various criteria Photo 
RAW uses when using the Smart Organize 
feature in Browse.  See page 49 for details 
on Smart Organize, and how to adjust the Auto 
Mark settings to fit your needs.

KEYWORD AI

This tab is for adjusting the settings of the 
Keyword AI feature in Browse. By default, 
Photo RAW scans all of the photos in all of your 
cataloged folders, and builds keywords based on 
the subjects in the photos.

If you don’t wish Photo RAW to use the 
Keyword AI feature, uncheck the Scan 
Cataloged Folders with Keyword AI option. If 
you do, you can tweak what parameters are 
used to apply keywords during the scanning 
process. These options include:

• Location lookup for GPS metadata.

• Photographic properties.

• Faces in Photos, with optional gender and age lookup.

• Objects and regions.

• Folder names.

If you are using ON1 Cloud Sync, you can set Photo RAW to sync or not sync AI-based keywords with your 
other devices.

For information on the Keyword AI feature, see page 39.
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Moving Your Lightroom Catalog to Photo RAW
If you are a Lightroom user and you wish to make Photo RAW your primary editing application, you can use 
our Lightroom Migration Assistant to transfer most of your catalog settings and metadata from Lightroom 
into Photo RAW. You can even—with a few caveats—transfer photos that have been edited in Lightroom so 
that they appear inside ON1 Photo with corresponding (non-destructive) edits applied to them. And, it does 
this without changing any of the original files in your Lightroom catalog, or the catalog itself. Instead, we 
use machine learning to migrate the actual Lightroom edits in a re-editable, non-destructive way. 

NOTE: This tool is designed for one-time migration of catalogs. As such, the 
migration process can take a long time. You can continue to use Lightroom and 
ON1 Photo RAW 2023 during the migration period. The migration process can 
also temporarily use a large amount of disk space on the drive (or drives) where 
you store your images. Make sure you have plenty of space before you begin.

This tool performs the following tasks:

• Top-level folders in Lightroom’s Folders pane become cataloged folders in Photo RAW. All the 
photos and videos in those folders will be cataloged automatically.

• Metadata changes made in Lightroom will be migrated, and include ratings, flags, keywords, 
descriptions, GPS data, color labels, orientation, and so forth.

• Standard Lightroom collections will be migrated as well. (Smart collections are not converted.)

• Most raw processing and editing settings made inside Lightroom’s Develop module are 
migrated non-destructively—and are editable—inside Photo RAW. These operations include 
crop, retouching, local adjustments, vignettes, noise reduction and sharpening, and more. 
(See “Which Lightroom Settings are migrated?” on page 274 for exact details of which 
settings are transferred and which ones are not.)

To migrate your catalog, open it inside Lightroom, and choose Migrate Catalog to ON1 Photo from File > 
Plug-In Extras. An assistant window will open up; the first and second tabs of the window have an 
introduction about the process. If you would like to see any additional up-to-date information on the 
Migration Assistant, click the Learn More button, which will take you to a help page on the ON1 website.

The Intro and Prepare tabs give you information about the Lightroom Migration assistant. Click the 
Learn More button to go to the ON1 website for more detailed information about the process.
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Click on the Next button when you’re ready; this will take you to the Settings tab, where you can choose 
whether to have the Assistant transfer your standard Lightroom Collections (Smart Collections are not 
transferable) and any Develop adjustments made in Lightroom. Once you’ve made your selection, click on 
the Next button to go to the Copies tab.

NOTE: If you migrated your Lightroom catalog, and your photo settings in 
Lightroom are not correct, launch the Migration Assistant again, go to the 
Settings tab and click the Roll Back button at the bottom of the tab. This will 
return your Lightroom settings to the state before you started the Migration 
process. (Click the Cancel button when the roll-back procedure is complete.)

The Copies tab lets you export copies of any photos that have Develop adjustments made to them inside 
Lightroom into a new file that includes all of those edits. These copies are created based on the options 
chosen in the Copies tab, and include the following options:

• File Type: This menu determines what type of file will be created. The default is PSD, which 
maintains layers. You can also select JPG or TIFF, if you prefer those formats.

• Color Space: The color space drop-down menu determines what RGB working color space is 
used; Adobe RGB 1998, sRGB or ProPhoto RGB.

• Bit Depth: This sets the copied file’s bit depth to either 8 or 16 bits per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

When the Copies option is checked, any photo that has been edited inside Lightroom will have a new copy 
saved in same folder as the original image. Both images will be visible in Photo RAW after the migration 
process is complete.

Once you have set your options in the Assistant window, click the Migrate button. Once initiated, the 
following steps happen:

1.	 Using the Photo RAW plugin, small JPEG versions of all images in the catalog—used for 
comparison purposes during the migration—are 
exported to a temporary location, as are separate 
sidecar files that contain metadata (.on1) and edit 
information (.on1meta) for each image. 

The Settings and Copies tab offer multiple options for the conversion operation.

Once you’ve clicked the Migrate button, Lightroom will 
begin the process of exporting catalog information to ON1 
Photo RAW 2023.
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2.	 If you checked the Copies option, those images are also exported and saved to the same 
folder as the original. 

3.	 When the process is complete from within Lightroom, Photo RAW will launch, and the 
Lightroom catalog’s folders will show up as Cataloged Folders inside the Browse module’s 
Folders pane. (The thumbnails for the images will initially be based on the temporary JPEGs 
exported in Step 1 above.)

4.	 In the background, Photo RAW will go through the cataloged folders and, using the 
information stored in the .on1meta files, will perform a conversion process to align edits 
between the Lightroom versions and the new ON1 Photo RAW version.

5.	 When viewing migrated catalog folders inside Browse, any image that has not yet been 
converted will have a small ‘LR’ badge in the lower right corner of the thumbnail. Once Photo 
RAW has finished the conversion on that image, the badge will change to a small ‘+/-’ badge.

6.	 As Photo RAW completes the conversion on each image, the temporary files are deleted, 
and the .on1 sidecar files are updated.

NOTE: Choosing the Create Copies option will create a copy of all photos that 
have any adjustment made to them. This includes such things as lens profiling 
or default noise reduction, which some people use as an import preset when 
bringing photos into Lightroom. We recommend examining your catalog, and 
determine how you wish best to proceed with the migration. In some cases, it 
might be better to use Lightroom’s export dialog to selectively export edited 
photos into a new folder, and add them to ON1 Photo RAW as a new cataloged 
folder—or however you might wish to organize them inside Photo RAW.

The process, which, as noted, can take quite some time, although you can continue work inside Photo RAW 
once the Lightroom export component has been completed. If you quit Photo RAW and restart it later, the 
app will continue to work in the background until all of the migrated images are translated into ON1 Photo 
RAW edits.

NOTE: Migrating the Lightroom Develop adjustments does not affect either 
the original photos or their settings inside the Lightroom catalog. What ON1 
Photo RAW does is apply a ‘translation’ of the Develop settings of your 
Lightroom edits to Photo RAW’s Develop settings, and saves those edits in 
an ON1-specific sidecar file. When you open a migrated photo inside the Edit 
module, you’ll see ON1’s approximation of the edits you made in Lightroom.

WHICH LIGHTROOM SETTINGS ARE MIGRATED?

Due to the complexities of moving editing settings from one raw development environment to another, 
not every setting in Lightroom is converted when you migrate your catalog. The following table lists key 
Lightroom features, if they’re converted, along with some notes about the specific feature mentioned.
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FEATURE CONVERTED? NOTES

Folders Yes All top-level Folders in Lightroom become top-level 
cataloged folders in Photo RAW.

Photos/Videos Yes All photos/videos in the cataloged folders are added. 
This may include some photos that are not cataloged in 
Lightroom. Photo RAW only migrates available photos and 
does not migrate photos from offline volumes. 

Virtual Copies Yes Virtual Copies become Versions inside Photo RAW.
Stacks No 
Collections Yes All normal collections are migrated to albums. Collection sets 

become album sets. Smart collections are not migrated.
Crop Yes 
Spot Removal Yes Spot Removal is migrated to the Clone Stamp when used in 

Clone mode. When used in Heal mode it is migrated to the 
Perfect Eraser. The results will not be a pixel perfect match 
but will generally remove the same spots with comparable 
results. 

Basics Yes Camera Profiles are matched for Adobe® and Camera 
profiles. Other LUTs or custom profiles are not migrated. 
Clarity is called Structure in Photo RAW. Dehaze is called 
Haze and will look a bit different. 

Black & White Yes 
Tone Curve Yes Point-based curve adjustments only. 
HSL/Color Yes You will find this in the Color Adjustment filter in Effects.
Split Toning Yes You will find this in the Split Tone filter in Effects.
Detail Yes There are significant differences in the sharpening and noise 

reduction algorithms. We did our best to align them but they 
may require manual adjustments to taste before output. 

Lens Correction Yes Automatic lens correction is applied if we have a matching 
lens profile. Manual distortion settings are not migrated. 

Transform No Unfortunately, Lightroom’s Transform function is very 
different and we couldn’t find a practical way to migrate 
these settings. You can achieve similar results using the 
Transform pane in Develop in Photo RAW. 

Effects Yes Found in the Vignette and Film Grain filters in Effects.
Camera Profiles No Profiles are proprietary to the developer of the raw engine.
Red Eye No You can reduce red-eye automatically in the Portrait module. 
Graduated Filter Yes You will find these as adjustment layers in the Local module 

using the Adjustable Gradient. Range mask, Moiré and 
Defringe are not migrated at this time. 

Radial Filter Yes You will find these as adjustment layers in the Local module 
using the Adjustable Gradient. Range mask, Moiré and 
Defringe are not migrated at this time. 

Adjustment Brush Yes You will find these as adjustment layers in the Local module 
using the Adjustment Brush, including the Auto Mask 
function. Range mask, Moiré and Defringe are not migrated 
at this time. 
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Backing up Your Work in Photo RAW
To safeguard your peace of mind in the event of computer failure—or help you get set up quickly when 
you move to a new computer—ON1 Photo RAW 2023 includes a back-up and restore function. While 
this feature will not back up your photos, it will back up the following items related to your Photo RAW 
installation:

• All preferences, references to cataloged folders and other basic settings for Photo RAW.

• Albums created in Browse.

• Metadata changes made to images in Browse, including keywords, ratings, labels, and any 
data added via the Metadata pane. 

• All presets and styles used in Photo RAW.

• All Extras, including any you have imported.

• All of the edits made on any image in the Edit module.

To back up your Photo RAW system, choose Back Up 
Data from the File menu in the Browse module. The 
Back Up Data window will let you choose a location for 
your backups, and also let you set a reminder schedule 
(daily, weekly, monthly, or no reminder) for backups. 
When you click the Back Up button, Photo RAW will 
create a .onbackup file in your chosen location, with the 
date and time embedded in the filename.

To restore your system to the latest backup, choose Restore Data from the File menu in Browse. 
(Depending upon the situation, you might need to reinstall ON1 Photo RAW 2023 first.) The Restore Data 
window will prompt you for the location of your backups, and will choose the most recent backup to 
restore from. (If, for some reason, you would like to use 
an earlier backup, just move the most recent one to 
another location on your hard drive.)

Clicking Restore will pull the information from the 
backup and apply it to your Photo RAW setup. During 
the restoration process, if Photo RAW can’t find the 
proper folders with your photos, it will present the 
Missing Folders window, with a list of each folder that it 
can’t find. You can click the Locate button to reconnect the folder, or you can click the ‘X’ to the left of the 
folder name in the window to remove it from Photo RAW’s database. 

NOTE: Photo RAW’s back-up feature will not back up your photos; you should 
use other methods to ensure that your photos are backed up in a safe place.
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shortcuts

Windows macOS
Change Modules/Tabs

Browse G

Develop D

Effects S

Portrait I

Local Adjustments A

Resize Y

Preview Nagivation

Zoom-in ⌃ + ⌘ +

Zoom-out ⌃ — ⌘ —

Fit to Screen ⌃ 0 ⌘ 0

Zoom to 100% (1:1) ⌃ ⎇ 0 ⌘ ⌥ 0

Pan Photo hold space

View & Window Modes

Grid View G

Photo View E

Filmstrip View F

Compare View (Browse) C

Fullscreen n/a ⌘ ⌃ F

Hide Right Panel ⌃→ ⌘ →

Hide Left Panel ⌃← ⌘  ←

Hide Both Panels ⇥
Split-Screen Compare (Develop/Effects) ⌃ Y ⌘ Y

Preview and Masking Views

Original View (Preview Off) \

Show Mask O

Show Clipping hold J

Enable Soft Proof ⎇ S ⌥ S

Browse

Change Thumbnail Size + /—

Browse a Folder ⌃ B ⌘ B

Select All ⌃ A ⌘ A

Select None ⌃ D ⌘ D

Deselect /

Set Rating 1-5

Set Label 6-0

Dislike X

Like P

Clear Like/Dislike U

Delete ⌦

Advanced Search ⌃ F ⌘ F

Presets

Open Quick View Browser ⎇ ↑ ⌥ ↑

Insert Preset ⎇ click ⌥ click

Windows macOS
Photo Settings

Rotate 90 ⌃ ] ⌘ ]
Rotate -90 ⌃ [ ⌘ [
Reset All Settings ⇧ ⌃ R ⇧⌘ R
Copy Settings ⇧ ⌃ C ⇧⌘C
Paste Settings ⇧ ⌃ V ⇧⌘ V
Sync Settings ⇧ ⎇ S ⇧ ⌥ S
Create Version ⌃’ ⌘’
Save Settings ⌃S ⌘ S 

Brushing
Bigger Brush ]
Smaller Brush [
Increase Brush Opacity ⎇ ] ⌥ ]
Decrease Brush Opacity ⎇ [ ⌥ [
Increase Brush Feather ⇧ ]
Decrease Brush Feather ⇧ [
Rotate Brush Clockwise ⇧⎇ ] ⇧⌥ ]
Rotate Brush Clockwise ⇧⎇ [ ⇧⌥ [
Set Brush Opacity ⎇ 1-0 ⌥ 1-0
Toggle Perfect Brush ⌃ R ⌘ R
Hold Perfect Brush Color hold ⌃ hold ⌘
Toggle Paint-in/Paint-out ⇧ X or hold ⎇/⌥
Invert Mask ⌃ i ⌘ i
Draw Straight Line ⇧ click

Misc
Quick Export ⇧ ⌃ S ⇧⌘ S
Print ⌃ P ⌘ P
Undo ⌃ Z ⌘ Z
Redo ⇧ ⌃ Z ⇧ ⌘ Z

Tools
Crop C
Adjustment Brush ⇧ K
Adjustable Gradient ⎇ K
Spot Healing Brush Q
Perfect Eraser ⇧Q
Retouch Brush R
Clone Stamp S
Super Select K
Masking Brush B
Gradient Mask/Masking Bug M
AI Quick Mask W
Line Mask ⇧P
Refine Mask N
Zoom/Pan Z
Move/Transform V
Text T
Portrait ⇧ I
Chisel H 
Blur L 

⌃ Control         ⌘  Command         ⎇  Alt       ⌥  Option        ⇧  Shift       ⇥  Tab

ON1 PHOTO RAW 
Common Keyboard Shortcuts
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